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Welcome to Jama Connect

Welcome to Jama Connect

Jama Connect is a centralized web application for managing the development of new products. It handles
all aspects of product development, including requirements, reviews, and testing. Jama Connect also
records test results and manages risk while maintaining regulatory compliance.

Read through this section to learn how Jama Connect can change the way you work and enhance your
product development process. We want to answer all your "How do | get started?" questions.

Feature overview

For details, see Getting to know Jama Connect features [34].

Self-hosted users

Content that is specific to self-hosted environments, like installation and upgrade information, is availa-
ble in your Jama Connect environment within your instance/application. From Jama Connect, select Help
to open the Jama Connect User Guide for the version you are running.

For version-specific PDFs, see the Jama Support Knowledge Base.

Getting started

If you're just starting as a Jama Connect user or administrator, this is the place to begin. This section is
useful if you have a new Jama Connect instance or if you're learning to use an existing instance for the
first time.
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Welcome to Jama Connect

Start here — Log in to Jama Connect, explore the workspace, set up your environment, and learn about
the Jama Connect features.

Log in to Jama Connect
To start using Jama Connect, you need your user account credentials to log in.

e Trial account — Sign up for a free trial at https:/www.jamasoftware.com/platform/jama-connect/trial/
¢ New user — Your administrator has your account username and password

Note

i View these short videos to learn the Jama Connect basics: how to navigate the system,
add and edit information, build in traceability, send information for review, and collabo-
rate with your project team.

To log in to Jama Connect:

1. Inasupported web browser, enter the URL provided by your administrator.

2. Type your username and password, then select Log in.
Header — Includes the main sections (Stream, Projects, Reviews, Admin) of the Jama Connect

interface.
Home — Shows links to your most relevant content like bookmarks, recent views, open views,
stream comments, and actions.
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Welcome to Jama Connect

3. To log out of the application, select Log Out in the top right corner. If you don't log out, the system
logs you out after two hours.

Important

You're allowed 10 login attempts within five minutes before you're locked out for
30 minutes. To unlock your account before then, follow the forgotten password
procedure.

4. Continue to Explore the Jama Connect workspace [12] , then to Set up your work environ-
ment [24].

Your account is now accessible. To manage your account, select the name in the top right navigation to
open the My Profile window.

b_r Tip
o Bookmark your projects, containers, sets, and folders so they appear under Bookmarks
and Recently viewed sections. Having items appear in both places allows you to keep
track of recently viewed items even if you remove the bookmark.

Exploring the Jama Connect workspace
The Jama Connect workspace is where you set up and manage your projects, create test plans, commu-
nicate with your team, track relationships, and more.

The workspace is divided into five distinct panels that you can expand, collapse, and resize.
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1. Explorer Tree — Manage projects by selecting the tabs at the top of the left panel, called the
Explorer Tree, to expand these views: Explorer, Filters, Releases, Baselines, and Test Plans.

2. Center details panel — View the details for specific items. Content from Components, Sets, Folders,
Filters, and individual items are displayed in this panel.

3. Related Items panel — Add relationships between items for traceability or add items to a change
request. Open this section from the Relationships tab and close it when it's not needed.

4. Project side panel (Tag Cloud) — Use keywords to group items for easy navigation to those items.

5. Item information panel — Manage item information associated with comments, relationships, at-
tachments, versions, and activities.

Jama Connect is highly configurable, so you can customize the workflow to work best for you. For
example, focus on creating requirements from the Explorer Tree, view details about a test case, or
explore the relationship between items. Depending on the task or goal, you might interact with one area
or all areas of the workspace.

For an overview and tour of the Jama Connect workspace, see Tutorial: Overview and Navigation.

Explorer Tree
The Explorer Tree organizes the sets, components, folders, and items in your project hierarchy.

How it works

To move items [88] and organize your project, you can drag and drop items between the Explorer Tree
and List View [16]. You can also configure settings [29] so that the Explorer Tree displays information
that's most useful to you.
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Welcome to Jama Connect

Jama Connect arranges content by component, set, and folder. Select one to view its content.

To move multiple items, multi-select them in List View and drag them to their new location in the
Explorer Tree.

; Tip
% When you work in a folder with a large number of items, use List View instead of the
Explorer Tree. The setting for the default number of items per folder is 250 but it can be

changed by a project admin.
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See also

e Find an item in the Explorer Tree [759]
e Filter the Explorer Tree [156]
e Move items in the Explorer Tree [88]

Toolbar

The toolbar is located in the center details panel of the workspace. The tools allow you ways to control
and view your content.

Toolbar options vary slightly depending on your location in the application.

Select this... To...

See the details of a component, set, folder, or a project overview.

List View Show data from multiple items in a table with a different field in each column. You can sort, select, and compare
items at a glance. See List View [16].

Document Create, edit, and read items all in one view — no need to switch views for each function. See Document
View View [17].
[
Datasheet Open the filter panel and filter the items you want to see. You can limit the results by content, author, keyword,
[ Set + View detail: date, or coverage.
=8 [¥v =

In List View, manually adjust the height of the rows. Selecting Extended formats rows to wrap text.

wewde‘a Configure which fields appear for each item in Reading View, List View, or Trace View. See Configure fields [31].
Y lI=v % 2
Refresh Refresh the list of results and recent changes from other users.
N
s

Add items, folders, sets, and components.

%* Trace view Show related upstream and downstream items, missing relationships, and item details in context of their relation-
ship. See Trace View [19].

Export your data to Word, Excel, PDF, or use an Office Template.

Update picklist fields and tags for multiple items at a time.
Batch edit

s I
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Select this... To...
Reuse [355] when your projects contain items that are the same or similar.

Reuse

L]

Change an existing item from one type to another.
Convert to

-

—— Select multiple items of the same item type and transition them to a different workflow status.

[+
(<]

o

-

[Er— Send specific items for review (maximum number of items is 500).

- 8 ©

Relate to existing Relate two existing items of the same item type.

5 0 &

List View

In List View, you can configure which fields appear as table columns in the center details panel. The table
is dynamic — you can sort, select, drag and drop, and reorder columns.

¢ To reorganize columns, select the column header and drag it to the new location.

¢ To choose which fields you see in the table, you can configure fields [31].

e Use the interactive links (breadcrumb navigation) to find your way around and view the location of
your project hierarchy.

¢ To sort items, select the column header.

_ View information about an item.

QL-BR-3

Move [88] items in a project.
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ﬂ View locked items locked items [76].

[
View how many relationships an item has, as well as whether those relationships meet the project's relationship rules.
For more information, see Relationship Status Indicator [310].

- View and add comments [244].

»3

_ View and add connected users [257].

24
View related items (the relationship between two items). For more information, see Add a relationship from Single ltem
View [311].

Document View

Document View provides a streamlined authoring and editing experience. Like other authoring tools, you
can create, edit, and read items all in one view — no need to switch views for each function.

Use the edit feature to quickly edit items without changing views or having to manually track your place
in the document.

With Document View, you can:

1. Leverage all the functionality and toolbar actions of Reading View: filter items, configure items,
Reuse, Batch Transition, Send for Review, Edit, and more.

2. Add orinsert content from a single screen.

3. Select an item to open quick edit mode, with the option to expand to full edit mode.
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4. Select the item action menu (horizontal ellipsis icon) to expand the Widgets drop-down menu, then
select Relationships to open the Relationships panel.

From here, you can:

¢ View existing relationships

e Add, update, and remove relationships
o Clear suspect links

o Filter relationship settings

5. Insert new items without losing your place in the document.
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Add comments and lock items. Select an item's speech bubble icon to open the Comments panel, so
you can view comments and items at the same time. From the Comments panel, you can:

¢ Read and reply to existing comments

e Add, like, mute, and filter comments

e @mention a person or group

Trace View

Trace View shows related upstream and downstream items. It also shows item details in context of their
relationship and any missing coverage (downstream relationship).
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1. Filter item types in Trace View [308].

Configure each level to display or hide fields [31].

3. Find any gaps in coverage.

The red exclamation mark (!) indicates a missing relationship based on the relationship rule [644].
For example, if your item types are System Requirements and Verifications, and your relationship
rule requires System Requirements to have a Verification item downstream, the Trace View displays
a red exclamation mark when a System Requirement is missing the downstream item.

Export the content [307].

Add related items directly from this view with the Add menu option in the toolbar.

Establish relationships between existing items.

Create a global filter to refine tiles to match filter conditions.

N

No vk

You can also display fields for various item types. For example, you can display the Test Case Status
for verification and verification testing. If a test case item is visible in Trace View, you can navigate
downstream to see any test runs generated from the test cases.

Understanding the Trace View interface

In the Source section, Trace View displays the items that were visible in List View, Reading View, or
Single Item View from the time the Trace View was initiated.

The source

Direct downstream items

Blue arrows = Travel upstream (left arrow) or downstream (right arrow)
Top of each level column = Number of item types on the entire level

AR
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é’ Note
The item count is a unique count. If the same item is downstream of multiple items
in the source column, it appears multiple times in the "1 level down" column, but it's
counted only once.

Single Item View

In Single Item View, you can view specific details about an item such as an item's ID, Name, Description,
and Status. This view always shows all fields that your admin configured the item type to include.

You can also edit the item [72] and use widgets [774] to access different areas of Jama Connect.

Here's a high-level look at some features in Single Item View:

Top right toolbar [15]

Projects workflow [232]

Side toolbar [21]

Global ID [353]

View previous versions of an item [267]

Breadcrumb navigation (formerly called "Find me"), which helps you find your way around and
indicates the location in your project hierarchy

S e

Side toolbar

The side toolbar appears on the right side in Single Item View. The widgets give you access to different
features of Jama Connect and can be configured by an organization admin [691].
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Select this...

To...

Relationship Status Indica-
tor

i

¥ s

Open the bottom panel where you can see the required relationships for this item and whether the
item follows the project's relationship rules. Suspect relationships [317] are also flagged.

Connected users

”
(2]

Open a window that displays the users directly associated with the item as well as indirectly
associated with related or traced items. The number displayed is the number of connected users.

Review comments

E

Open and close the bottom panel of review comments [194] related to this item. The number
displayed is the total number of comments for this item.

Comments

(0
o

Open and close the bottom panel of comments [244] related to this item. The number displayed is
the total number of comments for this item.

Activities

A
(34

Open and close the bottom panel display of activities [243] related to this item.

Versions

V|
(3]

Open and close the bottom panel of item versions [264]. The number displayed is the total number
of versions for this item.

Synchronized items

#

o

Open and close the bottom panel of synchronized items [761].

Child items

o

Open and close the bottom panel with a list view of child items [71]. Appears only if the selected
item has child items.

Items to be changed

Y

Open and close the bottom panel with a list of change requests [269] that might affect this item.

Compare View

Compare View displays content side-by-side so you can see the variations between content in different

item versions.

To open Compare View, select the Version widget in the side toolbar.
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Compare View is used in these areas of Jama Connect:

e Compare versions of reviews [202]
e Compare synchronized items [370]
e Compare item versions [266]

Learn more
You can access information about Jama Connect with these features.

o Select Projects > Learn more to see a list of resources about Jama Connect.
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o Select Projects > Learn more to see which version of Jama Connect you're using at the bottom of the
page or from the login page if you're using the default authentication.

e Select Help in the top right corner to open the Jama Connect Help in a new tab.

e View a glossary [775] of Jama Connect terms.

Setting up your work environment
You can change the settings for your profile and workspace to suit your needs and your project work.
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My Profile window

¢ Add photo
e Change your password — Only users configured with Basic Authentication can change their password
from this screen

e Control subscriptions (email notifications)
e Manage settings for reviews

Workspace

e Customize the Explorer Tree
¢ View content
e Configure fields

For an overview and tour of the Jama Connect workspace, see Tutorial: Overview and Navigation.

25


https://www.jamasoftware.com/video/jama-connect-overview-amp-navigation-tutorial-thank-you/?_gl=1*1xr3sc7*_up*MQ..*_gs*MQ..&gclid=CjwKCAiAlrXJBhBAEiwA-5pgwtCLfcHLM3pzTQl12ZLqm-FQpVPg2lF7etDMA5G91o22R7_YivcC5xoCaqUQAvD_BwE&gbraid=0AAAAADL9ZkIU1Pk0IRahCQO6xby1iujrx

Welcome to Jama Connect

Reset your password

Users configured with Basic Authentication can change their password from the My Profile window or
from the login screen.

An organization, user admin, or system admin can also reset user passwords [656].

Note
y This feature is disabled if your organization uses LDAP, Crowd, SAML, or Basic + IdP
authentication.

To reset your password:

1. Select your name in the header to open the My Profile window.

2. Select Change Password at the top of the window.

3. Enter and confirm your new password. To display tips about required characters, hover over the
center of the window.

4. Select Close.

Your new password is now saved.

Set API credentials

To integrate applications and scripts through the Jama Connect REST API [545], you must first generate
API credentials. We currently use OAuth 2.0 authentication to generate pairs of client IDs and secrets.

Important considerations

e API credentials are only used for safe authentication. User access and privileges set by your Jama
Connect admin are still enforced.

e For full instructions about using API credentials, see the developer notes on authentication.
e You can maintain a maximum of 20 API credentials. Remove any you don't need.

To set your API credentials:
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1. Select your name in the header to open the My Profile window.

Select Set API Credentials at the top of the window.

3. Add a required name for this set of credentials with an optional description that helps you identify
its use, such as Test Automation Integration.

4. Select Create credentials. Jama Connect generates a new Client ID and Client Secret pair.

N

5. Copy the Client ID and Client Secret into Jama Connect. The Client Secret is only visible after you
select Create credentials. If you skip this step, you must re-create the Client Secret.

6. (Optional) Remove any credentials you don't need by selecting the X next to the name.

7. Select Close.

Your API credentials are now available for you to use.

Configure email notifications and subscriptions

Before you can subscribe to email notifications [230], you must first configure your profile to be able to
receive these notifications.

If others subscribed you to certain notifications, you can’t unsubscribe from them. You can, however,
mute them if your organization admin has enabled this functionality.

To configure your profile for email notifications and subscriptions:

1. Select your name in the header to open the My Profile window.

2. Select My Subscriptions, then select the subscriptions you want to see:
e Me — Subscriptions you created
e Others — Subscriptions created for you by others

Show Items Subscribed by Me (1) Others (1) g YUnzubscrbe selected

Show Items Subscribed by Me (1) Others (1) g Mute selected
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3. Define how often you want to receive notifications using the drop-down menu at the bottom of the
window. The system automatically checks for new notifications every 5 minutes.
¢ Immediate — Receive an email as soon as the activity occurs.
e Daily — Receive a batch of notifications in one email per day.

Weekly — Receive a batch of notifications in one email per week.

Mute All Notifications — Silence all item subscription emails.

6” Note
Muting notifications affects only email concerning your item subscriptions.

4. Select Close.

Your profile is now configured for notifications and subscriptions.

Configure your profile to receive review notifications

To keep up to date with review comments, you can subscribe to notifications for that review [208]. First,
though, you must configure your profile to be able to receive these notifications.

To receive review notifications:

1. Select your name in the header to open the My Profile window.
2. Select the Review Center tab.
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3. Select the options you want for review notifications:

¢ Email me updates to items I've subscribed to

¢ Automatically subscribe to items I've commented on
4. Select Close.

Your profile is now set up to receive review notifications.

Customize the Explorer Tree

The Explorer Tree organizes the sets, components, folders and items in your project hierarchy. You can
configure the Explorer Tree settings so that it displays only information that's useful to you.

To customize Explorer Tree settings:

1. Select the gear icon at the top of the Explorer Tree to open the Explorer Settings window.

2. Inthe My settings tab, select the settings you want:
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¢ Use my own settings — Overrides the default Explorer Tree settings with your personal settings.

o Use default settings — Returns the Explorer Tree to default settings. An organization or project
admin can configure default Explorer Tree settings [729].

e Show item IDs — Displays the unique ID [731] (as in PROJ-REQ-25) before each item.

¢ Display global ID — Displays the global ID (as in GID-8845) before each item. This can be helpful
if the item is copied and synchronized.

e Show only folders / hide items — Hides items from view in the Explorer Tree. Components, set,
and folders are still displayed.

' b_r Tip
. If your project has a large number of items, use this setting to improve perform-
ance by limiting your tree to display only as far as folders. You then interact with
items only in List View or Doc View.

¢ Show outline numbering — Displays a number scheme of order and depth in the Explorer Tree.
Root level items have numbers like 1, 2, or 3. Child items contain the parent item number as well
as its own number, asin 1.1, 1.2, or 1.1.5.

¢ Show relationships in Explorer Tree — Displays downstream relationships of items in the Explorer
Tree. Select the green downstream arrow to open related items in List View.
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Important

Be careful not to relate an item back to itself, which can create an infinite loop
that causes the Explorer Tree to expand.

3. Select Apply.
4. When you're satisfied with your changes, select Close.

The Explorer Tree now reflects the settings you chose.

Configure fields

Choose which fields are visible for each item as it appears in Projects List View or Trace View.
Important considerations

¢ You can configure your Compare View for synchronized items [374] or your List View for base-
lines [291].

To configure fields:

1. Select the gear icon (show/hide fields) in the toolbar [15].
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Product Requirements
5 Set - View details

= B i Ew | & 44items
) Restore defaults Al Selected (14) X
v" # of Attachments ¥ # of Comments
v # of Downstrea... v # of Links
# of Upstream R... v API ID
v Assigned to Categories
Conditions Connected Users

In Trace View, you can configure fields for each level independently.
2. Inthe drop-down list, select the fields you want to see.

3. Select Close.

The displayed list reflects your changes.

Add and delete bookmarks

Bookmarks are handy links to content that you view frequently and are displayed at the top of your
homepage. You can bookmark projects, components, folders, sets, filters, risk analyses, and Trace Views.

Bookmarks always appear at the top of the homepage and are sorted by the page most recently viewed.

To add or delete a bookmark:
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1. Use one of these methods to add a bookmark:

e Bookmark recently viewed content on the homepage — When you view a folder, set, component,
or project, it appears on your homepage in the Recently viewed list. Select the empty bookmark
icon for the content you want to bookmark. The bookmark icon changes to a solid icon and the
content appears under the Bookmarks and Recently viewed sections.

e Bookmark Trace Views — When viewing a Trace View that you want to bookmark, you first save
the Trace View [305], then select the bookmark icon at the top of the page. Trace View is now
bookmarked on your homepage.

¢ Use your browser's bookmarks or favorites feature — Follow the conventions of your browser to
bookmark any view in Jama Connect.

2. To remove a bookmark: On the homepage, select the solid bookmark icon in the bookmarks list. The
content you remove appears at the top of the section.

Your bookmarks now reflect your choices.
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Getting to know Jama Connect features

Learn about the features that make up Jama Connect, from the product's foundational features to
advanced capabilities.

Basic features

¢ [tem-based product development — In Jama Connect, items serve as the fundamental construct for
defining and verifying products and supporting your product development lifecycle. Each item defines
a discrete requirement, test case, test run, and more. Trace, Versioning, status, and collaboration are
captured for each item, which ensures granular control, transparency, and efficiency throughout the
product development lifecycle.

¢ Projects and tree approach — Items are organized in Jama Connect into projects, which might repre-
sent a product line, a product, or a product variant, depending on your process. Within a project, items
are organized in a hierarchical tree called Explorer, and grouped by their type, enabling easy navigation
and item type specific data capture.

¢ Traceability — Traceability is at the core of product definition and verification processes. In Jama
Connect, a Traceability Information Model defines required relationships for consistent monitoring and
reporting on project status through Trace. Filters and reports enable live analysis to ensure coverage
from high-level business requirements through system and subsystem requirements and verification.

e Reviews — Reviews provide a structured process for ensuring that requirements meet stakeholder ex-
pectations, regulatory requirements, and market needs. They enable teams to evaluate requirements,
test cases, and plans collaboratively, ensuring alignment before development, which reduces rework
and risks. Features include a wizard for easy review setup and electronic signatures for coordinated
approval and signoff.

¢ Verification — The test capabilities of Jama Connect support the Validation and Verification processes,
helping define tests that ensure all requirements are met. Trace views provide full coverage of require-
ments, reduce risk, and highlight suspect links to identify the impact of changes on your verification
plan. Test Plans allow multiple test runs with complete traceability back to requirements.

Beyond the basics

¢ Exporting documents — Jama Connect lets you create documents to share with your customers,
quality teams, and auditors. You can easily create documents using our standard export to Word and
Excel or by creating your own custom templates.

¢ Baselines — A baseline is a snapshot of your project at a point in time. The current version of
each selected item and their relationships are forever associated with that baseline. Baselines can be
restored, reused, and exported at any time, which allows teams to work with and provide visibility into
historical data.

e Categories — The Categories feature helps you manage variants of a Jama Connect product, such as
size, color, material, or style. Once you define the product variants, you can create the categories and
apply them to items.

¢ Change management — Jama Connect enables impact analysis to assess the full scope of a change
before it’s applied, identifying affected requirements and tests in advance. Collaborative review capa-
bilities ensure that changes are evaluated and agreed upon, and once approved, versions and baselines
provide complete tracking at both the item and project level for transparency and auditing.

¢ Reuse and synchronization — Reuse allows you to start new projects from existing work, easily
enabling content libraries and product variants. Jama Connect maintains a connection between reused
content, called synchronization, which allows your teams to monitor for differences between synced
items and optionally push updates between items. In this way, changes made in a library of require-
ments or in a specific variant can be assessed for applicability in another project and pushed to that
project if needed.
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¢ Administration — The administrator controls the product development process as well as users' access
to the data. You can start with a template modeled after best practices, then tailor the process to fit
your environment.

Automation

¢ With the Jama Connect Advisor add-on, your engineers can save time with Al-powered requirement
refinement and automatic Test Case generation.

¢ With the Jama Connect Interchange add-on, you can connect your digital thread by creating live
synchronizations with tools like Atlassian Jira, and lets you exchange requirements with partners
utilizing the ReqlF open format.

Learn more

Visit the Community website to watch videos where a Jama Software expert introduces you to the most
commonly used features and functionality of Jama Connect.

Item-based product development

Jama Connect is a product development platform that is database driven.
Why do we use items instead of documents? Several reasons:

¢ Version control — Track changes and feedback at an individual item level, whether the item is a
requirement, a risk, a test, or even project documentation.

e Data integrity — Quickly search, filter, and create dashboards to view progress based on item attrib-
utes. Documents don't allow for this functionality and often have data integrity issues.

¢ Time savings — Save time by not having to manually maintain IDs and trace links in a document. In
Jama Connect, traceability is a by-product of the way you work.

¢ Review efficiency — Focus on smaller, more iterative item reviews. Users no longer have to wait for
entire documents to be submitted before they can provide feedback. Get to market quicker!

¢ Auditing quality — Quickly identify items that are missing coverage throughout the product develop-
ment process. Coverage is the extent to which items are validated by another item.

The shift from a document-based approach to item-based is key to the value of Jama Connect. Your
team's methodology directly influences how you set up and configure your Jama Connect environment
with different item types.

The following diagram illustrates how to shift from a document-based approach to an item-based ap-
proach using Jama Connect.

¢ |dentify the documents and content that need to live in Jama Connect.

e Determine the item types that exist in those documents. For example, item types might be system
requirements, use cases, or test cases. Item types must have defined relationships in Jama Connect,
which you can specify with a relationship rule.

e Configure a project structure, then build your content. You can import existing documentation or
author directly in Jama Connect.
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The following diagram is a typical relationship model in Jama Connect that adheres to a Systems Engi-
neering Methodology (SEM). In it, a box represents a single item type and lines represent relationships.

Your team's development methodology comes into play here, for example classic vs. agile methodology.
While some teams use only one method, many teams use a combination.

Each method might use different terms. For example:

Classic Systems Engineering Agile Methodology
e System Requirement e Strategic Themes
e System Architecture e Epics
e High-Level Requirement o User Stories
e Low-Level Requirement

Project approach and tree structure

Jama Connect is made up of projects and uses a tree approach, which allows users to easily organize
content and view the content of each project.

What is a project?
Think of a project as a virtual container or “workspace” of information. Each project relates to a product
you are creating or a software application you are developing.

Why have a project?

Projects allow you to organize content and apply permission schemas. For example, a user might be able
to create and edit requirements in Project A, but you might not want them to see content in Project B.
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Projects are created by the Jama Connect admins at your organization, who also control corresponding
permissions for each project.

At a high level, each Jama Connect environment can contain multiple projects. Typically, a single project
in Jama Connect relates to a single product or a single version of a system that you are building.

Monitoring your project

Within a Jama Connect project, you can track releases/phases, baselines, test plans, and results. As a
project or organization admin, you can also create a project dashboard [452] to track the data your team
wants to monitor for quality and progress. For more information, see Working with dashboards [451].

How do | access my project?
To open a single project, select PROJECTS in the header. If you're already in a project, select Change
project.
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Advantages of projects and tree structure

Jama Connect projects and the Explorer Tree are highly configurable, which allows your organization to
adapt the solution to fit your own unique hierarchy and development process.

We also have several templates to get your team started. This allows your organization to:

¢ Standardize methodology across different teams
e Decrease context switching when working across multiple projects
¢ Enable reuse of shared requirements

Organizing your content

Each project has its own Explorer Tree, which displays project items in a hierarchical structure. Think of
the tree like your filing cabinet.

Within the Explorer Tree you have access to several tools to organize your content:

e Component — A structural container used to organize a project into more manageable pieces.
For example, if your project represented an automobile, typical components in your Jama Connect
project might be: “Vehicle Airbag System” or “Emergency Braking System.” Below these components in
the Explorer Tree are all requirements and test sets that make up the subsystems for a car.

e Set — A container that defines groups of items of a single item type. Sets can exist at the top of a
project tree or nested under the components.
For example, in our “Emergency Braking System” component we might have a set of “System Re-
qguirements” and a separate set of “Verification Tests.” Typically, requirements documents (Product
Requirements, Functional Requirement specifications) translate in Jama Connect as a set.

¢ Folder — A way to organize items within a set.

¢ [tems — The granular types of content in Jama Connect.

For example, a single requirement is an item. A single test case is an item. You can configure multiple
item types in Jama Connect.

Learn more about projects and Explorer Tree

e Projects at a high level [716]
e Configure Explorer Tree settings [29]

Traceability from Requirements to Test

Traceability shows the relationship between items that depend upon and define each other. You can
travel upstream or downstream to get more context and trace product definition from high-level require-
ments all the way through to final tests.

Relationships in Jama Connect are established between discrete items. For example, Stakeholder Re-
quirement A is related to System Requirement X.

Benefits of establishing relationships
Why are relationships important in Jama Connect?

¢ Allocation — Understand which systems and subsystems implement the requirements.

¢ Traceability — Break down high-level requirements into more detailed specifications.

¢ Verification — Improve implementation and quality by linking requirements to tests and their results.

¢ Impact analysis — When requirements change, identify and understand the ripple effect to lower-level
requirements and testing.

Relationship rules are applied to projects to drive compliance to your organization’s model and method-
ology. Setting up relationship rules for your item types is critical because it enforces the methodology
your organization wants to use in Jama Connect.
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Jama Connect uses the terms “upstream” and “downstream” to describe relationship direction. When
upstream items change, their downstream items are flagged as “suspect” so that you can review any
impact the change might have.

Process to establish a relationship

1. Navigate to a single item in your project such as a user need or a requirement.
2. Select Add related and select the item type you want to add.

Jama Connect opens a new window where you configure the item relationship.
3. Select Save and Close.

The original item (Requirement) and the new item (Verification) are now linked with a trace relationship.
Viewing and adding relationships

¢ To view relationships, select the Relationships widget in right corner of the item.
¢ To add more relationships, select Relate Items.

39



Getting to know Jama Connect features

To learn more about adding relationships, see Add a relationship from Single Item View [311].

What's next

Once you establish relationships, the Trace View in Jama Connect is a great way to filter and extract
views of your traceability.

Trace View:
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How reviews work

Ever feel like work is harder than it should be? Multiple revisions of a document get emailed around; con-
flicting or out-of-sequence feedback on shared documents; time-consuming and costly review meetings.
Sound familiar?

Jama Connect alleviates these pain points with its review features.

Everyone is automatically included in the latest revision.

e Reviewers can simultaneously log their feedback and approvals.

All feedback is associated with a specific revision of the document.

Easily filter and view only the items that need additional review or feedback.

Reviews are critical to improving requirements and test quality and in increasing the shared understand-
ing among the teams that are engineering and implementing the requirements. Most item types in Jama
Connect can be sent to a review.

Review roles: who does what?

e Moderator — (Content owner) Starts the review and facilitates the discussion.
Users with a Creator license and necessary permissions to author and edit in the project can start and
moderate a review.

¢ Reviewer — Contributes to the discussion.

e Approver — Signs off and approves items in review.

What's involved in a review?
Here's a typical workflow:

a
Incorporate
changes

5
Close review

1
Define
review

3
Monitor
progress

1. Define what gets reviewed — Before starting a review, determine which set or folder of items you
want to send for review. You can select an entire document or particular sections only, which allows
for a more agile and iterative review. A review can be started from a location, filter, release, baseline,
or test plan.

2. Start the review — If leveraging Jama Connect workflow functionality, set the status of items to
“Review,” select the Explorer Tree location, then select Send for review from the menu. If starting
from a filter, release, baseline or test plan, select the name, then select Send for review from the
menu. Jama Connect loads the review setup wizard, where you can configure the review deadline
and invite Reviewers and Approvers.

3.  Monitor progress — When the review is initialized, Reviewers and Approvers receive an email
invitation to participate. They work concurrently, adding comments and marking items “Approved”
or “Rejected.” As moderator, you can track participant progress and respond to comments.

4. Incorporate changes — As moderator, you edit and incorporate feedback from the participants. You
are then prompted to publish a new revision of the review.

5. Close the review — Reviews close when the review deadline is reached or when the moderator
closes the review manually. You can close the review for feedback, finalize the approval review, or
mark the review as finalized.

Reviews can always be reopened to publish new revisions and review what has changed.
Quick tips

e Use feedback collected from reviews to determine the status (such as "Approved") for your require-
ments.
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e Keep reviews to a manageable size for participants by using filters or smaller folders of requirements.
¢ Provide guidance to your reviewers about the type of feedback you need.

Creating a review
You can create a review for any group of items in a project. And you can start a review from several
places in the Jama Connect interface.

Regardless of where you begin, the process is the same through an easy-to-follow wizard.

Learn more
For details about how to create and use reviews, explore these topics in the User Guide:

Review moderator [162]

e Compare versions [202]

Filter or search the review workspace [196]
¢ Organize and find review comments [194]

Testing
Do you need to validate and verify your product? Or maybe you need to create a report that shows the
connection between regulations, requirements, and tests?

Then look no further: use Jama Connect test capabilities to guide your teams through the testing
process, so you can validate and verify your products and systems.

Let's define our terms

Test case Test cases live within a project. They can be organized into a separate test suite project or into a project
alongside corresponding requirements. They contain the steps a tester or script uses to validate and verify
associated requirements. Test cases can be associated with one or multiple test plans.

Test plan Test plans live within a project. They contain a description of the strategy and objective for testing a
system or subsystem. Test plans can include test cases from the same project or from different projects.
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Test group Test groups live within a plan. They function as an optional method to organize test cases into collections
within the plan.

Test cycle Test cycles live within a plan. They function as a container to organize a specific set of cases that are
executed together. When a case is associated with a cycle, a corresponding test run is created in that
cycle.

Test run Test runs live within a cycle. They are the record of results for an executed test case.

Defect Defects live within a project. They are a record of an error or defect that was discovered while executing

a test run. When a defect is logged during test execution, it is traced to the originating test run to
upstream test cases and requirements through the relationship configuration.

What's involved in testing?
Here's a typical workflow:

1 2 4 5
Create Devise Monitor Review &

coverage plan progress report results

1. Create coverage — Create specific or generic test cases to validate upstream requirements. Create
one or more relationships between test cases and requirements. Use the Trace View to check for
gaps in test coverage between your requirements and test cases.

2. Devise a plan — Create a test plan and describe which requirements need to be tested and the
strategy for testing. Associate all test cases with the plan to verify and validate the intended
requirements. Optionally, organize the test cases into groups within the plan.

3. Execute the plan — Create one or multiple test cycles in the test plan. Associate all or a subset of
test cases from the test plan with each test cycle. A test run is created in the test cycle for each
associated test case.

Execute the test runs in each test cycle.

4. Monitor progress — Set up filters, dashboards, and trace views to monitor requirement coverage,
track testing progress for each cycle, and keep an eye on high-priority defects.

5. Review and report results — Send the entire test plan or just a single test cycle to review. Generate
a report showing results, such as the Test Details Grouped by Test Cycle or the Test Details Grouped
by Test Case.

Learn more about testing

Test cases [398]

Test plans [412]

Test groups [421]

Test cycles [425]

Test runs [431]

Defect item type [693]

Exporting documents from Jama Connect

While Jama Connect alleviates many pain points around managing documents, you might still need to
create documents to share with your customers, quality teams, or auditors.

The basics

With Jama Connect, you can easily create documents using our standard export to Word and Excel or by
creating your own custom office templates.

You can export the items that appear in your Jama Connect view with these export options:
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Beyond the basics with Office templates
If you need more than what the default Office templates provide, you can customize a template to suit
your project. For details about how to create a custom Office template:

e Exports [378] (User Guide)
e Word Template Guide (Community)

Advanced reporting
If you require more control over the report output than Word templates provide, you can use an
advanced reporting tool like Velocity.

Here are some common scenarios for using an advanced reporting tool:

¢ Ordering of documents — Word templates always arrange your included items in the same order that
they appeared in Jama Connect when you generated the export. If you need like items to stay together
or certain item types to always be displayed before other types, you need to use a custom export.

o Style formatting — Although Word templates support basic text formatting like bullets and fonts,
text size and color, they don’t support page formatting options like section breaks or custom page
numbering. Velocity exports provide a broader level of control than Word.

e Multiple levels of relationships — Default Word templates can export relationships one level upstream
or one level downstream. BIRT and Velocity can follow relationships and tree structure through
multiple levels.

¢ Conditional logic — Velocity allows more control over when and where to display information. For
example, an advanced reporting engine lets you display an item’s status, but only if it were created
more than 30 days ago and has an upstream relationship to a feature.

There are inherent differences between the Ul and export size. To align points and pixels (WIRIS font to
be same size as font size), you must manually configure the size to account for approximately 33% of the
difference.

Dashboards

You can configure your projects to show key metrics so you can quickly see what needs attention. Typi-
cally, dashboards are used to:

¢ Monitor progress — For example, status of Requirements or Execution Results of a Test Cycle.
o Audit progress — For example, show the count of items that are missing a critical data point or process
step.

To access the dashboard, select the project name in the Explorer Tree.
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As an administrator with organization or project permissions, you can customize dashboards per project
(not per user).

Customizations include:

Filter results Displays the results of an existing filter.

Assigned to me Displays a list of items "assigned to" the current user.

Bar chart Displays the results of an existing filter as a bar chart.

Recent activity Displays a line graph of recent activity over a period of time.

Pie chart Displays a pie chart for a filter and field that the user selects.

Activity stream Displays the current activity stream of the project. View all current activity including comments, edits
made, new items created, and assignment changes.

Project summary Displays a summary of the entire project, including total number of items in the project, number of days
until next release, and number of days until project completion.

Rich text Displays user-defined text, images, diagrams, and equations.

Recently viewed Displays the last 15 items viewed by the current user.

Relationship diagram Displays the relationship rules applied to the project.

Exporting equations and alignment guidelines

Organization admins can save MathType and ChemType equations in PNG (recommended) and SVG
formats.

When the equation format is changed, existing equations keep their current format until they are edited.
Depending on the format, the exported image might produce different results.

Here's what to expect when equations are exported and surrounded by text in PNG and SVG formats:

¢ PNG format — Recommended for the best web, exporting, and printing experience. The bottom of the
primary equation line always aligns with the bottom of the surrounding text. The outermost fraction
bar always aligns with the middle of the surrounding text line.

e SVG format — Produces the most varied export results because SVG doesn't handle embedded fonts
well. When exported to Word, certain characters might be rearranged. Because this format doesn't
include height information, equations might not align with the surrounding text, depending on the
overall dimensions.

All about baselines

A baseline in Jama Connect is a snapshot of your project at a point in time. The current version of each
selected item — and their relationships — are forever associated with that baseline.
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Why baselines are important

A baseline captures the relationship between your selected project components, as well as their state.
For example, Draft, Reviewed, and Approved.

A project in Jama Connect can have many baselines. You can use baselines as the basis for an export or
as a reference for a historical milestone. By creating a baseline at each project milestone, you can view
the status of your project at key points in the lifecycle. For example:

o At gate reviews
o Before a reorganization
e Before an import of requirements

Where to create the baseline
Use whichever method suits you best.

¢ In the Jama Connect Project, navigate to the Baselines tab and select Add > Baseline.

e From the Explorer tree, select a component, set, folder, or item, then select Add baseline from the
menu.
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Creating a baseline
Creating a baseline is recommended at several points in the product development cycle.

¢ When you are ready to send an item for review

¢ When you need to capture a snapshot of the current set of requirements or a set of items in your
project.

e When your project has reached a milestone like testing or approval.
You can select an entire project, a single set, multiple sets, a single item, or multiple items.

The baseline you create is highlighted under the source where you created it.

Organizing your baseline tree: the basics

Working with baselines is dynamic and intuitive: reorganize, rename, and restructure your tree however
you want.

The new folder you create is saved at the top of your baseline tree.

¢ To add a folder to an existing folder, select a folder, then select Add Folder from the menu.
¢ To move a folder or a source, drag it to a location in your baseline tree.

O Organization And Project Admins Only
You need organization or project admin permissions for this task.

Learn more
For detailed information about baselines, explore these topics in the User Guide:

e Baseline sources [279]
e Baseline organization [279]
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e Baseline activity [293]
e Add electronic signatures to a baseline [261]

Using Categories to manage product variants

Use the Categories feature to manage variants of a Jama Connect product. For example, you might have
a product version that differs from other versions in size, color, material, or style. You might also have
variants based on customers, market, or product features.

Once you define the product variants, you can create the categories and apply them to items. You can
then organize and view cross-project items based on classifications such as configurations, releases, and
features.

With Categories, you can manage product variations in the form of:

¢ Requirements from different regulatory markets
Different customer requirements

Different configurations of components
Different configurations of features

What's involved in using Categories?
Here's a typical workflow:

1 2 3 4
Define product Define variants Create variant Apply variant

categories categories

1. Define a product — Build your first product project, including all requirements, tests, etc., and all
traceability between them.

2. Define variants — Define the variants you want to create. For example, you might have market
variants (US, Canada, EU, and China) or customer variants (Customer A and Customer B).

3. Create variant Categories
a.  Work with an organization admin to enable the Categories feature [217] in Jama Connect

and add your categories [218].

b. Determine the projects where the categories are visible [228].

Note
i Visibility is set at the top node of the Category tree and maintained through-
out. Set visibility at the project level, not globally.

4. Apply Variant Categories to all items — When applying variant categories [212], begin with the top
level requirements, and propagate the category to all related items in the hierarchy. This method
ensures that all items tied to that category are categorized correctly and facilitates ease-of-use for
the team working with the category.
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Change management

Throughout product development, being able to track changes is critical, along with details and context
that led to the change, specific version differences, and stakeholders involved with and affected by the
changes. Jama Connect gives you the ability to capture all of these details.

Jama Connect has two effective ways to track changes:

e Versions — Capture changes at an item level. For example, a single requirement might have multiple
versions as well as associated change comments.

e Baselines — Capture a point-in-time snapshot of a group of items. Create a baseline to preserve a
version of an entire Jama Connect project or set of approved items.

Version changes
A new version is created each time you make changes to an item. In the bottom panel of the interface,
you can compare versions or make a past version current.

Changes to a single item

In the following screenshot, you can see how Jama Connect compares differences between multiple
versions of an item. The example engineering requirement has two versions. In the bottom panel, you
can also see who made the change, any change details, and any change comments. Get the complete
context of change from just this one screen!
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Version Compare view

This next screenshot shows the differences between two versions of a requirement. Individual field

differences are shown and highlighted in red (removed content) and green (added content), making it
easy to see what might have changed.
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Changes to several items in a baseline
This screenshot shows a baseline in Jama Connect, which is a snapshot of several items.

Jama Connect provides users the ability to identify and assess these changes between different baselines
from the baseline Document View compare feature, baseline Comparison Summary, and default reports.

Reuse and synchronization

Reuse and synchronization methods detect variance and highlight the impact of that variance across
releases and projects.

These methods are useful when:

¢ Your product keeps the same requirements as a previous version.
e Your product integrates and improves on original requirements.
¢ You include custom requirements for each product.
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Best Practice
- To save time and effort for your teams, reuse common product requirements across
projects and sync reused items to help determine and track variance across projects.

Reuse in Jama Connect is much more than a copy/paste mechanism. It's a full suite of features that
allows for complex capabilities like:

e Maintaining a library of common requirements
¢ Branching a project to create a variant product
e Comparing differences between a local version of a requirement and its source library version

When you apply reuse and synchronization methods within your requirements management configura-
tion infrastructure, you maximize your requirements resource management. You can modify and evolve
existing work quickly while maintaining your requirements lineage.

Library approach

¢ Alibrary project houses a collection of requirements maintained by a librarian or curator (permissions-
based).

e The curator of a library can pull differences back into the library when needed.

e Project members can pull and push updates between the project and the library.
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Branching approach

e Projects are branched by project duplication.

¢ Synchronization is enabled during project duplication and differences are monitored between contain-
ers and items.

. #g_r Tip
. Create a project baseline just after duplication. A baseline captures the state of the
project at the time of duplication and is used for baseline comparisons.

Administration

Administration in Jama Connect applies primarily to controlling the product development process and
users’ access to the data.

Product development process

There is no “one size fits all” process for developing products or applications. Each industry starts with a
template modeled after best practices, but every company can tailor the process to fit its needs.

Here is an example process used to develop a medical device.

In this example:
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e Boxes indicate an artifact/document (generically defined as item types in Jama Connect).

¢ Lines indicate relationships that enforce traceability between the items.

¢ [tem types indicate items with configurable fields to record specific details about each requirement, in-
cluding details like ID, Name, and Description, as well as values for capturing data (workflow status,
validation method), similar to columns in a spreadsheet.

User management

A primary role for administration in any enterprise system is the assignment of licenses and managing
access to data. Jama Connect includes several options for administrators to fine-tune read/write/review
access to fit their company’s needs.

Learn more about user management

e Licensing [656]
e Managing users [646]

Manage item types

By default, a trial user account is set up with permissions of an organization admin, which gives you
access to the ADMIN module in the top-level navigation. If you don't see this, ask your administrator to
update your permissions.

Edit an existing item type

1. Select ADMIN > Organization, then select Item Types.
Find the item type you want and select Edit in that row.
3. Adjust the details that your project users are able to see when they work with items.
¢ Display, Display plural — The name used to identify the item type, for example, System Require-
ment.
¢ Type key —The part of the ID that helps users quickly determine the item type of an item. For
example, the default type key for System Requirement is SREQ, so when a user sees an item with
the ID of QR-SREQ-34, they can know at-a-glance that the item is a System Requirement for that
project.
e Use as — Specific functions or permissions for item types configured as a test case or defect.
¢ Image — An icon to help users quickly differentiate items.
o Widgets — A graphic that shows additional data for the item. The most common widgets are
Versions, Links, Attachments, Relationships, Activities, and Tags.
4. Select Save.

Add a field

Chances are that the fields available in your selected item type are just what you need for your process.
But if you want to add details specific to your organization, you can do that too.

N

Select ADMIN > Organization, then select Item types.

Select Fields from the row of the item type.

Select Add Field from the fields’ header for the item type.

Select Custom Fields, then select the type of field you want to add.

Enter the name you want users to see in Field Label.

The Unique Field Name is pre-populated with a suggestion. This name is used for reporting or
accessing from REST API [545].

6. Depending on the field type you select, additional options might be required. If prompted, configure
them now.

ARE IR
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7. Select Save.
8. (Optional) Use the arrow keys in the header to move the field into the order you want on the form.

Configure pick lists

A common field to configure on an item type is a pick list. Pick lists can be reused, and the list you want,
like Priority, might already exist. You can adjust the language or values to fit your needs.

If you need a new list, you can create it before you add the new field to an item type.

1. Select ADMIN > Organization, then select Pick lists.
2. Find the pick list you want and select Values in that row.
3. Add a new value or edit an existing value:
o New — Select the + icon and enter the value.
e Existing — Select the row and the pencil icon.
4. Select Save.
5. (Optional) Use the arrow keys in the header to move the field into the order you want on the form.

Managing relationship rules

Relationships are an important part of ensuring compliance and quality. Many industries base their
processes around the V-Model and need relationships to enforce the traceability through the stages.

Creating the correct relationships can be challenging for users, so Jama Connect gives admins the ability
to configure rules that help guide users in making the correct connections.

In the previous process example for a medical device, the item type User Need can have two down-
stream relationships, System Requirement and Validation.

To configure these relationships, you use the Relationships option from the left panel.

Upstream refers to the higher-level item type that is affected by the lower level (downstream) item, often
through an activity like testing or decomposition.
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Add a new relationship rule
Creating a relationship establishes a directional link between two items.

1. Select ADMIN > Organization, then select Relationships.
2. Find the relationship ruleset you want.
3. Scroll to the bottom of the list of rules and select Add relationship.
4. Configure the relationships:
1. Select the Upstream Type.
2. Select the Downstream Type.
Relationship types describe why the relationship between the two items exists. View the pick
list above the rulesets on the Relationships page.
3. Select Yes or No to configure if the relationship is used for coverage.
If you select For Coverage, Jama Connect notifies users if this relationship doesn't exist.
4, Select Save.
Managing workflow

Workflow is an important part of ensuring compliance and quality.

Workflow in Jama Connect is highly configurable. In general, workflow is set up on an item type with

a pick list of available statuses. This process guides a user though specific steps, making sure that only
users with correct permissions can make the workflow transitions (using the Transition Permissions
features), then locks items from further updates when needed. For example, when an item is moved from
Draft to Approved, it is locked so no changes can be made while it is in the Approved state.

Workflow transitions and versioning

Jama Connect captures item versions for any item field change. By default, this applies to an item's
Status field. For example, when the item transitions from Draft to Review, version one of an item
generates version two.

If, however, you want an item to transition between status values without generating a new version of
the item, you can select Do not version on status change.

Add a new transition to a workflow

The best way to understand workflows is to start with a workflow that's included in your collection of
data.

1. Select ADMIN > Organization, then select Workflow.
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Find the item type you want and select Config in that row.
In the Workflow Configuration section, use the item type and picklist field options to set up and

manage the transitions between status types.
The Current Status column shows all values for the selected picklist field; the New Status column is
the option you want for the transition from that state. For example, a requirement that is a Draft can

be Approved or Rejected.

4. Under Versioning, select an option:
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¢ Version on status — Updates the version of the item when its status is transitioned. For example,
if the item is version one, after you transition the status it becomes version 2.
¢ Do not version on status change — The item's version isn't updated when its status is transi-
tioned. If the item is viewed in a baseline, the baseline displays the current status rather than the
status at the time of the baseline.
5. (Optional) To add a transition state, select + and configure:
o [f users are notified of the change
o [f the item is locked when it transitions to the new state
e Any restrictions on who can make the update
6. (Optional) Select - to remove a transition state.
7. Select Save settings.

REST API and extensibility

The REST API allows your team to integrate and extend the capabilities of Jama Connect.

Important

Access to the REST APl is limited to users with a Named Creator Jama Connect license,
which includes endpoints within v1, labs, and SCIM. Users without a Named Creator
Jama Connect license, including those with a Creator Float license, do not have access.

Typical use cases include:

¢ Integrating test results from automated test scripts
e Extracting specific data for analysis in Business Intelligence tools
e Automating manual batch tasks

You can see the REST API Swagger documentation at <your Jama URL>/api-docs/.
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Interested in learning how to work with the Jama Connect REST API? The following resources can help
you get started.

e API Cookbook provides recipes for users and partners creating integrations using the Jama Connect
REST API: https:/dev.jamasoftware.com/cookbook/

¢ Jama Connect REST API documentation provides information about the specifics of our API: https:/
rest.jamasoftware.com/

REST API terms
ID Description
Project ID Project IDs are unique to Jama Connect. Your administrator sets the default project and set keys.
Example: <project key> - <set key> # <SBX-REQ-1 or SBX-TEST-3>
Global ID Global IDs reference where a requirement or test was reused globally across Jama Connect

projects. The Global ID isn't unique because several copies of an item might be connected that
share the same Global ID.

Example: GID-1234
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ID Description

API ID API IDs are the database identifier for an item and is used by developers when interacting with
Jama Connect from the REST API.

In List View, you can locate the API ID as a column or in the browser URL for the item you're
viewing.

Example: 21374

Where to find the API ID
Find Project API ID in the URL:

Find Filter API ID, navigate to the filter in Jama Connect, and look at the URL:

Find Item API IDs:

Find API IDs in List View:

Product A

FH Component - View details

= B T IE~ e~ 2 655items

All Fields
All Selected (11) X

Common Fields

Block Requirement F

# of Downstrea... # of Links
Design Description F
# of Upstream R... Added field in n...
Product Requiremen P
Stakeholder Require v AP ID Approvers
System Architecture
Assigned Assigned to
Validation Fields
Verification Fields ¥ Author(s) Categories
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Jama Connect top tasks

Want to learn more about the Jama Connect tasks that are frequently used? Based on research and
feedback, we created a table with links to the tasks and information that matter most to our users.

Top task Helpful links

Traceability Traceability from requirements to test [38]

Jama Connect for modern requirements management

Search for content Search for content [145]

Full text search [144]

Search for items Filter items for targeted results [146]

Full text search [144]

Export content to Excel Export to Excel [380]

Create a review Reviews in Jama Connect [159]

Initiate a review [163]
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Creating content

Content in Jama Connect is structured using an item-based approach rather than a document-based
approach. Items are the major building blocks for your content and Jama Connect includes several item
types.

Item type: Containers

Components e Structural container
Organize projects into manageable pieces

Sets Structural container

ﬂ e Access rights can be configured

Items of the same type can be grouped
Contain folders, test items, child items

s Folders e Structural container
e Organize items
e Manage hierarchy in the Explorer Tree
e Contain text items or items of the same type
Item type: Items
= Item o Individual building block of a project

Comprised of customizable fields

Organizations typically create items as requirements, features, use cases, test cases, defects, or other
information types that define the scope of a project or product.

To create content in Jama Connect, you can import existing content from another platform, or you can
author directly in the application.

A typical process for creating content might include these tasks:

; ﬁ Tip
* Before populating Jama Connect with your data, discuss with others in your organiza-
tion which elements of the application you want to use and how to use them. Involving
team members early in the process can help avoid rework later.
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Containers

Containers help organize your content in Jama Connect. Types of containers include components [63],
sets [64], and folders [65].

Item type: Containers

Components e Structural container
|_|E| Organize projects into manageable pieces

Sets Structural container
Access rights can be configured
Items of the same type can be grouped

Contain folders, test items, child items

<

Structural container

Organize items

Manage hierarchy in the Explorer Tree
Contain text items or items of the same type

Folders

Note
ﬁ A source folder [279] is a specific type of folder that refers to baselines. It is the only
container type that is not an item.

Add a component
A component is a structural container item used to organize a project into more manageable pieces.

For example, you might define each piece of your product with a different component.

e Components can only be located or moved to the root of the Explorer Tree or inside another compo-
nent.

e Components might contain sets of various item types, text items, and sub-components. Each compo-
nent can have different access rights.

p“"f’ Note
Text items can appear anywhere in this structure.

To add a component:

1. Open the Add Item window using one of these methods:

¢ Wherever you want to add a component or subcomponent in the Explorer Tree, select the project
name.
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e Select Add > Component at the top of the left panel in the project where you want to add the
component.

2. Inthe Add ltem window:
a. Write a name and description for the component.

b. (Optional) Select Notify to select users or groups you want to notify about the creation of this
component.

c. (Optional) To add more components, select Add another.
d. (Optional) Use the Select Location window to choose where to put the new folder.
This option appears only if you created a folder from the Add drop-down menu.
Invalid locations are disabled.
3. Select Save and Close.

The newly created component is now included in your project.

Add a set

A set is a structural container item with configurable access rights, used to group items of the same type.
It can also contain folders, text items, child text items, and child items of the same type.

A set contains items of the same type. You can move or copy between sets of the same item type.
Item types for a set are configured by an organization administrator [687].
To add a set:

1. Open the Add Item window using one of these methods:

e Wherever you want to add a set in the Explorer Tree, select the project name, select Add > New
item > Set of..., then select the item type from the list.

e From the top of the left panel, select Add > Set of..., then select the item type from the list.
2. Inthe Add Item window:
a. Edit the set key, name, and description of the set.

b. (Optional) Select Notify to select users or groups you want to notify about the creation of this
set.
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c. (Optional) Select Add Another, then select the location for the new set.
d. (Optional) Use the Select Location window to choose where to put the new set.
This option appears only if you created the set from the Add drop-down menu.
Invalid locations are disabled.
3. Select Save and Close.

Add a folder

A folder is a container item you can use to organize items and manage hierarchy in the Explorer Tree.

Folders are a structural item type that contain other items, not an array of different item types. Folders

can contain only text items and the same item type as the folder itself. Folders can be located or moved
inside a set of the same item type, or inside another folder. You can't place a folder inside a component
of mixed item types.

An item can be moved between folders and sets of the same item type using drag and drop within the
Explorer Tree or from List View. Folders can be dragged to other sets of the same item type or into other
folders also in the same item type.

To add a folder:

1. Open the Add Item window using one of these methods:

o Wherever you want to add a folder in the Explorer Tree, select the set name, then select Add >
New item > Folder from the menu.
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e Select Add > Folder at the top of the left panel in the project where you want to add the folder.

2. Inthe Add ltem window:
a. Write a name and description for the folder.
b. (Optional) Select Notify to select users or groups you want to notify about the creation of this
folder.
c. (Optional) To add more folders, select Add another.
d. (Optional) Use the Select Location window to choose where to put the new folder.
This option appears only if you created a folder from the Add drop-down menu.
Invalid locations are disabled.
3. Select Save and Close.

The new folder is highlighted in blue in the Explorer Tree.

Items

Items are the building blocks of Jama Connect. Projects are made up of items and items are made up of
fields. Items can be containers [63] or documents.
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Item type: Containers

Components e Structural container
|_| e Organize projects into manageable pieces

Sets e Structural container
'ﬁ- e Access rights can be configured
® Items of the same type can be grouped
e Contain folders, test items, child items

Folders e Structural container
e Organize items
e Manage hierarchy in the Explorer Tree
e Contain text items or items of the same type
Item type: Items
Item e Individual building block of a project

e Comprised of customizable fields

All items have a global ID [353], a unique ID [731], and an item type that's determined by an organization
administrator [687].

Use text items to:

Manage context data — Create introductory paragraphs when the data isn’t traced as part of the
relationship model.

Contain information — Create figures or graphs to provide detail for data in adjacent items.
Store content — Save content that is required in exports, such as boilerplate text that must be
included, but isn't part of the core project data.

Maintain change logs — For change logs you manually maintain, use text items as part of a document
export.

Note
i Baselines, source folders, risks, risk analyses, reviews, and test groups aren't items, so
they don’t have an item type and a global or unique ID.

Several places in Jama Connect allow you to see a quick preview of an item without opening it in the
center panel. For example, select an item in the Explorer Tree, then select Preview item from the menu.

Performance safeguards for large-scale user actions

Safeguards provide direction to users who attempt large-scale actions that could adversely affect the
performance of your instance. For example, a bulk update to 5,000 or more items.

Container items

Product A

FH Component - |View details
= B b 4 = o B

Select View details next to a container's title to:

¢ Display container's detailed information.
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e Open container's attachments [96].
¢ Edit the name or description of the container itself.

O Best Practice

- Subscribe to a container so that you get email notifications when items are added,
deleted, or updated within that container. To control the number of emails you receive,
set your subscription notifications to Daily in your profile.

Add an item

Even if you import data from another application or sync data from another tool, you can also add a new
item to your project as needed.

You can add an item to a project from several places in Jama Connect. The list of displayed items includes
only item types that are valid for the selected location.

Before adding a new item, make sure your project includes an item set [64] for that item type, unless it is
a text item.

Important
You can't add items in filters or in lists of mixed item types.

To add an item to your project:

1. Open the Add item window using one of these methods.

o Select the project name — In the Explorer Tree (or wherever in that project you want to add an
item), select the project name, select Add > New item, then select an item type from the list that
appears.

e Add drop-down list — In the project where you want to add the item, select Add at the top of the
left panel, then choose the item type from the list that appears.
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¢ Toolbar — From the toolbar above Single Item View, List View, or Reading View, select Add, then
choose the item type from the list that appears.

In List View, if the list contains items of a single item type and no items are selected, you can add
an item of the same type, a text item, or a set to the bottom of the list.
If an item is selected, use one of these options.
¢ Insert new to insert a new item below the selected item.
¢ Add Item Type as child to add an item as a child item of the selected item.
¢ Add related to add a related item to the selected item. If a relationship rule [765] was applied to
that project, only item types that meet the rules are available for that selection.
¢ Quick add add items in a set of the same item type.
Select the location where you want to add the new item in the window that opens (invalid locations
are disabled), then choose Select & Close.
In the Add Item window:
a. Fillin the fields for the selected item type.

b. (Optional) Select Notify to add a notification comment and select users or groups to notify
about the creation of this item.

Comments are included in the version notes for the item [264] and are displayed in the
stream [243].
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. ﬁ Tip
o To add a version comment when you save the item, see Version Comments.

4. Select Save or Save and Close.
5. Select Commit.

The newly created item is now included in your project.

Quick-add an item

The Quick-add option lets you add multiple items at a time to a set of the same item type. You can add
up to 50 items at once.

Important considerations

The Name field is required.

The Description field is required or read-only, based on how the item type is configured.
To add required fields, edit the item after you create it.

The added item must match the item type in the set.

To quick-add an item:

1. Inyour project, select Add > Quick add.

If you don’t see the Quick add option, the item you're adding doesn’t match the item type in that
set.

2. Enter the required name for the item (255 characters maximum) and an optional description (500
characters maximum).

3. Select Add Row to include additional rows as needed, for a maximum of 50 rows (items). Include a
name and optional description for each added item.
Use the tab key to move across the table.
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4. Select Save.
The new items appear in the Explorer Tree.
5. To add required fields to a new item, select the item to open and edit it.

Add a child item

Create a child item when you need an item that falls hierarchically below a parent item of the same item
type.

Important considerations

¢ [f a parent item includes a child item, the parent item can't be converted to a text item.
¢ A parent item can include a child item that is a text item.
¢ Relationships and attribute values of a parent item aren't inherited by child items.

To add a child item:

1. Select an item, then select Add > New item > Sub Component from the context menu.
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2. Inthe Add item window, fill in the fields for the selected item type.

3. (Optional) Select Notify to add a notification comment and select users or groups to notify about
the creation of this item.

Comments are included in the version notes for the item and are displayed in the stream.
4. Select Save or Save and Close.
5. Select Commit.

The child item appears hierarchically below the parent item.

Edit an item
You can edit a saved item any time you need to add or change its information.

Important considerations

e You must have create/edit permissions to edit an item.
e A field must be enabled for read/write permissions.

e If a field is disabled for editing, it might have been configured to be read-only [674] by an organization
admin, locked by another user, or locked through a workflow.
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¢ Single Item View automatically displays items in a read-only format.
To edit an item:

1. Select the field you want to edit, using one of these methods:
e Select the field.
e Hover over the field and select the pencil icon to make it editable.

e Select Edit from the toolbar.

2. Edit the item field, as needed.
3.  When you're done editing, select an option:

e Save & done
e Save & add another
e Save & notify

b" Tip
. To add a version comment when you save the item, see Version Comments.

4. Select Save Changes to complete the edit and create a new version of the item.

A confirmation message confirms that the item was successfully changed.

Edit an item in List View

You can edit an item to make needed changes, for example to picklists, fields, and tags. In List View you
can update multiple items of the same type. You can make changes in one item, then press Enter to
move to the next row.

#g_r Tip
¥ To make the same changes across multiple items, use batch update [74].
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To edit an item in List View:

1. In List View, select the field you want to edit.

2. To undo any unsaved changes, press Escape or select Cancel below the selected item.
3. Select Save or press Enter to save the change and move to the next item in the list.

The item you edited now reflects the changes you made.

Batch-edit multiple items

You can update picklists, fields, and tags for multiple items at one time.
Important considerations

e Because the batch-edit method can't be used for some items types, use instead a Jama Connect to
Excel round trip [129] for rich text fields and the Test runs window to batch update test runs [446].

e Safeguards provide direction to users who attempt large-scale actions that could adversely affect the
performance of your instance. For example, a bulk update to 5,000 or more items.

To batch-edit multiple items:

1. Select items that you want to edit using one of these methods:
e |n List View, select the items that you want to edit, then select Batch edit.

e (Review moderator only) Select the items you want to edit in the item progress [205] tab of
review statistics, then select Batch edit.
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2.

3.

In the window, make your changes, then select Next.

Batch edit

Select fields to edit:

o o [ o i o o Ry

O

Assigned
Release
Symbol
Derating
Location

Type

Start Addr
End Addr
Package Code
Top Mark

Locked status

Remove tags

(Optional) Select users or groups you want to send a notification to.
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4. Select Commit.

The multiple items you edited are now saved.

Add, edit, or delete links

You can add a link to an item using two methods.

e Associate a link with an item.
e Embed alink in a rich text field in an item.

If the Links widget was enabled by an organization admin [691], you can store a link or URL in Jama
Connect, then assign the link to individual items across projects.

To add, edit, or delete a link:
1. Toadd alink, in Single Item View, select Add link, then fill in the fields and select Save.

LINKS:

www._jamasoftware.com e @[
© Add link...
2. To edit or delete a link, select Edit or Delete from the link's row.

The item now includes the link you added.

Using and managing locked items

Jama Connect provides two types of locks to manage items: system lock and user lock. A system lock
is applied to items that use workflows. A user lock is applied manually when you lock an item or
automatically whenever an item is being edited.
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You can view locked items in your profile window under the tab My Locked Items. The list includes
user-locked items across all projects and includes the item name and the date the item was locked. You
can also unlock any items that you previously locked.

If you are an organization admin, your profile window also includes the tab System Locked Items and the
option Show All Locked Items.

Access by role and permissions

e Users can unlock only the items they have locked.

Organization admins and project admins can unlock items that were locked by any user.
Organization admins and project admins can view system-locked items and unlock them according to
their permissions.

Project admins can use the batch update feature to manually unlock user-locked items. Batch update
can’t be used to unlock system-locked items.

Best practices

¢ Create a filter of locked items so your results include only items that are currently locked. To do this,
select the Locked option and set its value to is true.

¢ To limit the results to items where the current user has the lock, set the value for Last Locked By to is
current user.

¢ Select Make public so anyone can use the filter and see the items they locked.
e Set the value for Select a project to Current Project (limits results to locked items only in the current
project) or to All Projects (includes locked items across all Jama Connect projects).
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e Enable the Locked field in List View: select the gear icon to enable the Locked field, which helps you
quickly identify items that are locked.

Blue lock icons = Items locked by the system during a workflow transition. Hover over the icon to see
that it's locked by the system.
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¢ Yellow lock icons = Items locked by a user. Hover over the icon to see which user locked the item.

e Regularly check the list of user-locked items and determine if they need to remain locked. Unlock any
user-locked items as needed, so others can access them.

¢ When you create a filter of locked items for the Current Project, save the filter and add it to your
dashboard.

¢ Using the results of the locked items filter, add a bar chart widget to your dashboard to create a digital
display that your users can monitor live. Users are prompted to take immediate action on items that
must be unlocked. When you add the bar chart widget, select Last Locked by so that the locked items
are grouped by user in the bar chart.
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View and unlock items across projects
You can use the My Profile window to view and unlock all the items you previously locked.

To view or unlock items you had locked:

1. Select your name in the header to open the My Profile window.
2. Select the My Locked Items tab to view a list of items you locked.

3. Select the item you want to unlock, then select the Unlock icon in the top right corner of the
window.
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Note
é’ The option Show All Locked Items is only visible to organization admins. Users
don't see this option.

4. (Optional) Configure which fields are visible: open the item in List View, select the gear icon, then
select Locked, Last Locked By, and Last Locked.

= B b 4 E £~ 2 10items
Y Restore defaults Al Selected (14) X I
Item Path Item Type ,
Last Activity Date ¥ Last Locked l
¥ Last Locked By v Locked
Max Min
Maodified By Maodified Date

The new columns and results appear in the list of locked items on the My Locked Items tab.

Locking an item

A lock makes an item read-only, so that it can't be edited or deleted. An item can be manually
locked [82] or automatically locked [236] by the system.

What can you do with a locked item?

e Reuse [355] and create relationships from a locked item.
¢ View and unlock locked items [76].
¢ Find out who locked an item.

What can't you do with a locked item?
¢ Edit, delete, or synchronize locked items.
Who can unlock a Jama Connect item?

An organization admin or project admin can unlock system-locked items [626] and unlock items manually
locked by another user [624].

Locked items Who can unlock?
Manually locked by other users e Project admin
e Organization admin

Locked by system or workflow e Project admin
e Organization admin
o Creator user with workflow transition permissions (only for projects the user administers)
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Manually lock and unlock items from the toolbar
You can manually lock an item to prevent others from making changes while you're working on that item.

When you configure List View to show locked items, a gold lock appears next to items that are manually
locked.

Note
y If you need to access an item locked by another user, contact that user or your organi-
zation administrator to unlock it.

To manually lock and unlock items:

1. Tolock an item manually — In Single Item View, select Lock item from the toolbar.

2. To unlock an item — (Organization or project admins only) In Single Item View, select unlock
item [76] from the toolbar.

The lock icon changes to reflect your action.

Lock or unlock items in List View

You can view and unlock items you previously locked by viewing them in List View. When you have
multiple items to lock or unlock, you can use the batch edit option in List View.

To use List View to lock or unlock items:

1. In List View, select the items you want to unlock.
2. Select the Batch edit icon.
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3. In the Batch edit window, enable Locked Status, then select an option:
¢ Unlock all items
e Lock all items

4. Select Next, comment and notify users as needed, then select Commit.
5. (Optional) Configure which fields are visible: open the item in List View, select the gear icon, then
select Locked, Last Locked By, and Last Locked.
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] Y I[Ev

“J Restore defaults

Item Fath

Last Activity Date
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v Locked
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Modified Date

The new columns and results appear in the list of locked items on the My Locked Items tab.

Converting items to another item type

In Jama Connect you can change an existing item or items from one type to another. When you
convert an item to another type, these attributes remain intact: short name, description, relationships,
versions, activities, comments, and tags.

To convert an item, folder, set, or component, you can use:

e Drag and drop [85]
e Context actions menu [86]

Important considerations

¢ A field is converted only if its name or data type is identical in the current and new item types.

A lookup field is converted only if it refers to the same pick list (and has has the same name and data

type) in the current and new item types.
e Converting an item breaks the sync if you reused that item.
¢ If converting an item puts the item out of compliance with the relationship rules, the issue is reflec-

ted in the relationship diagram.

e When you convert a set, all items in that set are converted to a different item type.

e You can't "undo" an item conversion [88] but you can convert the item back to the original item type.
Use the same procedure you used to convert items.

You can convert from... To... Notes
Component set Set within the original component convert to folders in the
newly created set.
text item
Set component For components, the original set must be empty and at the top
level of the hierarchy.
set
The original set must be empty.
folder
text item
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You can convert from... To... Notes
Folder item
folder
Item item
text item*
folder**
Text item component
set
item

* An item that includes child items can't be converted to a text item.

** A child item can't be converted to a folder unless the parent is converted first. When converting to a
folder, items lose widget functionality and custom field values.

Convert items using drag and drop
When you need to change the item type for all items in a set, use the drag and drop method.

Important considerations

e Before converting items, read about how conversions work in Jama Connect [84].

¢ When you drag and drop a text item into a folder of your required type, the text item is moved to that
location, but it isn’t converted.

e You can’t use bulk conversion for text items. You must convert them one at a time.

e When converting an item to a folder, select Recursively convert all items with Children to Folders in
the Review Item Conversion window. Parent items at every level beneath the item being converted are
converted to a folder.

To convert an item or set to another item type with drag and drop:

1. From List View or the Explorer Tree, select the items and drag them into the set where you want to
move them.
2. Review the information in the Review Item Conversion window.

3. Select Next to view each page of the Review Item Conversion window.
4. If converting an item to a folder, select Recursively convert all items with Children to Folders.
Parent items at every level beneath the item being converted are converted to a folder.

y Note
This option appears only when you select a folder to be converted.
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5. Select Convert.

If the item can belong in its current location (such as a text item), it remains there. However, sets
can't contain mixed item types, so the item might need to be moved.

6. If prompted to move an item, select the new location for that item, then choose Select and Close.

The changes are visible when you select Versions in the side toolbar [21] of Single Item View [21], then
open the item's version tab.

Convert items in List View or Explorer Tree
You can use the drop-down menu in List View or the Explorer Tree to convert items or sets.

% Tip

Before converting items, read about how conversions work in Jama Connect [84].

To convert items in List View or Explorer Tree:

1. In List View or the Explorer Tree, select the items you want to convert, select Convert to, then select
an item type from the list that appears.

e List View — Select the checkbox for the item or set.

e Explorer Tree — Select an item or set.

86



Creating content

The Review Item Conversion window highlights in white the fields that are copied into the new
item type.

Select Next to view each page of the Review Item Conversion window.

If converting an item to a folder, select Recursively convert all items with Children to Folders.
Parent items at every level beneath the item being converted are converted to a folder.
This option appears only when you select a folder to be converted.
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4, Select Convert.
If the item can belong in its current location (such as a text item), it remains there. However, sets
can't contain mixed item types, so the item might need to be moved.

5. If prompted to move an item, select the new location for that item, then choose Select & Close.

4

Note

If you select multiple items in List View, you must also specify a location, even if it's
the items' original location. Doing this ensures that the items end up in the correct
place.

The changes are visible when you select Versions in the side toolbar [21] of Single Item View [21], then
open the item's version tab.

Convert items back to their original type

You can't undo an item conversion, but you can convert your item back to its original type. When
changing back, the item receives a new identifier.

To convert an item back to its original type:

1. Use the same procedures you used to convert the item.

2. To determine if fields were lost in the conversion, select Versions in the side toolbar of Single Item
View to open the bottom panel, then select Compare.

3. If any fields were lost, contact your organization admin to manually replace the lost fields [674].

Moving items

Within a project, you can move items using the Explorer Tree [88] or List View [89]. Once items are
moved, you can undo the move or find the items in the stream [760].

Rules for moving items

Item type Rule
Component Can have child components and can be moved to the root of the Explorer Tree.
Set Can be moved inside a component or to the root of the Explorer Tree. Sets can't have child sets.
Folder Can be moved to a set that's the same item type as the set where the folder was created, or to another folder.
Item Can have child items of the same item type and be moved to a set of the same item type or to a folder.
Text item Can be moved anywhere in the Explorer Tree.
General You must have write-access to both an item and its new location. When components, sets, or folders are moved, all
items within them are also moved.

Move items in Explorer Tree
Items must meet valid item location rules [88] before then can be moved.

You can also move items between projects [89].
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Visual indicators tell you if a move is allowed and provides guidance for moving an item.

¢ Green indicator — Moves that are allowed.
¢ Red indicator —Moves that aren't allowed.
¢ Dotted blue line — Guide for moving an item between other items.

To move items in the Explorer Tree:

1. Select the item you want to move in the Explorer Tree.
2. Dragand drop the item to the new location.

The item you moved now appears in its new location in the Explorer Tree.

Move items in List View
Items must meet valid item location rules [88] before they can be moved.

Important considerations

¢ [f you select the tab at the top of the Explorer Tree and drag items from List View to the release, you

can change the release on one item or multiple items.
e You can move items between projects [89].

Warning

To preserve the hierarchy, use the Explorer Tree to move your items [88], or ensure that

only parent items are selected when moving them in List View.

To move items in List View:

1. In List View, select the items you want to move.
2. Drag and drop the items to the chosen location.

The item you moved now appears in its new location.

Move items between projects

You can move an item or a set of items, along with all associated conversations, versions, and attach-

ments to a different project.

% Tip

Move items to a different project when your project has grown too large and perform-

ance has started to degrade.

Review this list before you move items between projects:

¢ A move can't be undone. Users can move items back to the original project but IDs are changed.
¢ You can move only components and sets between projects. To move a folder of items or individual
items from a component or set, you must first create a new component/set, then move those items to

the new component/set.
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Document key IDs are changed when an item is moved. The new ID is based on rules set up in the
destination project.

When an item is moved, all associated stream collaboration, activities, and versions are moved to the
new project. Attachments, tags, and releases are copied to the new project.

If you delete the source project, images inserted in a rich text field that are copied in other projects are
also deleted because they are referenced and aren’t copied from the original project.

O Best Practice
- To keep images intact in the duplicated project, archive the source project.

Original attachments, tags, and releases still exist in the source project, including links, images, and
diagrams within rich text fields.

Test runs can't be moved. Test cases can be moved without impacting test runs.

Iltems contained in a review aren't shown in future versions of a review after they are moved.

The document ID in old baselines reflects the new ID.

If any moved item is associated with an integration sync, make sure that integrations such as the JIH
aren't running while a move takes place.

Performance might be impacted at the time of the move if other resource-intensive processes are
running at the same time.

To move items between projects:

1.

w

Make sure that:

¢ You have write permissions in the source and destination project.

e The items to be moved must be unlocked.

o All other move operations are completed. You can't make two moves at the same time.

In the source project, select the set or component of items you want to move, then select Move
item in the menu.

In the Move items to... window, select the destination project and select Move.

Review details and select Confirm.

During the move you can go to the destination project by selecting Go to project or stay in the same
project by selecting Done.

A pop-up window shows progress of the move. If any item fails to move, the entire move fails.

Once the move is complete, you can find recently moved items [760] from the Activity Stream.

Duplicate an item

You can quickly make a copy of an item to use as a template for a new project or a new requirement. You
can duplicate an item that is locked or unlocked.

ﬁ:’ Note
You must have read/write permissions to complete this task.

When you use the Duplicate items option, the copy includes:

Iltem name

Item description

Item description

Test steps (if applicable)
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e Ability to include tags, attachments, categories, and links

O Best Practice

- To create a full copy of an item, including all fields and relationships, use the Reuse
items option. With this method you can reuse multiple items, reuse items with children,
duplicate more of the item's content, or duplicate an item from another project. For
more information, see Reuse items [356].

To duplicate an item:

1. Select the item you want to copy, then select Duplicate item from the menu.
2. Inthe Duplicate item window, indicate whether you want to duplicate tags, attachments, or links.
3. Press Enter or select Duplicate.

Note

y According to the item type, selected preferences are saved across sessions. Howev-
er, clearing your browser data restores default options. When specific attributes (as
in links) aren't enabled for an item type, the option doesn't appear in the pop-up
window.

The item you duplicated opens in Single Item View.

Delete an item

When you delete items, they aren't physically deleted. They are marked as inactive and are no longer
visible to users or reports. If needed, they can be re-activated through the database.

Anyone with read/write permissions for an item can delete it, unless an organization administrator has
made the option unavailable [684].

Important considerations

e You can delete an item only if it is unlocked.

e Deleted items show up in the activity stream. The activity entry is also the only method of restoring a
deleted item [92] for those with delete permissions.

¢ In most cases, nothing is deleted from the Jama Connect database. Even if you delete another user,
item, or something else in the system, a record is maintained and the deleted object is merely de-acti-
vated on the front end. However, you can permanently delete the selected project and everything
under it from the database.

¢ Additional safety checks for test runs and test cycles include enhanced locking safeguards to prevent
unintended changes or deletions. For more information, see Managing tests with Jama Connect [397].

To delete an item:

1. To delete in Single Item View [21], choose an item and select Delete.
2. To delete in List View [16] or Document View [17], choose one or more items and select Delete.
3. To delete in the Explorer Tree, select an item, then select Delete from the menu.

The deleted item no longer appears in the Explorer Tree or in your view.
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Restore a deleted item

If you have permission to delete an item, you can also restore it. When you restore a deleted item, it
retains all comments, versions, and relationships associated with the item.

é’ Note
You must have project admin permissions to complete this task.

To restore a deleted item:

1. Select the project name at the top of the left panel to open the dashboard, then open the Activity
Stream widget [455] to view recent activities.

2. Inthe search field at the top of the Activity Stream widget, type delete to display all recently deleted
items.

3. Find the item you want to restore and select Restore.

If the set for the restored item was removed, a component with a temporary set is created. The item can
then be moved to any set of the same item type.

Tags

Tags are labels that you can attach to items. They can help you find items with something in common.

f’ Note

These tags are different than hashtags [245] that you apply to comments in the stream.

The tag name length must not exceed 50 characters.

Tags are displayed in the bottom of the left panel in a section that can be hidden.

e Search for tags [145] using the "tag:" prefix.
e You can edit tags in List View.
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e Tags can be displayed in a Cloud View:

In either view, select the tag to view its associated items.

Add and delete tags

Add and delete tags as your project evolves, if you created a tag by accident, or to keep items organized.

The tags widget must be enabled by an organization administrator [687]. Otherwise, the option to add a
tag isn't available in the Ul.

Note

y Managing tags on a locked item is typically not available. However, if an organization or
project admin enables the Allow tag management for locked items [734] option for the
project, anyone with write permissions can add or edit tags on the locked item.

To add or delete a tag:

1. Add atagto anitem:
a. InSingle Item View, select Add tag.
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b. Enter the tag name in the available field, then press Enter.
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2. To delete a tag from an item, select the X in the tag.
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Attachments

Attachments are external files such as images, documents, and spreadsheets that can be attached to an
item.

A project administrator can manage attachments [734] for a project.

Important considerations

You must have create/edit permissions to access attachments.

File size limit is 4 GB.

These default file types are allowed: APK, AVI, BMP, CSV, DOC, DOCM, DOCX, DOT, DOTX, DWG,
GIF, GZ, JAMA, JPEG, LOG, MD, MOV, MP3, MP4, MPEG, ODG, ODP, ODS, ODT, PAGES, PDF, PGP,
PNG, PPT, PPTM, PPTX, RAR, RTF, TGZ, TIF, TIFF, TRA, TXT, VCS, VSD, VSDX, VSS, WAR, WAV,
WMA, WMV, WPS, XCF, XLS, XLSB, XLSM, XLSX, XLT, XPS, ZIP, ZIPX.

Self-hosted environment — The system admin can update this list directly [580].

Add, edit, and delete attachments

An attachment is an external file such as an image, document, or spreadsheet that can be added to an
item. You can add, edit, or delete attachments as needed.
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é’ Note
You must have create/edit permissions to complete this task.

To manage attachments:

1. Add an attachment:
a. InSingle Item View, select Add attachment.

o To upload new items, select the Upload tab in the Add File Attachment window, then select
Choose file to select the file you want to attach and upload.
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e To attach files that are already uploaded to Jama Connect, select the Existing tab in the Add
File Attachment window, then select the file you want to attach. Select Show all to see all the
files that are already attached to an item.

b. Select Attach to Item.
The file is now shown in Single Item View as an attachment.
c. To download the attachment, select the attachment name or the down arrow icon.
2. To delete an attachment, select Remove from item (trash icon).

Remove from [tam

LS "I~
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3. To edit an attachment, select Edit (three dots icon) to open the Edit File Attachment window.

[V]
(7]

& z

& e [

You can then:

e Reload the attachment.
e Update the name and description.

¢ Upload a different attachment, which overwrites the existing one. To add a new attachment, start
from step 1.

4. Select Save and Close.

The item reflects the changes you made.

Using the rich text editor

When the rich text editor is enabled [674] by your organization admin, you can format text in individual
fields and embed other data like images and tables.

With rich text fields you can use text formatting, hyperlinks [101], images [100], tables [102], spellcheck-
er (English), templates [104], diagrams, graphs [103], and equations [104].

Note
é’ The equation editor requires additional licensing. Contact your Jama Software account
manager for more information.

If a field is enabled with rich text, you see the rich text menu, which provides rich text controls.
These controls are like text editing options in many software applications. You can also use keyboard
shortcuts [770] with the rich text editor.

Important considerations

Many third-party reporting tools can't display rich text (HTML) properly.

Integrations with third-party applications might not be able to accept rich text (HTML) data.

Each rich text section can have its own style, making it difficult to control the overall look and feel of
your report.

As needed, you can disable the rich text editor [674].

Whenever a rich text item is saved, Jama Connect deletes certain text (usually code like JavaScript)
that might be a security risk. This doesn't affect most data.
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Rich text toolbar and buttons

N

w
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Text style and size

Cut, copy, and paste — Paste action inserts selected text as plain text.

Field view — Insert document templates [104] (must be configured [697] by organization admin),
view source code, and fullscreen mode.

Format text

Subscript, superscript

Text alignment

List formatting

Edit text

Insert links [101]

10. Special tools — Add diagrams [103], images [100], tables [102], special characters.
11. Accessibility checker
12. Equations editor — Math Editor, Chemistry Editor.

The spellchecker automatically underlines misspelled words in red. Cmd+right-click on the word to view
spelling suggestions.

Insert image to rich text fields

The rich text editor lets you add an image to an item field. The editor provides multiple methods for
adding an image.

A system admin can manage file types [580] for self-hosted customers.

To insert an image:

1.

Add an image using one of these rich text methods:
¢ Toolbar option: Add image

.O. Best Practice
- Provide the full path to the image file to comply with third-party converters for
PDF and Word. If you move Jama Connect to a new server or modify the server
name, edit your image files to match the path or name change.

e Copy and paste (not available with Internet Explorer 10)

e Drag and drop

¢ Browse the server (select Add image from the server)

(Optional) Resize or move the image as needed.

A system admin or organization admin can define a maximum height and width setting for an
inserted image.

If an inserted image is too large to be displayed, select Expand to view the image in full size.
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The image you added now appears in the item field.

Insert a link in rich text fields

Direct links to attachment files can be helpful to reviewers. You can link from a rich text field directly to
other sets, items, and attachments in Jama Connect, or to an external link.

To insert a link in a rich text field:

1. Select the Link icon in the Rich Text toolbar.

2. Inthe Enter URL or Choose Item window, do one of the following:
e Enter the URL for an external link.

o Select tabs to choose your link from recently viewed locations, the Explorer Tree, releases, search
results, or attachments, then under the Attachments tab, upload a file directly from your desktop.

3. Choose Select to place your link in the rich text field. The link doesn't work until you save changes
to your item.

The link you inserted now appears in the rich text field.

f’ Note
To break a link, select the Break link icon in the toolbar.
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Add and edit tables with rich text editor

You can add a table to an individual field using the tools section of the rich text editor [99]. You can also

edit the table.

O Best Practice
Although you can import tables from other documents, they can be difficult to work

with once imported, and they don't export cleanly. Instead, create tables manually in
Jama Connect.

To manage tables with rich text editor:

1. To add a table, select the Table icon in the Tools section of the rich text editor.

2. To format a table, select any table cell, then select the preferred action.

3. Toresize a table, select its borders.
4. To add space above or below a table, hover your mouse near the space, then select the arrow that

appears on the right.
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5. Select Save & done.

The changes you made are now reflected in the field.

Insert rich text diagrams

Diagrams can be anything from basic shapes to more complex modeling and business process flows.
Once saved, a diagram is an editable image within the rich-text field.

Important considerations

¢ You can't copy and paste between the diagram editor and other applications.
¢ You can’t import images from other diagramming tools.

To insert rich text diagrams:

1. Select Diagram in the Rich Text toolbar to open the Graph Editor window. If you highlight an
existing diagram before selecting the button, it appears in the window for editing.

2. In the Graph Editor window, create new shapes by dragging from the menu on the left and dropping
to the canvas.

3. To add shapes, icons, tables, or text, or to use the search function, use options in the left pane. For
more information, see MXGraph Editor.

4. To format style text and arrangement, use the options on the right.

5.  When finished, select Save and Close to insert your image into the field.

The image you inserted appears in the field.
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Insert equations in rich text fields

With this editor, you can create complex equations and edit them in Jama Connect. These are converted
into images for safe storage and export, but are always editable when you have a MathType license.

For more information about how to create mathematical equations or chemistry formulas, see the
MathType User Guide.

Important considerations

¢ Your organization determines the total number of floating licenses, which are available on a first-
come/first-served basis. If a license is available, you can use it by opening the Equation Editor. To
release the license, close the Equation Editor. If a license isn't available, try again in a few minutes or
contact your admin for help.

e The MathType Equations Editor requires a separate license. Contact your Jama Connect administrator
or sales representative to inquire about purchasing this license.

e For self-hosted customers with a license, the system administrator can enable the equations edi-
tor [570].

To insert equations in rich text fields:

1. To add a new equation or formula, open the appropriate editor by selecting its icon (Math Editor or
Chemistry Editor), then select the equation or formula you need.

2. To edit an existing equation or formula in your item, use one of these methods:
e Highlight the equation/formula, then select the appropriate icon for the editor you need.
e Select the equation/formula to open the appropriate editor.

The equation you inserted appears in the rich text field.

Insert templates to rich text editor

Templates are pre-written text or documents that can be inserted into the rich text editor to help
uniformly format items like test cases or use cases.

Important
This feature must be configured by an organization admin [697] before you can use it.

To insert a template:

1. To open the Content Templates window, select the Templates icon in the Rich Text toolbar.
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2. Select a template from the list (for example, Basic Use Case, Document Style Use Case, Basic Test
Case, or Agile Story Card) and continue editing the item.

3. Select Replace actual contents to delete content currently in the field.
4. Select Save & done.

The template text appears in the field.

Run Accessibility Checker

The Accessibility Checker is a plugin that analyzes content created in the rich text editor. It lets you know
if the content meets standards for people with impaired visual, cognitive, or motor skills.

To run the Accessibility Checker:

1. Select the Accessibility Checker icon from the Rich Text toolbar.

The plugin inspects output HTML code to identify common accessibility problems and offers a
"quick fix" solution.
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2. Use the arrows at the top of the window to scroll through issues found by the Accessibility Checker.
3. For each identified issue, do one of the following:

e Enter the suggested changes and select Quick fix to apply the changes.

e Select Ignore.

4. If the Accessibility Checker finds no issues, you see a confirmation message. Select OK to close the
message.

Your content reflects the changes you made with the Accessibility Checker.

Importing content into Jama Connect

Content in Jama Connect is structured using an item-based approach. Items in Jama Connect can be
containers (components, sets, folders) or instances of a particular type of item, such as a requirement or
test case.

One way to populate Jama Connect with content is to import existing items (such as requirements or test
cases) from other applications.

.O. Best Practice

- Before populating Jama Connect with your data, make sure all needed information has
a “home” (field) in Jama Connect. Involve your team members in this process to avoid
having to re-import for data that was not initially taken into account.

The most common applications for importing items into Jama Connect are:

Microsoft e Determine hierarchy of imported items with Word heading styles (Heading 1, Heading 2...).
Word e Retain formatting like bulleted lists, numbered lists, and text formatting.

e Import Word tables as rich text field content or use tables to identify and import discrete items into Jama
Connect.

Excel e Map columns directly to fields.
e Determine hierarchy of imported items with cell coloring or indentation.
o Import via one-way import [124] or round-trip import/export [129].
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IBM Doors ¢ Import objects found within Modules.
* Map object attributes directly to fields within Jama Connect.
¢ Maintain relationships during import with active IBM DOORS data.

The Data Import Wizard guides you through the process of importing items into Jama Connect. It
recognizes file types like .doc, .docx, .xls, .xlsx, and .csv and displays options accordingly.

u Tip
o You might need to prepare your source file for a successful import. For example, if your
Word file has requirements in tables, make sure that all tables use consistent headings
in the first row so that the wizard can successfully identify each table for import.

Importing items from a Word file

You can add items to Jama Connect from a Word file. You might, for example, have a Word document
with various types of requirements (customer, system, or software requirements) or with test cases.

Tip
% If you are familiar with how to prepare a Word file for import, go to Import a Word
file [112].

When using a Word document to import items into Jama Connect, you can use these features to control
how things are imported.

¢ Headings and styles — From the document’s Styles list, you can use default heading styles to deter-
mine hierarchy (nesting) of imported items in Jama Connect.Headings are always imported as items,
not as folders. However, the hierarchy can be converted to folders once imported to Jama Connect.
Apply the Normal style to item descriptions.

¢ Tables — Tables in a Word document can be imported directly into Jama Connect rich text fields as
tables. Word tables can also be used to create discrete items in Jama Connect. If a table has a first
row header and one row per requirement, the content is read as one item per row. If a table has two
columns where the first column contains headings (for example, “Requirement Text”) and the second
column contains data (for example, “The system shall...”), the content is read as individual items for
each table that conforms to a repeated structure.
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¢ Import/Ignore Sections — Use designated keywords in your Word document to define which sections
to import and which to ignore. This is useful for large documents when not all content is relevant to
import.

¢ Field mapping — Define how Word elements map to Jama Connect item fields. This process varies
slightly, depending on whether you use headers or tables to identify items.

Note

y Many Word styles are imported, but not all are converted exactly. The import wizard
can’t import a table of contents. Images are included as part of the import. OLE compo-
nents, such as embedded Visio diagrams, are imported as PNG images.

Setting hierarchy with heading styles

When importing items from a Word document, you must prepare the document so that the import is
successful. An important step in this preparation is to set the hierarchy, how items are nested in Jama
Connect.

To set the hierarchy, use Word heading styles. Each heading represents a new item in Jama Connect.
The heading text is imported into the item’s Name field and any paragraph text, tables, or images are
imported into the Description field.

Note
y In your Word document, all headings are imported as items, never as folders. However,
the item hierarchy can be converted to folders after import using the Convert function.

Jama Connect supports up to six levels of headings in Word. Any levels beyond that are
included in the text of the sixth level item.

The hierarchy of imported items is determined by which heading level you apply to the item name. A
nested heading in Word is treated as a child item in Jama Connect, with a maximum of seven levels.

For example, in this diagram, Item A uses Heading 1 and is imported as a parent item. Item B uses
Heading 2 and is imported as a child of Item A, and Item C uses Heading 3 and is imported as a child of
Item B.
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When you open the imported item in Single Item View, the Name field is populated with the text of the
Word heading, and the Description field is populated with the text of the Normal style paragraph.

Note

é’ For the Description and rich text fields, formatting for bullets, bold, italic, and underlin-
ing are retained when imported. Numbered lists are imported as bullets. When a list
contains multiple levels, Jama Connect continues to use bullets. However, each set is
indented to indicate the original level.

109



Creating content

How tables are imported from Word
When importing items from a Word document, the Data Import Wizard lets you choose how tables are
imported.

Each table is an individual item

Select this option when your Word document includes a separate table for each item you want to
import. The wizard prompts you to complete field mappings with this option.

In this example, the document heading (System Requirements) is imported to Jama Connect as a parent
item and each table is imported as a separate child item.

The table for each item must have at least two columns: column 1 is the field name (for example, Name)
and column 2 is the field value (for example, Three digit display).

' b_r Tip
o If your Word file includes multiple tables, make sure that all tables use the same word-
ing for the field name in the header (first) row. For example, if one table uses ID for the
field name, all tables must use ID, as in this example.

Each table row is an individual item

Select this option when your Word document includes tables where the first row is the heading row and
each subsequent row constitutes a discrete item. The wizard prompts you to complete field mappings
with this option.

The cells with field names must be the top row of the table. Each subsequent row represents a separate
item, and a row'’s cells define the field values. If you have multiple tables in your document, each table

must have the same heading values to be recognized by the import tool.

This is an example document after importing into the set called System Requirements.
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Descriptions might include tables

Select this default option when the document you're importing has no tables or the content of a table
applies only to the item description.

You don't need to map fields when you select this option.

Here is an example document and the results after you import.

Prepare your Word file for import
Before you import a Word file, make sure it is formatted for a successful import. For example, confirm
that you use default headings and that your tables are formatted properly.

You might also need to define the document scope by tagging sections of content to include and exclude.
Requirement documents are often large and might contain sections or items that need to be imported to

different sets, different folders, or not at all.

To prepare your Word file:
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N

5.

Open the Word file you intend to import to Jama Connect.

Set hierarchy with heading styles [108] (how items are nested in Jama Connect).

If your file includes tables, make sure they are formatted according to how tables are imported from

Word [110].

(Optional) If you want to import only portions of the file, add keywords to sections you want to

import and want to ignore.

Use start/stop keywords that are simple, one-word, and all caps with no formatting. Keywords must

not be actual words that might appear in the content. Commonly used start/stop keywords are

IMPORTSECTION and IGNORESECTION.

a. Insert the keyword IMPORTSECTION before and after each section you want to import.

b. Insert the keyword IGNORESECTION before and after each section you want to exclude from
the import.

Save and close the Word file.

Your Word file is ready to be imported.

Import a Word file

You can import data from a Word file to Jama Connect using the Data Import Wizard, which walks you
through the process.

To import a Word file:

1.
2.

Make sure your Word file has been prepared [111]for a successful import.
Open the Data Import Wizard: In the Explorer Tree, select an item where you want to import new
items, then select Import. Your file is imported below the selected item.
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The first page of the wizard opens with the Destination field pre-populated.
3. Complete the Select Import File and Destination page, then select Next.
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a. Select Choose File and select the Word file you want to import.
If the file type isn’t recognized, the import doesn't continue.

. #u_r Tip
. If you previously saved your field mappings for importing a Word file, choose
the field Select a saved field mapping and select that file. This is useful if you

are importing multiple documents with the same field mapping.

b. (Optional) In the Encoding section, select the character set encoding to use during the import.
For most imports you can use the default, UTF-8, which is used by the Jama Connect database.
4. Complete the Choose Field Mappings for Import page, then select Next.
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a. Document Scope Options — If you tagged your Word file to import and ignore some sections,
select the checkboxes and enter the name of each keyword (for example, INCLUDESECTION
and IMPORTSECTION).

b. Field Mapping
¢ Max length of Name field — Select this and enter a maximum number of characters for the

name. Default is 255 but this option lets you further limit the name length.
o Default Value — Use this option (when available) if you want a field value to be used
by default. Then, all items created during import include the default value you enter. For
example, you can set the status to Draft for all imported items.
5. Complete the How to Handle Tables page, then select Next.
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a. Choose a Table Import Style — Select this option if your item description includes tables:

¢ Descriptions may include tables — Select this option if your file uses headings for hierarchy,
but the content includes some tables.

o Each table is an individual item — Select this option if your file uses tables and includes a
separate table for each item. Must complete Table Field Mapping.

o Each table row is an individual item — Select this option if your file uses tables and the tables
use a separate row for each item. Must complete Table Field Mapping.

b. Table Field Mapping — Complete this section if importing table content as individual items
(option 2 or 3 above). From your Word tables, copy the heading values into the Identifier field
for each Jama Field mapping. For some Jama Fields, you can set a default value (for example,
setting status to Draft), which populates the field if the mapping has no value.

6. Verify First Item in Import File — Review the mapping of the first item found in the document you're
importing. If the mapping is correct, select Submit to import the target document.
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a. (Optional) Select Import another file to restart the wizard.
b. (Optional) To reuse the field mapping settings, select Save this as new document mapping.

Note
y Field mappings are project-specific and can be used by any user in the project
where the mappings are saved.

c. Select Submit.
7. Select Close.

A message appears in the Data Import Wizard to confirm that the import was successful.

Importing from Excel

You can use the Excel Import Wizard to import data into Jama Connect from a Microsoft Excel docu-
ment. This process is called a one-way Excel import. You can also export existing data from Jama Connect
to an Excel template, then update the data in Excel as needed, and import it back into Jama Connect.
This called an Excel round-trip.

¢ To ensure a successful import, your Excel worksheet must be created and formatted for the specific
type of data (items, test cases, item relationships) that you want to import.

¢ For items and test cases, your worksheet indicates item hierarchy — how items are nested — as
folders, parent items, or child items. You can use color or indentation to define hierarchy.

e When importing items, your worksheet can include only one item type. If you need to import more
than one item type, you must create a separate worksheet for each item type and import each
worksheet separately.
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Tip

% If you are familiar with how to prepare an Excel file for import, go to the tasks Import
items [124], Export/import via Jama Connect-to-Excel round trip [129], and Import
relationships [133].

Recognized file types — Jama Connect imports data from Excel files with these extensions: .xIsx, .xIs,
and .csv.

Note
i An import from a file with a .csv extension doesn't create folders or hierarchy. Only .xlsx
and .xls files create folders and hierarchy.

Preparing a worksheet to import items

Before importing items from your Excel worksheet, make sure it contains all the necessary elements for a
successful import.

e One item type per worksheet. If you have more than one item type to import, create a separate
worksheet for each type.
e Header row [119] with field names

¢ Valid pick list options [119]
If importing into a Jama Connect pick list field, make sure the values in your Excel worksheet exactly
match the available values in the Jama Connect field.

e Date format
When including dates in text-formatted cells, always format dates like this:
mm/dd/yyyy hh:mm:ss Z (example: -0800, +1000, +0700) where Z is the time zone difference from
GMT.

¢ Roundtrip
If importing to update existing items in Jama Connect, you must use a spreadsheet generated from
Jama Connect when you select the Excel Export for Roundtrip option.
Create a baseline [277] before a round-trip export/import process, in case you need to restore old
data.

u Tip
' To import test cases or requirements, see Preparing a worksheet to import test ca-
ses [123] or Preparing a worksheet to import relationships [132].
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Defining header row in Excel
Including a header row in your worksheet helps to easily map columns in the worksheet to fields in Jama
Connect. Typically, the Header row is the first row in your worksheet, but it doesn’t have to be.

The header row includes fields listed horizontally, with values for those fields defined in subsequent
rows.

Your worksheet can contain only one header row. If you don't use column headers, the import automati-
cally numbers the columns sequentially from left to right, starting with 1.

O Best Practice

- Always include the Name and Description fields. If you don’t include a Name field, the
worksheet must still contain a column to be mapped to the Jama Connect Name field.
Every item and folder in Jama Connect must have a value in the Name field. If your
requirements were previously managed in an Excel worksheet without this field, create
a new column for Name values or designate an existing column, such as a legacy ID
value, for the Name.

You can add optional fields like Status or Priority.

If other fields for the imported item type are required (based on Admin configurations), you can add them
to your worksheet or plan to set a default value during the import.

Important
An organization administrator can add or delete fields [674] for an item type in Jama
Connect. However, the Name field is a system field and can't be disabled.

Defining pick lists in Excel

When your worksheet includes a column for a pick list in Jama Connect, for example Priority or Status,
the values you define must match the list of available values in Jama Connect. Otherwise, the imported
item shows a blank entry for that field value.

In this example worksheet, Requirement 1 lists Fun as a Priority value, which doesn’t match the values in
Jama Connect (High, Medium, Low). After importing this item, the List Item View shows a blank entry for

Priority.
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.O. Best Practice
- Before importing your worksheet, identify the columns in Excel that will be mapped to
pick list fields in Jama Connect. Use the Excel Filter functionality to identify the values
found in that column in Excel. If the values found in Excel do not have an exact match
in the Jama Connect pick list, you must correct errors before importing. Otherwise, the
value will be blank.

Setting hierarchy with color in Excel
When you import items from an Excel worksheet, you can use cell color to determine hierarchy of
imported items. This method allows only one tier of hierarchy and doesn't differentiate between colors.

In your Excel worksheet, you can select the cell you want to use as a parent container and use a color to
indicate hierarchy.
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When you import the document, the Data Import Wizard prompts you to select the column that will
determine hierarchy. In this example, Name column is selected.

The resulting import shows the colored cells as parent containers.

Setting hierarchy with indentation in Excel

When you import from an Excel worksheet, you can use indentation to determine hierarchy of imported
items.

In your Excel worksheet, you decide which cells you want to be parent items, then indent the cells below
the parent items.

Using indentation for hierarchy allows multiple levels of hierarchy (for example, folders containing sub-
folders and subfolders containing items). This is an advantage over using highlighted cells for hierarchy.
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When you import the document, the Data Import Wizard prompts you to select the column that will
determine hierarchy. In this example, Description column is selected.

The resulting import shows the indented cells as child items:
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Preparing a worksheet to import test cases

To import test cases and their steps, you use the Excel import to Jama Connect option. You can use a
one-way import to import a test case from an Excel worksheet or, if you need to update existing test
cases, you can use a round-trip process.

Required header fields

To successfully import test cases and their test steps, your Excel worksheet must contain one header row
with these four columns (field names): Test Case Name, Action, Expected Results, and Notes.

A, B C D
Test Case Name Action Expected Results Notes

One-way import for test cases

Quickly bring legacy test cases into Jama Connect. This example worksheet imports two test cases: "Test
Wheel" and "Test Brakes." Each row with the repeated test case name is imported as a new test step.

A, B C ]

Test Case Hame Action Expected Results Notes

Test Wheel Fotate rowve in circular motion with no obstruction tester notes
Test Wheel Let air out self inflatar starts tester notes
Test Wheel Foke Hole self inflator starts tester notes
Test Wheel bend spoke wheel breaks tester notes
Test Brakes apply brakes downhill slows to a stop in 20ft at 80% downgrade at S0MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 30ft at 85% downgrade at B0MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 40ft at 90% downgrade at S0MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 15ft at B0% downgrade at 40MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 20ft at B85% downgrade at 40MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 25/t at 90% downgrade at A0MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 10ft at B0% downgrade at 30MPH tester notes
Test Brakes apply brakes downhill slows to a stop in 15ft at B5% downgrade at 30MPH tester notes

3

Test Brakes apply brakes downhill slows to a stop in 201t at 90% downgrade at 30MPH tester notes

When importing the Excel file, follow the instructions for any one-way import [124]. The Data Import
Wizard prompts you to select the worksheet, plus the number of the header row.

Note
é’ To import items or requirements, see Preparing a worksheet to import items [118] or
Preparing a worksheet to import relationships [132].

Round-trip for test cases

When you need to update a test case already in Jama Connect, you can use a round-trip [129] process.
First you export a test case from Jama Connect, which generates an Excel file populated with the
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required fields. Next you update any fields that need changes, then re-import the data back to Jama
Connect.

Because of the relationship between test cases and test runs, you can't update the test case status [408]
in a round-trip import/export. The test case status field is calculated from all test runs derived from that
test case.Test case status.

Add and delete a test step in Excel

You might need to add a new step to your test case or delete an existing step before you import content
from an Excel worksheet.

To manage test steps:

1. Add atest step — Copy an existing row (step), then select the row where you want to insert the
copy and select Insert Copied Cells. Edit the fields in the copied row to reflect the information
needed for the new step.

K E it I (8] P Q R 3 F L i

Tests included whe Medium Mot Sched 05417 Sam Test 05417720 1 Mot Sched
open a web browse Unassigne Mot Sched Sarmn Test 0517720 1 Mot Sched
open a web browse Unassigne Mot Sched Sam Test 05/17/2C 2 Mat Sched
open a web browse Unassigne Mot Sched Sarn Test 05/17/2C 3 Mat Sched
open a web browse Unassigne Mot Sched Sarmn Test 0517720 4 Mat Sched
open a web browse | Unassigne Not Sched SamTest 051720 BNotSched
wopen a web browse Unassigne Mot Sched Sam Test 05117/20 7 Mot Sched
open aweb browse Unassigne Not Sched Sam Test 0541720 7 Mot Sched
open a web browse Unassigne Mot Sched Sam Test 05/17/2C & Mat Sched
open a web browse Unassigne Mot Sched Sarn Test 05/17/2C 9 Mat Sched
open a web browse Unassigne Mot Sched Sarmn Test 0517720 10 Mot Sched
open a web browse Unassigne Mot Sched Sam Test 0517720 11 Mot Sched

Important

Always use Insert Copied Cells instead of Paste. The Paste command replaces the
row instead of adding a new row, and subsequent steps are removed on import.

2. Remove a step — Select the row (step) you want to remove, then select Delete.
Re-numbering of steps takes effect on import.
3. Save the file.

Your Excel worksheet includes the changes you made.

Import items or test cases from Excel

Importing items or test cases from Excel to Jama Connect is called a one-way import. The process is
handled by the Data Import Wizard, which guides you through the steps. The wizard recognizes .xls
and .xlsx file types.

Important

To update existing items or create new items in an existing set between items, use an
Excel round trip [129].

To import one-way from Excel:
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1. Open the Data Import Wizard: In the Explorer Tree, select the set or folder where you want to
import new items, then select Import.

The first page of the wizard opens with the Destination field pre-populated.
2. Complete the Select Import File and Destination page, then select Next.
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a. Select Choose File and select the Excel file you want to import. The wizard recognizes .xIs
and .xIsx file types. If the file type isn't recognized, the import doesn't continue.
b. (Optional) Encoding — Select UTF8.
3. Complete the Choose Field Mappings for Import page, then select Next.
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Excel Options — If your file has more than one worksheet, select the one you want to import, then

enter the number for the header row. If a header row doesn't exist, select row 0, which populates

the Mapping section with the Excel default column names.

¢ Round trip/Update Options — For one-way import, leave these options unselected.

¢ Field Mapping — Select the appropriate column from the worksheet for each field in Jama
Connect where you want to import data. Select a mapping for Name and any required fields, as
determined by the Admin configuration for the item type. Fields not required for the import don't
need to be mapped.

On the Additional options page, indicate whether your worksheet uses cell color or indentation for

hierarchy, then select Next.
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5. If the fields were mapped successfully, you see a preview of your import. Select Submit to import all
items.

The Final Import Summary page confirms the total number of items imported.
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6. (Optional) Import another worksheet or save the current mappings to use for future uploads.

Note
é’ Field mappings are project-specific and can be used by any user in the project
where the mappings are saved.

7. Select Close.

Your file is imported below the selected item in the Explorer Tree.

Export/import via Jama Connect-to-Excel round-trip
With a round trip, you can batch edit multiple items or test cases in Jama Connect, as well as create new
items or test steps to be imported.

The round-trip process involves these steps:

1. Export items via round-trip
2. Edit worksheet
3. Import worksheet

Round trip requires you to re-import Excel documents created by Jama Connect using an Excel template.
When the system identifies items that originated in Jama Connect, it updates your items according to the
conflict rule set at the time of the import.

Excel has a cell character limitation and, during the export, truncates rich text fields that exceed the limit.
A truncated rich text field can impact the data that's imported to Jama Connect using round-trip.

To import or export via Jama Connect-to-Excel round-trip:
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1. Export a folder, filter, or set of items to Excel:
a. Select Export > View all export options.

b. Inthe window that opens, select Excel Export for Roundtrip from the menu on the left, then

select Run.

6” Note
Excel limits the number of characters that a cell can contain. If a Jama Connect
field (rich text field) exceeds the limit, Excel truncates the text when it's exported.
As a result, the Jama Connect is updated with the truncated data if imported via

round-trip.

2. Open the newly downloaded Excel report and save it to a place where it can be edited.
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Columns A-E are hidden. They contain fields that Jama Connect requires to update existing items.
3. Edit the exported Excel document with required changes, then save it.
a. Edit the fields you need to update. In this example, the names of three test cases are changed.

If a field is based on a pick list in Jama Connect (for example, Priority), the pick list values are
exported as well. This ensures that valid data is entered before re-importing to Jama Connect.

b. As needed, create new items or test steps that you want added to Jama Connect. After import,
the added items appear at the bottom of the set or folder where you import to.

e You can add only one item type for the selected set or folder.

o Leave the ID and Global ID fields blank. These values are assigned to new items during
import.

o Leave Assigned field blank.

4. Import the edited Excel file. The process is the same as for the one-way import except for the
Choose Field Mappings for Import page:

a. Excel Options — If your file has more than one worksheet, select the one you want to import.
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Select the number of the row in your worksheet that contains the headers. By default, the Excel
for Roundtrip export uses row 2 as the header row.
If a header row doesn't exist, select row 0, which populates the Mapping section with the Excel
default column names.

b. Round trip/Update Options — Select the checkbox for Update Items to update Jama Connect
items that were modified in the round-trip Excel worksheet.
Select an option for Conflict Resolution: Excel wins or Do Not Update. Conflicts might occur
when a field in Jama Connect has changed values since the round-trip export was generated.

c. Field Mapping — Select the appropriate column from the worksheet for each field in Jama
Connect where you want to import data. Select a mapping for Name and any required fields,
as determined by the Admin configuration for the item type. Fields not required for the import
don’t need to be mapped.

The items you exported and edited are re-imported to Jama Connect.

Relationship Import Plugin

The Relationship Import plugin helps you batch create relationships between existing items in Jama
Connect using a comma separated file as input.

The process of using the Relationship Import Plugin consists of these actions. Your role determines the
actions you can take.

Preparing your CSV file [132] (admin or user)

Gathering information for the Relationship Import Plugin [630] (admin only)
Configuring the Relationship Import Plugin [632] (admin only)

Importing relationships from Excel [133] (admin or user)

L NS

Important considerations

e The Relationship Import Plugin must be configured and enabled by an organization admin.

¢ When importing relationships, the applied Relationship Type is determined by the default type selec-
ted by the admin [642].

e The Relationship Import Plugin entry is required for each pairing of upstream and downstream item
types. For example, to use the plugin to import Market Requirement to System Requirements relation-
ships and System Requirements to Verifications, you must configure two plugin entries, one for each
upstream/downstream item type pairing.

¢ To import requirements before creating relationships, see Importing content into Jama Connect [106].

Preparing your CSV file
The Relationship Import Plugin uses a CSV file with UTF-8 encoding as input.

When working with the CSV file in Excel, the worksheet must contain only two columns:

e Column A — Unique information about upstream items such as item ID
e Column B — Unique information about downstream items
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Important considerations

e Data can be written only in Columns A and B.

e The worksheet must not have any merged cells.

e Every row must have an upstream/downstream pair.

¢ Import relationships in small batches. Create each worksheet with fewer than 500 relationships.

e Although you don't need to use IDs generated by Jama Connect, the data in the CSV file must already
be in Jama Connect and unique to each item.
For example, if you are importing existing requirements from a spreadsheet, use a custom field in Jama
Connect (such as a text field named “Legacy ID”") to store the existing IDs. You can then refer to this
Legacy ID field for the relationship import and use the values from the spreadsheet to build your CSV
file.

If you use an existing Trace Matrix from Excel to create your CSV file of relationships, you might need to

reformat the spreadsheet. Be sure data is only in Columns A and B and there are no merged cells: every
row must have an upstream/downstream pair.

(Admin only) Go to the next action: Gathering information for the Relationship Import Plugin [630].

Import relationships from Excel
To import relationships to Jama Connect, use the CSV file you prepared.

Important considerations

The Relationship Import Plugin must be configured [632] and enabled by your admin.
A CSV file must include correct parent and child field values and must have the .csv extension.
Import relationships in small batches. Create each worksheet with fewer than 500 relationships.

Check that your parameters are written correctly and reference the right API ID or field. For more
information, see Configure Import Relationships Plugin [632].

To import relationships from Excel:

1. From the Project drop-down menu, select Import > Custom Import.
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2. Inthe window that opens, enter the following information:

e Select a destination — This is a required field. Your selection doesn't affect the outcome, so select

any set of items in the project.
o Select custom importer — Select the plugin entry you previously created.
¢ Field delimiter — Comma.
e Optional Encoding — UTF8.
o Select file to import — Choose the CSV file you created for this plugin.

3. Select Import.

The Activity Stream and Trace View display the relationships that you created in Jama Connect.

Importing from IBM DOORS

You can import active IBM DOORS data, such as requirements, test cases, and project information to
Jama Connect. You can also maintain relationships during the import process.

The steps for a successful import include:

1. Ensure you meet Jama Connect prerequisites [135] and DOORS prerequisites [134].
2. Export HTML zip file from DOORS [137].
3. Import to Jama Connect [138].

DOORS export prerequisites

Before exporting data from IBM DOORS, verify these prerequisites for a successful export.
Mapping

¢ The Object Identifier column in IBM DOORS is typically mapped to the Name field in Jama Connect.

e If you're importing hierarchy, the DOORS standard Object Heading and Text (or Main) column must
be mapped to the Description field in Jama Connect. This is the only column that exports hierarchy
information to HTML for Jama Connect imports.

Links

If you're importing links (trace relationships) across multiple modules in DOORS:
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e The modules must be open when you export. A DOORS export includes only the modules that are
shown in your view, so make sure no filters are selected because they limit the number of items
exported.

e Each module must have a unique prefix so that the Object Identifier is unique. DOORS doesn't
enforce this requirement, so make sure you confirm that each module has a unique prefix before you
export.

e The Object Identifier column must be visible in the DOORS module view (not Object Number or
Absolute Number). The Object Identifier is a combination of the Module Prefix and the Absolute
Number (as in SYS32). If the Object Identifier has only integer values, the Module Prefix is most likely
empty.

Jama Connect prerequisites for DOORS import
Before importing data from DOORS to Jama Connect, verify these prerequisites for a successful import.

Links
Relationships between items aren't created until both items are imported.

e To import relationships (or trace links), you must create a custom field in Jama Connect [674] for each
item type you're importing.

e Each custom field must contain a unique identifier, which aids in importing relationships from DOORS
to Jama Connect.

Create custom fields in Jama Connect

Before you can import relationships (or trace links), you must first create a new custom field in Jama
Connect for each item type you're importing. Each field must contain a unique identifier.

O Best Practice

- When importing many custom fields from DOORS, create a common custom item type
that contains all the custom fields. Use this item type only for the initial import, then
later convert sets to a standardized set of item types. That way, every imported item
includes legacy DOORS information in its version history. To view this information,
compare versions [266].

To create custom fields in Jama Connect:

1. InJama Connect, select Admin > Organization > Item types.

2. Find the item type you're using for the DOORS import, then select Add field.

135



Creating content

3. Inthe Add Field window, complete these options, then select Save.

¢ Select a Field Type — Select Custom Fields, then select Text Field from the drop-down menu.

¢ Field label — Enter a name for the field (for example, "DOORS ID").

¢ Unique Field Name — Enter "SYS_DOORS_ID." This is case-sensitive and must exactly match the
above image.

e Select Read Only.

This item type can now accept relationships (trace links) imported from DOORS.
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Important
The SYS_DOOR_ID field must be created for all the item types you are relating.

Export data from DOORS
Before you can import data from IBM DOORS to Jama Connect, you must first export it to an HTML .zip
file.

To export data from DOORS:

1. Onyour local system, create the export target folder in the local drive/directory.
2. Open a DOORS module that you want to export and make sure there are no active filters.
3. Select File > Export > HTML.
4. Select Layout > Table.
5. Select Export > Current.
6. Select Links to import links as relationships and create the necessary field in Jama Connect [135].
7. Select a folder or location where you want to store your DOORS files.
8. Browse to the target folder and select Export.
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Images in the item description are imported. Comments, attachments, and item history aren't imported.

Import DOORS files to Jama Connect

After you have exported data from DOORS [137], you can import it to Jama Connect using the Data
Import Wizard, which guides you through the process.

The import process creates:

e Sets or folders in an existing set. DOORS Attributes map to fields in Jama Connect.
¢ Relationships between items only after both items are imported.

To import DOORS files:

1. Open the Data Import Wizard: In the Explorer Tree, select an item where you want to import new
items, then select Import. Your file is imported below the selected item.

The first page of the wizard opens with the Destination field pre-populated.
2. Complete the Select Import File and Destination page, then select Next.
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e Select Choose File and select the DOORS file you want to import.
If the file type isn't recognized, the import doesn't continue.

e (Optional) Select a saved field mapping — Select previously created import configurations that
were saved in the project for the same file type. This is helpful if you need to import multiple
documents with the same field-mapping layout.

e Optional Encoding — Select UTFS8.

Complete the Choose Field Mappings for Import page, then select Next.
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Data Import Wizard

£ ] Choose Field Mappings for Import

Field Mapping
L* ]

Jama Item Field Default Value Mapping
Business Owner R None —
Name D b4
Description Rich text fields cannot have default values. BusinessRequirementsl i
Priority w7 None —
Status Cannot map workflow field
New Text Field None e

Back | Next | Cancel

¢ Field Mapping — Select a mapping for the Name field (this is usually the DOORS Object Identifier
attribute). You can assign a default value for other Jama Connect fields and select which DOORS
attributes you want to map to each.

Important

The Description field is usually mapped to the Main attribute in DOORS. Bullets
and other symbols are exported from DOORS as images, not as formatting. If
you're mapping a field that contains images or formatting, the corresponding import
field must be configured as a rich text field, otherwise these images don't appear.

You can't select a mapping for Step action, Step expected results, or Step notes.

4. Select the options you want for hierarchy and relationships, then select Next.
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Data Import Wizard

=)

Preserve Hierarchy

[7] Use item-subitem structure (instead of folder-item structure) when creating hierarchy of imported items

Relationships

=
[7] Create relationships fram DOORS links: -
Relationship Type: »
DOORS Id column; v
"From’ (QUT) link direction in DOORS v
maps to:
Back Next Cancel

¢ Preserve hierarchy — Select to keep the DOORS hierarchy when importing. If left unselected, the
resulting items are at the same level.

e Use item/sub-item structure — Select if you want all parent items to keep the item type of their
children. If left unselected, all parent items become folders.

Important

All items converted to folders lose their relationships (links). If you're importing
relationships, use the item or child-item structure.

¢ Create relationships from DOORS links — Select to migrate Trace Links from DOORS to relation-
ships in Jama Connect.

If you see the following error, check that you successfully completed all Jama Connect prerequi-
sites before import.

Relationships

-
It appears the Scope Definition you are attempting to import into is missing a necessary field for the DOORS id. This field is required. See
your administrator or check the help documentation.

Relationship Type: b

DOORS Id column: W

From® (OUT) link direction in DOORS b
maps to:

¢ Relationship type — Select the type of relationship you want to create. If left unselected, this
value is set to your organization's default value.

e DOORS ID column — Select the name of the column from your export that contains the DOORS
Object Identifier, which is used as the identifier when creating relationships. It must match
between item types.
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¢ 'From' (OUT) link direction in DOORS maps to — Set OUT=upstream or OUT=downstream.
DOORS and Jama Connect use different terminology for relationship direction. The selection
depends on how relationships are used in DOORS. Check the HTML file or run a test import to

verify that this works as expected.

Important
Because relationships are created based on the DOORS Object Identifier, importing
items twice creates multiple relationships.

If the fields were mapped successfully, you see a preview of your import. Verify that it looks correct,
then select Submit to import all items.

Data Import Wizard
5 . . - Destination: DOORS:: MediKiosk ex
= Verlfy _lflrsi ltem in Import File Import File: Doc —
step 3 of 4 File Type: ZIP File
Matt Mickle
BR-1

1 Business Requirements
Unassigned
Draft

BR-1

Back | Submit | Cancel

The Final Import Summary page confirms the total number of items imported.
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Data Import Wizard

— . Destination: DOORS: MediKios .E“’lf'}l'”‘”f'}l't...
! |
— | Final Import Summary Import File: Doorsimportzip

Step 4 of 4 File Type: ZIP File

Import successfull

“fou have imported 22 tems.
“fou have created 1 relationships.

Import another file

Save Mapping Options

Save or Update this document mapping

Save This As New Document Mapping

Close

e (Optional) Import another DOORS Module.
o (Optional) If you plan on importing the same item type (objects) with the same mappings multiple
times, you can save your mapping changes as a new document mapping here.

6. Select Close.

The DOORS files are now imported to Jama Connect.
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Searching for content

The content you want to find might be anywhere in your project. Jama Connect gives you many ways to
access the items you need.

The process of finding what you need consists of a simple SEARCH for a word or phrase, then refining
your search results with a FILTER, and optionally saving a filter for future use.

1. Search [144] — Use the search bar in the header to enter a term or phrase. Add wildcards or
Boolean operators. Search through an index of item type fields, text in a document (Word, PDF) or
text attachments.

2. Filter [146] — Refine your search results: filter by author, keyword, date, or coverage. To open the
filter panel, select Filter items at the top of the center panel in List View or Reading View.

3. Advanced filters [150] — Build complex search rules using item types, fields, and relationship data.

Save and share for repeated use.

Full text search

For its search function, Jama Connect uses an index of the database fields to find the items you are
looking for. It also searches in files — text, Word, and PDF files.

You can search for fields and attachments for terms and phrases. For more targeted searching, use
powerful syntax.

Ways you can search

Search option

Example: type this...

To return...

Single term — Enter a single word.

Test

Items that include the terms test,
pretest, tests, tested, and
tester.

Phrase — Surround a group of words in double
quotes.

‘primary test"

Only items that contain the words
primary test.

Single character wildcard — Enter a single char- te?t Items that contain test, tent, and
acter wildcard (?) with a single term (not a text.

phrase).

Multi-character wildcard — Enter a multi-charac- syn*ize items that contain the terms syn-

ter wildcard (*) with a single term (not a phrase).

chronize and synthesize.

Boolean operators — Boolean operators in ALL CAPS to combine phrases or terms.

OR (]]) is the default Boolean operator when you
enter two terms or phrases.

primary test ORsample

Items that contain either primary
testor sample.

AND returns items where both terms and phra-
ses exist.

primary test AND sample

Items that contain both "primary
test"and sample.

+ returns items that must contain the term or
phrase immediately following the +. For example,
+primary test returns items that must contain
primary and might contain test.

+primary test

Items that must contain primary
and might not contain test.

NOT (-) excludes items that contain the word or
phrase after NOT. The application doesn't allow
null searches, so you must enter something be-
fore the word NOT to get any results.

primary testNOT sample

Items that contain primary test
but not sample.

Parentheses — Group clauses and form sub-quer-
ies.

(tests OR samples) AND
maps

Items that contain tests and
maps OR samples and maps.

Field name — Use field names followed by a co-
lon to search for information in specific fields. If
a field name contains spaces, replace the space
with an underscore character (_).

user_status:new and tag:se-
curity

Items with a User status field that
contains new.
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Important considerations

The application doesn't support searches for null values, including checkboxes that haven't been
selected.

Files larger than 25 MB aren't indexed, so their content isn't searchable.

Searchable file types are: PDF, DOC, DOCX, PPT, PPTX, TXT, RTF.

Non-searchable file types are: XLSX, XLS, XML, HTML, HTM.

To avoid a syntax error when you search, don't begin a search with an open or close parenthesis
followed by text or by itself.

These special characters are automatically excluded (escaped) from full text search, so that they can be
searched for as plain text:

\ AL~/

If you used \ to manually exclude special characters, you can achieve the same results by using double
guotations. For example, if you previously searched using \*abc to treat the * character as text, you
can now use “*abc” instead.

Special character search only works with newly created items. To use with older items, re-index the
items you want to use in the search.

Search for content

When you need to search across all projects or within a current project, you can enter a simple query in
the search field. For more complex searches, use advanced filters [150].

Note
é’ You must have read permissions to items for them to appear in your search results.

To search for content:

1.

In the header next to the Search field, select where you want to search using the drop-down menu.

o Project — Within the current project.

o All — Across all projects where you have access.

Enter your query in the search field and press Enter.

A wildcard is automatically added to the end of your search term. For example, if you search for
enable the wildcard returns the results enablle, enablement, enabled, enabl ing, etc.
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3. (Optional) Select Include wildcard results to add a wildcard to the front of your search term. For
example, if you search for enable and select this option, results return openable, alienable,

tenableness, etc.

The results of your query appear in a list. To refine your search, select Filter items (see Filter items for
targeted results [146] for details).

Filter items for targeted results
An easy way to refine your search results is to use a filter. Filtering also allows keyword search.

You can also filter by "item type" if your results included multiple types, or "project” if results are across
multiple projects. Coverage might need a “where applicable” because it does not always appear.

See Advanced filters [150] to save or reuse a filter.

O Best Practice
- For best search results and quality performance, make your filters as specific as possible
to return only the results you need. If you run a filter against all your Jama Connect
projects, the results you get might be too broad to be helpful and performance can be
affected by such a large data set.

To filter items for targeted results:

1. In Projects > Project, select the project with the items you want to filter, then select the Filter icon
to open the Filter by panel.
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Define how you want to filter your results. Filters are cumulative and are displayed at the top of the
screen.

o Keyword — Enter a term in the Keyword field. For more information, see the "Ways you can
search" table in Full text search [144].

Include wildcard result — Further refine your keyword search with wildcards.

Item Type — Filter by specific item type. For example, System Requirement, Set, Folder, or more.
Author — The person who created or last modified the item.

Direct Coverage — Parameters for upstream, downstream, missing, and suspect relation-

ships [309].

Last Modified — Time stamp of when the item was last modified.
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The search results appear in List View.
3. Select the Filter items icon again to close the panel.
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All filters that were applied to the item are visible at the top of the page.
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Advanced filters

With the Advanced filters feature you can save a filter (a set of rules or conditions) for later use, as well
as share it with other users.

This feature lets you add advanced filters [151], edit advanced filters [151], bookmark them, filter the
Explorer Tree [156], and send items for review [163].

O Best Practice
- For best search results and quality performance, make your filters as specific as possible
to return only the results you need. If you run a filter against all your Jama Connect
projects, the results you get might be too broad to be helpful and performance can be
affected by such a large data set.

Rules and conditions

e Each rule is matched to a specific item type or to all item types that meet a specified condition.

¢ A condition describes specific attributes of an item such as fields, tags, relationships, location, key-
word, or if the item has children.

e Each rule can contain any number of conditions.

e Arule can be set to return items that follow any one of the conditions, all conditions, or none of the
conditions.

Finding advanced filters

¢ To display a list of existing filters, select Filters in the left panel next to the Explorer Tree tab.
¢ To find out the author of a filter, hover over the filter name.

Important

Only organization admins can delete filters that they didn't create. Before deleting a
filter, make sure the filter isn’t in use. When you delete a shared filter, it's deleted for
everyone.
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Create or edit an advanced filter
Filters allow you to customize the scope of a search so it's more granular and efficient. You can create a
filter or edit an existing saved filter.

O Best Practice
- For best search results and quality performance, make your filters as specific as possible
to return only the results you need. If you run a filter against all your Jama Connect
projects, the results you get might be too broad to be helpful and performance can be
affected by such a large data set.

Note

ﬁ Only organization admins can edit filters that they didn't create. Depending on your
permissions, you might not be able to edit filters that were created by other users.
To view a filter's details, select the filter name under the Filters tab and select View
criteria.

To create an advanced filter:

1. Select the Filters tab in the Explorer Tree, then select Add filter.

2. Inthe New filter window, enter a name for the filter and define the project scope:
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w

¢ This project only — Queries data from the project you are viewing at the time. The filter appears
only when using this project.

¢ Current project — Queries data from the project you are viewing at the time but the filter is also
available for other projects.

o All projects — Pulls data from every project in the organization where you have permissions to
view. Results include items from other projects that match the filter criteria.

(Optional) Select Make public to share the filter with anyone who has access to the project.

Define the Match option for a specific item type or All Iltem Types.

When you select a specific item type, you can filter by its fields. Searching for All Item Types limits

your criteria to Jama Connect core fields.

Define your filter with available conditions, which depend on the selected item type.

e Add rule creates a new rule. A filter can contain any number of rules.

e + adds a condition.

® - removes a condition.

¢ Add condition group (blue button) creates a condition group, which depends on the selected item
type.

¢ When you filter by relationships, Add embedded filter opens the Add embedded filter window,
where you can add a sub-filter and configure an embedded filter to limit the related items to a
specific item type.
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For example, you can create a filter to identify change requests with downstream relationships
and a configure an embedded filter to limit the related items to a specific item type.

a. Enter a name for the embedded filter.
b. From the Select a project drop-down menu, select All Projects or Current Project.
c. Inthe Create rules section, add the conditions for the new embedded filter.
d. Select Add embedded filter.
In the New filter window that opens, define the following.
¢ Limit to items updated within — Define a time frame when items were updated.
¢ Sort order for results by — Define how results are sorted on output.
Select Preview <number> results... in the bottom left corner of the New filter window. Results
appear in the same window.

Results example:
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8. (Optional) To see the filter items in List View, select View in List.
9. Select Save.

The new filter is now available in the list of bookmarked filters.

Copy and customize an advanced filter

You can duplicate an existing filter, then edit it for another search. This saves time and is especially useful
with complex criteria.
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O Best Practice

- For best search results and quality performance, make your filters as specific as possible
to return only the results you need. If you run a filter against all your Jama Connect
projects, the results you get might be too broad to be helpful and performance can be

affected by such a large data set.

To copy and customize an advanced filter:

1. Select the Filters tab in the Explorer Tree to view your saved filters and other users' filters that were
saved as "Make public."

2. Select the filter you want to copy and select Duplicate Filter.
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3. In the window that opens, enter a name for the copied filter and edit the filter settings [151] as
needed.

4. Select Save.

The new filter appears in the list on the Filters tab.

Filter the Explorer Tree

Typically, the Explorer Tree contains many items, which makes finding what you need difficult or time-
consuming. To quickly locate multiple items in the Explorer Tree, apply an existing filter.
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O Best Practice
- For best search results and quality performance, make your filters as specific as possible
to return only the results you need. If you run a filter against all your Jama Connect
projects, the results you get might be too broad to be helpful and performance can be
affected by such a large data set.

To filter the Explorer Tree:

1. Select the Filters tab in the Explorer Tree to view your saved filters and other users' filters saved as

"Make public."
2. Select the filter you want to use and select Apply filter to Explorer.

The filter results are displayed in the Explorer Tree. Items in the hierarchy that don't apply to your search
criteria are displayed in lighter text.

Export data from advanced filters
You can use advanced filters to export data directly to Word, Excel, or PDF.
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To export data from advanced filters:

1. Create the advanced filter [150] that gathers the items you want to export.
2. Select Export and choose the output type.

The newly created file opens in a new tab.
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Reviews in Jama Connect

Reviews play a key role in successful product development. They help ensure that a new project meets
stakeholder, market, and compliance requirements.

Jama Connect uses an iterative and collaborative approach for reviewing requirements and other arti-
facts in real-time, which improves stakeholder alignment, reduces review cycles, and eases the path to
compliance.

Your organization administrator configures review center settings [712] to meet the needs of your
organization.

Review features include a wizard that streamlines review setup and electronic signatures for coordinated
approval and signoff.

Roles for review workflow

Your role determines which tasks you perform in a review.

Moderator — Create, manage, finalize, and close a review. Only moderators can comment on a review
that has been Closed for feedback.

Approver — Provide feedback and approve or reject the item during the review.
Reviewer — Provide feedback.

Review Administrator — See and manage all reviews.

Role Responsibilities and actions

Moderator e Initiate a review.

o Add and manage review participants.
e Modify a review.

e Edit an item to incorporate feedback.
e Close and reopen a review.

e Publish a revised review.

e Finalize a review.

e Archive a review.

e Delete a review.

e Recover an archived review.

e Transition items based on item workflow.
e Remove items.

Vi . ibu .
Reviewer* Contribute feedback.
e Finish a review as a reviewer.

Approver e Contribute feedback.

e Approve or reject review items.

e Delegate approval.

e Finish the review as an approver.

o Add electronic signatures to a review.

Review administrator e View a list of all reviews.

o Perform administration tasks for all reviews, whether or not they were invited to participate.
e Archive and unarchive a review.

e Recover a deleted review.

e Configure review comments.

All e Find and view review items.

e Compare versions.

e Monitor progress.

e \ote on items.

e Subscribe to items on the page.
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* Moderators and approvers can also perform all reviewer actions.

Review lifecycle — Who does what during a review

Action Moderator Reviewer Approver Review Admin

Initiate a review [163] X

Invite participants [170]

Add and manage review participants [172]

X | X | X

Modify a review [172]

Delegate approval [190]

Participate as a reviewer [184]

Find and view review items [196]

Contribute feedback [185]

X | X X| X
X | X X| X
X | X | X| X
X

Finish the review as a reviewer [186]

X

Finish the review as an approver [188]

Electronically sign the review [189] X

Incorporate review feedback [173]

Close a review [176]

Mark a review as completed and update workflow status [183]

Compare versions [202]

Monitor progress [204]

Vote on items [209]

X | X | X| X| X|X| X
X | X | X| X
X X X X

Subscribe to items on the page [208]

View list of all reviews [161]

Perform administration tasks for all reviews [192]

x

Archive a review [179]

Recover an archived review [180] X

Recover a deleted review [193]

X X[ X[ X|X|X|X|X|X| X

Configure review comments [194]

Remove or recover items in a review [181] X

Workflow status for reviews

The review status field shows the current workflow stage (status) of a review. This field changes as a
result of other operations, like closing and archiving a review.

In Grid and Table View, you can quickly find a review status.

In some cases, the review status value in Grid View is different than in Table View. For example, In
Progress (Table View) vs X days left (Grid View).

Grid View Table View
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Status Definition Grid List
View View

In progress Default status when moderator initiates a review [163] . Status can be changed to No Yes
“In progress” when the moderator restores a deleted review or marks the review
status as "In progress [763]."

Completed Status displayed when a moderator selects Close for feedback or a deadline date Yes Yes
is met.

Review final- Status when a moderator marks a review as finalized. Yes No

ized

Archived Status when a moderator archives a review [179], or when a review administrator Yes Yes
recovers a deleted review or sets the status to "Archived."

Deleted Status when a moderator or review administrator deletes a review [179]. No Yes

Review Center dashboard views
Access reviews from the top navigation by selecting REVIEWS in the header.

From the header, you have two options:

My reviews

All reviews where you are assigned as a reviewer [184], approver [187], or moderator [162].

All reviews

Reviews that haven't yet been archived.

What you see in the dashboard

What is displayed in the dashboard depends on your role, whether you've been invited to a review, and
the options you select.
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Review administrators — See all reviews.

Users — See only public reviews until they are invited to a review (depends on how your organization
administrator and moderator have set public review permissions).

Filter by — Filter reviews by review status or by your role in the review.

Include/Hide archived reviews — See reviews that have been archived or remove them from your
results.

The indicator for a public review depends on your view:

Grid View Table View

v

Moderator tasks

Certain tasks can only be performed by a moderator. Moderators can also be reviewers or approvers, in
which case they can perform all tasks for those roles as well as moderator tasks.

e |nitiate a review [163]
e Add and manage participants [172]
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e Modify a review [172]

¢ Incorporate feedback for review items [173]

¢ Close an "in progress" review for feedback [176]
¢ Finalize a review [178]

e Publish a revised review [177]

e Archive a review [179]

e Delete a review [179]

e Recover an archived review [180]

e Remove or recover items in a review [181]

¢ Transition a Peer review to an Approval review [182]
o Close and finalize Approval review [183]

Create a review
You can create reviews for any item or group of items in a project. By default, you are the moderator for
any reviews you create.

Note

é’ The safeguards for sending items for review is a maximum of 5,000 items and 100
review participants. We recommend working with fewer items (~250) and participants
(-25) for best results.

Ways to create a review:

e From REVIEWS — Select Start a review.

¢ From Project > Explorer Tree — Select List View or Document View, select the items you want to
include in the review, then select Send for review.
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e From Project > Project toolbar — Select Explorer, Filters, Releases, Baselines, or Test Plans, right-click
on the item or collection of items you want to include in the review, then select Send for review.

Regardless of where you begin, the process is the same through an easy-to-follow wizard. Follow the
prompts in the wizard to define and initiate your review.
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Initiate review

o Definition 2 Settings 3 Participants 4 Invitation
@ Learn more

Deadline k

07/16/2024 [ 17:00 PDT -

Project
Semiconductor Project 2.0 Q
Items
Select items... Q

Include item attachments (Reviewers must have proper project permissions to view attachments. )

Next

Initiate review

o Definition 2 Settings 3 Participants 4 Invitation

Definition [165] — Name your review, set a deadline, and select items to be reviewed.
Settings [168] — Configure the settings for your review.

Participants [170] — Configure who you want to review your items.

Invitation [171] — Complete and send the invitation email.

Define your review — Definition page
When you initiate a review [163], the first page of the wizard is where you name the review, set a
deadline, and select items to be reviewed.
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To define your review:

1. Enter a name for this review.
2. Set a deadline for the review, or keep the default of one week from today.

Note

y Windows users — Make sure that Adjust for daylight saving time automatically
is enabled in the Windows "Date and time" settings, so that the time zone is
displayed correctly when you create a review.

3. Select the project that contains the items for this review.
4. Select items from one of the tabs (you can select from only one tab per review), then choose Select.
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¢ [tem selection tab — Select whole containers or expand containers to select individual items to
send for review.

o Releases or Filters tab — Select a release or filter to send for review.

(Optional) To add attachments for this review, select Include item attachments.

Iltems

Project: Semiconductor Project 2.0 Q

~ Include item attachments (Reviewers must have proper project permissions to view attachments.)

Include related items

When the review is created, you see attachments for the item in each section of the review (if they
exist). Select the attachment link to open the latest version of the attachment.

(Optional) To make existing upstream and downstream items visible in the review, select Include
related items.

The wizard displays each related upstream and downstream item type, along with the number of
related items.

a. Select Show filters to filter those relationships by type.

b. Select the related items you want to include in the review.
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7. Select Next.

The Settings page of the wizard is displayed.

Configure review settings — Settings page
When you initiate a review [163], the second page of the wizard is where you choose the settings for
your review.

This image shows the default settings. Additional settings are available only if they were configured by an
organization or project admin.
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You see the Review template option if it was enabled in the Review Center by an organization admin. For
more information, see Item workflow for Approval Reviews [714].

To configure review settings:

1.

Select settings for electronic signatures.

e Require electronic signatures from approvers — When selected, all approvers must sign the
review in order for it to be approved.

¢ Enable signature group for approvers — Your review signatures have a particular signer role. See
Electronic signatures [258].

Select settings for permissions.

¢ Allow for review comments to also appear in the single item view within a project — This option
only appears if was enabled by an admin in the Review Center settings.

e Make public — The review is visible beyond the invited participants. An organization admin
determines whether public reviews [712] are seen by anyone with access to reviews, or only by
those with permission to ALL items in a review.

e Let approvers add reviewers and approvers — Allow participants to add others to the review.

o Let approvers delegate their review to others — Allow the approver role to be delegated. If an

approver is assigned a signer role and they delegate their approver role, the signer role is also
delegated.
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3. Select settings for notifications.

¢ Notify moderators when participants complete review — Send notification emails [230] to the
review moderators when any reviewer or approver marks a review as complete or when a partici-
pant requests a new version.
¢ Notify participants when other participants complete review — Send notification emails [230] to
the participants when any reviewer or approver marks a review as complete.
4, Select optional settings.

¢ Enable time tracking — Track the amount of time each reviewer spends within the review. The
clock that tracks the time is visible to all participants in review statistics [204].

¢ Enable voting — When selected, participants can provide input on issues needing to be resolved.
You must also designate the number of votes per user and a label for what the vote means. Read
more about voting [209].
5. Select Next.

The Participants page of the wizard is displayed.

Choose reviewers — Participants page
When you initiate a review [163], the third page of the wizard is where you choose review participants.

Important considerations

e The safeguards for sending items for review is a maximum of 5,000 items and 100 review participants.
We recommend working with fewer items (~250) and participants (-25) for best results.

¢ Inviting anyone to a review gives them read access to the entire content of the review, even if they
don't have permission to the underlying items.

To choose reviewers:

1. Using the left column, choose participants for this review, whose names then appear in the right
panel.
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Important

An organization admin can disable this function or can restrict which domains are
allowed for outside review. [712]

¢ Jama Connect users — Use the tabs at the top of the column to select individual users or groups
from the project team or from outside the project team.

Use the Search field to search by name or email. If you select a group, you can add all users from
the group or individual users.

¢ Non-Jama Connect users — Select the Invite user by email tab to invite users from outside of
Jama Connect. They receive an email invitation with a link to the review. The link gives them a
floating review license (if available) and prompts them to set up an account, which can access only
the review you invited them to.

2. Select a review role (approver [187] or reviewer [184]) for each participant.
3. (Optional) If you enabled signer roles [168], assign that role to each approver.

Signer roles are based on groups. If you select a group name, select All users. The signer role for
those users defaults to the group name.

4. Select Next.

The Invitation page of the wizard is displayed.

Configure email notification — Invitation page

When you initiate a review [163], the final page of the wizard is where you review your previous
selections and complete the invitation by filling in the email subject line and message fields.

You see a draft of the email that's sent to participants. It includes the total number of participants who
receive the email and their roles, as well as the deadline and a link to the review.

To configure email notifications:
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2.

3.

Enter a subject line for your email invitation. Typically, the subject line is the name of this specific
review.

Enter a message for the email invitation. Typically, the message is a brief explanation of what you
expect from the participants.

Select Initiate review to send the email to all review participants.

You receive a confirmation that your email was sent.

Add and manage review participants
As a moderator, you can add or remove moderators from your review.

Important considerations

If you remove yourself from a review, you no longer have access to that review. All added and existing
moderators receive email notifications for changes to the list of moderators during the review.
Moderators can be added to a review regardless of their access rights to the items in the review.
However, when a new revision for the review is published, it includes only items that moderators have
write access to. This can have unexpected consequences for reviews sent from filters, such as missing
or extra items in the new revision.

The safeguards for sending items for review is a maximum of 5,000 items and 100 review participants.
We recommend working with fewer items (~250) and participants (-25) for best results.

To add and manage review participants:

1.

3.
4.
5.

In a review, select Add moderators or Add participants.

If you are viewing multiple reviews in the Table View, select Update moderators from the available
actions.

Add moderators or participants from your team (Project Team tab) or from outside your team/Jama
Connect (Outside Project Team tab).

To remove a moderator or participant, select the X next to the name.

(Optional) Add a comment about the changes you made.

To finish, select Update Moderators or Update participants.

The updated moderators or participants are saved.

Modifying an "In progress" review
You might want to change the content that's included in a review, the due date, or the participants. You
can also close a review so that feedback is no longer allowed.

Only a moderator [162] or a review administrator [192] can change a review.
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You can change a review from different locations and views in Jama Connect:
¢ |n a review, use the Manage review drop-down menu.
‘= Manage review -

Edit
Close for feedback

Mark review as finalized

¢ In Reviews > Table View, use the Actions column.

The icons in the Actions column are:

Edit — Open the wizard where you change the deadline, invite new reviewers, or change an approver’s
status (role).

Reopen — Open a review that was closed.

Delete — Remove a review permanently (only a review administrator can recover a deleted review).
Update moderators — Add to or remove moderators from your review.

Archive — Remove the review from the list that appears to users.

Modify a "Closed" review

A review closes automatically on the end date and time or it can be closed manually by the modera-
tor. When a review is closed, reviewers can no longer add comments.

Important considerations

¢ As the moderator, you can reopen a closed review to allow more feedback, archive the review, or
publish a new version.

e Only a moderator or a review admin can edit a review.

¢ When viewing a closed review, a blue status bar at the top of the review lets participants know
whether a review is closed.

To make changes to a closed review:

1. Inaclosed review, select Archive to remove a review from the primary list of reviews.
2. Select Recover to retrieve a review that was archived or deleted. Noitem updates are published.

Incorporate review feedback
A moderator can incorporate feedback by editing items directly from the review.

To incorporate feedback:
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1.

2.

3.

From the header, select REVIEWS, then open the review with the items you want to edit.

Edit the item using one of these methods:
o Select the triangle drop-down menu, then select Edit.

e Select the item name to open it, then select Edit item from the menu on the right.

In the window that opens, make the changes you need.
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4. (Optional) Select Notify to designate people or groups you want to inform about this change, then
choose the people to be informed.

Your changes are saved in the project, but not in the review.
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Any time an update is made to an item that's in review, a blue status bar appears at the top of the
review. The review remains unchanged until the moderator publishes a new version.

5. Select Commit.

To update change in the review select Publish new revision.

7. In the window that opens, select one:

o

e Publish — Update the review for all participants.
¢ Modify review — Make further changes to the review itself in the wizard.

Participants receive an email notifying them about the new revision.

Close an "In progress" review

A review closes automatically when its deadline is reached. A moderator might want to close a review
manually before the deadline if, for example, all reviewers already provided feedback.

Once a review is closed, a moderator can recover it by changing the status back to In progress.
To close an "In progress" review:

1. To close a review manually that you are currently viewing, select Manage review > Close for
feedback.

The closed review now displays the message “This review is closed” in the blue status bar.
2. Toreopen a closed review, select Recover.
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The blue status bar no longer appears when the review is reopened.

The review reflects your changes.

Publish a revised review

When changes are made to the original review items, you can publish a new version of the review that
includes the changes.

To published a revised review:

1. Open areview that includes changes. The text in highlighted in blue indicates the number of
pending updates.

2. Select Publish new revision to include these changes in the review.

3. In the Publish new revision window, select an option:
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e Publish — Publish the revision immediately (available only when a new version of an item is
created).

¢ Modify review — Change more options for the review in the wizard.

A confirmation message confirms that the revision was successfully published.

Finalize a review

When you're satisfied that your review is complete — that all items have been reviewed and approved
and that all comments have been resolved — the next step is to finalize the review.

Important considerations

¢ When you finalize the review, the review workflow tool automatically updates the status of the review
items. For example, at the end of a review, a moderator can trigger the status of reviewed items to
change from "In review" to "Approved.”

o |If workflow is assigned to an item type in your Approval review [714], the item will transition. If you
don't use a template, the review is marked as finalized.

¢ When you reopen a finalized review, items are transitioned to their previous review status.

To finalize a review:

1. Inthe review, select Manage review > Finalize approval review.
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2. In the window that opens, select Finalize review.

This action automatically triggers Review Status Workflow, which updates the status of the review.

Delete a review

You can delete a review, but not if it includes electronic signatures. However, if an entire project is
deleted, all reviews in that project are also deleted, even if they include electronic signatures.

Once a review is deleted, only a review admin can recover it.
To delete a review:

1. From the header in the review, select Delete review (trash icon).

© Add moderg Delete review

= Manage review ~ [Es» ~ m

2.  When prompted to confirm, select Yes.

Now, when a user selects REVIEWS, the review that you just deleted is no longer listed with other
reviews.

Archive a review

When a review is archived, it's no longer visible in the list that’s displayed when users select REVIEWS in
the header.

Reviews can only be archived by moderators and review administrator, and only if their status is
“Closed.”

As the moderator, you can control which reviews are visible to your participants:

¢ Select Filter by > Include archived reviews.
¢ Select Filter by > Hide archived reviews.

To archive a review:

1. From the header, select REVIEWS > Table.
2. In the Actions column of the review you want to archive, select the folder icon to archive the
review, then confirm when prompted.
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The selected review is now archived.

Recover an archived review
A moderator or review admin can recover a review that was archived [179].

Important considerations

¢ When an archived review is recovered, the participant roles and contributions are unchanged. For
example, if an approver signed and approved a review before it was archived or deleted, it remains the
same after the review is recovered.

¢ [f items were edited after a review was archived or deleted, they don't appear in the recovered review
until the moderator publishes a revised review.

® You can recover an archived review from the review’s Actions column or from its blue status bar.

To recover an archived review:

1. To recover an archived review from the Actions column:
a. From the header, select REVIEWS > Table.
b. In the row with the review you want to recover, select the Reopen icon from the Actions
column.

c. Inthe window that opens under Select review status, use the drop-down menu to select "In
progress," select a new end date and time, then select Save.
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2. Torecover an archived review from the review’s blue status bar:
a. Open areview that was archived.
b. From the header, select Recover.

The recovered review is once again listed in the table under REVIEWS.

Remove or recover items in a review

A moderator can remove or recover items in a review, and can perform either of these actions without
altering the source in the project.

Important considerations

¢ When you pair these actions with the Approval workflow, those items remain in their original state
and aren’t updated when the review is finalized.

To remove items from a review:

1. Inthe review with the item you want to remove, select the triangle drop-down menu, then select
Remove next to the item.
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The "Tagged for removal" label appears.
2. Select Publish new revision to remove the item from the review.

3. In the Publish new revision window, select Publish.
A label appears with the version the item was removed in.

+ M Removed in V1

Anyone who has access to the review can see items that were removed.

To recover items in a review:

1. From the triangle drop-down menu, select Recover to recover the item you removed.

The "Tagged for recovery" label appears.
2. Select Publish new revision to recover the item in the review.

The selected items are again available in the review.

Transition a Peer review to an Approval review

When reviewers are done looking over a Peer review, the moderator can transition a review to an
Approval review.

Important considerations

e Both templates must be enabled [714] by an organization administrator.

e When an item is tagged for removal or recovery, and you want to transition to an Approval review,
those items are automatically updated.

To transition a Peer review to an Approval review:
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1. Inthe review, select Manage review > Transition to Approval.

The Transition to approval review wizard opens.
2. On the Definition page, make your changes, then select Next.

3. On the Settings page, confirm you're using the approval template, then select Next.

4. On the Participants page, make your changes, then select Next.
5.  On the Invitation page, update the subject and message as needed, then select Transition review.

A revision is created and an email notification is sent to reviewers.

Close and finalize an Approval review
After the review is approved, the moderator closes and transitions items to their approved state.

Workflow must be enabled [56] in ADMIN > Organization for the items in the review, or the option to
Close and transition items won't appear when you finalize a review.

Example with workflow disabled:
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To close and finalize an Approval review:

1. In the review, select Manage review > Finalize approval review.
Wizard opens. You can change the name, deadline, and participants.
2. Review the overview and workflow transitions, then select Finalize review.

The review is now closed and finalized.

Reviewer tasks

The following tasks can be performed by reviewers.

e Contribute feedback [185]
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e Finish a review as a reviewer [186]
Reviewers can also perform tasks that are available to all review roles.
For example:

¢ Find and view review items [196]

e Compare versions [202]

¢ Vote on items [209]

e Subscribe to items on the page [208]

For details, see Tasks for all review roles [196].

Contribute feedback

Once a review is created, all participants can read through the items, make comments, and ask questions.
Important considerations

¢ By default, you see only comments made in a specific version. For example, comments made in version
2 only appear in that version.
e Once areview is closed, reviewers can no longer comment.

To contribute feedback:

1. From the review, open the Comment window using one of these methods:
¢ Select the Comments icon next to the item.
o Select the text you want to comment on.

2. Type your comment.
3. (Optional) Apply a category to your comment to help participants understand and track key feed-
back.
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Category Outline color Meaning

Comment / Speech bubble Yellow Open

Green Acknowledged by Moderator
Question mark Yellow Open

Green Answered by Moderator
Pencil / Proposed change Yellow Open

Green Accepted by Moderator

Red Rejected by Moderator
Exclamation / Issue Yellow Open

Green Resolved by Moderator

4. Select Submit feedback to save the comment.

Your comments are saved.

. u Tip
. Use the "like" icon when you agree with a comment and want to track how team
members vote on a decision.

Finish a review as a reviewer

When you complete your work as a reviewer, the next step is to “finish” the review. This action lets the
moderator and other participants know you're done with your work (if notifications were set up) and
updates the overall review progress in review statistics [205].

If the review is closed before you finish the review, the blue status bar includes a message: “This review
is closed.”

To finish a review as a reviewer:
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1. From the review, select Complete review on the toolbar.

2. In the review summary window, add any final comments, select Finish.

3. If you need to make more comments after finishing the review, select Reopen review from the
toolbar, as long as the moderator hasn’t yet closed the review.

Your work as a reviewer is complete.

Approver tasks

The following tasks can be performed by approvers.

e Approve or reject review items [187]
Finish a review as an approver [188]

Add electronic signature to a review [189]
Add reviewers [191]

Delegate approval [190]

FYI

o After delegating approval, you are no longer an approver, but you remain a reviewer for the current
review.

e When you delegate approval, all new approvers receive an email notification.
Approve or reject review items

During a review, you can view items and their comments, approve or reject individual items, and approve
or reject an entire review.

187



Reviews in Jama Connect

If you don't see a checkmark or X, you don't have Approver status. Contact your Moderator if you need
Approver status.

To approve or reject review items:

1. To mark an individual item, select an icon next to its name:
e Checkmark = Item is approved
e X = Item is rejected

2. To mark all items on the page, use the Batch item actions drop-down menu:
¢ Mark entire page approved
e Mark entire page rejected
3. If your review contains more than one page of items, repeat this action for each page.

When you're done, the blue status bar includes the message “You've marked all items in the review.” You
can then finish the review as an approver and electronically sign the review.

Finish a review as an approver
When you are through providing feedback for a review, you can finish the review as an approver.

To finish a review:

1. Select Complete review from the toolbar.

2. In the Review finished window, mark any remaining items "Approved" and add a final comment. If
this review requires an electronic signature [189], you can also add that here.
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3. Select Request new revision or Approve (or Approve and sign if you're using an electronic signa-
ture).

Your comments are visible under Reviews > Feedback in the top-right menu. If email notifications are
enabled, an email is sent to the moderator or other participants to let them know you're done with your

work.

Note

é’ If you need to reopen your review after finishing a it as an approver, select Reopen
review, as long as the moderator hasn't closed the review. Reopening a review revokes
your electronic signature [258].

Sign a review electronically
If a review requires an electronic signature, you are asked to add a signature when you finish a review as
an approver.

To electronically sign a review:
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In the Review finished window, enter your username and password as your electronic signature.
If your organization uses SAML, the SAML authentication window opens, where you enter your
username and password.

2. Select Approve and sign to complete the review.

If email notifications are enabled, an email is sent to the moderator or other participants to let them
know you’re done with your work.

Delegate approval
Assign approval to another team member if you're away when a review needs to be approved or
someone else is a better fit.

To delegate approval:

1. Inthe review, select Delegate approval from the toolbar.
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2. Inthe Request reviewer delegation window, select a delegate.

3. Select Delegate approval.
A confirmation message appears.

4. Select Yes to confirm.

An email is sent to the new approver notifying them of the request.

Add reviewers
Approvers can add reviewers to an open review at any time.

To add reviewers:

1. In the review, select Add participants.
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2. Inthe window, select the review participants you want to add.

3. Select Add participants.

An email is sent to the reviewers notifying them of the request.

Review administrator tasks
The following tasks can be performed by review admins.

Recover a deleted review [193]

Configure review comments to appear in projects [194]
e Recover an archived review [180]

Modify a review [172]

Make a review public [168]

FYI

e Permissions for a review admin must be assigned by an organization admin.
¢ As a review admin, you can access a review's content when:

e The review is public

e You are also a reviewer, approver, or moderator in the review

e You add yourself to the review

192



Reviews in Jama Connect

Recover a deleted review
Only a review administrator can recover a review that was deleted.

When a deleted review is recovered, the participant roles and contributions are unchanged. For example,
if an approver signed and approved a review before it was deleted, it remains the same after the review
is recovered.

If items were edited after a review was deleted, they don't appear in the recovered review until the
moderator publishes a revised review.

To recover a deleted review:

1. From the header, select REVIEWS > Table.
2.  From the FILTER BY... drop-down menu, select Deleted.

3. In the row with the review you want to recover, select the Recover icon in the Actions column.

4. In the Recover review window, select the new end date for the review.
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5. Select Save.

The table is refreshed and the review is now open.

Configure review comments to appear in projects
Comments made during reviews can provide valuable context, whether you're reviewing a requirement,

lower-level feature, or test item. A record of those comments offers enhanced traceability, so you can
make informed decisions over the course of the item's lifecycle.
The review moderator can allow comments from a review to appear in the project view for that item.

When enabled, the Review comments widget appears in Single Item View. Select it to see the review
comments for that item.

This option needs to be enabled in two places for it to take effect. The organization admin must enable it
in the Review Center Settings and the moderator must enable it when creating a review.

For the administrator:

1. Select ADMIN > Organization > Review center.

2. Under Permission settings, select Allow for review comments to also appear..., then select Save
settings.
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This option is now available and visible to review moderators when they create reviews.
For the review moderator:

e  When creating a review, select Allow for review comments to also appear in the single item view
within a project.

Once enabled, comments are grouped by review and sorted with the latest comments at the top.
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FYI

e Why aren't comments appearing? For review comments to be visible within a project, this setting must
be enabled for each review.

e How do | see comments from older reviews? For reviews created without this setting, you can go back
and change this setting to include review comments.

¢ View More — Appears if there are more comments from that review that haven't loaded.

¢ Load More — Provides comments from older reviews that haven't loaded, including comments that
might have occurred since the page loaded.

Tasks for all participant roles

¢ Find and filter items in a review [196]
e Highlighting review comments [198]
e Compare versions [202]

e Show related items in a review [202]
¢ View participant progress [204]

e View item progress [205]

e View review activity [206]

e Filter review comments [207]

e Subscribe to a review [208]

e Export reviews [208]

e Voting [209]

Filter items in a review
Use filtering to view items and comments that need your attention.

You can navigate to different areas of the review workspace without losing your filter or search selection.
For example, if you make a filter selection and go to another view, your filter selection is saved when you
navigate back to the review.

All user roles can search for and filter specific items in a review.
All review participants can filter review items:

¢ To find comments by status, version, author, or activity.
¢ By Activity, Comments by status, Comments by version, and Comments by author.

Selecting and applying filters in a specific category is additive and applies ADD statements to each
selection. If you apply filters that span multiple filter categories, it becomes an OR statement.

To filter review items:

1. Enter text in the Search field, then expand the Search by item types drop-down menu to filter your
search.
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2. Select the item type, then enter text in the Search field.

3. From the search results or table of contents, select an item, which is then outlined in blue. In the
Find items panel, refine your search as needed, based on the filtered results.
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4. To open the Find item panel and view the item in the review hierarchy, use the drop-down menu in
the left panel of the review to select View in tree.

You can resize the panel as needed.

The item is highlighted in blue in the project tree.

Highlighting review comments
You can organize and find comments based on their status: Open, Resolved, or Rejected. Comments of
each status type are highlighted by a different color (highlighting is turned on by default).

For example, a comment highlighted in yellow lets review participants know that it's open, while a
comment highlighted in red indicates that a proposed change was rejected.

By default, the review version that you're looking at shows only highlighted comments that are open,
resolved, or rejected.

When two highlighted comments overlap, that text is highlighted in light blue.
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You can only reject comments that propose a change.

Moderators resolve an open comment: select it, type a response, select Reply > Resolve.
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The comment box and highlighted text changes to a resolved status (green).

Apply @mention to review comments

Use the @mention feature to direct comments to a subject matter expert. This is useful when you have
several reviewers and need to direct a question to a specific reviewer.

Important considerations

e Comments that include @mention are highlighted by color, based on whether you or another review is
tagged. Light yellow = comment for you. Light blue = comment for another reviewer.

e Only users participating in the review appear in the list of possible reviewers who can be tagged with
@mention. You can modify the review [172] to add participants.

¢ Anyone who is participating in the review can @mention other participants.
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To use the @mention feature:

1. Inareview, select the comment icon and type @ followed by the name of the reviewer.
Repeat for each reviewer you want to mention.
Only the names of the people you included when you created the review [163] appear in the list.

2. Type your message, then select Comment.

3. (Optional) To display only items where you are mentioned, select Filter items > My mentions.

An email notifies the tagged review participant with the review name, items, and comment.
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Compare versions
Whenever a published review has more than one version, you can compare two versions.

Important considerations

¢ If you want to make other fields visible in the review, an organization administrator can configure item
type views [697] in Single Item View to show those fields.

¢ Typically, item fields contain fewer than 10,000 characters (2,000 words). When you compare review
versions, the applications might skip fields with lengthy content.

¢ The date and version a comment was added appears in the comment.

To compare versions:

1.  From the review with the versions you want to compare, select Compare.

2. Select the versions drop-down menu near the review title to select the version you want to compare
to the current review.

Changes are displayed inline. Deleted text is red and highlighted. Added text is green and underlined.

The "compare view" displays inline changes for most field types. If the field can't be compared, you see
the message: Not available for reviews.

Show related items in a review

Include related items in a review to give reviewers context and help them understand the coverage of
items in a review.

Related items are visible only if the moderator selected the option Include related items when the
review was created.
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If you don't have permissions to view a related item, you see an item type icon and the text This item is
outside the scope of this review.

To view items directly related to a review item:

1. In the review, select Show related items.

Initially, up to five upstream and downstream items are displayed.
2. To view additional related items, select Load More Downstream Items.
3. Select a related item to see more details.
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The details provide context for the items in the review.

View participant progress

As a review progresses, you can view statistics about the participants' progress. This information is
unique to the current version of the review.

In separate tabs, you can see item progress [205] for this version, or review activity [206] across
versions.

To view participant progress:

1. From the review with statistics you want to view, select Stats.

2. Select the Participant progress tab to see a panel with participant details and links to email partici-
pants.
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A bar charts show overall review progress for approvers and reviewers who have finished the review. For
approvers the chart shows how many items they approved or rejected. For other reviewers it shows how
many items are marked as read and reviewers' time spent.

Each participant is listed with their review role, signer role, signature information, comment count, time
spent (hours:minutes), and a progress bar showing their completion level.

6” Note

Time is logged if a tab with the review is left open by a reviewer.

View item progress

As a review progresses, you can view statistics about the progress of the items in review. This informa-
tion is unique to the current version of the review.

In separate tabs, you can see participant progress [204] for this version and review activity [206] across
versions.

To view item progress:

1. From the review with the items you want to view, select Stats.

2. Select the Item progress tab to see an overview with the total number of items in the review, their
item types, the start and end dates for this version of the review, the current approval status for all
items (if this review uses approvers), and a summary of open comments in the review.
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A table shows item fields, the number of votes, and the number of participants who marked the item as
approved, rejected, or reviewed.

If you're a moderator, you see the preset filters to filter the list by item type, folder, or set. You can
use Views to configure which fields are visible in the table. You can use Actions to batch update items.

For reviews with multiple approvers, the item approval status count increases when all approvers ap-
prove the item. However, it only takes one approver to reject an item for the rejected count to increase.
Items that aren't marked as approved or rejected are considered not reviewed.

View review activity

You can see all activities for a review across versions, including when reviews were opened, closed, when
new versions were published, or when signatures were added. This can be useful for collecting electronic
signature [258] information for FDA 21 CFR Part 11 compliance.

You can also see item progress [205] and participant progress [204] for each version of the review.
To see review activity:

1.  From the review with activities you want to view, select Stats.

2. Inthe page that opens, select the Review activity tab.
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The table shows activity for all versions since the review was created.

Filter review comments

You can view and filter comments for all the items in a review to find only the comments you want to
see.

To filter review comments:

1.  From the review, select Feedback to see all the comments for the review, with a filter panel on the
left.

2. (Optional) As needed, use the filters in the filter panel to search for comments by category or
keyword. Available categories are:

All Every comment from the review.
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Open Comments the moderator hasn't acknowledged or responded to
Mine Your comments

Review Comments sent to participants about the review by email
Important Comments flagged as important by a moderator

Questions Comments that are questions to be answered

Proposed changes Comments that suggest changes

Issues Comments that raise issues

With the comments filtered as needed, you can read and reply to comments.

Subscribe to a review

If you're a review participant, you can stay up-to-date on review comments with email notifications in
reviews where you're a participant.

To receive notifications, you must first configure your review subscriptions [28] in your profile. You can
also configure your profile to automatically follow an item when you comment on it.

To subscribe to a particular review:

1. Open the review with the items you want to subscribe to.
2. Select Subscribe > Subscribe to the items on this page.

Important

Some reviews contain multiple pages of items. To subscribe to all items in a large
review, you must subscribe to items on multiple pages.

You will now receive notifications for this review.

Export reviews
You can export reviews as a Word document or a PDF by selecting Export anywhere in Reviews.

You have two export options:

e Export activity review — Includes all review activities [206] across versions (for example, when the
review was created, versioned, closed, marked as finalized) along with the date, name, and role of the
person responsible.

¢ Export version review — Includes an overview of the review, a list of participants with their review
role, signer role, signature meaning and status, as well as the content of the review and the comments.

To download an export to your desktop:

1. Inthe review you want to export, select Export in the top right toolbar.
2. Select the type of export and format.
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3. Inthe window that opens, choose how you'd like to open the file, then select OK.

The file opens in a new tab.

Voting

With voting, your team can prioritize items or rank them based on a topic proposed by the moderator.
Each participant has a certain number of votes. Participants can give multiple votes to a single item.

Moderators can enable voting in the settings [168] when they initiate a review.

You can apply votes as a participant using one of these methods:

e Select the up arrow to add a vote or the down arrow to subtract votes. The box on the left displays the
number of votes you used on that item. You also see how many votes you have left to use.
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e Participants can also apply votes while viewing an item's detail.
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Categories

In Jama Connect, the Categories feature allows you to organize and view cross-project items based on
classifications. Examples of classifications include configurations, allocations, releases, and features.

Use the Categories feature to manage product variants in Jama Connect. For example, you might have
a product that differs from other versions of the same product in size, color, material, or style. Or, you
might have variants based on customers, market, or product features. Once you define the product
variants, you can create the categories and apply them to items.

You can assign cross-project items like requirements, test cases, and use cases to customer-defined
groupings. According to your project needs, you can assign a single category or multiple categories.

The Categories feature is disabled by default. The organization admin must enable it before the option
appears in the Jama Connect Ul. Once the feature is enabled, users with read/write permissions can
make edits. For more information, see Enable categories [217].

Note
y If you prefer to hide the Categories tab for a project, go to the Page layout settings
(gear icon > Change layout).

Your role determines your interactions when you use the Categories feature.

Role Responsibilities and actions
User with read e View categorized items in the Category tree.
permissions e See a list of cross-project items.

e View Category Path.
e View Category Path ID.

User with read/ e Organize your requirements across projects.
write permis- e Apply a category to items from Single Item View, List View, or Reading View.
sions o View categorized items in the Category tree.

e See a list of cross-project items.
e View Category Path.
o View Category Path ID.

Organization e Control and manage the Category admin tree: add, move, copy, and merge categories; edit and delete
admin categories.

e See category details like description and when the category was created.

e View Category Path.

e View Category Path ID.

e View Category ID.

o Clean up categories.

Changes to the Categories admin tree affect any allocated items in your projects.

Managing categories in projects (users)
The Categories Ul consists of multiple sections and its appearance depends on whether you are in List
View or Single Item View.
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1. Categories tab in the Explorer Tree — Select it to open the Categories Ul.

2. Category tree — Select a category to view specific details about a category like the Category Path.
You can also expand the tree to see how your organization admin organized the hierarchy for the
categories they created.

3. Category Path and list of variations column — Displays the category variation paths and Category
Path IDs.

4. Applied column — Displays the version history, which allows you to see the version of the item
when the category was applied. When you view an older version, you can see which categories
were applied or unapplied.

5. Manage categories button — Select it to open the Manage categories window where you can apply
and unapply categories.

Apply or unapply categories (user)
When the Categories feature is enabled by the organization admin, you can apply categories to items or
unapply them as needed.

Important considerations

¢ You must have read/write permissions to use the Categories feature.

e You can select a maximum of 4,999 items at a time. Here are the guardrails:
e Minor: 500
e Major: 2,000
e Critical: 4,000
e Maximum: 5,000

e Organization admins can allow users to manage categories on system-locked and user-locked items.
When enabled, users with read/write access can manage categories on locked items. For more infor-
mation, see Enable category management for locked items [217].

¢ Managing access has an impact on cross-project use of categories. When a user is working with a
cross-project list in Reading View and they select Manage categories, the displayed categories are
limited to Global categories and categories that intersect with the selected projects.

¢ When you view an older version, you can see which categories were applied or unapplied.

o Categories Tree View is identical to the Categories tree, so you can view category hierarchy at a glance
and select categories more quickly.
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To apply and unapply categories:

1. Select the items where you want to apply or unapply categories.
2. Open the Manage Categories page depending on your view.
o List View or Document View — Select the Manage categories button from the header.

¢ Single Item View — Select the Manage categories button from the Category Path table.
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On the Manage Categories page that opens:

e Unapplied column lists available categories to apply to selected items.

o Applied column lists categories already applied to the selected items.

To apply a category, use one of these methods:

o |n Categories Tree View, from the Unapplied column, select the categories you want to apply and

use the arrows to move them to the Applied column. A green checkmark indicates that a tag was
applied.
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e |n Categories List View, from the Unapplied column, select the categories you want to apply and
use the arrows to move them to the Applied column.

The selected categories are highlighted in yellow until you save your changes.

The bottom of the page lists the number of categories that will be applied and the number of items
that will be impacted.

To unapply a category:

¢ In Categories Tree View, select it in the Applied column and use the arrows to move them to the
Unapplied column. When unapplied, the green checkmark is removed.

e |n Categories List View, select it in the Applied column and use the arrows to move them to the
Unapplied column.

The selected categories are highlighted in yellow until you save your changes.
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5. Select Save to apply your changes.

The category selections you made are now in effect.

Controlling the Categories feature (organization admin)

The Categories feature allows users to organize and view items in a cross-project hierarchy. It allows
users to see how items and components can build a final product.

The Categories feature is disabled by default. As the organization admin, you must enable it for the
option to appear in Jama Connect and be available to users.

When this feature is enabled, organization admins can interact with:

1. Categories tree
e Create a hierarchy that is specific to your company's workflow.
e Add, move, copy, and merge categories.
2. Selected category path option
¢ View category details like description and when it was created.
e Remove category.
3. Variations of selected category option
e Edit and delete a category.
¢ View category paths, associated variation path, and category IDs.

Example Category ID: CAT-123

Category ID encompasses all variations of a category

Example variation path ID: PATH-123

Variation path ID is specific to each path

4. Clean up categories option

This option is rarely needed. Under extreme circumstances of large scale concurrent actions, the

data available to the Ul might need to be refreshed.

Use this option in the following scenarios:

¢ Incorrect category item display — If items are missing from the Category List View but are visible
in Single Item View.

¢ Inaccurate category counts — If the counts of applied or unapplied categories are incorrect or
don’t match your expectations.

¢ Inaccurate categories column — If the Version Applied column in the historical categories view
shows “null” instead of a number.
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When enabled, users with read/write permissions can interact with:

1. Categories tab in the Explorer Tree
2. Categories table in Single Item View
3. Manage categories button in Single Item View and List View

Enable the Categories feature (organization admin)

As an organization admin, you must enable the Categories feature before users with read/write permis-
sions can apply categories to items. By default, this feature is disabled.

To enable Categories:

1. From the Jama Connect header, select ADMIN > Categories.

2. Next to Enable categories, select On.

The Categories option is now visible in Jama Connect and available to users.

Enable category management for locked items (organization admins)

As an organization admin, you must enable the category management feature before users can manage
categories on system-locked and user-locked items.

Important considerations

e This option is disabled by default.
¢ When enabled, users with read/write permissions can manage categories on locked items.
¢ When you enable or disable this option, a message appears in the Admin Activity stream.

To enable category management for locked items:

1.  From the Jama Connect header, select ADMIN > Organization > Categories.
2. Select Allow category management for locked items.
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The ability to manage locked items is now available to users.

Add a new category (organization admin)
Create a hierarchy or a list of categories that users can then apply to organize project requirements.

O Organization Admins Only

You need organization admin permissions for this task.

To add a new category:

1. From the Jama Connect header, select ADMIN > Organization > Categories.
2. Inthe Categories tree, select Add.

3. Inthe Add category window, enter a name for the new category, then select Add.
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Your new category appears in alphabetical order in the tree and is immediately visible in all Jama
Connect projects.

Edit category properties (organization admin)
You can change the name of an existing category and add an optional description.

When you edit a variation of a category, all variations are changed.
To edit category properties:

1. From the Jama Connect header, select ADMIN > Organization > Categories.
2. Inthe Category tree, select the category that you want to edit.
3. Select Variations of selected category, then select the pencil button.

4. In the Edit category window, enter a new name or description, then select Save.

The change appears in the Category tree and is immediately visible in all Jama Connect projects.
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Remove a category variation (organization admin)

If you want to disassociate requirements related to a category or update the hierarchy, you can remove a
category variation.

Removing a category variation removes only that single variation. For example, if you have two variations
of a category called “Transmission,” you can remove the variation that is no longer needed, and the other
variation remains unchanged. To remove all variations of a category, see Delete a category [220].

Important considerations

e Categories that no longer belong to a variation are deleted.

Nested categories are removed.

Nested categories that are orphaned are deleted.

Organization admins must delete a category [220] with only one variation. When you delete the only
variation of a category, the Category ID is deleted along with the remaining Category Path ID.

All items, including locked items, are updated to reflect the category changes made by the organization
admin.

To remove a category variation:

1. From the Jama Connect header, select ADMIN > Organization > Categories.
2.  From the Category tree, select the variation you want to remove.
3. Select Selected category path, then select the minus icon.

4. When prompted to confirm, select Yes.

The selected category is removed. Nested categories are removed and descendant categories that are
orphaned are deleted. All items associated with these categories are updated.

Delete a category (organization admin)
When you delete a category, all variations of that category are also deleted.

For example, if you have two variations of a category called "Transmission" and you delete either
variation, both variations are deleted from the Category tree along with the associated Category ID.

To remove only one variation of a category, see Remove a category variation [220].
Important considerations

¢ Deleting a category affects all variations of a category and can have a widespread impact on your cate-
gory hierarchy.

Nested categories are deleted.

Nested categories that are orphaned are deleted.

Categories that no longer belong to any other variation are deleted.

All items, including locked items, are updated to reflect the category changes made by the organization
admin.

To delete a category:
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1. From the Jama Connect header, select ADMIN > Organization > Categories.
2. Inthe Category tree, select the variation that you want to delete.
3. Select Variations of selected category, then select the trash icon (Delete category variations).

4. When prompted to confirm, select Yes.

The selected category and all variations are deleted. Nested categories are removed and descendant
categories that are orphaned are deleted. All items associated with these categories are updated.

Organize the Category tree (organization admin)

You can organize the Category tree to reflect how your items are structured. After completing a move,
copy, or merge, items with those applied categories are updated to reflect the new hierarchy.

Important considerations

e When you drag a category to an existing category, it is nested under the category you selected. A new
variation is created. Items with those categories are updated to reflect the new hierarchy.

e Copying a category duplicates it and its nested categories to the area you selected in the Category
tree. New variations and Category Path IDs are created. Iltems with those categories are updated to
reflect the new hierarchy.

¢ Merging two categories, from the move or copy actions, duplicates the selected categories and its
nested categories to the area you selected in the Category tree. New variations and Category path IDs
are created. Items with those categories are updated to reflect the new hierarchy.

To organize the Category tree:

1. From the Jama Connect header, select ADMIN > Organization > Categories.
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2. From the Category tree, select the category you want to update, then do one of the following:

¢ Move — Drag and drop the category to a new location in the Category tree, then select Move
category.
If a duplicate category exists in the location you selected, you have the option to merge them.

e Copy — Drag and drop the category to the new location in the Category admin tree, then select
Copy category.
If a duplicate category exists in the location you selected, you have the option to merge them.

¢ Merge — Select Yes, then select Move and merge category or Copy and merge category.
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3. Select Save.

All items associated with these categories are updated.

Managing category access to projects (organization admin)
You can configure a category'’s visibility to hide or show one, many, or all projects.

Important considerations

e When an item is deleted and restored, associated categories are not restored.
e If a project is archived and restored later, associated categories are not restored.

Category access types

Unassigned access: Not visible in projects.

Project access: Visible in one or more projects.

Global access: Visible in all organization projects.

As projects are added to the organization, visibility is applied automatically.

Unassigned categories — Unassigned categories are not visible in any of the organization's projects. This
includes project views, List View, Reading View, Single Iltem View, tree views, and the Manage categories
window. When new categories are added, users don't have access by default, so that the organization
admin can configure new categories without disrupting existing work or revealing categories to the
entire organization.

Project access — Project access categories can only be seen and used in specific projects set by the
organization admin. The organization admin manages access and makes any necessary changes.

Global access — Global access gives all projects the visibility to a category. Select Global access to enable
or disable this option at any time. When enabled, all active organization projects can see that category.
The Manage access option is disabled because all projects are set to Visible.

Note

é’ If the user disables Global access, the category is converted to a Project access catego-
ry and the visible projects are still accessible. The user can choose to manage access
and make any necessary changes.
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Add Categories field to items in review (organization admin)

For the Categories field to appear in Review Center Reading View and Review Center Single Item View,
the organization admin must add it to an existing item type.

To add Categories field to a review item:

1. Select ADMIN > Organization, then select Item types.

2. Inthe Item types section, select Views in the Action column for the item type you want.

3. Inthe View window that opens, select Review Center Single Item View from the drop-down menu.
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Projects List View - Companents

I Projects List Wiew| Iv

Projects List View
Drag and drop to hide/show and re-order fields  Projects List View with Mixed Iltem Types

 Projects Document View

Hidden fields | ) ;
Heading D Review Center Single ltemn View

APILID |ty REview Center Reading View
Last Locked By Locked

Last Locked MName

Created By Categories

Created Date
Modified By
Modified Date
Project
Description
Global 1D

) &)

Steps

Connected Users
# of Comments
Relationship Status

Save Close

4. Drag Categories from the Hidden fields column to the Visible fields column, then select Save.
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Review Center Single tem View - Block Requirements

| Review Center Single ltem View |v

Drag and drop to hide/show and re-order fields

Hidden fields Visible fields

Steps Mame
Created Date Description
Date Categories
Modified By

Modified Date

Project

Last Activity Date

# of Upstream Relationghips

®[E)

# of Downstream Relationships
Tags

Current version

‘ersion

Item Path

# of Links

# of Attachments

Save Close

5. From the drop-down menu, select Review Center Reading View.
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Projects List View - Components

I Projects List Wiew| Iv

Projects List View
Drag and drop to hide/show and re-order fields  Projects List View with Mixed ltem Types

. )  Projects Document View
Hidden fields Vis

Heading D Review Center Single ltemn View

APIID itef Review Center Reading View

Last Locked By Locked
Last Locked Mame

Created By Categories
Created Date

Modified By
Muodified Date
Project

Description

Glebal 1D

Steps

Connected Users
# of Comments
Relationship Status

[ &

Save Close

6. Drag Categories from the Hidden fields column to the Visible fields column, then select Save.
7. Select Close.

The Categories table now appears when users are in a review.
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Configure access to projects (organization admin)

Access to a project can only be managed on one non-global category at a time. Organization admins can
hide or display any projects that are active in the organization.

Important considerations

® You can only edit access to projects on top-level parent categories. All child categories inherit the
top-level (parent) access to projects. This action also affects all move, copy, and merge actions.

¢ Organization admins can't edit category access when categories are applied to items in the project
they are trying to remove. Applied categories must be unapplied from all items in the selected projects
before category access can be hidden. This action also affects all move, copy, and merge actions.

To configure access to projects:

1. From the Jama Connect header, select ADMIN > Organization > Categories.
2. Inthe Categories tree, select the Project category you want to update, then select Manage access.

The Manage access page opens.

3. From the Hidden projects column, select the projects you want to be visible and use the arrows to
move them to the Visible projects column.
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The selected categories are highlighted in yellow until you save your changes.
The bottom of the page lists the number of projects that will be hidden or visible and the number of
categories that will be impacted.

4. From the Visible projects column, select the projects you want to hide and use the arrows to move
them to the Hidden projects column.
The selected categories are highlighted in yellow until you save your changes.
The bottom of the page lists the number of projects that will be hidden or visible and the number of
categories that will be impacted.

5. Select Save to apply your changes.

The project list reflects your changes.
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Collaborating with your team

For companies to turn today’s research into tomorrow’s products, teams must stay connected and
synchronized. Jama Connect equips teams to track decisions and ensure quality of the product they set

out to build.

Jama Connect links globally distributed team members and facilitates collaboration in the product de-
velopment lifecycle. It allows you to provide and capture feedback, decision making, and approval for
requirements and all product aspects under review.

Jama Connect enables efficient sharing of data, documents, files, information, and knowledge within and
across teams in your organization.

Use these features to work with your team, document conversations, and track decisions.

e Reviews [159] — A method to help teams, stakeholders, and customers discuss, evaluate, revise, and
approve items in the development process. For details, see Reviews in Jama Connect [159].
e Workflows [232] — An automated set of transitions, from one status to another, over the course of an

item's lifespan.

¢ Notifications [230] — Optional emails sent to groups or individuals to alert you when changes to items

are made.

e Stream [237] — A collection of the most recent comments and activities in the project.
o Electronic signatures [258] — A method for getting approval on electronic documents or forms.

Email notifications and subscriptions
Users can configure email and notification settings in their profile [27] to stay up to date with activity in

their projects.

Important

To receive notifications in Jama Connect, your SMTP must be enabled by your system

admin.

You can sign up for notifications to be sent to you automatically from several places in Jama Connect.

Notifications from...

Are sent to you...

Review [163]

When you're invited to participate

When someone replies to your comments in a review

Workflow [736]

When status of an item changes

Stream [248]

When you're mentioned in the stream

System Health Report [627]

With updates on license usage

Your Jama Connect admins control what you can do with subscriptions. For example:

¢ Organization admin — Allows users to subscribe others and to mute subscriptions.
¢ Project organization admin — Unsubscribes groups or individuals from any of their subscriptions.

As a user, you can:
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e Set up notifications for a single item in a project or for an entire project.
e Configure email notifications and subscriptions.

Subscribe to email notifications for yourself
You can subscribe to a single item, to multiple items, or to an entire project.

To subscribe to email notifications:

1. To subscribe to a single item, choose the item in Single Item View, then select Subscribe.

2. To subscribe to multiple items:
a. Open the items in Project > List View.
b. Choose the items you want to subscribe to, then select Subscribe.

A confirmation message appears below the toolbar.

Subscribe other users to email notifications
You can subscribe other users to a single item or to multiple items.

Only a system, organization, or project admin can subscribe others to all items at a project level.
To subscribe others to email notifications:

1. To subscribe others to a single item, choose the item in Single Item View, then select Subscribe >
Subscribe others.
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2. To subscribe others to multiple items:
a. Open the items in PROJECTS > List View.

b. Choose the items that you want others to subscribe to, then select Subscribe > Subscribe
others.

c. Inthe window that opens, choose the groups or users that you want to subscribe to the
selected items.

d. Select OK.

The users you chose will now receive email notifications for the selected items.

Workflow

A workflow is a set of transitions from one status to another, over the course of an item's lifespan.
All workflows must be set up by an organization or process admin before they can be used.
Workflow can be used in these scenarios:

e Project items [232] — Creates a common pathway for items to follow.

e Review items [714] — Allows organizations to configure items to transition to a specific workflow state
following the review process.

Using workflow in Projects

You can set up a workflow for Project items, so that users in your organization can move your project
items along a similar path as they progress.

Workflow in Projects allows you to:

e Update status for an item or group of items. ltems must be the same type and in the same workflow
state.

¢ Transition items from one status to the next, either for a single item or as a batch transition for a group
of items.
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If workflow is configured by an organization [736] or process admin, use the drop-down menu in Single
Item View to move the status of an item along the workflow and activate any related actions or

notifications.

Use workflow to batch transition items
With batch transitions, you can select multiple items of the same item type and transition them to a

different workflow status.

Important
All items that you transition must be in the same state. For example, you might batch

transition all "In Progress" items to a "Complete" status, but you can't select both "In
Progress" and "Proposed" items for batch transition.

To use workflow to batch transition items:

1. Select the project, folder, or set that contains the items you want to transition and view them in List

View.
2. Choose the items you want to transition, then select Actions > Batch transition.

3. Inthe window that opens, confirm your item selection, choose the status, add a comment, then
select Commit.
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Batch transition workflow

(@) Selected System Requirements (2)

Transition Items from Draft. .. Under Review v

Transition Comment:

Please review these requirements by end of week.

Your comment appears in the version history of the item and as an activity in the stream.
A batch transition is the only way to add a version or notification comment.

Baselines /

From | To | Version Ravisws Change detalls User comment and transitions | Created By
VERSION COMMENT:

I I “Status® changed from "Draft” i ; 03/28/2022 Sample

~ 2 to "Under Review" bp;g:ig L?:L?:;_hggg requinamanis 08:05:18 am User

The status change is shown for each item you transitioned.
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Use workflow to batch transition items in reviews

With batch transitions, you can select multiple items of the same item type and transition them to a
different workflow status.

Important
The items you select for transition must be the same item type and workflow state.

To use workflow to batch transition items in reviews:

1. When you're in a review, select Stats > Item progress.

2. Scroll to the bottom of the page and choose multiple items of the same item type and workflow
state using the Shift or Ctrl keys, then select Actions > Batch transition workflow.
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Note
J You can also batch update non-workflow fields, but you can't batch delete from
here.

3. Inthe window that opens, choose the set of items you want to update and the intended workflow

transition, then select Commit.

Batch transition workflow

(@ Selected Automationltems (1)

Transition Items from Initial... State 1 -

Transition Comment:

| can only update items that are of the same item type and the same workflow state.

Commit Cancel

If the workflow doesn't have another transition state to select, you don't have permission or the
item is locked. A pop-up window displays a warning that you can't proceed.

The selected items are transitioned to the workflow state you chose.

Lock items in a workflow (organization or project admin)

To avoid unwanted changes, you can lock items in a workflow. For example, a project admin might want
to leave items unlocked while in "draft" status, but lock them when they reach "approved" status.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Important considerations

¢ |tems that are automatically locked by the workflow [232] display a gray lock after their name and a
blue lock in List View.

e System-locked items are unlocked when they transition through the workflow or are transitioned by
an organization or project admin.

To add an automatic lock to the workflow:
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1. Select ADMIN > Project > Workflow.
2. For the item you want to lock, select Override.
3. Inthe Lock? column, select the lock icon to include (or remove) an automatic lock in the workflow.

4. Select Save settings.

The items you selected are now locked and can't be changed.

Stream — Staying connected

The Stream is where you can see the most recent comments and activities of your Jama Connect project.
The Stream is built on three basic activities:

e Connect
e Communicate
e Collaborate
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Working with the Stream

With everyone having the most up-to-date information through the Stream, stakeholders stay informed
and aligned.

You can:

Include stakeholders in a conversation [246] by name or email.

Keep up to date on the latest activities [243] for a project or item.

Clarify conversations by using actions [250] like questions, decisions, or issues.

Include whiteboards, prototypes, or other images [249].

Filter the Stream [252] to include only comments or activities that refer to a specific project, item, or
person.

e View the Stream across projects [256], at an item level [253], or at a project level [254].

Types of streams
Jama Connect includes Streams for specific types of collaboration and activity.

Global Stream [239] — At this level, you see a collection of the most recent comments and activities.

Project and Item Activity Stream [239] — At this level, you see comments and activities for the entire
project.

Item Collaboration Stream [240] — At this level, you can see comments and connected users related to a
specific item.

Baseline Activity Stream [241] — At this level, you can monitor activity, quickly find a baseline ID, or see
if a signature is revoked.

Review Activity (Stats) [242] — At this level, you can see all activities for a review across versions,
including when reviews were opened, closed, when new versions were published, or when signatures
were added.

Admin Activity Stream [619]— At this level, you see an audit trail of updates made by organization and
project administrators.

Test Plan Activity Stream [243] — At this level, you can see an audit trail of changes that were made to
your test plan. For example, as contents are added and removed from the test plan — such as test groups
and test cycles — a detailed log of the user, date, and time is captured.
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Global stream
At this level, you see a collection of the most recent comments and activities.

How to access
From the Jama Connect header, select Stream.

What you can do
See the most recent comments related to an item.

Project Activity Stream

At this level, you see comments and activities for the entire project.

How to access

e Select the project name to open the Activity Stream.
e If you don't see the Activity Stream, select Add widget. In the window, select Activity stream, then
select Add. You must have project admin permissions to do this.

What you can do

e See comments and activities for the entire project.

e See changes to items — Adding, editing, or deleting content from item fields, commenting on an item;
using features like releases, baselines, or reviews that impact the item.

¢ Find out when a review is opened, revised, closed, reopened; when signatures are added or revoked.

¢ View items that are reused and synchronized and reuse details that appear in the activity stream.
Users with read permission can view details about reused items and can select a link to view newly
copied and synchronized items.

e From a project, select the Collaboration Stream View icon to see information only for that project.

& Stream
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Item Collaboration Stream
At this level, you can see comments and connected users related to a specific item.

Here's an example of what the Stream looks like in List View:

How to access
There are several ways to view the Stream at the item level.

¢ In Project > List View, select the speech bubble icon.

¢ In Project > Document View, select the speech bubble icon.

¢ In Project > Single Item View, select the speech bubble icon.
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What you can do

e See comments and connected users related to a specific item.

e See changes to items — Adding, editing, or deleting content from item fields, commenting on an item;
using features like releases, baselines, or reviews that impact the item.

e View items that are reused and synchronized and reuse details that appear in the Activity Stream.

Users with read permission can view details about reused items and can select a link to view newly
copied and synchronized items.

Baseline Activity Stream
At this level, you can monitor activity, quickly find a baseline ID, or see if a signature is revoked.

How to access

Select the Baselines tab, baseline name, and View details (which changes to View items) to open the
Activity stream.
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What you can do

¢ Monitor activity, quickly find a baseline ID, or see if a signature is revoked.
¢ View changes to baselines — Adding (manually or automatically with a review), editing, or deleting
baselines or sources. Visible to users with read-only permission.

*Deleting requires admin permissions. Baselines with e-signatures can’t be deleted.

Review activity (stats)

At this level, you can see all activities for a review across versions, including when reviews were opened,
closed, when new versions were published, or when signatures were added.

How to access

¢ In the review, select Stats to open the activity page.

What you can do

e See all activities for a review across versions, including when reviews are opened, closed, when new
versions were published, or when signatures were added.

¢ Find out when a review is opened, revised, closed, reopened; when signatures are added or revoked.

e See when items are sent for review.

e See all activity for a single review across revisions in the Review activity tab.
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Test Plan Activity Stream

At this level, you can track changes that were made to your test plan. For example, an archived or
unarchived test plan appears in the Activity Stream and the Project Activity stream. You can also see
which test cases were unassociated in the activity log.

How to access
Select the Test Plans tab, then select the Activities widget to open the Test Plan Activity Stream.

What you can do

e Monitor activity and track changes in your test plan.
¢ View logs of the following activities:
e Add or delete test groups
e Add test cycles or bulk-add test runs
e Delete test cycles or bulk-delete test runs
e Manually delete test runs
e Add test cases to a test plan
e Archive or unarchive test plans
e When a test cycle or test plan is sent for review, or when part of a filter is sent for review, the
activity is logged.

Activity Stream

Activities are the recorded changes made to an item, including editing, commenting on, relating to other
items, deleting, and restoring.

You can view activities at an item level [253] or a project level [254]. You can also view activities specific
to different parts of Jama Connect, such as reviews [206] and baselines [293].
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These are the types of activities that appear in the Stream.

Activity type

Definition

Visible in...

Changes to items

Adding, editing, or deleting content from item fields; comment-
ing on an item; using features like releases, baselines, or re-
views that impact the item.

Project Activity Stream

Item Activity Stream

Changes to baselines

Adding (manually [283] or automatically with a review [288]),
editing, or deleting* baselines or sources. Visible to users with

Baseline Activity Stream

read-only permission. Baseline Activity Stream [293] shows all Project Activity Stream
activity for a baseline.
Reused and synchronized When items are reused and synchronized [353], details of reuse Project Activity Stream

Test Plan Activity Stream. For example, logs are displayed when
a test group is added or deleted.

items appear in the Activity Stream. Users with read permission can .
view details about reused items and can select a link to view Item Activity Stream
newly copied and synchronized items.

Comments Comments related to an item or project. Review comments Collaboration Stream
aren't included in Activity Stream.

Reviews When review is opened, revised, closed, reopened; when signa- Project Activity Stream
tures are added or revoked.

Review activity (stats)

When items are sent for review, see all activity for a single Review activity (stats)
review across revisions in the Review activity [206] tab.

Test When changes are made to a test plan, details appear in the Activity Stream

Test Plan Activity Stream

* Deleting requires admin permission. Baselines with e-signatures can’t be deleted.

Comments

Comments are user-created messages that you can see in the Stream or in reviews.

Comments are visible:

e At anitem level [253]
e At a project level [254]
o In reviews [185]

e Across projects [256]

You can add and delete a comment as well as restore comments that you deleted. You can also add a
hashtag (#) to a comment for filtering or add a reference to a specific person, project, or group.

Add, delete, or restore a comment

All comments made in Jama Connect are displayed in the Stream. You can see any comment you have
permissions to view.

Important considerations

e You can add comments, delete comments that you made, and restore comments that you deleted.

¢ You can also restore comment threads or replies that you deleted, but only if they were associated
with an item. You can't restore deleted comments that aren't associated with an item.

¢ When the discussion gets long, Jama Connect shows only the most recent comments. Select View all
replies to expand the thread and show all comments. Select Hide replies to collapse the thread.

To manage comments:

1. To add a comment to the Stream, to an item, or to a project:
a. Open the Stream at an item level [253], project level [254], or across projects [256].
b. Enter your comment:
o New comment — In the Stream comment box.
e Replying to a comment — In the reply box below the comment.
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Stream

R- T~

c. (Optional) As needed, you can refer to a particular person, group, project or item [246], request
or resolve an action [250], upload an image [249], or add a hashtag [245].

d. Select Comment.
2. To delete a comment:
a. Select Delete below the comment.
b. When prompted, select Yes.
3. To restore a deleted comment:
a. InSingle Iltem View, select the Activities widget to open the bottom panel.

=

b. In the deleted comment, select Restore.

c.  When prompted, select Yes.
The comment is restored and appears in the My Settings section.

All comments in the My Settings section reflect your changes.

Add a comment hashtag
By adding a hashtag to your comments, you can quickly filter the Stream by selecting the hashtag itself.

Important considerations

e Tags begin with the # character and are lowercase letters with no spaces.
e Comment tags are different from item tags. Comment tags are added to comments and can be used

to filter the Stream, but item tags are added to an individual item and can be used to search or group
items.
To add a comment hashtag:

1. Inthe Stream comment box, type # followed by the tag. For example, #alert or #review.
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2. Select Comment.

Admin Test Comment - afew seconds ago

#review

5+ Mute + Delete

The comment appears in the Stream thread.

Add an @mention reference

To increase the efficiency and usability of your comments, you can refer to specific items, projects,
people, or groups with @mention.

Anyone you include in a comment receives an email notification [248].
To add an @mention reference:

1. Open alist of names (items, projects, people, groups) using one of these methods:
e |In the comment field of the Stream window, type @ followed by the first few letters of the name.

e Below the comment field of the Stream window, select @.

2. Scroll through the list to select the name you want to include in your comment.

The name that you included appears as a bold link in your comment.

Add a reviewer from outside Jama Connect

You can add a commenter who is not part of Jama Connect. They get a temporary license [656] that
allows them to view the comment threads to which they were invited. They can also see descriptions of
referenced items in the thread.
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Once you send the invitation, the person can optionally set up a user login and password, which is then
available in the @mention drop-down list. After 30 days the license expires and the user is locked out of
Jama Connect unless it is changed to a permanent one. Users can still be @mentioned in the Stream if
their license has expired, but they can no longer access the conversation or items.

Note
y An admin can grant invited users permission [748] to view additional project data.

To give Stream access to someone outside of Jama Connect:

1. In the comment field of the Stream window, type @ followed by the user's email address, then select
the blue Invite bar that appears to trigger an invitation.

2. In the Invite User window that opens, enter the full email address and select Invite.

3. Type your note and select Comment.

The person you invited now automatically receives Stream emails [248].

View referenced projects and items
When a project or item is referenced with @mention, you can view it in its Activity Stream.

To view references projects or items:

1. View a reference to:
¢ Project — Open the project's Activity Stream.

247



Collaborating with your team

e [tem — Open the item's Activity Stream in Single Item View.

2. (Optional) In the Activity Stream, select Description to see details about the referenced project or
item.

3. (Optional) Select View additional references to see more than the first displayed reference.

Email notifications for the stream

Jama Connect includes several types of email notifications, including ones initiated in the stream. This
information applies only to stream email notifications.

G Best Practice

- To control the amount of notifications you receive from Jama Connect and reduce po-
tential email “noise,” mute conversations that no longer require your attention. You still
have access to these threads and receive emails again if you are tagged with @mention.

Adding participants
When you comment on an item or project in the activity stream, you can add people to a comment by
using @mention. This includes people who aren't current Jama Connect users.

When you receive stream notifications
Initial email — When your name is added to a comment in the stream.

Update email — When anyone replies to a comment thread where your name was added.

New comments — If you subscribed to the item.
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Additional notes

¢ |f you're a member of multiple groups mentioned in a comment, you receive only one email for each
comment or reply.

¢ When participants receive an email because they're mentioned in the stream, they can comment di-
rectly to the thread by replying to that email. A copy of the comment is emailed to everyone on the
thread.

¢ Email updates contain links to see the entire comment thread in Jama Connect.

¢ Replying to a thread by email works for comment threads in the stream, but not for comments in
reviews.

O Best Practice
- Control the amount of notifications you receive from Jama Connect to reduce potential
email “noise.” To help with this, mute conversations that no longer require your atten-
tion. You still have access to these threads and will receive emails again if you are
specifically mentioned in a comment or are a member of a group that is specifically
referenced.

Upload images to the Stream

You can include useful photos (meeting notes, white board drawings, or prototypes) in the Stream by
uploading images.

To upload images to the Stream:

1. In the Stream window, select the Image button.

2. Select the image file you want to upload, then select Open.
The image appears in the Stream comment field.

3. (Optional) To resize the image, hover over the bottom right-hand corner of the image, grab the
handle and drag the corner to the required size.

4. (Optional) To move the image in the comment, hover over the top left-hand corner of the image and
grab the handle. Drag the image to the correct location in the comment.
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5. Select Comment.

The image you uploaded now appears in the Stream.

Request or resolve an action

Actions can highlight important conversations in the Stream by identifying a comment as one of three
types: decision, question, or issue.

Actions also help clarify your request to someone that you include in your comment. You can also filter
by actions [252] to see which questions, issues, or decisions need attention.

To request or resolve an action:

1. Toinitiate a request, choose from the Actions menu or type a ! in the comment box and choose an
action from the menu that appears.

A comment that contains a request action has a yellow left border and a blue button to invite other
users to resolve the action (Answer question, Make decision, Resolve issue).
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2. Torespond to a request, choose from the Actions menu: Decision, Answer, or Resolution.

Actions =

OPEN ACTIONS

Decision needed
Cluestion

Issue

RESOLVED ACTIONS

Decision
Answer

Resolution

e Resolved actions have a green border.
e Open actions have a yellow border.

3. (Optional) Use the Like icon to agree with a comment and to track how team members vote on a
decision.

4. (Optional) Select the number next to the Like icon to see who agreed.
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Your changes (request, resolution, like) are saved.

Filter the Stream

Filters let you see only comments that matter to you.

A filter remains active only if the session is active. You can save a filter to reuse it. You can also bookmark
a filter in your browser to view later.

Note
y You can create an item-level custom filter [253] to filter comments or activities in the
Stream.

To filter the Stream:
1. Open a Stream window and select the Filter comments field.

Stream

- | l

2. Enter one of the following and select from the displayed menu to create a filter:

# Displays a menu of hashtags.
Displays a menu of users.
! Displays a menu of actions.
Keyword Displays a menu of frequently used names for people, groups, projects, or other content types.
Select an option from one of the menus or press Enter if you typed a new keyword.
4. (Optional) To filter by actions, select the Quick filters menu. These filters are additive so you can
filter on multiple actions.

w
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T~
OPEN ACTIONS
Decisions needed
Questions

Issues

RESOLVED ACTIONS

Decisions
Answers

Resolutions

The filters you choose appear below the comment field. The Stream is refreshed with each filter you
add or delete.

5. (Optional) To save a filter, select the bookmark button and enter a name for the filter, then select
Save.

6. To set a quick filter from a comment, select people, projects, items, or other boldfaced references in
the comment. These filters aren't additive.

7. (Optional) To share a filter with another Jama Connect user, copy the URL of your filtered results
and send it via email.

The filter you created remains active only while the session is active.

View collaboration Stream at an item level

You can view the Stream [237] comments and activity for an item, for example, to see all "Open"
(unresolved) questions about that item. A speech bubble icon includes a number that indicates how many
comments were recorded for that item.

6” Note

The side toolbar is only visible if it is configured by the organization admin [691].

To view Collaboration Stream at an item level:
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1. Select an item’s speech bubble icon using one of these methods:
Projects > List View

Projects > Document View

Single Item View > Side toolbar

=3
1]

2. In the window that opens, select the silhouette icon to view comments, add comments, or view
connected users.

View Collaboration Stream at a project level

You can view the Stream [237] at a project level, you see comments [244] and activities [243] for the
entire project in the project dashboard.
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Important considerations

¢ Any comments you enter at this level automatically refer to the selected project.

o [f the Stream doesn't already appear on your project dashboard, a project or organization admin can
add it.

To view a project-level Stream:

e  Open the project dashboard using one of these methods:

e Explorer Tree — Select the main project level in the Explorer Tree or select the name of the
project just above the Explorer Tree.

e Stream — Select Stream (comment bubble) in the upper right navigation.

The project dashboard displays all comments and activities for that project.

View Comment and Activity Stream for an item

You can view the Stream [237] comments and activity for a single item, for example, to see all "Open"
(unresolved) questions about that item.

Note
y The side toolbar is only visible if it is configured by the organization admin [691].

To view Comment and Activity Stream:

1. InSingle Item View, select the Activities button on the side toolbar to see the history of an item.
The number on the button indicates the item's activity.

A
[ 20
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2. The bottom panel displays the Stream, all activities (such as edits, reviews, relationships), and all
comments for this item. From here you can add a comment, search the Stream with a keyword,

refresh the display, or hide the panel.

3. Use the three buttons in the top left corner of the Stream to:
¢ Display active comments
¢ Display all activities
e Apply a custom filter to activities
4. Select the Settings (gear) icon in the top right corner to open the Activity Filter Settings window.
5. Keep the default settings or customize keywords, activity type, date range, or item type, then select

Apply.

Your custom filters are saved across items.

View the Collaboration Stream across projects
View the Collaboration Stream across projects when you want to search or filter projects. For example, if
you want to see open questions that are assigned to you for all projects.

To view the Collaboration Stream across project, use one of these methods:
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1. Select STREAM from the top navigation.

The most recent comments are displayed first.
2. Select View All Stream Activity from the home page.

All comments from all projects are displayed.

View connected users

A connected user is a creator, editor, or someone who has commented, subscribed, or been @mentioned
on an item.

View connected users to see who is connected to items. For example, if you're changing a requirement
and want to see who might be impacted by a change.

To view connected users:

1. Open the Connected users window using one of these methods:
¢ Single Item View — Select the connected users icon.

u
2

e List View — Select the user icon.

2. Select Show indirectly connected users to view users who are interested in items related to this
one.
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3. (Optional) To toggle the related users on or off, select the circle icons at the top of the list.

You can now view the list of connected users and make comments in the Stream.

Electronic signatures

An electronic signature is a way for project participants to virtually approve reviews, baselines, and
electronic documents like test plans and requirements.

Review moderators can require a signature for a review and add a signer role. All review signatures carry
the Signature meaning: "l approve the content of this review."

Electronic signatures consist of a username and password. They are captured with a time and date stamp
and an audit trail. Each signature is tied to the individual user, as well as to a baseline or review where
the signature was added.

Electronic signatures, time stamps, signer roles, and signature meaning are all visible in review activi-
ty [206].

Things to know

e For easy identification, a baseline with an electronic signature includes a blue dot and white exclama-
tion mark in the baseline tree.
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¢ As the moderator, you can add a signer role or a reason for signing to a review signature [189], but not
to a baseline signature.

¢ Signatures are enabled by default, but can be disabled by a system administrator.

e Electronic signatures depend on the authentication system your organization is using. Authentication
properties can be configured by a system administrator.

¢ You can't delete a review with an electronic signature, or a baseline created from a review with an
electronic signature.

¢ You can revoke your signature if it was signed in error or something needed to change. Select Revoke
to cancel your signature. Only the user who signed the baseline can remove their signature. When
revoking a signature, you can leave a reason for revoking, which appears in the Activity Stream as a
comment.

¢ As an approver, you can reopen a review that you signed, but this revokes your signature.

¢ To see a review that was signed, look in the participant progress [204] or review activity [206] tab.

e Self-hosted customers can't edit a baseline that is signed.

ﬁ:’ Note
You can't delete a review with an electronic signature, or a baseline created from a
review with an electronic signature.

Electronic signatures depend on the authentication system your organization is using.
Authentication properties can be configured by a system admin.

Sign a review electronically
If a review requires an electronic signature, you are asked to add a signature when you finish a review as
an approver.

To electronically sign a review:

1. In the Review finished window, enter your username and password as your electronic signature.
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If your organization uses SAML, the SAML authentication window opens, where you enter your
username and password.
2. Select Approve and sign to complete the review.

If email notifications are enabled, an email is sent to the moderator or other participants to let them
know you're done with your work.

Add signer role

As a moderator, you can enable the signer role for other approvers. This allows them to associate their
role with their signature. Signer roles are created from user group names.

If your moderator is inviting a user from outside of Jama Connect, they must log in and register before
you can assign them to a group. After your organization or project admin adds them to a group, the
moderator can edit the review to give them a signer role.

To add a signer role

1. Initiate a review [163].
2. Make sure electronic signatures and signer roles are enabled in settings [168].
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3. Toinvite participants [172], select the user and use the Signer role drop-down menu to assign a
signer role to that user.

If the user belongs to multiple groups, choose their role as signer from multiple options.

If the user doesn't belong to any groups, their role is "Not assigned."

To add a signer role, create a user group [647] with a name that indicates the role you want to
represent (for example, QA, Business Analysts, Security). The person you want to assign the role
to must belong to that group.

If you select a group in the participants panel, select Add all users. The signer role defaults to the
name of that group.

4. Select Initiate review.

Approvers assigned a signer role are notified of their role in their email invitation [171].

After a review is signed, anyone with permission to a review can view signer roles that were used for a
signature under review activity [206].

Sign a baseline electronically

If your business process dictates that signatures must be applied to collections of data such as baselines,
electronic signatures can be associated directly with a specific baseline. Signatures can also be captured
and associated with a baseline if signatures are collected during a review.

To electronically sign a baseline:

1. Inthe Explorer Tree under the Baselines tab, select the baseline you want to sign, then select View
details.
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2. Select Add signature.

3. In the Electronic signature window, enter your username, password, and any optional comments,
then select Save. Username and password must match that of the logged in user.
If your organization is using SAML for authentication, you are asked to select Sign baseline, then
enter your username and password to authenticate your signature.
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Electronic signature

Your full name: Signature date and time:
Admin Test 04/15/2022 11:57 am

To complete your electronic signature, please enter your usemame and password.

Username:
Password:

Comments:

Cancel

If email notifications are enabled, an email is sent to the moderator or other participants to let them
know you've signed the review electronically.
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Managing your content

Content in Jama Connect uses an item-based approach, where items are the major building blocks for
your content. Managing your content includes planning, organizing, and tracking progress and impact.

e |tem versions [264] — Each time you change an item, a new version is created. You can compare
versions [266] and make a past version current [265].

e Change requests [269] — Change requests are items that call for a change to a product or system.

o Releases [274] — A release is a group of items that are developed together and mapped to a specific
completion date.

e Baselines [277] — A baseline in Jama Connect is a snapshot of your project at a point in time.

e Coverage and Traceability [304] — Coverage is the extent to which items are validated by another
item. Traceability shows the relationship between items that depend upon and define each other.

e Reuse and synchronization [353] — With reuse [355] you can duplicate supporting information for any
item, container of items, or even a project. With synchronization [363] you keep items continuously in
sync.

e Exports [378] — Select the data you want to export directly to Word [379] or Excel [380].

Item versions
A new version of an item is created each time you change a field value for that item.

When you view item versions, these details are visible:

e Baselines and reviews that include the specific version of that item.
e Automatically generated change details.

e User comments applied by the person who made the changes.

e Date when the item was changed.

e Name of the person who made the changes.

y Note
To add a version comment when you save the item, see Version Comments.

To view an item's versions, select the Versions widget in the side toolbar, which opens the bottom panel.
There you can compare versions [266] or make a past version current [265].
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The current version number appears next to the item name. From the Version drop-down menu, select
the version of the item you want to view.

Change the current item version

When you make a past item current, the system creates a new version with field values identical to the
version you chose. This preserves a past version if you need to revert to it.

Important considerations

e Past versions of a test cycle can't be made current.

¢ Pick list values that existed when the previous version of the item was active are restored, even if a
value was removed.

¢ For items that were converted from one type to another, you can't use the Make Current option to
revert to the previous item type.

To change the current version:

1. In Single Item View, select the Versions widget to open the bottom panel [21].
2. Inthe row with the version that you want, select Make Current.
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3. In the Restore version window, select Confirm.

The screen is refreshed and a note appears in the column User comment and transitions.

From To Version Baselines / Reviews Change detalls User comment and Created By
transitions
VERSION
O O *Description” changed, Priority” COMMENT: 08/21/2022 Admin
changed from "Medium” to ™ Restored from version | 07:38:49 pm Test
2

Compare versions of an item
To track changes, you can compare different versions of an item.

To compare two versions of an item:

1. Select the Versions widget to open the bottom panel in Single Item View [21].

2. Select the two versions you want to compare, using the buttons in the From and To columns, then
select Compare.

In the Version Compare window:

e Selected From version is on the left.
e Selected To version is on the right.
e Changes are displayed inline.

e Deleted text is red and highlighted.
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e Added text is green and underlined.

. u Tip
¥ Select Hide Details to see a side-by-side view of the versions without the colored inline
changes. Jama Connect highlights the entire field where the versions differ.

View previous versions of an item

In Single Item View, you can view differences between items that have more than one version. View the
history of an item to quickly identify changes and track progress.

Important considerations

¢ You can only edit the current version of an item.
¢ The Relationships widget is the only available widget.
e When you view an older version, you can see which categories were applied or unapplied.

To view a previous version of an item:

1. From the Explorer Tree, select the item you want to view.
The item opens in Single Item View.
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2. From the Version drop-down menu, select the older version of the item you want to view.

The screen displays the information for the version you selected.
3. (Optional) Select the Relationships widget to view all relationships for the version you are viewing.
Suspect information doesn't appear in the relationship table.
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Change requests
Change requests call for a modification to an item that affects a product or system.

When an item type is activated as a change request [687], you can add new change requests and
associate them with other items [269].

With change requests you can:

e Use Associate item(s) [269] to associate the change request with those items directly impacted by the
request.

e Use Impact Analysis [273] to determine if and how your change requests affect other items.
e Send a change request to review [163] to gather feedback from stakeholders and determine if the
change request is approved or rejected.

Add a change request and associate items

When an item needs to be altered, you can add a change request, which helps track the requested
change.

As the author of a change request, you can capture the details of the requested change, manage the
status of the change request, add and update the associated items, and close the change request as item
updates are made.

Note
y The change request must be an available item type for your project. Available item
types are managed by the project admin.
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To add a change request:

1. Create a new set of Change Requests in your project:
a. Select the project and select Add > New item > Set of... > Change Requests.

b. Inthe Add Item window, enter a name for the set, for example, Change Requests.
c. Select Save & done.

2. Add a new item [68] to that set.
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3. Select the item, then open the bottom panel by selecting the bell widget (Iltems to be changed) from
the side toolbar. This widget only appears when configured by an organization admin [691].

@

4. Select Associate Items in the bottom panel, select the items that apply to this change request, then
select Associate.

Important
Change request items can't be associated with other change request items.

The associated items appear in the bottom panel with links to those items. Each item includes the
starting version (when the change request was introduced) and the ending version, which fulfills the
change request.

When you view other items that were associated with this change request, you see the same widget in
the right toolbar of their Single Item View, as well as any change requests they're associated with in the
bottom panel.
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Edit a change request association
Edit change request associations to indicate which version is the starting or ending version of a change
request.

To update a change request association:

1. In Single Item View, select Change Request to open the bottom panel with a list of associated
change requests.

2. Select the row with the item you want to update.

3. In the window that opens, change values for Starting Version, Ending Version, and Note as needed.

4. Select Save.

The item is updated with your changes.
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Run Impact Analysis on a change request
Before implementing a change request, you can determine its impact on related downstream items.

To run the Impact Analysis:

1.

2.

In Single Item View, select Change Request to open the bottom panel with a list of associated
change requests.
Select the item you want to know more about, then select Actions > Impact Analysis.

The Impact Analysis is displayed as a highlighted table, listing all items directly associated with the
change request. Also, any items that are downstream from directly associated items are shown with
their degree of separation from that item.

Jama Connect provides visibility of the potential impact of a change request. The impact is then used to
determine if any impacted items need to be updated.

Delete change request associations

If you included an item in a change request and later determine that the item isn’t impacted by the
change, you can remove or “disassociate” the item from the change request.

To delete an association:

1.

2.

In Single Item View, select Change Request to open the bottom panel with a list of associated
change requests.
Select the row with the item you want to update, then select Edit > Remove Association.

The screen is refreshed, and the associated item is removed.

Close a change request

A change request records the current version of each associated item, which is the starting version.
Closing a change request records the end version of each item being changed.

To close a change request:
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1. In Single Item View, select Change Request to open the bottom panel with a list of associated
change requests.
2. Select the change request you want to close, then select Actions > Close Change Request.

3.  When prompted, select Yes to confirm.

The change request is closed.

Releases
A release is a group of items that are developed together and mapped to a specific completion date.

To see all the releases listed for this project, select Releases at the top of the left panel. Select a specific
release to see the items assigned to it.

If you include items in a release, you are assigning them to that release. If the release field [275] is visible,
you can use List View to see the name of the release where an item is assigned.

Assigning an item to a release
When you assign an item to a release, the item appears under the Releases tab, and the action is noted in
the version history.

Important

Admins only — You can only use the system predefined Release field to show items in
the Releases tab. If you use a custom Release field to designate an item to a release,
that item doesn’t appear in the Releases tab.
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Before you can assign items to a release, a project or organization admin must first create the release.
Once the release is created, you can assign an item to that release in several ways:

e Locate the release field [275] (if it is visible [697]) in Single Item View or List View and select the
release name you want from the drop-down menu.

¢ In the List View of your project, select the items you want to add to the release. Select the Releases
tab at the top of the left panel and drag the items into the release.

e Use batch update [74].

e Use round-trip import and export [129].

Release field
The release field is a predefined field [672] with a picklist that contains all the releases created in a
particular project.

Important

You can only use the system predefined Release field to show items in the Releases tab.
If you use a custom Release field to designate an item to a release, that item doesn'’t
appear in the Releases tab.

If you don't see a Release field in the item type you are using, an organization admin can edit the fields
for that item type [674] and make them visible [697].

A project admin must also configure pick list values [680] for each release.

Customize the Release settings
You can determine what you'd like to see under the Releases tab for your project, whether it is the
default settings or your personal settings.

To customize settings for the Release tab:

1. Select PROJECTS > Project, then select the Releases tab.
2. Select the Configure release explorer (gear) icon.

3. Inthe Release Explorer Settings window, determine what you want to see on the Releases tab:
e Select Use my own settings or Use default settings.
e Select the item types, types of IDs, archived releases, and relationships that you want to see.
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4. Select Apply.

Your saved changes are now reflected in the Release tab listings.
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Baselines

A baseline in Jama Connect is a snapshot of your project, or a select collection of items (for example, a
set or folder of items), at a point in time.

The version of selected items — and their relationships — are forever associated with that baseline.
Important considerations

¢ When you add a relationship to a baseline, the version doesn't change.

¢ Relationships do not change if you replace it with a baseline.
For example, if you have two relationships at the time of baseline version one, make a change to
version two, add a relationship to version three and replace it with a baseline, you still have three
relationships.

¢ If you select Replace with baseline, all item fields are set back to their values at the time of the
baseline. For more information, see Replace baseline with current [298].

¢ When you select an item with previous versions in the baseline, the historical view of that item opens
in Single Item View. Hover over a link to see the available versions for an item. Selecting an item’s
link from a baseline routes you to the baselined version — Historical or current. You can also select
the gear icon (Show/Hide) to open the drop-down menu, then select Current version and Version to
display those columns.

¢ Organization and project admins can unlock locked baselines from the baseline header. This option
only appears when a baseline is locked and you have admin permissions.

¢ Baselines that were created before Jama Connect 9.6 now display an icon to indicate that the new
fields aren’t available. This icon appears in List View, Document View, in-app comparison summary,
and the Preview panel.

Baseline View details
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What you need to create a baseline

Versioning must first be enabled to create a baseline. Once versioning is enabled [742], a baseline is
created:

e Automatically [294] when someone initiates or revises a review
e Manually [283] by anyone with read/write permissions

Why are baselines important?

Baselines allow you to capture the state of your content in alignment with key points in your product
development lifecycle, such as at key approval gates or when generating documents from Jama Connect.
Having the baseline allows you to compare items as they change over time and, potentially, revert to a
previous state.

What can | do with a baseline?

Locate an existing baseline [288]

Create a baseline manually [283]

Compare baselines [290]

e Use Compare with current to see baseline changes [291]
View baseline activity [293]

¢ Replace current items with baseline [298]

Categories feature and baselines

When enabled by an organization admin, historical versions of categories are visible in the baseline. They
can't be configured. To show or hide the Categories feature, select the gear icon.

= B = - |R~] & 10f17 selected
All Selected (9) e
APIID Assigned to
¥ Categories Conditions
Created By v Created Date
v Current version v Description
Global ID Heading

The categories that were applied to the baselined items appear in List View.
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What is a baseline source?
A baseline source is a container that holds all the baselines for a specific group of items.

You can add a baseline from a project, set, folder, filter, release, or individual items. Adding a baseline
creates the source automatically. The source is created in the tree and contains the new baseline. A

source can't exist without a baseline.

If a source already exists when a new baseline is created for the same set of items, the baseline is added
to that source. Otherwise, a new source is created and added to the top of the tree.

Key to the baseline tree

Green database icon — Source

White box wrapped in gray — Baseline

Individual Items — Default source name when multiple items are selected at the time the baseline is
created.

B1-04/27/2020 — Example of a default baseline name (baseline number and date it was created).
Baseline name is editable as needed.

FYI

¢ You can create a new baseline from an existing source.
¢ Deleting a baseline source deletes all the baselines it contains.

Benefits of organizing your baseline tree
Organize your baseline tree to reflect how your organization works.

Project and organization admins can reorganize the baseline tree by dragging and dropping sources and
folders.
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Organizing baseline sources and folders

e Use drag and drop to move baseline sources from one location to another, from the root level to a
folder, and between folders.

e Baseline folders can be created at the root level or added to a folder. Use drag and drop to reorder
baseline folders.

¢ If you hover over an icon or name in the baseline tree, hover text describes the contents of the item.

¢ Editing a source name creates an event in the project activity stream. In the activity stream, select the
baseline source ID to open the baseline tree and view the highlight.

Searching and identifying baselines, baseline folders, and baseline sources

¢ When you type a name in the search field, the results are highlighted so you can find them easily.

¢ When you clear the search field, the results from the previous search are expanded and highlighted in
the baseline tree.
e When you create a folder or baseling, it is highlighted in the baseline tree.

¢ [f you accessed the baseline from a link or if the Explorer Tree hierarchy is collapsed, select Find me to
locate the baseline in the baseline tree.

¢ When you toggle Show IDs to On, the baseline IDs are displayed in the baseline tree. When the IDs
are visible, you can search for them using the baseline search box.
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¢ When you select the baseline ID in the activity stream, the source is expanded and the baseline is
highlighted. Use the baseline activity stream to monitor activity, quickly find a baseline ID, or see if a
signature is revoked.

¢ Alink is added in the baseline header when a baseline is created from a review or a new revision of a
review. Use the link to navigate to a specific review quickly.

Folder: Processor / BASE-318

Review Folder: Processor v1
Baseline * View details | View REV-156 v1 |

- [~ 2 17items

Creating and renaming baselines and baseline folders

Once a baseline is created, the collection of items in the baseline can't be changed. You can, however,
change the baseline name and description.

Users with a creator license and permissions for project or organization admin can create, edit, and
delete an empty baseline folder.
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Anyone with read/write permissions can edit, delete, or restore a baseline that they created. However,
you must have project or organization admin permissions to edit, delete, or restore baselines created by
others.

Create a baseline folder using one of these methods:

e From the Add drop-down menu, select Folder.
e Select the folder, then select Add Folder.

Compare baselines in Baseline source List View

A baseline source is generated when you create a baseline or review. To see all baselines associated with
that source in List View, select the baseline source.

An in-app comparison summary provides a high-level view of baseline changes and lets you run the
baseline comparison report. This feature displays detailed information about the baseline, such as the
number of items, Baseline ID, Baseline signatures, Baseline status, and Baseline type.

To compare baselines:

1. Select the Baselines tab in the Explorer Tree, then select the baseline source that includes the
baselines you want to compare.

2. In List View, select the two baselines you want to compare, then select Compare.

The Compare baselines window opens.
3. Review the Baselines comparison summary, then select Done.
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The Compare baselines window closes.

Create a baseline manually
Create a baseline when you want to capture a snapshot of where items are at in that moment.

p“"f’ Note
You must have a creator license and read/write permissions to manually create a base-
line.

Important considerations

e Baselines are created automatically [294] whenever anyone creates a review.

¢ Project versioning must be enabled [742] to be able to create a baseline.

o All upstream and downstream relationship information from items included in the baseline scope is
also included in the baseline snapshot, even if those upstream or downstream items aren't part of the
baseline scope. This functionality is limited to relationship direction, item name, and item ID.

To create a baseline manually:

1. Inthe Explorer Tree, select the Baselines tab in the project where you want to create the baseline.
2. Add a baseline using one of these methods:
o |f the item already has a source, select the source and select Add baseline.
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¢ To create a baseline from the Project Explorer Tree, select a set, component, folder, or item.

¢ To choose items, select Add > Baseline from the top.
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Note
é’ If the items from an existing source were deleted, you can't add a new baseline
from that source.

e To create a baseline from a filter, select the Filters tab, select the filter, and select Add baseline.

3. Inthe window that opens, select a tab (Item selection, Releases, Filters) and select containers or
individual items in that tab. You can select containers or individual items, but you can select from
only one tab.

285



Managing your content

4. Select Create.
5. (Optional) Change the default name for the baseline and add a description.

You can update the pick list and rich text as needed. When the baseline pick list is updated, the
activity is captured in the baseline and project activity streams.

Add baseline

Name: B1-12M13/2022

Description:

£ Acrich text description field is available in the baseline details' edit view.

190 items Save Cancel
6. Select Save to create the baseline.

The new baseline is added to the tree under an existing source or at the top of the tree. Baselines are
always listed in the order they were created.

Edit a baseline

Once a baseline is created, the item content can't be changed. You can, however, change the baseline
name, description, and baseline status.

Important considerations

¢ Anyone with read/write permissions can edit, delete, or restore a baseline that they created.

¢ You must have project or organization admin permissions to edit, delete, or restore baselines created
by others.
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¢ You must be an organization or project admin to edit a signed baseline.

To edit a baseline:

1. Select the Baselines tab in the Explorer Tree, then select the baseline you want to edit.
2. Edit the baseline using one of these methods:
o Select the baseline and select Edit.

¢ |n the upper right corner of the main panel, select Edit.

3. In the window, enter your changes and select Save & done.
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Your changes appear in the Explorer Tree.

Locate an existing baseline

When anyone creates or publishes a revision of a review, a baseline is automatically generated. Knowing
where to look for an existing baseline can be helpful when you want to compare changes in a review that
has multiple versions.

You can find a baseline for a specific project from the Explorer Tree or Single Item View.

Explorer Tree
Use the Explorer Tree to quickly find a baseline.

1. Select the Baselines tab of the project you want to look at.
2. Type the baseline name in the search field. The results are highlighted so you can find them easily.
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3. Expand the source to see all the baselines from the same source, then select the one you want. If a
baseline was created from a review, it is preceded by the word "Review" in the name.

4. Select the baseline to view its contents.

Single Item View

Use the Versions information in Single Item View to see which versions of that item are associated with
specific baselines and reviews.

1. Open the item in Single Item View [21].
2. Select the Versions widget on the side toolbar [21].
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The list of reviews and baselines is displayed in the bottom panel under the Baselines/Reviews column.

Compare baselines

When a baseline has more than one version, you can compare two versions in baseline Document View
using the baseline in-app Compare option.

Important considerations

e Document View must be enabled. If the setting has been disabled, the organization admin can enable
it from ADMIN > Details.

e The Compare option for baselines is available only when you have multiple baselines of a source and
you are viewing an older baseline.

¢ When comparing baselines, the categories table isn't available.

¢ Baselines that were created before Jama Connect 9.6 now display an icon to indicate that the new
fields aren't available. This icon appears in List View, Document View, in-app comparison summary,
and the Preview panel.

Baseline View details

To compare baselines:

1. Select the Baselines tab in the Explorer Tree, then select the baseline with the version you want to
compare.

2. Select Document View, then select Compare.

3.  From the drop-down menu, select the version to compare with the baseline you are viewing.

The information bar for baseline in-app comparison displays the total number of item changes
(updates to relationships aren't included in the total count).

Changes are displayed inline by color and formatting:

Green + solid underline = Added text/item

Red + dashed underline = Removed text/item
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Red + solid strikethrough = Deleted text/item

4. To compare relationships between two versions of a baseline, select Show related items.
Changes are displayed inline by color and formatting:
Green + solid underline = Added text/item
Red + dashed underline = Removed text/item
Red + solid strikethrough = Deleted text/item

5. Select X to return to baselines Document View.

Folder: Processor | BASE-317

B1 -11/02/2023 Compared to = Select option « j

Baseline + View details

= & g~ 2 1Titems

Compare current baseline to an older version

The Compare with current option allows you to compare baselines and see if an item changed since
the last baseline, and what those changes were. Use this feature to compare a baselined version with all
versions up to the most current.

You can use several methods to compare the current baseline to an older version.
To compare baselines:

1. From Baselines tab
a. Select the Baselines tab in the Explorer Tree.
b. Select the baseline you want to view.
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2. From List View
a. In List View, select the gear icon (Show/Hide) to open the drop-down menu.
b. Select Current version and Version to display those columns.

3. From Preview item

a. Select the row, then select Preview item to display a panel with the information for the versions
you selected.

b. From the Version drop-down menu, select most current or baselined to view the full details.
4. Side by side

e Select the row for the item, then select Compare with current in the top right.
5.  From Baseline reports —

e To show changes over time, use Baseline Comparison [461] to compare two baselines and
Baseline Compared to Current [460].

Open baselined items in Single Item View
In Jama Connect 9.6.0 and later, baselined items open in Single Item View.

This view provides a comprehensive display of all versioned and non-versioned fields, including attach-
ment and link counts, accurately capturing the state of the item at the time the baseline was created.

Important considerations

¢ You must select an item from the baseline to open Baselines Single Item View.

¢ When an item with relationships is deleted, the relationships don't appear in Baselines Single Item
View. You can only see them in the baseline.

To open baselined items:

1. Select the Baselines tab in the Explorer Tree, then select the baseline source with the baselined item
you want view.
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2. Select the baselined item's ID link.

The item opens in Single Item View.

View baseline activity

Use the baseline activity stream to monitor activity, quickly find a baseline ID, or see if a signature is
revoked.

To view baseline activity:
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1. Select the Baselines tab, then select the name of the baseline that you want to view.
2. Select View details.

The baseline activity stream is visible at the bottom of the center panel.

Locate review baselines
When anyone creates or revises a review, a baseline is automatically generated so that you can compare

changes between reviews.

To find automatically generated review baselines, use one of these methods:

1. Select Baselines in the Explorer Tree of your project.
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Baselines that were automatically generated for reviews are displayed with the word "Review"
preceding the name of the review.

If you know the items that were included in the baseline (or the review that created it):

a. Open the item in Single Item View [21].

b. Select Versions in the side toolbar [21].
The list of reviews and baselines is displayed in the bottom panel under the Baselines/Reviews
column.

c. Select the link for the review or its corresponding baseline. The link is enabled only if you were
invited to the review.
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Sign a baseline electronically

If your business process dictates that signatures must be applied to collections of data such as baselines,
electronic signatures can be associated directly with a specific baseline. Signatures can also be captured
and associated with a baseline if signatures are collected during a review.

To electronically sign a baseline:

1. In the Explorer Tree under the Baselines tab, select the baseline you want to sign, then select View
details.

2. Select Add signature.

3. In the Electronic signature window, enter your username, password, and any optional comments,
then select Save. Username and password must match that of the logged in user.
If your organization is using SAML for authentication, you are asked to select Sign baseline, then
enter your username and password to authenticate your signature.
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Electronic signature
Your full name: Signature date and time:
Admin Test 04/15/2022 11:57 am

To complete your electronic signature, please enter your usemame and password.

Username:
Password:

Comments:

Cancel

If email notifications are enabled, an email is sent to the moderator or other participants to let them
know you've signed the review electronically.

Delete a source or baseline
Delete a source or baseline if it was created by mistake or you no longer need it.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Important considerations

e Delete — Deleting a source deletes all the baselines it contains.

¢ Undo — If you change your mind after deleting a source or baseline, you can select Undo in the
success notice.

e Restore — You can restore a deleted baseline or source by finding the deletion activity [243] in the
projects activity stream and selecting Restore. If you deleted a source that contains multiple baselines,
you can restore individual baselines or the source and all its baselines. When you restore a baseline or
source, this event appears in the baseline activity stream.

¢ Limitations — You can't edit or delete a baseline that is electronically signed. You also can't delete
a source if it contains an electronically signed baseline. However, deleting a project [721] deletes all
project content, including baselines and signatures.
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To delete a source:

e Select the source you want to delete, then select Delete source and baselines.

To delete a baseline:

e Use one of these methods to delete a baseline from the project.
e Select the baseline, then select Delete (trash icon) in the top right.
e Select the baseline name, then select Delete.

Replace current items with a baselined version

When you replace current items with a baselined version, a new version of the item is created and
content is replaced with the baseline content. No versions are lost.

Important considerations

¢ |tems that were deleted are restored to the version when the baseline was created.
e Relationships that were deleted aren't restored.
¢ You can restore a prior version of an individual item from the versions tab in Single Item View [264].

é’ Note
You must have project or organization admin permissions to do this.

To replace current items with a baselined version:

1. Select the baseline you want to revert to in the Baselines tab of the Explorer Tree [288].
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2. Select Replace with baseline.

3. Inthe confirmation message, select Replace.

A pop-up message displays the number of items that were updated.

Reuse baselined items

You can reuse baselined items in the same project or in a different project. Reusable items include
folders, sets, components, text items, and a single item baseline.

Note
i You can't reuse baselines created from a filter, a release, individual items, a project, a
test plan, a test run, or a test cycle.

To reuse baselined items:

1. Select a baseline using one of these methods:
¢ Baseline tree — Select the baseline that you want to reuse, then select Reuse baseline from the
context menu.
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¢ Baseline List View — Select the baseline you want to reuse, then select Reuse.

¢ Baseline Document View — Select the baseline you want to reuse, then select Reuse.

The Reuse baseline window opens with the reused baseline highlighted. You can also select a
different baseline.
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In the Select reuse options section, choose an option:

¢ Sync items and share Global ID — Gives the source item and the destination item the same global
ID. With the same global ID. Changes to one item flags the relationship between the source and
destination.

¢ Create a baseline in destination upon reuse — Creates a baseline source and a child baseline in
the destination project after reuse is successful.

¢ Include categories — Includes categories with the reused items in the destination project.

301



Managing your content

Note
y The category isn't reused if it is deleted from the destination project, or the organi-
zation admin reorders or removes the category path.

3. Inthe Select a target destination section, choose a valid location for the reused content. For
example, when reusing a System Requirement, the target location must include a set of System
Requirements.
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b
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Depending on the options you chose, select Reuse and sync or Reuse.

In the confirmation window, select an option:

e Yes

e Preview

e Cancel

In the Reuse complete window, select an option:

¢ View items — Shows a list of all newly reused items. If the destination is in a different project, a
new browser tab opens and displays a list of items.

¢ Reuse again — Reuses the same source items in a different location.

¢ Finished — Closes the window.
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The newly reused items are saved in the specified locations.

Coverage and traceability

Coverage is the extent to which items are validated by another item. Typically, a requirement is consid-
ered “covered” only if it has corresponding test cases against it and test engineers assigned to it.

Traceability refers to the established connections made between various levels of requirements, risk
analysis, designs, and verification. Trace is the item-to-item relationship made to indicate a connection
between items, whether for indicating the abstraction of requirement to more detailed levels, mitigation
of risk, fulfillment of a requirement by a design, or verification of a requirement. The creation of trace
establishes the traceability of information which can be analyzed to assess change impact, determine
coverage, and identify gaps.

In industries with rapid change and innovation such as medical device development and automotive
manufacturing, an unidentified coverage gap can be risky to end users and costly to remediate. Tracking
of coverage with end-to-end traceability helps eliminate these blind spots and ensure quality.

By relating items [311] according to a set of relationship rules [644], you can assess the impact that
changes can have on other items. When you view items in Trace View or use options to analyze item
relationships, you can determine if you have the coverage you need.

Trace View

Trace View shows related upstream and downstream items. It also shows item details in context of their
relationship and any missing coverage (downstream relationship).

1. Filter item types in Trace View [308].

Configure each level to display or hide fields [31].

3. Find any gaps in coverage.
The red exclamation mark (!) indicates a missing relationship based on the relationship rule [644].
For example, if your item types are System Requirements and Verifications, and your relationship

N
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rule requires System Requirements to have a Verification item downstream, the Trace View displays
a red exclamation mark when a System Requirement is missing the downstream item.

Export the content [307].

Add related items directly from this view with the Add menu option in the toolbar.

Establish relationships between existing items.

Create a global filter to refine tiles to match filter conditions.

No vk

You can also display fields for various item types. For example, you can display the Test Case Status
for verification and verification testing. If a test case item is visible in Trace View, you can navigate
downstream to see any test runs generated from the test cases.

Understanding the Trace View interface

In the Source section, Trace View displays the items that were visible in List View, Reading View, or
Single Item View from the time the Trace View was initiated.

The source

Direct downstream items

Blue arrows = Travel upstream (left arrow) or downstream (right arrow)
Top of each level column = Number of item types on the entire level

HpoObdE

é’ Note
The item count is a unique count. If the same item is downstream of multiple items
in the source column, it appears multiple times in the "1 level down" column, but it's
counted only once.

Save, copy, and bookmark a Trace View

Saving a Trace View lets you bookmark it to quickly find or share it. You can copy a saved Trace View,
then rename and edit it to use as a a new Trace View.

To save a Trace View:

1. Select the Trace View [19] that you want to save, then select Save.
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The Name field is now editable.
2. Edit the name as needed, then select the checkmark (Save) next to the field.

3. (Optional) Bookmark the Trace View by selecting the bookmark icon.

4. (Optional) To see a list of saved Trace Views, select the arrow next to the name.
Bookmarked views appear at the top of the list.
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Bookmarked Trace Views are visible from your homepage; use the URL to share this Trace View with
other users.

Export a Trace View

When you export from a Trace View, the result contains all data from the currently visible columns on
your screen to the Source column. This means that if you are two levels downstream from the source,
the export contains all the levels between the sources and the second level down. All displayed fields are

also exported.

Important
You can export a maximum of six levels from Trace View. If you try to export a view
with more than six levels, the Export button is grayed out.

To export a Trace View:

1. From the Explorer Tree or an advanced filter, select the items you want to export, then select Trace
View.

2. Navigate to the furthest level upstream or downstream that you want to export, then select Export
to generate a CSV file.
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3. Select OK to open the CSV file.

The exported contents opens as a CSV file.

Filter items in Trace View

When you filter items in Trace View, you get the flexibility and control to effectively manage and analyze
your data.

In Trace View, you can refine your results by filtering items by item type, downstream relationship type,
user, and last modified to refine your results.

To filter items in Trace View:

1. In Trace View [19], select the items you want to filter.

2. If the column you want to filter includes more than one item type, select Filter items at the top of
the column.

3. In the window that opens, choose how you want to filter the items, then select Apply.

After the filter runs, a message reports how many levels and item types were filtered. A small blue
dot next to "Filter items" indicates that filters are selected.
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4. (Optional) To remove a filter, select X. To remove all filters, select the refresh icon.

5. (Optional) To keep the Trace View, which you might access frequently, select Save the Trace
View [305]. If you need regular reports on your coverage across certain item types or items that
have been modified recently, select Export the Trace View [307] with filters in place.

6. (Optional) To add a global filter, select Global filter, and in the window that opens, select filter
options from existing categories in the project, then select Set Global filter.

The Trace View is saved or exported.

Relationships
When items are connected, their relationship is used to establish traceability between those items.

When an upstream item changes, you can check all downstream related items to make sure they are still
accurate and verify that the requirements are intact.

A relationship (trace) between items indicates a direction of definition or abstraction from higher-level
requirements or lower-level requirements, from requirements to verification, and from risks to mitigation.

Relationships help you analyze and identify gaps in coverage (such as a requirement lacking verification)
and identify change impact. Filters and Trace View features use relationships in Jama Connect to support
this analysis.

In Jama Connect, relationships between items have a “direction” indicated by upstream and downstream.
These directional relationships are used to assess the impact of a change. For example, if an upstream
item is changed, that change might impact how downstream items are defined. When an upstream item
changes, the relationship between it and any downstream items is considered suspect.

Upstream/downstream relationships support the horizontal and vertical trace of a V-Model, a standard
Systems Engineering approach to requirement definition. Lower-level requirements (downstream require-
ments) are defined based on their upstream requirements (vertical trace) while verification items are
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defined based on their related upstream requirement (horizontal trace). As a result, a change to the
upstream requirement can potentially impact downstream requirements and verification.

With appropriate permissions [310], you can relate items within the same project or between multiple
projects.

You can:

Find and view relationships Add relationships

Single Item View Single Item View

List View

Trace View

Relationships and access permissions

Your ability to interact with relationships depends on your access permissions for each of the related
items. Read more about permissions [656].

Permissions for Permissions for You can...
current item... related item...
Read/Write Read only * View trace relationships.
e View ID and name of related item.
o Modify relationships.
o Create new relationships.
* Navigate to related item and clear suspect links.
Read only or No permission o View trace relationships, but not modify or create new relationships.
Read/Write ¢ See ID and name, but not navigate to related item.
Read only Read/Write * View trace relationships.
o Modify relationships.
e Create new relationships.
o Navigate to related items and clear suspect links.
Read/Write Read/Write e Create, modify, and delete relationships.
o Navigate to related items and clear suspect links.
Read only Read only e View trace relationships.
* Navigate to related items, but not create or modify relationships between the two
items.

Relationship Status Indicator

The Relationship Status Indicator shows an item’s relationship count. The indicator shows red if the item
is missing an upstream or downstream relationship, is suspect, or is causing a suspect relationship.

The Relationship Status Indicator is visible in the Relationship widget of the side toolbar [21], as well as
in a column in List View (when configured [31]).

Relationships widget

-4

Top number — Number of upstream items related to this item.
Bottom number — Number of downstream items.
Red — Item not in compliance with relationship rules.

Gray — Item in compliance with relationship rules.
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List View
When you hover over an icon (exclamation mark, question mark, up arrow, down arrow), you see how
the item violates the relationship rule applied to the project.

An item might violate relationship rules in one of these situations:

¢ Orphan Item — Item is missing a required upstream relationship. Adding a related upstream item
resolves the error.

¢ Missing Downstream — Item is missing a required downstream relationship. Adding a related down-
stream item resolves this error.

e Suspect — Suspect Item means one or more upstream items have changed. Causing Suspect means a
change has caused a suspect relationship with all downstream items. When you've properly assessed
the change, clearing the suspect links resolves the error.

If relationship rules haven't been applied to the project, an error appears only if the link is suspect.

Add a relationship from Single Item View
Creating a relationship establishes a directional link between two items. The related items can exist in
the same project or in different projects.

Important considerations

¢ You must have permissions to a linked related item to be able to preview, open, or edit it. Otherwise,
you can only see the related item’s name, project, and relationship attributes.

o If relationship rules [644] were applied to the project, only items that meet the rule's criteria appear
in the right panel. Likewise, you can only create a relationship with item types that meet the applied
relationship rule. To display the rules associated with this project, select Show Traceability Information
Model at the top of the right panel.
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To add a relationship:

1.  While viewing an item in Single Item View, select Relationships in the side toolbar, then select
Relate Items in the bottom panel that opens.

2. Inthe side panel that opens, select the items you want to relate to the item you're viewing, then
select Relate.
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A relationship is added to the selected item in the direction defined by the rules. It is then immediately
visible in the bottom panel. If the new relationship isn't defined in the rules, you are prompted to define
the relationship direction and type.

Add a new related item
You can add a new item and relate it to one or more items of the same type at the same time.

To add a new related item:

1.
2.

View the items to be related in List View [16] or Trace View [19].

Select the items where you want to add related items. All selected items must be the same item
type.

From the side toolbar, select Add > Add related, then from the drop-down menu, select the item
type for the upstream or downstream items you want to add. The drop-down menu lists only item
types allowed by relationship rules.

When a rule is applied, it dictates the direction and relationship type for the item you want to relate.
If a rule is not applied: In the Relationship settings window, select the direction (upstream or
downstream) and the relationship type for the item you want to relate (must be configured by an
organization administrator) [641], then select Create relationship.

Common examples include: related to, dependent on, derived from, validated by, verified by, or
mitigated by.
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In the Add Item window, enter a name, description, and other details as needed, then select Save.
In the Select Location window, choose where to save this item, then choose Select & Close.
Locations that aren't permitted appear in light gray. You might need to expand folders, sets, or
components to find the location you want.
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7. If you selected Notify, enter the comment, select groups or users to notify, then select Save
Changes.

The changes are saved and the groups or users are notified of the changes.

Allow locked items to be related (organization admin)

As part of your workflow, users can relate two existing locked items. However, this functionality must
first be configured by an organization admin.
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To allow users to relate two locked items:

1. Select ADMIN > Organization, then select Relationships.

2. In the Relationship Options section, select Edit.
3. Select Allow relationship changes between two locked items.
4. Select Save.

Users can now relate two locked items.

Filter relationships
You can filter items to display only items that are related to a single item. For example, you might want to

view only the test cases related to a requirement. The filter is stored until the end of your session, so the
filter remains in effect as you move from item to item.

To filter relationships:

1. In Single Item View, select Relationships in the side toolbar.
2. In the bottom panel that opens, select Filter.

3. In the Relationships filter settings window, choose your own settings or keep the defaults, then
select Apply.
The filtered results appear in the bottom panel.

The filtered results appear in the bottom panel.

To release the filter and see all related items again, select Filter Applied - Click To Restore Defaults.
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Relate to an existing item

Many times, the items you want to relate have already been added to Jama Connect. You can relate
existing items of the same type.

Recently viewed items is the default view, but you can also use the Explorer Tree, Releases tab,
or Search tab to find the items you need.

To relate to an existing item:

1. View the items to be related in List View [16] or Trace View [19].
2. Select the items you want to relate. All selected items must be the same item type.
3. Select Relate to existing.

4. In the side panel that opens, select the items that you want related, then select Relate.

A relationship is added to the selected item in the direction defined by the relationship rule. It is then
immediately visible in the bottom panel of the relationships [764] view. If you establish a relationship
that is not defined by a relationship rule, you are prompted to select a type.

Clear suspect links

Suspect links appear on an item when changes were made to upstream items, meaning the item might
no longer be correct or complete. For example, if a requirement changes, the downstream verification
might no longer correctly verify the requirement as-is. The change to the requirement causes a suspect
relationship to the verification item.
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Only updates to certain fields trigger suspect links. These fields are determined by the organization
admin, who configures item types [674].

Suspect links also cause the relationship status indicator to be red when you view items in List View or
Single Iltem View.

If you determine that a suspect link has no impact or if you make the necessary changes, you can
manually clear the suspect link.

To clear suspect links:

1. Open all suspect links for the project or for a single item [766].
2. Select Clear (one link) or Clear All (all visible items).
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The suspect links are removed.

Run Impact Analysis

Impact Analysis shows you a complete picture of all upstream and downstream related items that might
be affected by changes. You can run an impact analysis on an item or on a change request.

With traceability, you can see how a change might impact a selected item before you make the change.

For example, if you're about to change a requirement, you can run an impact analysis to see the degree
to which the change might impact other requirements and verifications.

To run Impact Analysis:

1. Onanitem — In the top toolbar of Single Item View, select Impact Analysis.

2. On achange request — In the side toolbar of a change request, select Items to change (bell widget)
to open the bottom panel, then select Actions > Impact Analysis.
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Coverage Explorer
The Coverage Explorer is a tool to view downstream relationships (or the lack of them) from a selected
collection of items like a set, folder, or filter. Coverage Explorer provides needed coverage.

You can create and save coverage views and export them to an Excel document [321].

To open the Coverage Explorer, select PROJECTS in the header, then select Project > Traceability >
Coverage Explorer.
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The Coverage Explorer opens. From this window, you can add a new coverage view and look at existing
views.

Create and export views in the Coverage Explorer

Coverage Explorer enables you to analyze the relationships established across items in your project
and identify gaps. For example, you can use Coverage Explorer to identify if any requirements lack
verifications, or to ensure your requirements trace to “passed” verifications.

A view can contain a maximum of 500 items per level. You can bookmark a view to highlight and
prioritize it. Only the view's creator can rename or delete it.

To use Coverage Explorer:

1. Select PROJECTS in the header, then select Project > Traceability > Coverage Explorer.

2. Select Add Coverage View to open the Select Items window.

3. Select the items you want to analyze for coverage.
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To change your view, use the tabs at the top: Recently Viewed, Explorer, Filters, and Releases.
4. With the items selected that you want to analyze, choose Select to close the window.

5. (Optional) To hide, show, or reorder fields for that level, select the gear icon at the top of the
Coverage Explorer.

6. (Optional) To add a new level of downstream relationships, select the green plus button.
You can add only one item type per level. However, if you add a downstream level and leave the
item type blank, Coverage Explorer displays all items regardless of type if type isn't selected.

7. Select Save.

8. (Optional) Deselect the star by selecting it again.

9. Select Export to generate an Excel document.

An Excel document is exported, where you can analyze the results.

Live Trace Explorer

The Live Trace Explorer provides an at-a-glance snapshot of the traceability of your product require-
ments. The generated diagram helps you easily evaluate coverage, address any gaps, and proactively
manage associated risks.

The Live Trace Explorer helps you answer two key questions:

e How complete is my traceability? Completeness is measured by the coverage percentage of the items
in the diagram based on the relationship rules of your project.

e What is the quality of my traceability? By looking at suspect links, we can measure the validity of your
coverage.

To generate a diagram, select an item in the Project Tree, then select Live Trace Explorer diagram.
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The diagram opens in a new browser tab.

e An organization admin must first enable the Live Trace Explorer feature in ADMIN > Organization >
Details before the option appears in Admin Project settings. For more information, see Enable Live
Trace Explorer [330].

¢ An organization or project admin must enable the Live Trace Explorer feature in Admin Project settings
for a project before the option appears in Jama Connect for users with a creator license. Once the
feature is enabled, those users can access the Live Trace Explorer, save existing diagrams, and modify
them as needed. For more information, see Enable Live Trace Explorer for creators [332].

Your role determines the available interactions when you use the Live Trace Explorer feature.

These roles... Can perform these actions...

Organization admins only e Enable Live Trace Explorer
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These roles... Can perform these actions...

Enable Live Trace Explorer for a specific project for users with a creator license
Generate diagrams

View saved diagrams

Configure settings and modify a tile or entire diagram

Use Save as to create a copy of an existing diagram

Save new configuration settings

View Traceability Information Model

Export to PDF

Rename diagrams

Delete diagrams

Organization and project admins*

Users with a creator license View saved diagrams

Configure settings and modify a tile or entire diagram
Use Save as to create a copy of an existing diagram
Save new configuration settings (only if diagram owner)
View Traceability Information Model

Export to PDF

Rename diagrams (only if diagram owner)

Delete diagrams (only if diagram owner)

*Organization admins can access the Live Trace Explorer for all projects. Project admins can create new
diagrams only in projects where they have admin permissions.

What's included in the diagram

The interface for Live Trace Explorer includes a diagram with an overall Trace Score. The diagram consists
of tiles that represent containers generated from the project tree, and trace paths that indicate the status
of the relationships between the tiles.

1. Diagram name — The name of your project or container (project, set, or component) that generated
the diagram.

2. Global filter — Access to the Global filter panel, where you can create a global filter to refine tiles to
match filter conditions.
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Actions menu — Access to the Configuration panel, where you can change the diagram by enabling
or disabling item types and relationships. You can also view the Traceability Information Model for a
project.

Your role and permissions determine which options are available from the Actions menu. For exam-
ple, if you are the diagram owner, you can rename, delete, and save new default configurations for
the current diagram.

Actions =

View saved diagrams

Current diagram

Configuration settings

Save as
Rename

View Traceability Information Model
Export to PDF
Delete

If you aren't the diagram owner, the available options are more limited:

Actions =

View saved diagrams

Current diagram
Configuration settings
Save

View Traceability Information Model

Export to PDF

For more information about the Live Trace Explorer roles and permissions, see Jama Connect Live
Trace Explorer [322].

Trace Score — The overall percentage (0-100%) of the expected relationships and items in the
diagram.

Next to the Trace Score, select Calculation (calculator button) to view a detailed summary of the
Trace Score calculation and the configuration settings that influence the score.
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Vertical trace path — The percentage of valid (green) or suspect (red) relationships between items in
the two connected tiles. A gray line indicates no relationships exist. Hover over the percentage to
reveal the number of valid or suspect relationships.

Specification tile — The container with coverage details for a specific item or relationship. Select the
arrow icon to access that particular data set in Jama Connect.

Items — The list of items and counts that make up the content of a tile. Selecting an item from the
list provides access to List View, which lists all items from the specification tile. From there, you can
navigate to Single Item View to update and add relationships as needed.

Total coverage per tile — The sum of all individual relationship rule coverages. Helps you quickly
identify which tiles and containers need attention.
Coverage relationship rules — Shows the coverage percentage for each relationship rule. Select a

rule to access Trace View, which is filtered to this specific set of items. Update and add relationships
as needed.
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10. Horizontal trace path — The percentage of valid (green) or suspect (red) relationships between the
specification tile and any of its related test cases. A gray line indicates no relationships exist. Hover
over the percentage to reveal the number of valid or suspect relationships.

11. Related test case tile — Container for all test cases related to the paired specification tile.

12. Test plan coverage — A test case is covered when it belongs to a test plan.

Understanding the diagram

The Trace Score in the upper right corner of the generated diagram indicates the completeness of your
project’s traceability. A score of 100% means that all requirements are met for the expected relationships
in your diagram, according to the relationship rules of your project.

Specification tiles and coverage

Specification tiles are generated from the project tree and appear vertically in the diagram in the same
order as the project tree. Test item types don’t appear as specification tiles.

Test case tiles and coverage
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A test case tile is generated from and paired horizontally with a specification tile when a relationship
exists between the item types and a test case item type.

Trace paths

Paired tiles in the diagram are connected by a trace path. The trace path indicates the percentage of valid
(green) and suspect (red) relationships between the items in the paired tiles.

The vertical trace path shows the relationship of items between a pair of connected (upstream and
downstream) specification tiles. The horizontal trace path shows the relationship of items between a
specification tile and its related test cases.

Suspect links

A relationship between two items is considered suspect when changes are made to an upstream item, so
that the relationship might no longer be correct or complete.

For example, if a requirement changes, the change causes a suspect relationship to the verification item.

The horizontal and vertical trace paths don’t affect or contribute to the Trace Score. The number
represents the percentage of valid relationships between the items in the upstream tile and the items in
the downstream tile.

With this information, you can pinpoint areas that need attention and investigate by looking at each
relationship and item.
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By default, the trace path displays a percentage. When you hover over the percentage, the exact number
of valid relationships is displayed.

Interpreting the Trace Score calculation

The Trace Score is the overall percentage (0-100%) of the expected relationships in the project. You can
generate a Trace Score at any level in your project — for example, system requirements, validation, or
test.

The Trace Score is scoped to the contents of the diagram, which can be configured through the diagram
settings. The score is based on the total number of expected relationships between the items (as defined

by the relationship rules set by the project admin).

For example, if you have one item that can be related to three different items, the expected number of
relationships is three. If you have two of those items, the expected number of relationships is six.

Next to the Trace Score, select Calculation (calculator button) to view a detailed summary of the Trace
Score calculation and the configuration settings that influence the score.

For more information, see Requirements Traceability Benchmark.

How the trace path figures are calculated

In the generated diagram, the horizontal and vertical trace paths between the tiles represent the validity
of the relationships between items in the paired tiles.

The default view of the trace path displays the percentage of valid and suspect links. You can see the
actual number of valid and suspect links by hovering over the trace path percentage.
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Horizontal trace path — The validity of the relationships between a parent tile and its corresponding test
case tile.

Vertical trace path — The validity of the relationships between a parent tile and its downstream child tile.
The percentage and number are calculated in this manner:

1. Calculates the total number of existing relationships between the parent tile and its corresponding
child tile.

2. Compares the total against the number of valid relationships (green), presented as a percentage of
the total.

3. Compares the total against the number of suspect relationships (red), presented as a percentage of
the total.

Example
A tile pair has a total of 50 existing relationships, with 45 valid and 5 suspect relationships.

® % of valid relationships = 90% (45/50 x 100 = 90%)
e % of suspect relationships = 10% (5/50 x 100 = 10%)

For this example, the horizontal trace path displays these calculations:

Enable Live Trace Explorer (organization admins)
Organization admins must enable the Live Trace Explorer feature before it appears in projects and as an
option in Admin Project settings. By default, this feature is disabled.

To enable Live Trace Explorer:

1.  From the Jama Connect header, select ADMIN > Organization > Details.
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2. Next to Live Trace Explorer, select Configure.

3. In the window that opens, select Enable Live Trace Explorer, then select Save.
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The field Live Trace Explorer changes to Enabled.

Now, the Live Trace Explorer feature is visible in Admin Project settings and available to configure for
users with a creator license [332].

Enable Live Trace Explorer for creators (organization and project admins)

Organization or project admins must enable the Live Trace Explorer feature for users with a creator
license. Once this setting is enabled, users with a creator license can access Live Trace Explorer from the
Project menu. From there, they can view and edit saved diagrams within the project.

Important considerations

¢ This setting is disabled by default.

e Organization admins must enable the Live Trace Explorer feature before it appears in projects and as
an option in Admin Project settings.

e Users might be able to see the names of item types and containers in a project even if they have
limited access to that project.

To enable Live Trace Explorer for creators:

1. From the Jama Connect header, select ADMIN > Project.

2. Inthe project tree, select the project where you want to enable the Live Trace Explorer feature, then
select the Settings tab.

3. Select Edit, then select Enable Live Trace Explorer for Creators.
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4. Select Save.

The field Enable Live Trace Explorer for Creators changes to Yes.

Now, users with a creator license see Go to Live Trace Explorer when they select an item in their project
tree. They can now also view and edit saved diagrams from this project.

Save an existing diagram

When you copy an existing diagram as your own, you can modify an individual tile or the entire diagram,
rename it, or delete it.

Important

Users with creator licenses can access saved diagrams only in projects where the Live
Trace Explorer Admin setting is enabled.

To save an existing diagram:
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1. From the top navigation, select the Actions menu, then select View saved diagrams.

The Saved diagrams panel opens.
2. Select My diagrams or All diagrams, then select the diagram you want to copy.

The diagram you selected appears on the page.
3. Select the Actions menu, then select Save as.

4. In the window, enter the diagram name, then select Save.
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A pop-up message notifies you that the diagram was saved, and the diagram now reflects the new name.

Generate a diagram (organization and project admins)

The Live Trace Explorer feature provides an at-a-glance snapshot of the traceability of your product
requirements, so you can fix any missing coverage.

You determine the scope — by project level or container level — so you can customize the diagram to
meet your organization’s needs.

Important

Organization admins can access the Live Trace Explorer for all projects. Project admins
can access the Live Trace Explorer only in projects where they have admin permissions.

To generate a diagram:

¢ Inthe Project Tree, select the project or container that you want to include in the diagram, then
select Live Trace Explorer diagram.

The diagram opens in a new browser tab.
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Modify a tile in the diagram
When you don'’t need to track or include certain data in a specific tile, you can modify the diagram by
turning on or off specific items or relationship rules in that tile.

Scenarios for modifying a tile

e |f a specific item or relationship rule isn't needed for the Trace Score, you can exclude it from the tile
without excluding it from other places in the diagram.

e If a specific item or relationship rule isn't applicable to a certain phase of your project, you can turn it
off to reduce noise.

Important considerations

o All item types and relationship rules are turned on by default.

¢ When an item type is turned off, all relationship rules associated with that item type are automatically
turned off.

e Selections and exclusions are made to an individual tile from the specification tiles. To make selections
or exclusions from Global settings, see Modify the entire diagram [345].

¢ To filter an item type, that item type must contain at least one picklist or multi-select field.

¢ You can set up to 10 conditions per item type filter.

To modify one tile in the diagram:

1. From the top navigation, select the Actions menu, then select Configuration settings.
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The Configuration panel opens to the left of the diagram and lists all the specification tiles that exist
within the diagram. By default, all item types are included.

2. To turn off an item type:
a. Inthe Specification tiles section, select the tile you want to modify (for example, System
Requirements).
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b. Select the green toggle switch for the item type you want to turn off. The toggle switch is gray
when the item is turned off.

< System Requirements 86 b

Item types from this tile @ 1

| | Expand all relationship rules

» System Requirement Y

c. Select Apply.

A confirmation message notifies you that the diagram was updated.

d. (Optional) To include the item type again, select its gray toggle switch to turn on the item. The
switch appears green with a checkmark to indicate that the item type is again included in the
diagram.

3. To turn off a relationship rule:

a. Inthe Specification tiles section, select the tile that includes the relationship rule you want to

turn off.
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b. Select the arrow icon to expand the list.

c. Select the blue checkbox next to the relationship rule you want to turn off (for example,
Validation). The checkbox is unchecked and gray when the relationship is turned off.
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In the example below, relationship rule Validation is turned off.

d. Select Apply.

A confirmation message notifies you that the diagram was updated.

e. (Optional) To include the relationship again, select the gray checkbox to turn on the relation-
ship. The checkbox appears blue with a checkmark to indicate that the relationship is again
included in the diagram.

4. To filter an item type:

a. Inthe Specification tiles section, select the tile with the item type you want to filter, then select
the Filter button.
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b. Inthe window that opens, set one or multiple conditions: select filter options from existing
fields assigned to this item type, then select Set filter.
You can set up to 10 conditions per item type filter.

A teal dot on the Filter button indicates that a filter has been set.
c. To apply the changes, select Apply.
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A confirmation message notifies you that the diagram was updated. The filtered Specification
tile, trace score, and any associated trace paths are refreshed.
5. Toremove a filter:
a. Next to a filtered item type, select the Filter button.
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b. Inthe window that opens, select Remove.

c. To apply the changes, select Apply.
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A confirmation message notifies you that your configuration settings were updated.
6. To update a filter:
a. Next to a filtered item type, select the Filter button.

b. Inthe window that opens, select the filter options you want to change, then select Update.
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The changes are reflected in the filter.
c. To apply the changes, select Apply.

A confirmation message notifies you that your configuration settings were updated.

Modify the entire diagram

When your project doesn't require that you track an item type or if you have a relationship rule to
exclude, you can turn it off for the entire diagram.

Scenario for modifying the diagram globally

e If a specific item type or relationship rule isn't needed for the Trace Score, you can turn it off for the
whole diagram rather than manually turn off each item type or relationship rule in every tile.
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e [f a specific category is needed for the entire diagram, you can apply a global filter to the diagram.
Important considerations

o All item types and relationship rules are turned on by default.

¢ When an item type is turned off, all relationship rules associated with that item type are automatically
turned off.

e Selections and exclusions are made to the entire diagram from Global settings in the Configuration
panel. To make selections and exclusions to an individual tile, see Modify a tile in the diagram [336].

e Open conversations represent the total number of comments from all items in that tile. By default, this
setting is enabled.

¢ You can set up to 10 conditions in a global filter.

To modify the entire diagram:

1. From the top navigation, select the Actions menu, then select Configuration settings.

The Configuration panel opens to the left of the diagram.
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2. To turn off an item type:
a. Inthe Global settings section, select All item types.

The panel displays the available item types. All item types are enabled by default (toggle switch
is green with a checkmark).

b. Select the item type you want to turn off, then select its green toggle switch to turn it off. The
toggle switch is gray when the item type is turned off.
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c. Select Apply.

A confirmation message notifies you that the diagram was updated.

d. (Optional) To include the item type again, select its gray toggle switch to turn on the item. The
switch appears green with a checkmark to indicate that the item type is again included in the
entire diagram.

3. To exclude open conversations in tiles:
a. Inthe Global settings section, select Diagram settings.

Configuration panel X

Global settings

Diagram settings »

All item types »
b. Select Include open conversations in tiles.
< Diagram settings X

I:I Include non-rule relationships in diagram

This includes any current relationship that no longer has a defined
relationship rule or that was made with the "Allow any items to be related”

option enabled in Admin.

[C] Include open conversations in tiles

c. Select Apply.
A confirmation message notifies you that the diagram was updated.
4. To include non-rule relationships:
a. Inthe Global settings section, select Diagram settings.
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Configuration panel X

Global settings

Diagram settings -

All item types 2
b. Select Include non-rule relationships in diagram.

< Diagram settings X

Include non-rule relationships in diagram

This includes any current relationship that no longer has a defined
relationship rule or that was made with the "Allow any items to be related™

option enabled in Admin.

c. Select Apply.
A confirmation message notifies you that the diagram was updated.
5. To turn off relationship rules:
a. Inthe Global settings section, select All item types.

Configuration panel X

Global settings

Diagram settings »

All item types »

b. Select the item type with the relationship rule you want to turn off, then select the arrow or
select Expand all relationship rules to expand the list.
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c. Select the blue checkbox next to the relationship rule you want to turn off (for example,
Validation). The checkbox is unchecked and gray when the relationship is turned off.

d. Select Apply.
6. To set a global filter:

' Tip
% You can also access the Global filter from Configuration panel.

a. From the top navigation, select Global filter, then select the Global filter button.
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b. Inthe window that opens, select filter options from existing categories in the project, then
select Set Global filter.

A teal dot on the Global filter button indicates that a filter has been set.

test ¥

c. Select Apply.
A confirmation message notifies you that the diagram was updated.
7. Toremove a global filter:
a. From the top navigation, select Global filter, then select the Global filter button.

b. Next to the category label, select X to remove a single condition or select Clear all.

c. Select Apply.
A confirmation message notifies you that the diagram was updated.
8. To update a global filter:
a. From the top navigation, select Global filter, then select the Global filter button.
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b. From the Global filter panel, select the filter options you want to change, then select Update.
c. Select Apply.

A confirmation message notifies you that the changes were applied to the diagram.

To include the relationship again, select the gray checkbox to turn on the relationship. The checkbox
appears blue with a checkmark to indicate that the relationship is again included in the entire diagram.

Export a Live Trace Explorer diagram to PDF

From the Actions menu, you can export a diagram as PDF. This feature uses your browser's printing
capabilities to save the diagram as a PDF, which is useful for tracking metrics over time and monitoring
progress.

To export a diagram to PDF:

1. From the top navigation, select the Actions menu, then select Export to PDF.

The "Print" window opens.
2. Update the settings as needed, then select Save.
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The "Save" window opens.
3. (Optional) Rename the PDF, then select the location where you want it saved.
4, Select Save.

The PDF is saved to the location you selected.

Reuse and synchronization

With reuse [355] you can copy items and containers of items such as components, sets, and folders,
along with any supporting information. With synchronization [363] you can maintain a connection
between reused items and containers, monitoring them for differences and updating any that are out of
sync.

Supporting information that can be duplicated [90] includes:

e Entire item
e Item fields
¢ [tem widget relationships, tags, attachments
e Child items

When items are synchronized, they receive a Global ID that they share regardless of their location in the
system. You can synchronize the items that you reuse, or connect existing items so that they share a
Global ID and can be synchronized.

To keep track of synchronized items, you use the Sync Items window, where you can compare
items [370] and decide how to update synchronized items.

You can see which items are synchronized in the Explorer Tree. A blue dot on the item’s icon indicates
that the item is synchronized.
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Important considerations

e Only an organization admin can configure reuse and synchronize [627] options.
e While the link to an attachment is synchronized, the content in the attachment is not.

e Reusing and synchronizing items adds activity entries to the stream [253] for all items created or
modified during the process.

¢ Reuse and synchronization can require significant memory, especially if your organization has a large
Jama Connect database and has heavy reuse or heavy synchronization use.

e Reusing and synchronizing hundreds of items can affect system performance. When you try to reuse
and synchronize hundreds of items, a warning appears that performance is likely to be impacted.

O Notice

- To reuse and synchronize hundreds of items, run the reuse and synchronization options
in smaller batches or start the process during off hours when demand for resources is
less.

Global ID

A Global ID is an identifier of synchronized items. While every item has its own unique ID [731], which is
also the project ID, synchronized items share a Global ID.

Items that share this Global ID are considered cloned artifacts, despite being in different areas of Jama
Connect.

Global IDs have two parts:

¢ Global ID prefix — The Global ID (for example, GID-) is the same across the organization. An organiza-
tion admin can change the Global ID prefix [620].

¢ Global ID counter — The Global ID counter is a number that increases for each new Global ID. It can
only be reset or reduced by an organization admin. If a user tries to set the counter value below the
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Last Used Global ID Counter, Jama Connect shows an error message notifying the user to choose a
greater value.

When items are synchronized, they are assigned the same Global ID. When an item is removed from this
group through Break sync [365], a new Global ID is assigned.

Use cases for reuse and synchronization
Typical scenarios for reuse and synchronize include:

¢ Duplicate — Make a copy of items, containers, sets, or folders for reuse. Synchronization is optional
but can be enabled between duplicated items.

e Library — Create a library to establish system-wide standards in your organization for all business
units to follow. These standards might include common business practices, rules, glossaries, or non-
functional requirements that teams must reference but can’t modify. This information can be created
and managed in one place and reused in projects where applicable.

% Best Practice

o If you're using a library to push changes to many projects, you can synchronize items
to push changes from your “library” project to all other project items that share the
same global ID. To do this, you must have write access on all projects included in the
sync.

¢ Shared requirements — Large projects typically adhere to a common set of requirements, but often
each requirement also has information specific to and managed by a project. For example, a require-
ment name and description can be shared across multiple projects, but release values, priorities,
assignments, and relationships are managed by each project.

¢ Branching — You can split a set of artifacts into several branches so that each branch can be modified
at the same time.
This can be useful when you want a snapshot of items at a point in time, but still allow the items to be
modified at the same time. In this case, reuse results in the versioning of an entire document made up
of multiple items, rather than a version of only a single requirement.

¢ Release management — Similar to branching, reuse and synchronization let you use items across
multiple releases in parallel. Typically, in this scenario, projects in Jama Connect represent a release.

¢ Project template — You can set up a project as a template that you reuse and synchronize. A template
lets you ramp up new projects quickly or establish standard practices on content organization. You can
also push updates to all projects that used the template.

Reuse

If your projects contain items that are often the same or slightly different, reusing items helps you work
more efficiently. You can reuse items over multiple projects and synchronize them, as needed.

Reuse for users

Selecting items to reuse can be helpful if you are creating several copies, but want the original “source”
item to maintain a connection with its copied items.

For example, you might have a set of requirements from a library project in Jama Connect and need to
reuse it in several other projects. You copy the set to Project 1 and Project 2. When viewing the copied
requirements in Project 2, users might see an upstream relationship to the “source” requirements in the
library. Adding or not adding this relationship has no impact on how items are compared or synced.

You can only reuse items in sets of the same item type. For example, if you have two requirement sets in

a project created from the same item type, you can duplicate and move items between these sets. Child
items can also be reused, but they must be the same item type as the parent item.
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O Best Practice

- If you have several items that are reused regularly, put them in a central project so
future changes to items can be maintained from a central location. For instance, during
reuse, relationships can automatically be created that are inconsistent with the relation-
ship rules of a specific project.

Reuse administration
Sync compare views and Advanced Reuse options are best managed by a dedicated reuse admin. An
organization admin can assign reuse admin permissions [667].

Reuse admins are the only ones who can:

e Edit and delete Compare Views of synchronized items.
¢ Manage (add, edit, delete) reuse rules under Advanced options.

Reuse an item
You can reuse individual or multiple items or containers of items such as components, sets, and folders.
Items can be reused in the same project or in a different project.

. u Tip
o To quickly make a copy of an item in the same project, use the Duplicate items [90]
option.

To reuse an item:

1. Select items for reuse with one of these methods:
o Explorer Tree — Select the item or container that you want to reuse, then select Reuse items in
the context menu.
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o List View — Select the items you want to reuse, then select Reuse.

¢ Document View — Select the items you want to reuse, then select Reuse.

357



Managing your content

2. Inthe Reuse Items window, select the source items you need.

3. On the Basic tab, select the options you want.
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¢ Sync items and share Global ID — Gives the source item and the destination item the same global
ID. With the same global ID, changes to one item flag the relationship between them as out of
sync.

e Append a prefix — If items are being reused but not synchronized, you can append a prefix to the
new item to differentiate between two copies of the same items. Enter the prefix you want to use
in the field.

¢ Add a relationship from the original item —Creates a relationship between the original item and
the new item.

¢ Include all tags, attachments, and links — Duplicates all tags, attached files, and URL links asso-
ciated with the items. If an existing item is overwritten and this option is selected, all tags,
attachments, and links are updated to match (removes any tags, attachments, or links that existed
in the destination but not in the source item). If this option isn't selected and you overwrite an
existing item, any tags, attachments, and links are cleared in the destination item.

¢ Include categories — Includes categories with the reused items in the destination project. The cat-
egory isn’t reused if it's deleted from the destination project, or the organization admin reorders
or removes the category path.

¢ Do not include relationships outside of the source selection — Copies only the source item. Rela-
tionships within the source item aren't copied. For example, if the source item has a component
that contains Features, Requirements, and Test Cases, relationships between those selected items
are copied when the component is reused.

However, those relationships aren't copied if any source items have relationships to items outside
the source component, such as a relationship between a requirement in the source component
and a use case in another component that is not reused in this action.
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¢ Include relationships from the source selection — Copies the items and relationships contained
within the source. For items within the source that have relationships outside the source, the
copies of these items have relationship created to those same related items outside the source.

¢ Include related items and mirror relationships — Copies the items and relationships contained
within the source. Any items outside the source that are directly related to items within the
source are also copied.

Important
If you change the hierarchy of the source component, changes aren't made in the
destination component.

4, Select a target destination for the item.

ity Semiconductor Project 2.0 v

@®©

Reuse source project hierarchy in destination
project

Manually select location(s) for reused item(s)

Reused items will be placed in the destination project
based on the hierarchy of the source project. The
system will automatically create components, sets, and
folders in the destination project as needed if a matching
location is not found.

¢ Reuse source project hierarchy in destination project — Reuses the project structure that con-
tains the reused items. For example, if a folder is selected for reuse, the set that contains the
folder is also reused.

e Manually select location(s) for reused items(s) — Select a specific location to place the reused
content. The target location must contain a valid location to house the reused items. For example,
if you select this option when reusing a System Requirement, the target location must have a set
of System Requirements.

5. Select Reuse and sync at the bottom of the window. If you reuse something that has already been
reused, you are prompted to select Overwrite Items or Skip Items.
6. In the Reuse Complete window that shows a summary of what was reused, select one:

e View Results — Shows a list of all newly reused items.

¢ Reuse again — Reuses the same source items in a different location.

¢ Finished — Closes the window.
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The reused items are saved.

Note
ﬁ Rich text images still reference the original source project and are accessible to users
outside of that project.

Add and edit reuse rules
As the reuse admin, you can create reuse rules and edit existing reuse rules.

Any field left unchecked uses its default values.

Important
You must be a reuse administrator [355] to perform these tasks.

To add and edit reuse rules:

1. Select items for reuse from the Explorer Tree or List View, then select Reuse.

2. In the Reuse Items window that opens, under Reuse Options, select the Advanced tab.
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3. Add arule or edit an existing rule:
o Existing rule — Select edit next to a rule name.
o New rule — Select Add Rule, select Add item type rule, then select an item type from the
drop-down menu.

¢ Define how to handle upstream and downstream items that are related to this item type: select
the green Related button. You can add multiple rules for each item type and each rule can include
a maximum of 16 levels.
¢ To remove a level or rule, select the red Delete (minus) button.
4. Configure the reuse options that you want to apply to these rules:
¢ Sync items and share Global ID — Gives the source item and the destination item the same Global
ID so that changes to one item flag the relationship between them as out of sync.
¢ Append a prefix to the names of the copied items — For items reused but not synchronized, adds
a prefix to the new item to differentiate it from the original. Enter a prefix in the field.
¢ Add a relationship from the original item — Creates a relationship between the original item and
the new item.
5. At the bottom of the window under Fields to Copy, select Configure next to each item type you
want to configure to limit the fields and widgets to be copied.
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6. On the Fields tab, define whether all fields or specific fields are copied.

Important

Release fields can't be reused and synced between projects because they are
unique to each project.

7. On the Widgets tab, define whether to copy tags, attachments, and links.
8. Select Done.

Your changes are saved and the window closes.

Synchronization

Synchronization checks for differences between reused items and containers. When differences exist,
users can update the corresponding information for those items or containers.

Synchronized items are only visible if you have read permissions to both items. You must have write
permissions to edit, synchronize [367], reuse [356], or duplicate items.

If you change the hierarchy of a source component, those changes aren't synchronized in the destination
component.

When you convert a synchronized item to a different item type, such as converting a Requirement to a
Feature Request, the item loses its synchronization and receives a new Global ID.

Note

y Synchronization changes don't trigger suspect links [317]. Synchronizing doesn’t remove
deleted items. For example, if an item is deleted from the original component, you can't
choose Sync All to delete that item from the new component.

Synchronization updates are allowed only on projects where you have read/write permissions. You can
pull data from projects where you have read-only permissions, but you can't push data to items in those
projects.

When you add a new item to a synced container, Jama Connect indicates that the item is out-of-sync.
Syncing the containers results in the creation of that item in the synced container.

You can synchronize items using any of these methods:

¢ When you connect items from Single Item View [369]

¢ In the Sync Options window (when syncing multiple items) [367]
e When you reuse items [356]

¢ When an organization or project admin duplicates projects [719]
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Note
é’ If items with the same Global ID are not allowed in the same project, Jama Connect
doesn't allow you to reuse in the same project with sync enabled.

Sync options window

When viewed from Compare View, the Sync Options window is divided into top and bottom sections,
which correspond to the left and right columns in Compare View, respectively. The functionality is the
same for each section.

When you select the Basic tab in the top right corner, you can view and select these options:

Basic options

Handle relationships e Don't synchronize relationships.
¢ Include relationships from the source selection
e Include related items and mirror relationships

Options as needed ® Synchronize all tags, attachments, and links.
When synchronizing related items that don't exist in the destination project, all fields, tags, attach-
ments, and links are reused. Fields that aren't applicable to the destination project are set to defaults.
Only links to attachments are synchronized, not the attachments themselves.

e Add a relationship from the original item

Default destination e Reused items are placed in the destination project based on the hierarchy of the source project.
uses the specified tar- o If a matching location isn't found, the system automatically creates components, sets, and folders in
get destination the destination project as needed.

When you select the Advanced tab in the top right corner, you can view and select these options:

364



Managing your content

Advanced options

Reuse rules shown are filtered by item type.
Deselect Only show applicable to display all reuse rules.
Select Add rule to add a new rule to the items selected in this view.

Display and mod-
ify existing reuse
rules or add new

ones
Select a destina- o Select Manually select location(s) for reused item(s) to select a specific destination for your synced items.
tion o Select Synchronize to sync all fields specified in the reuse rules in the Sync Options window. This also

removes all attachments, tags, links, and relationships if selected.

When synchronizing related items that don't exist in the destination project, all fields, tags, attachments,
and links follow the sync option that's applied to the view (fields that aren't applicable to the destination
project are set to defaults).

Select Synchronize to sync items based on the selected Sync Options setting.

When synchronizing related items that don't exist in the destination project, all fields, tags, attachments,
and links follow the sync option that's applied to the view.

Break synchronization

When you break the synchronization, the connection is removed between items and other relationships
built on this connection. The removed item receives a new Global ID. Further synchronizations for that
original Global ID don't affect the item with the broken connection.

To break synchronization:

1. Access the Number of Synchronized Items panel using one of these methods:
e Open the Sync Items window by selecting an item in the Explorer Tree and selecting View synced
items.
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¢ In Single Item View of the item whose synchronization you want to break, open the bottom panel
by opening an item in Single Item View, then selecting the Synchronized items widget.

[V
(4

A
Synchronized items 3

In the window that opens, select an item and select Break Sync.

In the Sync Items window, break the synchronization for one item or all listed items:

¢ One item — To remove the sync from a specific item and assign a new Global ID, select Break
Sync in the same row as the item.

¢ All listed items — To break the synchronization between all listed items and assign a new Global
ID to each item, select Break Sync at the top of the window.
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4. When prompted to confirm, select Yes.

A message confirms that the item is no longer synchronized.

Synchronize items from Synced Items window

Synchronization checks for differences between reused items and containers. When differences exist,
you can update the corresponding information for those items or containers.

To sync item from the Synced Items window:

1. Open the Sync Items window: In the Explorer Tree, select the item, component, or set you want to
sync, then select View synced items.
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2. Select Sync All to open the window for all displayed items or use the up or down arrow to sync
changes to or from the displayed items.

3. Select Compare to open the Compare View, then use one of these synch methods:
e One item — Use the right or left arrow for each item to sync it in a particular direction.
o Multiple items — Select multiple items (highlighted in blue) with the Ctrl+Shift keys, then use the
arrows at the top of the Sync All column to synchronize all items in one direction.
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Important

When you synchronize an item, a new version of that item is created. If the sync
was done by mistake, it can't be undone but you can make the prior version
current. This applies to field updates only, not to relationships created or new items
created.

4. (Optional) The Batch Sync window displays the selected number of items to update, with Selected
Items chosen by default. If needed, select All Items.

5. Select Batch Sync to complete the update.

¢ Sync items — Only fields that are enabled as synchronized fields [691] are updated. Child items
are added to the destination if they exist in the source only.

¢ Sync a container — The container and all children are synced unless you created advanced reuse
rules [361] that specify otherwise.

The update is complete.

Connect items from Single Item View
If you want items to share a Global ID, you can connect them to keep them in sync.

To connect items from Single Item View:

1. Open the bottom panel in Single Item View [21].
2. Inthe bottom panel, select Connect Items.

3. Inthe panel that opens, select the item you want to connect to, then select Connect.

To help you find the item, you can use the Recently Viewed, Search, Explorer, or Releases tabs. You
can also select Preview to open a window with details about an item.

369



Managing your content

The newly connected item now appears in the bottom panel with the same Global ID. This change also
appears as an activity in the Stream [237].

Compare synchronized items
You can compare synchronized items to see what has changed.

To compare synced items:

1. Open the Sync Items window: In the Explorer Tree, select the item, component, or set you want to
sync, then select View synced items.
The selected item or component is displayed with a sync status that lets you know whether that
item is in sync or out of sync.
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2. If the item is out of sync, select it to open a Detailed Comparison View of those differences.
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3. To view the differences at an item level, select Compare.

A list of all synchronized items in that component is displayed.

4. To filter items within a component, use the links at the top. Use your mouse to scroll left or right so
you can compare fields.

5. Select Configure View to configure which fields are displayed [374]. Yellow highlights indicate
synchronized items with content that doesn't match.
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Note
i If an organization admin didn't enable a field to be synced [691], it's never highligh-
ted in yellow, and it can't be synced.

6. (Optional) Select Save Diff View.

7. For more information that helps determine whether to sync something, select Detailed compare

view for the items you want to compare.
The Detailed Compare View window lists changes, with old text red and highlighted and new text

green and underlined.
8. To synchronize the data, select the green arrow or the pencil icon to manually edit the content of

the fields.
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9. Select Save when you're done.

Your changes are saved and the Detailed Comparison View window closes.

Configure Compare View for synchronized items
Configuring the Compare View window allows you to customize which fields you see, as well as relation-
ships, widgets, and item types.

To configure Compare View:

1. Inthe Explorer Tree, select the item, component, or set you want to sync, then select View synced
items.
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2. Inthe Sync Items window that opens, select Configure View in the top right corner.

3. From the drop-down menu at the top of the Configure View window, select the item type you want

to configure.
4. On the Fields tab, move the fields you want from the Hidden Fields column to the Visible Fields
column, and move those you don't want to the Hidden Fields column. You can drag or use the

arrows.
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Configure view

[tem Type to Configure: Information 2
Fields Relationships Widgets

Drag and drop to hide/show and re-order fields

Hidden fields Visible fields
Project ID ltem Type
Glebal 1D Mame

Text Box_not_richwithlongname Description
Text field
Heading

APIID

Locked

Last Locked By
Last Locked
Created By
Created Date
Modified By
Modified Date
Project

Last Activity Date

®IE

Apply Cancel

5. On the Relationships tab, select whether and how to view relationships in the Compare View
window.
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6.

Configure view
ltem Type to Configure: Mixed ltem Types

Fields Relationships Widgets

View the following relationships

O Do not view relationships
() view all directly related items
@} Wiew specific related items

Filter the relationships that you would like to view

When viewing a

377

Apply

On the Widgets tab, select the widgets you want to see in the Compare View window.
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Configure view
ltem Type to Configure: Mixed Item Types 7

Fields Relationships Widgets
View these widgets
Tags
Attachments

URL Links

Apply Cancel

7. (Optional) To save the changes you made in this window, select save a Compare View [370].
Otherwise, the changes don't persist when you close this window.
8. Select Apply to save your changes.

The window is refreshed and your changes are saved.

Exporting data to a document

When you need to create a document from your Jama Connect content, you can export the data to
Word, Excel, or PDF. This is useful for stakeholders who don'’t have access to Jama Connect.

Word and Excel exports

You can use the standard export to Word and Excel or you can create a custom export with Office
Templates [386].

Standard export (without a template) — To export data directly to Word [379] or Excel [380] in List View,
or Document View, you can use advanced filters [150] or the Explorer Tree.
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Custom export (with a template) — To speed your work and improve consistency, use a template to
export data. With Excel templates, you can easily create and share your customized analysis. With Word
templates, you can create standardized documents that are automatically populated with your data.

To export to a specific template, you can download an existing template [389] and modify it as needed.

Export to Word

You can export a set of items to a Microsoft Word document. You can export from List View or
Document View.

The default Word export is a boilerplate that was created with Office Templates. You can modify the
default template to meet your needs.

u Tip
o Word for Mac is known to have some issues with exporting certain formats and tables.
If you experience issues, eliminate special formatting or tables within tables.

To export data to a Word file:

1. Select the items you want to export using the Explorer Tree or an advanced filter, then select the
view: List View or Document View.

2. (Optional) Customize your output by including fields or excluding fields for your document:
a. From your view (List View or Document View), select the gear icon to display the list of
available fields.

379



Managing your content

b. Select the fields you want to include in your document and deselect the fields you don't want.
c. Select X to close the window.
The screen now includes only the fields you selected.

3. Inthe toolbar, select Export > Export to Word.

Your exported content is displayed according to the view you selected:

e List View — Exported items are displayed as a table of contents, followed by each item, its name, and a
list of its field names and values.
e Document View — Exported items are displayed as section headings followed by item details.

L] Method Results
Explorer Tree The selected container becomes the title page for the export.
Advanced filter within Reading View includes the container hierarchy above the filtered items, up to the top of the project.
one project Container items that show hierarchy have a grayed-out (disabled) checkbox, while the rest of the items
can be selected. Hierarchical containers are exported with the content items.

Export to Excel
If you need to provide data to external stakeholders who don't have access to Jama Connect, you can
export to Microsoft Excel.

You can export selected items to two types of Excel template:
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e Default boilerplate template
o Office Templates, which can be customized

You can also use Excel roundtrip to update and re-import existing data.
Important considerations

¢ Don't use field names in Jama Connect that start with the equal symbol (=). When Excel encounters a
field value that starts with =, the cell is interpreted as a formula. For example, if the name of an item in
Jama Connect is =1338-1, Excel interprets it as a formula and the value is displayed as 1337.

e Excel doesn't support rich text. Jama Connect removes formatting when it exports to Excel.

To export data to an Excel file:

1. Select the items you want to export using the Explorer Tree or an advanced filter, then select the
view: List View or Document View.

2. (Optional) Customize your output by including or excluding fields for your document:
a. From your view (List View or Document View), select the gear icon to display the list of
available fields.
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w

b. Select the fields you want to include in your document and deselect the fields you don't want.
c. Select X to close the window.

The screen now includes only the fields you selected.

In the toolbar, select Export.

From the drop-down list, select an option:

¢ Export to Excel — To use the default boilerplate. Your results appear immediately.

¢ View all export options — To create a customized template, select an Excel export option, then
select Run.

o Export to Excel default — To generates an export that includes the fields that appear in List View
(one column per field).
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¢ Excel Export for Roundtrip — To update and re-import existing items in Jama Connect. Includes all
available fields. Edit the resulting spreadsheet and import the changes back into Jama Connect.
All fields that you plan to update using roundtrip must be included in the export, including rich
text fields like Description. Rich text is output in raw HTML format, so the content can be
preserved when re-imported.

A confirmation message appears with a link to the report.

Export to PDF

You can export a set of items as a PDF file using the PDF reports included with Jama Connect. If you
want to show your content in context, you can include hierarchy in these exports. The default export is
created with Office templates and can be modified as needed.

Note
y For information about creating custom PDF reports and how to make existing reports
PDF-compatible, see Export Velocity reports to Excel [464].

To export data to a PDF file:

1. Select the items you want to export using the Explorer Tree or an advanced filter, then select the
view: List View or Document View.

2. (Optional) Customize your output by including fields or excluding fields for your document:
a.  From your view (List View or Document View), select the gear icon to display the list of
available fields
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b. Select the fields you want to include in your document and deselect the fields you don't want.
c. Select X to close the window.
The screen now includes only the fields you selected.

3. In the toolbar, select Export > Export to PDF.

Your exported content is displayed according to the view you selected:

¢ List View — Exported items are displayed with a table of contents, followed by each item, its name,
and a list of its field names and values.

e Document View — Exported items are displayed as section headings followed by item details.

Restore line breaks by updating Report Parameters (organization admin)

When exporting data, extra line breaks are removed by default to improve the published document.
However, this might cause consecutive tables to be combined.

To restore line breaks to your previous exported results, you can apply a new parameter to the Report
Parameter field in the template.
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Note
é’ You must have organization admin permissions to adjust this setting.

To update Report Parameters:

1. Select ADMIN > Organization, then select Reports.
2. Choose the report you want to restore, then select Edit to open the Add/Edit Report window.

3. Inthe Report Parameters field, add the parameter.

385



Managing your content

¢ To remove extra line breaks:
cleanEmptyParagraphs=true
¢ To keep extra line breaks:
cleanEmptyParagraphs=false
4. Select Save.

A message confirms that the report was successfully saved.

Office Templates

Microsoft Office Templates are Word documents and Excel spreadsheets that allow you to add format-
ting to your exported data.

u Tip
o Office Templates are best for simple exporting with Word and Excel using data that you
select in the Explorer Tree or with an advanced filter [150].

To open the Office Templates window, select Export > View all export options.
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The Office Templates window shows several default templates that come with Jama Connect. You can
download an existing template [389] and use it as is or modify it, or create your own template in Word
and upload it [390]. Select the bookmark next to a template to move it to the top of the list.

Your system or organization admin can upload custom Velocity exports [638] that are displayed in the
Export window.

4i¢ Upload a Template

Other Reporis -
All ltem Details

Coverage Report
Default Work Product Export to
Word

Excel Export for Roundtrip
Export to Excel Default

Export to Word Default
Sync Repaort
Sync Status

Test

Trace 2 Levels Up and Down
Trace Report

Trace Upstream 2 Levels

Note
y All Iltems Details Export [393] and the Coverage Report [394] are made with Velocity
and can't be downloaded and modified with Microsoft Word
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Each Office Template consists of three sections:

e Cover page — Contains general information about the export, and the data it references. Some fields
typically included in this area are:
<<reportName>> - shows the Report Name entered in the Office Templates window
<<reportDescripti on>> - shows the Report Description entered in the Office
Templates window
<<cont ext Type>> - shows the type of content being used (e.g. release, component,
filter, folder, item etc)
<<cont ext Nane>> - immediate context for the data being used (e.g. container name,
like "Requirements')
<<user Nane>> - name of the user generating the report
<<proj ect Nane>> - name of the project
<<pr oj ect Manager >> - project administrator
<<or gani zati onNane>> - name of the organization
<<cont ext Pat h>> - hierarchical path from the content to the project level

¢ Table of contents — Automatically generated using Word's heading hierarchy. You can delete this by
editing the template and removing this section.

¢ Items and fields — Contains the items and their respective fields from the selected data set. This
section can be modified.

' Tip
% For a list of fields available for export in your current project, download the Field
Reference Guide [395].

O Best Practice
- To handle complex formatting or logic, consider developing custom reports [462] to
better meet your exporting needs.

Export data with Office templates

Using data that you select in the Explorer Tree or with an advanced filter, Office Templates can be
leveraged for simple exporting with Word or Excel.

To export using Office templates:

1. InList View or Single Item View, select Export > View all export options.

2. Inthe window that opens, select the export you want from the template list on the left.
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w

Select the format for your export and enter any additional information required for some templates.

4. (Optional) Select Email me the report to receive a link to the export when it's finished. Links are
stored for 7 days before they're automatically deleted.

5. Select Run.

A confirmation message appears with a link to the report.

Download an existing export template
You can download an existing Office Template to use as is or modify it as a a new template.

To download an existing export template:

1. InList View or Single Item View, select Export > View all export options.

2. Inthe window that opens, select the template you want to download, then select Download
Template.
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The template is downloaded to your computer. Next you can modify the template in Word as needed,
then upload it as a new template [390].

Upload an export template for a report
Any user with read/write permissions can upload and export a custom template.

For self-hosted customers, an organization or system admin can upload templates in multiple projects.
To upload an export template for a report:

1. Save the template you want to upload to your desktop computer [389].
2. Select Export > View all export options to open the All export options window.

3. In the window that opens, select Upload a Template.
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4, Select Choose File and choose the template you want to upload.

Upload a Template
Mo file chosen

Share this

Report Name:
Report Description:

Share with:
(@ Organization
() Project

Save Report

5. Enter a name and description for the report.
To make the template name and description visible in your export, include these field tags:

Report Name «reportName»

Report Description «reportDescription»
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For a list of other available field tags you can include in your templates for the current project,
generate the Word Template Reference Guide [395].

6. Under Share with, select the option for how you want this export template to be available, then
select Save Report.

Share this
Report Mame:
Test Report

Report Description:
Sprint 2

Share with:

(@ Organization

() Project

Save Report

¢ Organization — Available to users in any project. Export templates that are shared with the organi-
zation are visible in the left column of the Office Templates window with the label All Projects.

Bookmarked reporis -
Ex?{m to Excel Default

Other Reports -
All ltem Details

Coverage Report

Default Work Product Export to
Word

Excel Export for Roundtrip

¢ Project — Available to other users in this project only.
7. Select Run.
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Upload a Template

| Choose File | Test Report.docx

Share this
Report Name:
Test Report

Report Description:
Sprint 2

Share with:
(@ Organization

() Project

Save Report

[ ] Email me the report Run Clase

A confirmation message appears with a link to the report.

Create an All Item Details report
The All Iltem Details report displays all item details for the selected project. It was designed in Velocity for
output in Microsoft Word and HTML.

This report is useful for sharing details of a set of requirements or another group of artifacts with others
outside of Jama Connect.

To create the report:

1. Select the data you want to export using the Explorer Tree or an advanced filter.
2. Select Export > View all export options.

3. In the window that opens, select All Item Details, select a format, and choose the parameters you
need (Include relationships, Include tags).
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4. (Optional) Select Email me the report to receive a link to the report when it's finished. Links are
stored for 7 days before they're automatically deleted.
5. Select Run.

A confirmation message appears with a link to the report.

Create a Coverage Report

The Coverage Report displays downstream relationships to the selected set in HTML, Microsoft Word,
or Microsoft Excel. It provides a summary and detailed information on the traceability coverage for the
selected items.

To create the report:

1. Select the data you want to export using the Explorer Tree or an advanced filter.
2. Select Export > View all export options.

w

In the window that opens, select Coverage Report.

4. Select a format and choose the parameters you need (Missing coverage only, Downstream item
location). If you select no parameters, your report looks like the following image. For a report with a
more specific set of relationships, select one or both parameter options.
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Coverage Report

Coverage by Any Location

May 25, 2012
Coverage Summary
Project Name CoveragePlus
Total Items B
Total Missing 3
Percent Covered a0%

Coverage Detail

Selected ltems

Any Location

CP-CWMP-1 Core Application

MWlissing Any Location

CP-UC-1 Schedule Patient Appaintment

CP-TC-1 Schedule Patient Visit

CP-UC-2 Perform Patient Procedure

CP-TC-3 Displa&t Patient }{-r?\]ys
CP-TC-2 Record Procedure Motes

CP-UC-3 Manage Patient WWaitlist

Missing Any Location

CP-UC-4 Coordinate Patient and Insurance Billing

CP-TC-4 Send Bill to Insurer
CP-TC-5 Send Bill to Patient

CP-UC-5 Manage Patient Infarmation

MWlissing Any Location

5. (Optional) Select Email me the report to receive a link to the export when it's finished. Links are

stored for 7 days before they're automatically deleted.

6. Select Run.

A confirmation message appears with a link to the report.

Generate the Word Template Reference Guide

The Word Template Reference Guide is helpful when you're creating or editing templates. It provides a
dynamic reference of all field tags that you can use to expose information in your export templates.

This guide is unique to each project in Jama Connect. Downloading the guide provides an up-to-date list

of all available field tags for items in the currently selected Jama Connect project.

When creating a new template, you can copy and paste from this reference guide. If any fields change in

your project, download a new guide to see how the changes affect export templates.

To generate the guide:

1. InList View or Single Item View, select Export > View all export options.
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2. Inthe window that opens, select Upload a Template, then select Generate Word Template Refer-
ence Guide.

3. (Optional) Select Email me the report to receive a link to the export when it's finished. Links are
stored for 7 days before they're automatically deleted.
4. Select Run.

A confirmation message appears with a link to the report.

Embed custom fonts in exports
You can embed custom fonts into Word or PDF exports.

Important
The custom font you use in the template must be in the TrueType Font format (TTF).

To embed custom fonts:

=

Download the template [389] for the existing export that you want to publish with a custom font.
Convert that template to DOCX format: select File > Save As > Word Document (.docx) in Microsoft
Word.

Select all of the text in the document and apply your custom font.

Enable embedded fonts in the document.

Upload the template [390] to an existing or new export in Jama Connect.

Export the document [388] to Word or PDF format.

N

o kW
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Testing for verification

Testing for verification

Using tests in Jama Connect helps validate the quality of your product and verify that the product meets
its requirements. When you run a test, the generated report shows connections between regulations,
requirements, and test results.

Terms

Test case — A description of the specific tests you need to run in order to validate or verify product
features or systems.

Test plan — An item that documents the overall strategy for validating or verifying that a product or
system meets its design specifications and requirements. It also serves as a means of organizing test
cases from the project or another project. Test runs are generated for the test cases included in the test
plan.

Test group — A way to organize and optionally assign test cases in a test plan. The order of test groups
and test cases with each group determines how the test runs appear in the test cycle.

Test cycle — A group of test cases converted into a series of test runs that are ready for execution.

Test run — An item used to record results for a test case you ran against your product. Test runs are
traced directly to the test case where they were generated, and the results for each run determine the
Test Case Status for the related test case

Testing workflow

A typical workflow for testing looks like this:

1. Create test cases [398] and relate them directly to the requirements that the test cases verify. A test
case describes the specific tests you plan to use and their steps [405].

2. Create a test plan [412] that gives an overview of how you want to test requirements.

Associate the necessary test cases with the test plan and organize them into groups [421].

4. Get ready for testing by adding a cycle [425] in the test plan. When building a cycle, you must select
from the groups in the plan. When you save and create a cycle, you see test runs for all test cases
and the selected groups are also created.

5. Execute the test runs and log defects [437] as needed.

w

Resulting test run statuses roll up to calculate the overall test case status [408].

Securing your data with locks and tests

You can lock test plans, test cycles, and test runs, adding a layer of protection for critical organizational
data.

The following rules define how locks affect actions such as deletions and modifications across test plans,
test cycles, and test runs.

e Test plan lock — Prevents the following actions:
e Deleting locked test plans
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Editing the test plan overview

Editing, adding, and removing test case groups

Adding or removing test cases to test case groups

e Removing test cycles from the test plan (regardless of test cycle lock status)

Note
y While the test plan is locked, users are still able to manage test cycles and execute
test runs.

¢ Test cycle lock — Prevents the following actions:
e Deleting the parent plan (regardless of test plan lock status)
e Deleting locked test cycles
o Adding or removing test cases to the test cycle
e Adding or removing test runs from the test cycles (regardless of test run status)
e Syncing test runs to test cases (regardless of test run lock status)

ﬁ" Note
When a test cycle is locked, users are still able to execute test runs.

e Test run lock — Prevents the following actions:
e Deleting the parent test cycle and test plan (regardless of the test cycle or test plan lock status)
o Editing, executing, or deleting test runs
¢ Syncing test run to test case versions

For more information, see Delete an item [91].

Important

You must have at least a Test Runner license to be able to add and edit defects and
items, create test plans and runs, and manage relationships and attachments. However,
test runners can only affect items that are used as defects [401]. More extensive
permissions require a different license [656].

Test cases

Test cases are items that define how a requirement is verified. Test cases (also referred to as validations
or verifications) are directly related to the requirements they are meant to verify. This ensures proper
coverage and establishes a trace from requirements to the results of testing (verification).

Test cases are created in the same way any item is created and organized in the Jama Connect structure.
Jama Connect sample frameworks typically provide a default test case item, but your organization can
configure its own test case item type with terminology and fields relevant to your process.

Like most other items in Jama Connect, test cases can be reused across projects. They can be organized
directly within a project or within a library of test cases, where they can be reused.

After creation, organization, review, and approval, test cases are added to one or more test plans in Jama
Connect, where test runs are generated for the test cases. During a test run, results are captured for
test cases. Jama Connect automatically establishes a trace from test cases to test runs and displays this
relationship in Trace View.
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Manage test cases
From the Manage test cases button, you can add and remove test cases from a test cycle.

To add or remove test cases:

1. For the test plan you're using, select Test Runs in the toolbar.

2. From the toolbar, select Manage test cases.

3. Toremove test cases: select the test cases you want to remove, then select Next.

399



Testing for verification

4. To add test cases: select the test cases you want to add, then select Save.

A message confirms that the test cycle was updated.

Import test cases

You can import multiple test cases and their corresponding test steps from a spreadsheet.

e You can use a one-way import [124] to quickly bring legacy test cases into Jama Connect.
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e You can use a round-trip import [129] so you can work with content outside of Jama Connect and
bring changes back in safely.

Best Practice
- Use Excel to import test cases. Make sure your worksheet includes the following col-
umns: Name, Description, Step Action, Step Expected Result, and Step Note.

Important considerations

e Each row with the same test case name is imported as a new test step for that case.
e Test cases and steps can be edited with a round-trip import. For more information, see Edit test cases
using round-trip [401].

To import test cases:

1. Make sure your spreadsheet includes columns for the test case Name and Description. If importing
steps, also include a column for Action, Expected results, and Notes.

2. Add columns to represent additional fields as part of the import. This is consistent with how other
imports to Excel work [117].

Edit test cases using round-trip

You can edit multiple test cases and their corresponding test steps using round-trip. The process consists
of exporting items to a worksheet by round-trip, editing it, then reimporting the worksheet.

Note
y You can't use a round-trip [129] to edit the test case status [408] because that field is
automatically calculated from test run statuses.

To edit with round-trip:

1. Export a round-trip Excel file [129] and include the Steps field.

2. To add a test step in Excel, copy a preexisting row and insert it where you want to add a step.
Change the content of the cells as needed to create the new step. The steps are automatically
renumbered on import.

3. Toremove a step in Excel, delete a row anywhere in the sequence of steps. The steps are automati-
cally renumbered on import.

4. Import test cases [400].

Special use of item types for test

Any item type can be set up by an organization admin [693] to work in ways that are specific to a test.

For example, the item must be set as a Test Case or Defect to operate within a test.
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e Test case — Items used as a test case have test steps [405] and test case status [408] fields, as well as
work in test plans for users with a Creator license.

¢ Defect — Items you use as defects work in testing for users with a Test Runner license [658] or a
Creator license.

View and edit test case details
Test cases are created in the Explorer Tree for a project and edited like any other item [72]. You can open
test cases from the Explorer Tree or from List View, or find them using search or a filter.

' u Tip
¥ You can view key test case details in the Test Runs widget [449], located in the Single
Iltem View of a test case. This includes information such as the associated test plans and
test cycles, run history (including who ran the test and when), current status, and more.

To view or edit test case details:

1. To view test cases in groups — In the Test Case of the Test Plan view, select the test case ID to open
and edit the test case.
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2. To view test cases from test runs:
a. InSingle Item View, select the Test case widget to open the bottom panel and view details
about the test case.

b. Select the test case ID to open and edit the test case.
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The test case is saved with your changes.

Export test cases to Microsoft Excel

You can export test cases to Excel for audit purposes when the documents need to be saved in a formal
repository.

The content that appears in the final output depends on the items you select. For example, if you select
Name and Modified by, those are the only fields that appear in the output.

Note
ﬁ For test cases, you can also export to a Microsoft Word document [379] or create an
export with Office Templates [386].

You can export test cases with or without steps. When including steps:

e Each step is assigned its own row in Excel output.
e Each step row includes the same non-step data for that case. The repeated data impacts the item
count in the spreadsheet.

To export test cases:

1. From the Explorer Tree, select the set or folder for the test cases that you want to export. If the test
cases are in multiple locations, you must use a filter to select them.

2. Select List View.

3. Select the gear icon to open a drop-down menu and select what you want to include in the Excel
spreadsheet.

4. In the toolbar, select Export > Export to Excel.

The results of your export depend on whether or not you included steps.
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.
With steps
A B C D E [ G H

1
2 FOIder Produced by:  Shawnna Williams MediKiosk
» Patient Information on: 0512312013 Jama Software
4 |[v] Item Type Locked Name Assigned Priority Test Case Status Step # Step Action
5 Test Case FALSE Edit Patient Infc Will French Unassigned Passed 1 Select "Edit Info" on patient rec
6 Test Case FALSE Edit Patient Infc Will French Unassigned Passed 2 Enter a new last name
7 Test Case FALSE Edit Patient Infc Will French Unassigned Passed 3 Click "Save”
8 Test Case FALSE Edit Patient Infc Will French Unassigned Passed 4 View updated record
9 Test Case FALSE Record Proced Sean Adley High Blocked 1 Search for patient or select frc
10 Test Case FALSE Record Proced Sean Adley High Blocked 2 Select tooth, procedure or ger
11 Test Case FALSE Record Proced Sean Adley High Blocked 3 Enterintext. Select from pre-
12 Test Case FALSE Record Proced Sean Adley High Blocked 4 Open existing note and make
13 Test Case FALSE Record Proced Sean Adley High Blocked 5 Search by date, procedure, fc
14 Test Case FALSE Validate insurai Will French Unassigned Scheduled 1 Navigate to a patient record
15 Test Case FALSE Validate insurai Will French Unassigned Scheduled 2 Select "Update Insurance”
16 Test Case FALSE Validate insurai Will French Unassigned Scheduled 3 Enter inaccurate insurance infc
17 Test Case FALSE Schedule Patie Sean Adley Medium Failed 1 Enter in date, needed time, dal
18 Test Case FALSE Schedule Patie Sean Adley Medium Failed 2 Compare against database set
19 Test Case FALSE Schedule Patie Sean Adley Medium Failed 3 Pick one of the available times

When you export the Steps field from Jama Connect, all Step columns are included in the export: Step #,
Step Action, Step Expected Results, and Step Notes.

Without steps
A B C D B F G H
1
» Folder Produced by:  Shawnna Williams MediKiosk
» Patient Information on: 05/23/2013 Jama Software
4 |Iv] Item Type Locked Name Assigned Priority Test Case Status
5 Test Case FALSE Edit Patient Infc Will French Unassigned Passed
6 Test Case FALSE Record Proced Sean Adley High Blocked
7 Test Case FALSE Validate insurai Will French Unassigned Scheduled
8 Test Case FALSE Schedule Patie Sean Adley Medium Failed
9 Test Case FALSE Create family g Will French Medium Passed
10
11 Total ltems 0
Test steps

Test steps are distinct actions used to run a test.

When running a test, you can indicate the success or failure of each step. The Test Steps field is available
in any item whose item type is used as a test case.

A test step consists of these fields, which are authored in the test case:

e Action
e Expected Result
¢ Notes

Add and edit test steps

For complex test cases, you can add tests steps as needed, as well as edit existing steps.
Important considerations

¢ When you use a carriage return in test case steps, the displayed text is wrapped. Enable Rich Text
Editor for line breaks to be displayed in steps.

o Test steps are plain text by default. Once an organization admin enables rich text in test steps [677],
you can edit these steps with rich text. To do so, select the pencil icon or the Steps field. Selecting Edit
in the toolbar allows only plain text or html edits.
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. u Tip
o To add and edit test steps using your key commands, see Keyboard shortcuts [770].

To add and edit test steps:

1. View details of the test case [402] where you want to add steps.
2. Select Edit in the toolbar (for plan text or html edits only), select the pencil icon next to the field (for
rich text), or select the field to make it editable, then in the Steps field, select Add Step.

3. Enter text in these fields as needed: Action, Expected Result, and Notes. Use the rich text edi-
tor [407] to format text or to add images in the steps.
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4. Use the action buttons in the far right column to reorder, duplicate, insert, or delete a step. If you
need to use the same step multiple times in a test case, highlight the entire step, then copy and
paste as needed.

5. Select Save.

The test case is saved with with the edited test steps.

Add images to test steps

To provide more detail in a test step, you can add an image.

Test steps are plain text by default. An organization admin can enable rich text for basic formatting and
embedded images [677].

To add an image to a test step:

1. Save a new test case, which must be done before you can add an image to the test step field.

2. Select Edit in the toolbar (for plain text or html edits only), select the pencil icon next to the field (for
rich text or html edits), or select the field to make it editable.

3. Place your cursor in the cell where you want to add the image, then select the Add image or File
icon and select the image from your browser or server.
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Large images are resized automatically to fit the width of the cell. When you save the test case, select
Expand to view the image in full size.

Test case status

Test case status is a system-managed field that is automatically calculated based on the status of
associated test runs.

Important considerations

¢ An organization admin can choose to hide the test case status field [678] on any item being used as
a test case. It is possible to have the test case status visible for one test case item type and not for
another.

o Test case status is a system-managed field that is automatically calculated and can't be updated
manually.

By default, this status is calculated using all available test runs associated with the test case, including
runs that aren't executed. An organization admin can disable this option [684] so that unexecuted runs
aren't included in the calculation.

The status is calculated by one of these methods:

¢ [f the test case is used in only one active test plan, the test case status reflects the most recent
associated run status.

e If the test case is used in multiple active test plans, the test case status reflects the most urgent run
status based on the following hierarchy, regardless of when it ran.
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If a test case is used in multiple plans and it picks up the status of a plan that's no longer relevant, you
can archive that plan [419]. Doing so removes that plan's test run statuses from the test case status
calculation.

You can also use archiving to trigger a recalculation of all test cases in a plan. When a user archives and
then unarchives the test plan, the status for all test cases in that plan is recalculated. This can be useful if
you want to recalculate the test case status after changing the admin setting to include unexecuted test
runs [684], which isn't retroactive.

Add a Test Run Results column
The Test Run Results column displays the status of all downstream test runs. You can add this column to
test cases in reviews, List View, and Trace View.

To add a results column:

1. Toadd a column in List View:
a. From the gear icon, select Test Run Results.

b. Hover over the progress bar to view the status for each test run.

| Pass 0% 0 runs
In Progress 0% 0 runs
Mot Run H0% 1run
Elocked 50% 1 run
Fail 0% 0 runs
Total 2runs

2. To add a column in Trace View:
a. From the gear icon, select Test Run Results.
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All Selected (5)

Steps Symbol
Symbol SY5_DOORS_ID
Tags Test Case Status

v Test Run Results

textbox

Text field (required)

Top Mark

b. Hover over the color bar to view the status for each test run.

(Organization admins only) To add a column in reviews:

a. Select ADMIN > Organization, then select Item types.

b. On the Item types page, select Test Case > Edit.
Your admin might use a different name for Test Case, like Verification. To confirm the item type,
look at the Use as section in the Edit ltem Type window.
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c. Select Save.

d. Select Test Case > Views and enable the Test Run Results field for Reading View and Single
ltem View.
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In a review with Test Case items, the results rollup bar now appears.
e. To view the status for each test run, hover over the color bar.

Test plans

A test plan is an item that documents the overall strategy for validating or verifying that a product or
system meets its design specifications and requirements.

Working with test plans consists of these tasks:

e Add a test plan [413]
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Add test cases to a plan [414]
View test plan details [415]

Edit a test plan [416]

Send a test plan for review [417]
Duplicate a test plan [418]
Archive a test plan [419]

Delete a test plan [420]

Add a test plan

You can add test cases to a plan, edit, duplicate, or delete the plan, send it out for review, and archive the
plan.

Note
y You must have read/write permissions for the entire project to create a test plan.

To add a test plan:

1. Select the Test Plans tab in the left panel.

2. Select Add > Test plan.
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3. Inthe window that opens, enter the name and description of your new plan. An organization admin
can edit the default template [697] included in the test plan description.

4. To let others know that you created this plan, select Notify. You can leave a comment and notify a
user or group by email.
5. Select Save & done.

The new test plan appears at the top of the list in the Test plans table.

Add test cases to a plan

Once you create test cases, you can add them to a plan in groups. For example, you might group all the
cases for a specific aspect of the product, for a test location, or for a specific tester.

You can only add a test case to one group in a test plan because a test case can appear in a test plan only
once.

To add a test case to a plan:

1. Inthe left panel, select the Test Plans tab and the name of the plan where you want to add the test
cases.

2. Inthe toolbar of the center panel, select Test Cases for that plan.
The right panel shows the tree for your project.

Note
i If you select a different project in the project selector drop-down menu, the right
panel displays the tree for the selected project.
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3. To add test cases to an existing group: Select any component, set, or folder of test cases, or an
individual test case from the plan's tree on the right, then drag it to an existing group.
You can also select the Releases, Filters, or Search tabs to find the test cases you want to add.

4. To create a new group based on the Explorer Tree hierarchy: Drag the component, set, or folder that

contains test cases to the dashed line box at the top of the center pane. The hierarchy is used to
generate groups with test cases.

For example, if you drag and drop this set of test cases:
= |:| Test Case Library

= Feature 1
TC1

E Feature 2
TC 2

= Feature 3
TC 3

These three groups are created:

The text cases are added to the selected group.

View test plan details
You can view the details of a test plan by opening it, then you can toggle between three views.

To view test plan details:
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1. Select the Test Plans tab in the left panel.
Select the plan to open it.
3. Inthe center panel, toggle between these views:
e Overview — Describes the testing goals and purpose and is displayed as a Single Item View [21]

of the test plan. An organization admin can configure which fields are displayed for this item
type [674].

N

Overview [E]| TestCases " Test Runs

o Test Cases — Where you add groups of test cases to a plan.

o Test Runs — Where you add and perform a cycle of test runs.

Edit a test plan

Once you find the test plan you want to use, decide which way to edit the Overview section of the plan.
To edit a test plan:

1. Select the Test Plans tab in the left panel.
2. Choose the plan you want to edit and select Edit.
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3. Make changes to the test plan as needed.
4. Select Save & done.

The test plan is saved with your changes.

Send a test plan for review

You can send a test plan for review to ensure that the content is correct and the expected test cases
were included. You also gain a baseline of the test plan with its test cases for later comparison, if
needed.

Important considerations

¢ When you send test items for review, Single Item View might not display all relevant fields. To include
the necessary fields, ask your organization admin to configure views [697] for an item type.

e You can create an advanced filter [150] that contains any combination of test plans, cycles, cases, and
runs and send that to review.

To send a test plan for review:

1. Select the Test Plans tab in the left panel.
2. Choose the test plan you want to review and select Send for review.
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3. When the Initiate review [163] wizard opens, complete the pages and select Initiate review.

The test plan is sent to the recipients in the invitation.

Duplicate a test plan
To save time, you can create a copy of an existing plan to use as a template.

The copy contains:

o All details from the original
o All groups of test cases from the original

The copy doesn't contain:

e Test runs from the original
e Test cycles from the original

To duplicate a test plan:

1. Select the Test Plans tab in the left panel.
2. Select the test plan you want to copy (active or archived) and select Duplicate.
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An active copy of the selected test plan is created.

Archive a test plan

The only way to archive a test run is to archive the associated test plan. When you archive a test plan,
the associated test runs no longer appear in the associated test case, and the test case status reverts to
"not scheduled."

To archive a test plan:

1. Select the Test Plans tab in the left panel.
2. Select the test plan that you want to archive and select Archive.

3. To make a test plan and its associated test runs active again, select the test plan and select Unarch-
ive.
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This action recalculates the test case status.

Delete a test plan

When you delete a test plan, you also delete all associated test cycles and test runs. This action also
changes the status of test cases associated with the deleted test runs.

Important
If a plan has any associated test runs, archive the test plan [419] rather than deleting it.

Locked test plans can't be deleted, and unlocked test plans can't be deleted if they
contain locked child items, such as test cycles or test runs.

To delete a test plan:

1. Select the Test Plans tab in the left panel.
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2. Inthe Test Plan tree, right-click on the plan you want to delete, then select Delete.

The test plan is deleted, along with all associated test cycles and test runs.

Test groups
A test group lets you organize and optionally assign similar tests in a test plan.

Test cases are added to a plan in groups. This organization makes it easier for others to understand and
run your test plan.

For example, you might want a group to include all the cases for a specific aspect of the product, or you
might want to group by test location or tester.
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Add, edit, or delete a test group

Test cases are added to a plan [414] in groups, which makes it easier for others to understand and run
your test plan. For example, you might want a group to include all the cases for a specific aspect of the
product, or you might want to group by test location or tester

Along with the default test group, you can create a new group manually by selecting Add Test Group or
automatically generate test groups by dragging test containers to the center panel. These automatic test
groups inherit the name of the test case container. For example, test cases organize by folders in a set
generate test groups for each folder.

G Best Practice
- Create a user as a placeholder for a particular team, such as "Software Team," and assign
groups to that team. While this method requires an active license, it allows members
of the team to see all the runs that are assigned to their team in a cycle. When you
execute a run that was assigned to another user, such as "Admin Test," you can reassign
that run to yourself.
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Note
i Test groups can't be added, removed, or altered when the test plan is locked.

To add, edit, or delete a test group:

1. To add a test group:
a. Select the Test Plans tab in the left panel, then choose the plan where you want to add a test
group.
b. Inthe toolbar of the center panel, select Test Cases for the plan you want to see.
Select Add Test Group.

d. Inthe window that opens, complete these fields and select Save:
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2.

3.

e Name - Enter a name for the group.
e Assigned To - Select Search (magnifying glass icon) to assign a person to run the tests in this
group, then select the person's name, and choose Select User.

Any runs created from this group are automatically assigned to that person.
To edit an existing group:
a. Select the gear icon to open the Add/Edit Group of Test Cases window.

b. Make your changes and select Save.
To delete an existing group:
a. Choose the Test Group you want to delete, then select X (Delete this test group).

b. Select Yes to confirm.
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The test group is removed from the center panel.

c. Select Test Runs and review existing Test Cycles to see if there are test runs linked to the
removed test group cases.

d. If test runs are unassigned and appear in the Not Run state, select Cycle > Edit cycle.

A wizard opens and guides you through the process [428]. The removed test group no longer
appears on the second page of the Edit Cycle wizard.
e. Save the Test Cycle.

The test cycle is updated and test runs removed.

Important

If the test runs were executed, then you must delete each test run from Single ltem
View.

Test cycles
A test plan contains one or multiple test cycles.

A cycle is associated with all or a subset of test cases in a test plan. A test run contains the record of
results for a given test case. When you are ready to begin testing, add a test cycle [425] to a plan and
associate some or all test cases. Test runs are generated [437] in the cycle for each associated test case.
You can also send a test cycle for review [429].

Add a test cycle

Add a test cycle, then select the test cases from the test plan that must be executed together. A test run
is created in the test cycle for each associated test case.

To add a test cycle:

1. Select a Test Plan from the Test Plan tree.
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2. Inthe toolbar of the test plan, select Test Runs.
The screen displays the most recently created cycle and all associated test runs.

3. Select Switch cycle from the drop-down menu, then select Add test cycle.

The "Add test cycle" wizard opens.

4. On the Cycle details page, enter the name, optional description, start and end dates, then select
Next.

5. On the Define scope page, select one or multiple groups to associate with the cycle, then select
Next.
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6. On the Refine selection page, use column filter and sort criteria to identify specific cases for
association with the cycle.

Note
y The Latest result column won't appear when you're creating the first cycle of each
plan because there are no results associated with that plan yet.
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7. Select Save.

The page is refreshed and displays the new test cycle.

Edit a test cycle

You can edit test cycle details, such as the name, description, and start and end date.

Alternatively, you can edit the cycle details and scope. When you edit the scope, you can select which
test cases are associated with the cycle. Associating additional test cases to the cycle creates additional
runs, while removing associations to test cases in a cycle deletes the corresponding runs. However, you
can't delete runs with data, such as "Assignee" or test run results, while editing a cycle.

Note
é’ When a test cycle is locked, it can't be deleted, test case associations can't be changed,
and test runs can't be added or deleted from the test cycle.

To edit a test cycle:

1. Navigate to the appropriate test cycle, then select Manage test cases.

2. Follow the prompts to remove or add associations to test cases, then select Save to update the
cycle.
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A message confirms that your changes were saved.

Send a test cycle for review
A wizard guides you through the process of sending a test cycle out for review.

Note
ﬁ When you send test cycles and test runs for review, some relevant fields might not ap-
pear in a review's Single Item View. If this occurs, an organization admin can configure

views [697] for an item type to include the necessary fields.

To send a cycle for review:

1. Inatest plan, select Test Runs, then select the cycle you want to send for review.

2. Select Send for review.
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3.  When the initiate review [163] page opens, complete the pages and select Initiate review.

When you send a cycle to a review, the review content includes the cycle details and all runs in the cycle.
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Test runs
A test run is an item that records results for a test case against your product.

A test run item type is created as a singular instance of a test case. The core information (name,
description, and steps) is copied from the test case into the test run when the test run is generated.

If a test case changes after a test run is created, the test run must be manually updated to reflect the
newer version of its test case.

Test runs are executed in test cycles, where test runners indicate a result of passed, failed, blocked, or
passed with errors. These test run statuses roll up to a single status in the parent test case.

Example of a test run:

Find and manage test runs
By selecting Test Runs in the toolbar, you can manage all the runs in the cycles for a test plan.

Important considerations

e The test cycle displays a selectable ID for each test run. Selecting the ID navigates to the test run in
Single ltem View.

e Some column headers support filtering and sorting. To restore the original order of test runs, either
clear the sort from the filter dialog or cycle through the sort options in the column header.

e The order of runs in the test cycle follows the sequence of test cases within each group, as well as the
order of the groups themselves.

To find and manage test runs:

1. For the test plan you're using, select Test Runs in the toolbar.
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Test runs are displayed in a configurable List View in the center panel.
To make fields visible, select Show/hide fields (gear icon) in the toolbar.

To see the test case associated with this run, select the Test Case ID link in the Test Case column.

To assign a user to a test run, use one of these methods:
e Select a test run, then select Edit to open the test run in Single Item View.

e Select multiple test runs, then select Batch edit to batch update the Test run status, Assignee, and
Lock status.
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5. To filter the List View for test runs assigned only to you:
a. Select the filter in the Assigned to column.

b. Select your username, or search for and select other users to filter the results.

c. Select Apply.
6. To export the visible test runs as a standard Word, Excel, or custom format document (Office
Templates), select Export.

View test run details

You can view specific details about a test run, such as connected users, comments, and associated test
cases.

To view test run details:

1. Inthe test plan, select Test Runs from the toolbar to display test runs in List View.
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2. Select the ID of a test run to view its details in Single Item View.

3. From the toolbar on the right, you can:
¢ View and add relationships, comments, and connected users.
e Check the activity and version history for the test run.
¢ Open the associated test case.
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Configure test run view

You can configure how your system displays test runs, which columns are visible when you view test
runs.

To configure the test run view:

1. Select a test plan, then select Test Runs from the toolbar.

2. From the toolbar, select Show/hide fields (gear icon).

3. Inthe window that opens, select the field names and drag and drop to move them between the
Hidden fields column and Visible fields column, or use the arrows.
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4. Select Restore organization defaults if you want to return to the default settings. An organization
admin can configure the default view settings for test run item types [697].

5. Select Save as default for Test Runs if you want to use this configuration for all test runs that you
view in Jama Connect. Otherwise, your settings are applied only during this session and return to
default settings when you log in again.

6. Select Apply.

Your changes are saved.

Assign test runs
A test run must be assigned to an individual. It can be assigned in advance or when a user executes a run.

Assigning users in advance allows them to easily identify which test runs they are responsible for
executing. It also ensures that no test runs are missed because they weren't assigned.

To assign test runs:

1. Inthe test plan, select Test Runs.
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2. Select the test runs you want to assign. Press Ctrl or Shift to select more than one.

3. From the Batch edit drop-down menu, select Assignee.

4. Inthe Assign Test Runs window, select the name of the user you want to assign, then choose Select
User.
5. Select OK.

The page is refreshed and the user you assigned to the test run appears in the Assigned to column.

Execute a test run
When a user executes a test run, results like Pass/Fail are captured for that run. The run displays details
for conducting the run, including the description and steps defined in the associated test case.

Important
When you select Pause, the results (Pass/Fail) aren't automatically saved. You must
select Save and Done to save the recorded results or "actual results" values.

When a test run is locked, it can't be synced to test cases, edited, executed, or deleted.
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To execute a test run:

1. Inthe test plan, select Execute this Test Run (blue arrow button) next to the run you want.

The Execute Test window includes three tabs at the top: Test Execution, Test Run Details, and Test
Case.

fﬁ’ Note

If you try to execute a test run that isn't assigned to you, you are prompted to
reassign it to yourself.

2. To execute multiple runs assigned to you, make sure they are assigned to you before opening the
Execute Test window, then select Open my next assigned test to continue to the next run.

3. Select the Test Execution tab.
a. Select Start Test Run to start the duration timer.

Unless the field is configured to read-only, you can select the duration field and change the
timer to reflect the actual testing time.
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If you discover a defect while running a test, select Log a Defect to open the right panel, fill in
the information and select Save Defect. (A project admin can determine where these defects
are saved [742].) When you add a defect from the Test Execution window, it's automatically
related to that test run and test case where the test run was generated.

Once you start the timer and begin the test, mark each step as passed, failed, or not applicable*.
You can add results for each step in the results field. If there are no steps, you can assign an
overall passed, failed, or not applicable status*.

* Not applicable status is only available when configured by an organization admin.
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d. Toinclude images in the Results column of the test steps, select Add Image. You can also
provide feedback for the test run as a whole using the Actual Results field, which is a rich text
field that can include formatted text, tables, images, and links.

The test run status [445] (in progress, passed, failed, blocked) is shown at the bottom of the
status column.

e. (Optional) If any step failed but you want to conditionally pass the test run, select Pass with er-
rors. If the test run couldn’t be executed (steps couldn’t be performed), select Mark as blocked.

4. Select the Test Run Details tab to view details about the run.

These items are visible:

o Test case that generated this test run — View the version number of the test case at the time the
test run was generated and the current version. Select the ID to open a new window that displays
the details of the derived item, such as the goal of the test case, preconditions, steps in the case,
and the duration of the test run.

o Upstream items related to this test run — Select the item ID to view detailed information about
the related items in a separate window.

5. Select the Test Case tab to view details about the test case that generated this test run.
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6. Select Save and Close.

The window closes and your changes are saved.

Archive a test run
The only way to archive a test run is to archive the associated test plan.

When you archive a test plan, the associated test runs no longer appear in the associated test case,
and the test case status reverts to "not scheduled" or the appropriate value based on any existing
non-archived test runs.

To archive a test run:

1. Select the Test Plans tab in the left panel.
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2. Choose the test plan that you want to archive and select Archive.

The archived test plan is now displayed as inactive (grayed out).
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Note
y To unarchive a test plan (make it active again), select it and select Unarchive.

Along with the default test group, you can create a new group manually or by dragging
test cases to the center panel.

Configure custom fields to appear during test execution

When custom fields are added to the Test Run item type, they appear in the Test Execution window dur-

ing testing. Similar to the Actual Results field, these custom fields can be filled in during test execution.

Supported custom field types

Only these custom field types appear on the test run execution panel:

Date

Flag (Boolean)

Integer

Multi-select

Picklist

Text field

URL

Text box (plain text)

Text box (rich text)

You can use Editor Templates in custom rich text fields. To export the Editor Template information for
a Test Run item from Single Item View, select Export > View all export options > All Item Details, then
select Run.

To configure custom fields:
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1. Select ADMIN > Item Types > Test Runs, then select Add field.
2. In the Add field window, complete the form [674], then select Save.

On the next test run, the custom fields are available and can be edited.

Example: Add a custom text field to capture the serial number for a product being tested during that test
run's execution.

Sync test runs with test cases

When you create a test run, the Name, Description, and Steps values are copied from the test case to
the test run.

Important considerations

¢ |f you make a change to the test case after synchronization, the change isn't reflected in the test run.

e Synced test runs are versioned and updated to reflect the changes from the test case. Any previous
progress, results, or statuses are saved in the test run version history. The previous results can be
restored with the Make Current action in the test run version history widget.

¢ When a test run or its parent cycle is locked, the "Sync to Case" action becomes unavailable.

To sync test runs with a test case:

1. If atest case has changed since the test cycle was updated, a button appears in the test cycle header
indicating the number of out-of-sync runs.
This alert also appears in the test run execution window next to the test run name.
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2. To update specific out-of-sync test runs, select the runs you want to update, then select the teal
button.

3. To update all out-of-sync test runs, select the teal button.

4. In the confirmation window, select Sync.

A confirmation message confirms that the test runs were updated.

View the test run status summary
Test run status indicates the current state of a test run, and is used in calculating test case status.

When enabled by your organization admin, possible default statuses are: Blocked, Failed, In progress, Not
run, and Passed. Only the status "Not applicable" is optional.

To view the test run status summary:

1. For the test plan you're using, select Test Runs in the toolbar.
2. Inthe content header, hover over the progress bar to view the test run status summary.
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3. In the content header, select View details.

A panel opens where you can view a summary of the test run results.

Note

i If you need to reset the test run to a status of Not run, you can batch update test run
status [446] or deselect steps that were marked as pass or fail, and set the test run
duration to 0. This automatically resets the status to Not run.

Batch update test run status
As long as test runs aren't locked and you have write permissions, you can update the status of multiple

test runs at once.

You can only batch update test runs in the Test runs window. You can't use advanced filters to batch
update test runs.

To batch-update the status:
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1. Select Test Runs in the toolbar.

2. Inthe center panel, select the test runs you want to update.

3. Select Batch edit > Test Run Status.

4. Confirm the number of runs, then select Next.
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5.

6.

Batch Update Test Run Status

Items to Edit

(®) Selected 3 (Test Runs)

MNote: [tems that are lecked by someone else, or that you do not have write privileges te, will not be updated!

Select the new status you want for the selected runs, then select Next.

Batch Update Test Run Status

Select a new Test Run Status:

Test Run Status: || |v
Not Run '
.In Progress
Blocked
Failed
Passed

Mot applicable

Select the users or groups you want to notify, then select Commit.
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The status is updated for the selected test runs.

Using the Test Runs widget

The Test Runs widget on the test case item allows you to view all runs and their results from that test
case.

In Single Item View, the test runs widget appears on item types where the Use as setting is Test Case.

This widget shows all test runs associated with the test case. From the Test Runs widget, you can view
the test runs status and take action on the test runs:

e Batch assign
e Status updates
e Sync with a test case

The Test Runs widget allows you to:

¢ View the test plans and test cycles where the test case is used
e See the status of each test run that includes the test case

e Access detailed information about each test run, including who ran it, when it was run, and which
version of the test case was used

The number indicates the number of active test runs.

449



Testing for verification

450



Analysis — Monitoring your project

Analysis — Monitoring your project

Jama Connect includes tools that give you the big picture of your project and that help you gain insight
on different areas of your product development.

e Dashboard [455]

e Reports [458]

e Coverage and traceability tools [304] — Find out how mature the product development is. For exam-
ple, if 100% of requirements have a traced verification, development is in a mature and complete state
and can claim compliance.

e Exports [378] — Analyze data in tools like Excel. Jama Connect provides dashboards for a visual
at-a-glance display of your project. Users with organization admin or project admin permissions can
configure a project dashboard.

Working with dashboards

In Jama Connect, the dashboards feature allows you to track the data your team wants to monitor for
quality and progress.

You can select dashboard widgets [455] that display a project's key metrics, so you can see which parts
of your project need attention. Dashboards are customized per project, not per user.

Example dashboard widgets include:

¢ Pie chart — Shows all requirements by status. For example, 25% are in draft state, 75% are in review
state.

e Bar chart — Shows count of all requirements missing a downstream verification test.

Your role determines your interactions — and the options that are available — when you use the
dashboard feature. For example, a user with read/write permissions can view the dashboards created
by an organization or project admin, but they can't create, edit, or delete a dashboard. Work with your
admin to create a dashboard with the widgets that best support your team's needs.

Role Responsibilities and actions

User with read/write permissions o View the dashboards created by an admin.
e Choose your default dashboard.

e Download or view data from a chart.

o Switch dashboards.

o Print the contents of your dashboard.

Organization and project admins o Create, edit, and delete dashboards for users with read/write permissions.
e Choose your default dashboard.

e Download or view data from a chart.

e Switch dashboards.

e Print the contents of your dashboard.

View and customize the dashboard (user)

When the dashboard feature is configured by an organization or project admin, you can use the dash-
board to give your team insight into the progress of each project. Dashboard changes are made at the
project level.

Important considerations

e Only organization and project admins can can create or modify dashboards.
e Dashboard names appear in alphabetical order.

To view or customize the dashboard:
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1. From the Explorer Tree, select a project name to open the project dashboard.

2. To download or view data from a chart, select an option from the drop-down menu. (Options only
appear in the Bar, Line, Pie, and Complex chart widgets.)

Download PNG — Downloads the widget image
Download CSV — Downloads the data from the chart
Download PDF — Downloads the widget image

View data table — Displays the data table/chart and the numerical information associated with
the data

3. To view a different dashboard, select from the Switch drop-down menu.

4. To see the current dashboard when the project page loads, select Set as my default dashboard.
5. To print the contents of your dashboard, select Print.

b" Tip
o For best results, use landscape page setup and enable printing of background
images in your browser settings.

If you made changes to your project dashboard, they appear the next time you open it.

Configure the dashboard (organization or project admin)

The dashboard feature allows organization and project admins to customize a project dashboard so that
it displays the information needed by project members. Dashboard changes are made at the project level.

452



Analysis — Monitoring your project

Important considerations

Only organization and project admins can create or modify dashboards.
You must create a filter [151] before you can generate a graph or filter list dashboard widget.

Each dashboard must have a unique name. Also, descriptive names can help you organize and manage
your dashboards.

The initial project dashboard is allowed an unlimited number of widgets, and subsequent dashboards
are limited to 20 widgets.

O Best Practice
- For optimal performance, limit the number of widgets to a maximum of 20, even in
the initial project dashboard.

Projects must have at least one dashboard. You can have a maximum of 20 dashboards per project.
The first dashboard created for a project is automatically set as the default dashboard for all users.

o [f you delete the project default dashboard, you are prompted to select a new dashboard as the
default.

e Users can customize which dashboard first appears upon their login by viewing the dashboard of
their choice and selecting set as my default dashboard

e Dashboard names appear in alphabetical order.

To set up the dashboard:

From the Explorer Tree, select a project name to open the project dashboard.

To add a widget to the dashboard:
a. Select Add widget in the top right toolbar of the dashboard.

b. Inthe window that opens, select the dashboard widget options you want, then select Add.
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3. Select Layout in the toolbar, then choose how you want the windows to appear on the dashboard.

4. To create an additional dashboard, select Add dashboard in the toolbar.
a. Inthe window that opens, enter a unique name.
b. Select Create.
The screen is refreshed and the new dashboard appears.
5. To edit the name of a dashboard, select Edit.
a. Enter a new name.
b. Select Save.
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A pop-up message confirms that the new name was saved.
6. To view a different dashboard, select from the Switch drop-down menu.

7. To see the current dashboard when the project page loads, select Set as my default dashboard.

Semiconductor Projec...
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8. To download or view data from a chart, select an option from the drop-down menu. (Options only
appear in the Bar, Line, Pie, and Complex chart widgets.)

Download PNG — Downloads the widget image.

Download CSV — Downloads the data from the chart.

Download PDF — Downloads the widget image.

View data table — Displays the data table/chart and the numerical information associated with
the data.

9. To print the contents of your dashboard, select Print.

b{ Tip
o For best results, use landscape page setup and enable printing of background
images in your browser settings.

If you made changes to a project dashboard, they appear the next time you open it.

Dashboard widget options
You can customize a project dashboard to display the information needed by project members. Dash-
board changes are made at the project level.

455



Analysis — Monitoring your project

Note
é’ To manage the dashboard [451], you must have organization admin or project admin
permissions.

The following widgets can be added to the dashboard.
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Filter results ¥ Displays the results of an existing filter in a chart: Name the window, select a filter and which columns
to display, and select how many items to display.

Bar chart it Displays the results of an existing filter as a bar chart.
Configure the name, filter, field shown, and number of elements with the gear icon in the top right.

Select individual bars in the bar chart to view those items in a new tab.

Pie chart ¢ Displays a pie chart for a filter and field that the user selects.
Configure the filter and field with the gear icon button in the top right.

Select the individual items in the pie chart to open those items in a new tab.

Project summa- 2 Displays a summary of the entire project, including total number of items in the project, number of
ry days until next release, and number of days until project completion.

Recently ® Displays the last 15 items viewed by the current user. Select a recently viewed item to openitin a
viewed new tab.

Assigned to me 2 Displays a list of items assigned to the current user.

Recent activity b Displays a line graph of recent activity over a period of time.

Activity stream w Displays the current activity stream of the project.

View all current activity including comments, edits made, new items created, and assignment changes.

Use the filters at the top right to filter only comments, activities, or search for specific items.

Rich text Tr Displays user-defined text, images, diagrams, and equations.

Select the gear icon to insert text, pictures, and tables with the same rich text options as an item
description field [99].

Traceability In- v Displays the relationship rules [765] applied to the project.

formation Mod-

el

Complex chart = Displays a granular snapshot of data based on filter, field, and series selections.

Select the gear icon to configure the filter, fields, and series.

Select individual bar sections in the stacked bar chart to view those items in a new tab.

The following custom field types are available for grouping when defining chart widgets (Bar, Pie,
Complex Charts):

¢ Pick list fields (single select)
e User fields
¢ Flag fields

System fields available for grouping in charts include:

e System User fields (Created by, Modified by, Last Locked by)
e Locked (Flag field)

o |tem Type

¢ Project

Reports

A report is a document that helps you analyze the current status and progress of your project. Reports
can include graphs, tabular data, metrics, and other roll-ups.

Important considerations

e Reports can refer to specific data within a project, to an entire project, or they can apply across
multiple projects.

e To access reports, select PROJECTS > Reports in the upper-right header. From there, you can run a
report [459].

¢ Jama Connect includes default reports that were created with Velocity. You can also create custom
reports.
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e Your system or organization admin can upload custom Velocity exports [638] that are displayed in the
Export window.

JAMA CONNECT INCLUDES THESE DEFAULT REPORTS

Baseline Compared to Current
Baseline Compared to Current {PDF)
Baseline Comparison

Baseline Comparison (PDF)

Review Comments & Signatures

Test Details Grouped by Test Case

Test Details Grouped by Test Cycle
Run a report

Reports can refer to specific data within a project, to an entire project, or they can apply across multiple
projects.

To generate a report:

1. From the Jama Connect header, select Reports > Run report.

Jama Connect lists all default reports and any custom reports [462] you have added. Bookmarked
reports appear at the top of the list.
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Run Reports

Bookmarked reports -

License Report

Review Center Stats Report

Other Reporis -

Baseline Compared to Current
Baseline Compared to Current (PDF)
Baseline Comparison

Baseline Comparison (PDF)

Baseline to Baseline Diff - 3 columns
Baseline to Current Diff - 3 columns
Review Comments & Signatures
Test Cases Baseline Comparison
Test Details Grouped by Test Case

Test Details Grouped by Test Cycle

2. (Optional) To add a report to your bookmarked reports, select its bookmark icon.

3. From the list of reports, choose the one you want to run, then define the options for that report.
For details on defining the report options, see the task for running that specific report.

4. Select Run Report.

The report is displayed with the options you selected.

Run a Baseline Current Diff report

The Baseline Current Diff report compares items and relationships in a baseline to their current versions,
displayed in side-by-side columns.

To run this report:

1. From the project with the baselines you want to compare, select Reports > Run report in the
upper-right corner of the header to open the Run Reports window.

2.  From the list of reports in the Run Reports window, select Baseline to Current Diff.
3. Define the report:
a. Select the format for the report (available formats are listed).
b. Navigate to and select the baseline you want to compare to the project’s current state.
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c. (Optional) Include relationships, exclude status field, include version comments, or show finish-
ed text.
4. (Optional) Select Email me the report to receive it by email.
5. Select Run Report.

The report shows a table that compares the baseline items and relationships side by side.

Run a Baseline Comparison report
The Baseline Comparison report displays a side-by-side comparison of items and relationships in two
baselines.

This report compares two specific states of selected items at a certain point in time. For example, to see
what has changed between two baselines, you can compare the baseline that's created when you open a
review with the baseline of the completed review.

Note

i When comparing baselines, the hierarchical order must be the same between the two
baselines. If items are reordered in the Explorer Tree from one baseline to the next, the
report shows incorrect or no results.

To run this report:

1.  From the project with the baselines you want to compare, select Reports > Run report in the
upper-right corner of the header to open the Run Reports window.

2. From the list of reports in the Run Reports window, select an option for this report:
¢ Baseline Comparison — Word format
¢ Baseline Comparison (PDF)
3. Define the report:
a. Select the format of the report.
b. Navigate to and select the two baselines you want to compare.
c. (Optional) Include relationships and version comments.
4. (Optional) Select Email me the report to receive it by email.
5. Select Run Report.

Items added or deleted between the compared baselines are noted at the top of the report.
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Custom reports

If your reporting needs go beyond built-in default reports [458], exports [378], and Office Tem-
plates [386] you can create custom reports.

Jama Software Consulting Services can help in creating:

e Reports with logic
e Reports with charts and graphs
e Reports with custom formatting

To get help, contact your account manager or Jama Software support at support@jamasoftware.com.

View and download Reports history

From the the Reports history page, you can view and download reports. You can also see the status of
reports that are generated.

The information on the Reports history page is maintained for a rolling 7-day period. After this period,
reports are removed from the history. This feature allows you to return to Jama Connect once a report
has completed, because reports aren't generated instantly.

O Best Practice
- Download and save any reports you want to retain according to your organization’s
policies and data retention guidelines.

é’ Note
Organization admins see all reports. Users see only reports they create.

To view and download reports:

1. From the Jama Connect header, select Reports > Reports history.

2. Choose the report you want to view, then select Download.
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3.

A pop-up message notifies you that the download was initiated.
From the Downloads section of your browser, select the report to open it.

The report you selected is displayed.

Manage the Reports history page

From the Reports history page, you can sort columns, search, download, and delete multiple reports.
View the Context column to determine the origin of a report or export, such as a set or filter.

A non-context sensitive report can be run from anywhere and isn't associated with a set, folder, filter,
container, or baseline.

To manage the Reports history page:

1.

From the Jama Connect header, select Reports > Reports history.

To search for a report — Enter your query in the search field.
The results appear in the table.

Reports history

diff < | Tresult
] Name Format Type Run by Context Started Finished

[J Baseline to Current Diff - 3 columns Word Velocity Non-Context Sensitive 04/29/2024 10:48:47 am  Complete

To download multiple reports — Choose the reports you want, then select Download.
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4. To delete multiple reports — Choose the reports you want to remove, then select Delete Selected
Reports (trash icon).

5. To sort columns — Use the up arrow icon and down arrow icon to reorganize the table.

The Reports history table reflects the changes you made.

Export Velocity reports to Excel

As a root user, you can configure settings that allow users to export a Velocity report to Excel in XLSX
format. This option lets users export directly to Excel rather than using the legacy XLS format.

Important considerations

e This option is available only for Velocity reports.
¢ You must configure this option for each report.

To enable the Velocity report option:

1. Loginto Jama Connect as root user.
2. Select Reports > Add Report.
3. Inthe Add/Edit Report window, enter the following information:
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Report Name — Enter a name
o Report Type — Velocity
¢ Report Format — Microsoft Excel
o Excel Format — XSLX format

4. Select Save.

When a user runs a report, they can now see the Excel format type when they hover over the "Select a
format" icons.

XLSX format example
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XLS format example

From the Jama Connect header, select Reports to view the Reports history section. You can see the XLS
and XLSX format options and whether a report type is Velocity. For more information, see View and
download Reports history [462].
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Installing Jama Connect (KOTS)

Jama Connect is a Linux-based application that uses containerd to manage containers and depends

on Replicated KOTS software to "orchestrate" deploying applications. The process of installing Jama
Connect includes installing and configuring the software. These tasks deliver the components necessary
to run Jama Connect.

Components and what they do

Replicated KOTS — A container-based platform for easily deploying cloud native applications inside
customers' environments, providing greater security and control. The KOTS Admin Console is the inter-
face for installing and administering the Jama Connect application. See https:/www.replicated.com/ for
details.

Containerd — A container runtime that assists in the deployment, management, and operation of con-
tainers that support Jama Connect KOTS. See https://containerd.io/ for details.

Jama Connect license — The license included in your Welcome email. You save the license to your

application server, then begin installing Jama Connect.

Jama Connect architecture
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Users access Jama Connect by browsing to the instance URL (https:/jamainstanceurl.customer.com/).
Administrators browse to the KOTS Admin Console using the same instance URL, but on port 8800
(https://jamainstanceurl.customer.com:8800/).

Jama Connect and the license are updated via API calls for internet-enabled environments. Our airgap
option removes the need for remote API calls.

Content that is added to your Jama Connect instance is stored in the database.

Uploaded artifacts, such as attachments and report templates, are stored in a Persistent Volume
created by a Persistent Volume Claim (PVC) called tenantfs.

For more information about KOTS, see https:/www.replicated.com/blog/announcing-kots/

Installation workflow (KOTS)

Whether your environment is internet-enabled or airgapped, the installation process consists of three
stages: planning, preparation, and installation.

Review the system and server requirements for your environment, then follow the instructions for each
stage.

Plan

Review Release Notes

System requirements

Application server requirements
and resource sizing

Database server requirements and
resource sizing

Prepare Install

Prepare application and database Install KOTS software
servers Provision your Jama Connect
Install and configure database dataset

Configure memory settings for Create a Replicated Snapshot

Elasticsearch

For this component...

Follow these instructions

MySQL Install and configure MySQL [475]

Microsoft SQL Install and configure Microsoft SQL Server [476]
Internet Install KOTS software (internet) [480]

Airgap Install KOTS software (airgap) [487]

Local OpenSearch

Included by default

Remote OpenSearch

Configure dedicated OpenSearch nodes [503]

Planning your installation (KOTS)

Before you install the Admin Console and Jama Connect, make sure you have the following according to
your type of installation.

All installa- e The license file sent from Jama Software (included in the Welcome email)
tions * An application server with the necessary preparation [470] and sizing requirements [471]

e 3.10 (minimum)

o A database server with the necessary preparation [474]
e Supported [469] 64-bit Linux distribution with a kernel of:
o 4.x or greater (recommended)

Airgap in- o URL to the airgap-safe portal (included in the Welcome email) for downloading the Jama Connect application file
stallations e A unique password (included in the Welcome email) to access the airgap-safe portal

e PDF of this installation guide for the version of Jama Connect you are installing

Important
If you lose the URL and password, contact Support to generate new ones.

Optional o TLS certificate and private key to secure the Admin Console and Jama Connect application
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System requirements and supported software (KOTS)

Make sure that your environment conforms to all requirements and recommendations before installing
Jama Connect software.

After reviewing the information on this page, see "Things to do before installation" in the Jama Connect
9.35.x User Guide.

Important

To use Ubuntu 22.04, you must update the memory or OpenSearch fails. From the
KOTS Admin Console, adjust the memory settings so that Maximum Memory is 6G and
Maximum Memory for Container is 8G.

Application server

Use the information in this table for the server that runs the Jama Connect application. For details on
sizing your application server to your environment, see "Resource sizing for application server" in the
Jama Connect 9.35.x User Guide.

Component
Minimum Recommended
e 8CPU e 16 CPU
e 32 GBRAM * 64 GB RAM
e 200 GB storage per node e 256 GB storage
e Every node has the same storage space e Every node has the same storage space
Operating system

e Recommended — Ubuntu 22.04* and 24.04
e Red Hat 9.6 — Supported only when the RHEL Container Tools are not installed.

*To use Ubuntu 22.04, you must update the memory or OpenSearch fails. From the KOTS Admin Console, adjust the memory settings
so that Maximum Memory is 6G and Maximum Memory for Container is 8G.

Software installed with Jama Connect

e KOTS
e Containerd

Musts

e Dedicated server — Is running only Jama Connect
e Accessible by admin with permissions
e Uses only supported software and environments

Database server

Use the information in this table for the server that runs your database. For details on sizing your
database server to your environment, see "Resource sizing for database server" in the Jama Connect User
Guide.

Component
Minimum Recommended
e 4-8 CPU e 8CPU
e 16-24 GB RAM e 24 GB RAM
e Dedicated volumes for data
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Component

Database software

e MySQL 8.4.x
e Microsoft SQL Server 2022

Musts

e Database is hosted on a server separate from the Jama Connect application.
e Database server can host other databases, but no other applications.

e Accessible by admin with permissions.

e Uses only supported software and environments.

e Databases must be able to accept a minimum of 300 concurrent connections.

Not supported

o Azure database

e MariaDB

o Custom configurations of Jama Connect databases (for example, query optimization and additional indexes that aren’t shipped with
Jama Connect)

Supported software
Make sure your environment uses only supported software.

Component

Browsers Important

Browser zoom is supported only at 100%. Use of browser exten-

E hromi R . L A .
* Edge Chromium sions/add-ons or enabling Compatibility View is not supported while

e Firefox™ using Jama Connect.
e Google Chrome*
o Safari* Tip

To prevent session issues, use the application in a single browser

*Versions released over the past 12 months are supported. .
window.

Word processor and spreadsheet programs Office 365 is used for exports and reports.

e Office 365 for Mac
e Office 365 for Windows

MathType Equations Editor

® 7.7.1.6472
® 7.6.1.6408

Authentication

Jama Connect supports the following authentication options.

e Crowd 6.2.5
e LDAP
e SAML

Application server requirements (KOTS)
To install and run Jama Connect successfully, your application server must meet these requirements.

Requirement Notes

A dedicated application server Jama Connect is the only application running on the application server. External services can affect
stability of the application, for example by consuming memory resources.

Sufficient storage, CPU, and To estimate the size of and required resources for your application server, see Resource sizing for
memory for optimal perform- application server [471].
ance
Accessible by an admin with An admin must have proper permissions to maintain the application, perform upgrades, and access
permissions the server for regular maintenance.
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Requirement Notes
Uses compatible software and Verify that you're using supported software and environments [469] compatible with the most
environments recent self-hosted release.

Resource sizing for application server (KOTS)
For optimal performance, estimate your application server needs before you install Jama Connect.

Requirements

¢ Each node must have a minimum volume size of 200 GB. 256 GB is the recommended volume
size. Increase this size based on the size of the assets that you plan to save in Jama Connect. We
recommend that every node has the same storage space.

e KOTS must be up and running before you configure the application settings in the KOTS Admin
Console.

Important

To avoid performance issues, use the recommended requirements for horizontal scaling,
rather than minimum requirements.

Use the following tables to help determine resources for the primary node of your application server.

Table 1. Minimum size (AWS instance sizing = m5.2xlarge)

CPU RAM CPU + memory settings CPU + memory setting with horizontal scaling jamacores

8 32 GB N/A jamacore application settings:

e Maximum CPU: 1000m

e Maximum memory: 2 G

e Maximum memory per container: 3 G
e Number of ingress nodes 2

Table 2. Recommended size (AWS instance size = m5.4xlarge)

CPU RAM CPU + memory settings CPU + memory setting with horizontal scaling jama-
cores
16 64 GB Supports: Supports:
e 1,250 users with a ramp-up time of 30 sec- e 1,250 users with a ramp-up time of 10 seconds
onds e 2,500 users with a ramp-up time of 30 seconds
jamacore application settings: jamacore application settings:
e Maximum CPU: 12000m e Maximum CPU: 3000m
e Maximum memory: 48 G e Maximum memory: 12 G
e Maximum memory for container: 60 G e Maximum memory for container: 15 G
e Number of ingress nodes: 2
OpenSearch settings: OpenSearch settings:
e Maximum CPU: 8000m e Maximum CPU: 8000m
e Maximum memory: 8 G e Maximum memory: 8 G
e Maximum memory for container: 10 G e Maximum memory for container: 10 G
Diff Service settings: Diff Service settings:
o Maximum memory: 2 G e Maximum memory: 2 G

Use the following table to help determine resources for the secondary node of your application server.
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Table 3. Secondary nodes dedicated to OpenSearch: Recommended size (AWS
instance size = m5.2xlarge)

CPU RAM CPU + memory settings
8 32 GB Supports:

e 2,500 users with a ramp-up time of 10 seconds
OpenSearch settings:

e Maximum CPU: 8000m
e Maximum memory: 8 G
e Maximum memory for container: 10 G

. b_r Tip
* Once you're up and running, you can monitor usage and adjust your settings as needed
(see "Monitoring memory usage" and "Configure memory settings" in Jama Connect User

Guide 9.35.x).

Database server requirements (KOTS)

The database must be hosted on a server separate from the Jama Connect application. This server
can host other databases, but we don’t support running other applications on the same server as the
database.

Supported databases

e MySQL 8.4.x (recommended)
e Microsoft SQL Server 2022

What is not supported

e Azure database
e MariaDB

e Custom configurations of Jama Connect databases. Customizations such as query optimization and
additional indexes that aren’t shipped with Jama Connect aren’t supported.

Resource sizing for database server (KOTS)
For optimal performance, estimate your database server needs before you install Jama Connect.

Use the information in this table to determine resources needed for your database server.

Database server Small Medium Large Enterprise
Active items in system < 600,000 < 2 million 2-4 million 4 million+
Active projects <100 <500 < 1,000 1,000+
Concurrent users <50 <500 < 1,000 1,000+
CPU 4 8 16 Contact Support
Total systems of RAM 16 GB 32 GB 64 GB Contact Support

If your usage approaches the Enterprise threshold, contact Support for customized recommendations
and advanced, multi-server setup.
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u Tip
* Once you're up and running, you can monitor usage and adjust your settings as needed
(see "Monitoring memory usage" and "Configure memory settings" in Jama Connect User
Guide 9.35.x).

Important considerations

¢ Total system RAM for your database server can vary if you're using memory intensive workflows such
as reuse, exporting, moving items, integrations, and batch updates. Database sizing is based on your
usage patterns and platform. You must have a minimum of 4-8 cores and 16-24 GB of memory.
Consult with your database admin when determining database size.

e The memory allocation allows for minimum headroom. If you need to run additional software for mon-
itoring and analysis, consider the system requirements for that software. Configure dynamic memory
settings as needed in the Admin Console.

Things to do before installation (KOTS)

Whether your environment is internet-enabled or airgap, make sure that your application server and
database server are ready before installing Jama Connect.

Review the Jama Connect Release Notes.

e Prepare your application server [474].

e Prepare your database server [474].

Install and configure your database (MySQL [475] or SQL Server [476]).
Configure custom memory settings for OpenSearch [479].

Run the KOTS preflight installation checks

Whether your environment is internet-enabled or airgapped, run the KOTS preflight installation checksto
ensure your system is ready for upgrade.

The preflight checks verify that all server requirements are met to help avoid installation and upgrade
issues.When the results display green checkmarks for each test, you can begin the installation process.

To run preflight checks for internet-enabled environments:

1. Follow the instructions in the KOTS preflights repository to run the preflight checks on your applica-
tion and database servers.

2. Press S to save the file, then review the results.

3. Submit an Installation Service Request Form (guided for Self-Hosted) and include your preflight-
check results to help our technical services team support your installation needs. Include any
guestions or concerns about the results in the ticket.

To run preflight checks for airgapped environments:

1. Follow the instructions in the KOTS preflights repository.

Note
i You must download the necessary files from an internet-enabled system and move
them to your airgapped application and database servers.

2. Press S to save the file, then review the results.
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3. Submit an Installation Service Request Form (guided for Self-Hosted) and include your preflight-
check results to help our technical services team support your installation needs. Include any
guestions or concerns about the results in the ticket.

Prepare your application server (KOTS)

Make sure your application server meets all requirements. See System requirements and supported
software [469].

For users and admins to properly access Jama Connect, specific ports must be accessible to inbound
traffic. Work with your network admin to make sure your network is configured properly.

To prepare the application server:

1. Inbound rules and ports for nodes — Make sure the ports in the following table are accessible to
inbound traffic and the inbound rules are configured for each server in the KOTS cluster.

Protocol Port range Source* Inbound rule ap- Description
plies to node...
HTTPS 443 Anywhere All Jama Connect port for SSL/TLS communication

(HTTPS), which is used to access Jama Connect. It can
be disabled or the port number can be reconfigured.

HTTP 80 Anywhere All Jama Connect port for clear text communication
(HTTP), which is used to access Jama Connect. It can
be disabled or the port number can be reconfigured.

TCP 8800 Anywhere All Allows admins to access the KOTS Admin Console,
which is used to configure, install, and upgrade Jama
Connect.

SSH 22 Anywhere All Allows admins to make remote connections to the no-
des using SSH.

TCP 6443 Anywhere Primary Allows admins and KOTS nodes to access the Kuber-
netes API server.**

Any node

TCP 2379-2380 Any node Primary Allows the KOTS nodes to access the etcd server client
APL**

TCP 10250 Any node All Allows the KOTS nodes to access the Kubelet API
server.*®

UDP 8472 Any node All Allows KOTS (Flannel) to create a virtual network that

connects the services running inside the cluster.**

* Anywhere means anyone or anything that must consume the resources in the environment.

** Can be disabled in single node clusters.

2. User IDs — Verify that the following User IDs are available and unused on the application server.
e User ID 91 — Used by Tomcat to read and write to directories inside jamacore pods.
o User IDs 480-499 — Used by the various services.

3. Time sync setting — To ensure accurate time on the application server, set up a cron job to sync the
time on a routine schedule (for example, every day or hour). Use this command to set up the cron
job:

ntpdate pool._ntp.org
Your application server is now ready to install Jama Connect (KOTS) application.

Preparing your database server (KOTS)

The following information is needed when connecting the application server to the database server.

Information Requirements

Type/vendor Database must be one of the following:

o MySQL 8.4.x (recommended) — Install and configure MySQL [475]
o Microsoft SQL Server 2022 — Install and configure Microsoft SQL Server [476]
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Information

Requirements

Database hosthname

Example: jama.companydb.com

Listening ports

The application server must be allowed to communicate remotely with the database server over the
listening ports.

Default ports are:

e MySQL = 3306
e Microsoft SQL Server = 1433

Database schema name

The database owner must be able to create one:

¢ A new database schema
e Tables inside an existing database schema of the given name

The database name must follow these rules:
e Start with a letter (a-2)

e Contain any number of characters: a-z, 0-9 or an underscore ("_")
o Letters must be lowercase

Username jamauser

Password

Connections The database must be able to accept a minimum of 300 concurrent connections.
SAML schema username samluser

OAuth database user- oauthuser

name

The username and password for SAML and OAuth must match what's entered in the Microsoft SQL

Server upgrade preparation script. See Install and configure Microsoft SQL Server [476] for more details.

Install and configure MySQL (KOTS)

MySQL is the recommended database server. Follow these steps to install and configure it.

Important considerations

¢ You must have full database admin permissions to the server hosting the MySQL database.

e For the Jama Connect installation to succeed, you must first create two additional database schemas.
e |If you need to upgrade the MySQL, see "Install and configure MySQL (upgrading traditional to KOTS)"

in Jama Connect User Guide 9.35.x.

Recommended settings and sample

The following recommended settings require 8 GB of memory allocated to MySQL Server for a typical
installation and 16 GB for an enterprise installation.

When creating a database, use the default character set and collation (utf8mb4 and

utf8mb4_0900 ai_ci).

These settings can be added to your my.cnf file (Linux) or my.ini file (Windows).

Property Typical installation Enterprise installation
max_allowed_packet 1GB 1GB
tmp_table_size 2 GB 2 GB
max_heap_table_size 2GB 2GB
table_open_cache 512 512
innodb_buffer_pool_size 2GB 12 GB
innodb_log_file_size 256 MB 256 GB
innodb_log_buffer_size 12 MB 12 MB
innodb_thread_concurrency 16 16
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Property Typical installation Enterprise installation
max_connections 151 351
wait_timeout 259200 259200

Here is a sample text config file at an enterprise level. You must add the following values for your
environment:

bind-address=0.0.0.0

key_ buffer_size=16M
max_allowed_packet=1G
thread_stack=192K
thread_cache_size=8
tmp_table_size=2G
max_heap_table_size=2G
table_open_cache=512
innodb_buffer_pool_size=12G
innodb_log file_size=256M
innodb_log_buffer_size=12M
innodb_thread_concurrency=16
max_connections=351
wait_timeout=259200

To install and configure MySQL.:

1. Make sure that the InnoDB engine is enabled.
2. Download and install a supported version of MySQL [469].

On the MySQL database server, create an empty Jama Connect schema / database that uses UTF8:
CREATE DATABASE jama character set utf8mb4;

4. Onthe MySQL database server, create two additional database schemas and a user ("jamauser")
with the ability to access, create, and update tables within the database:
CREATE DATABASE saml;
CREATE DATABASE oauth;
CREATE USER *jamauser"@"%" IDENTIFIED BY "password”;
CREATE USER "oauthuser"@"%" IDENTIFIED BY "password®;
CREATE USER "samluser®"@"%" IDENTIFIED BY "password®;
GRANT ALL PRIVILEGES ON jama.* TO "jamauser=@"%";
GRANT ALL PRIVILEGES ON oauth.* TO "oauthuser®@"%";
GRANT ALL PRIVILEGES ON saml.* TO "samluser®@"%";

5. Create a database schema for Quartz to support horizontal scaling in KOTS:
CREATE DATABASE quartz;
CREATE USER "quartzuser"@"%" IDENTIFIED BY "password-®;
GRANT ALL PRIVILEGES ON quartz.* TO “quartzuser=@"%";

6. Restart the database server.

MySQL is now installed and configured on your database server.

Install and configure Microsoft SQL Server (KOTS)

If you are using Microsoft SQL Server for your database, follow these steps to install and configure it.
Important considerations

¢ You must have full database admin permissions to the server hosting the MicrosoftSQL Server data-
base.

¢ If you need to upgrade the Microsoft SQL Server, see "Install and configure Microsoft SQL Server
(upgrading traditional to KOTS)" in Jama Connect User Guide 9.35.x.

Before installing Jama Connect 9.35.x
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¢ [nstall Microsoft SQL Server 2022 for the database server.

e Create an empty Jama Connect database and two additional database schemas for the installation to
succeed.

¢ Jama Connect requires that the MSSQL COMPATIBILITY_LEVEL value is 160 or greater.

To confirm the current value:

SELECT compatibility level FROM sys.databases WHERE name = <DATABASENANE>;

To modify the value:

ALTER DATABASE <DATABASENAME> SET COMPATIBILITY_LEVEL = 160;

For more information, see https://learn.microsoft.com/en-us/sql/t-sql/statements/alter-database-
transact-sql-compatibility-level?view=sql-server-ver16

Organizations using Microsoft SQL Server must enter database users in Replicated. Without these
entries, the installation will fail.

The new schema must be created for a successful installation. Otherwise, the system continues to
attempt to connect to the databases and produces log failures. After you create the database schemas,
you must restart Jama Connect.

For more information, go to Supported software, environments, and system requirements and select your
version of Jama Connect.

To install Jama Connect for the first time:

1. Connect to the SQL Server using a SQL management application (such as SQL Server Management
Studio).

2. Replace the following values in the installation script: <JAMA_LOGIN_Psswd>, <SAML_LOG-
IN_Psswd> & <OAUTH_LOGIN_Psswd>.

3. Copy and store the passwords you create here. You will need them later to configure the Admin
Console settings.

4. In anew query window, run this SQL query script:

-- Fresh Install Preparation SCRIPT

/*

Jama Connect Preparation Commands for a fresh install. It is required to run
these command / script on the Microsoft SQL Server BEFORE running the Jama

Connect 8.62.x install

for ON-PREM installation using Microsoft SQL Server 2016 - 2019

DATE: 05/10/2021

NOTES:

This script assumes this is a new Installation of JAMA Connect. DO NOT RUN

THIS SCRIPT ON AN EXISTING JAMA INSTALLATION.

The script will create a new empty JAMA database, add 2 new schemas (empty) to

the Jama Database, 2 new DB Logins and Database users to support the Multi-

Auth functionality released in Jama Connect 8.62.0.

INSTRUCTIONS:

This script must be run prior to Jama installation or installation may fail to
complete.

Modify the <JamaUser LOG N _Psswd>, <SAML_LOG N _Psswd> & <OAUTH LOG N_Psswd>
values in the script below before Execution.

Passwords must be enclosed in single quotes.

*/

USE master;

CREATE LOGIN jamauser with password = "password”;
CREATE LOGIN samluser with password = "password”;
CREATE LOGIN oauthuser with password = "password”
GO
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USE master;
GO

CREATE DATABASE jama
COLLATE Latinl_General_CI_Al;
GO

ALTER DATABASE jama

SET READ_COMMITTED_SNAPSHOT ON
WITH ROLLBACK IMMEDIATE;

GO

USE jama;

EXEC ("CREATE SCHEMA oauth®);
EXEC ("CREATE SCHEMA saml®);
GO

USE jama;

CREATE USER jamauser for LOGIN jamauser;

CREATE USER samluser for LOGIN samluser with DEFAULT_SCHEMA=saml ;
CREATE USER oauthuser for LOGIN oauthuser with DEFAULT_SCHEMA=oauth;
GO

EXEC sp_addrolemember N*db_owner®, jamauser;
EXEC sp_addrolemember N*"db_owner®, samluser;
EXEC sp_addrolemember N"db_owner®, oauthuser;
GO

Create a database schema for Quartz to support horizontal scaling in KOTS:

USE master;
CREATE LOGIN quartzuser with password = "password®;
GO

USE jama;
EXEC ("CREATE SCHEMA quartz®);
GO

USE jama;
CREATE USER quartzuser for LOGIN quartzuser with DEFAULT_SCHEMA=quartz;
GO

EXEC sp_addrolemember N*db_owner®, quartzuser;
GO

Confirm that these actions were successful:

e Script completed — Check the Query Execution results for errors.

e Users created — Run the following SQL script in a new query window.
USE jama

SELECT * from master.sys.sql_logins
SELECT * from Jama.sys.sysusers

The results include jamauser, samluser, and oauthuser in the "Name" column of the result panes.
e Users granted the DB_owner role — Run the following SQL script in a new query window.

USE jama

SELECT DP1.name AS DatabaseRoleName,

isnull (DP2.name, “No members®) AS DatabaseUserName
FROM sys.database_role_members AS DRM

RIGHT OUTER JOIN sys.database_ principals AS DP1

ON DRM.role_principal_id = DP1.principal_id

LEFT OUTER JOIN sys.database_principals AS DP2

ON DRM.member_principal_id = DP2_principal_id
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WHERE DP1.type = "R"
ORDER BY DP1.name;

The results show that db_owner role is granted to jamauser, samluser, and oauthuser.
7. Keep the database from locking users' accounts while they are logging in or working in Jama
Connect (you must have db_owner permissions):

ALTER DATABASE jama SET READ_COMMITTED_SNAPSHOT ON WITH ROLLBACK IMMEDIATE;
8. Make sure the flag was successfully enabled:
SELECT is_read_committed_snapshot_on FROM sys.databases WHERE name="jama“;

If the returned value is 1, the flag is on.

Microsoft SQL Server is now installed and configured on your database server.

Configure custom memory settings for OpenSearch (KOTS)

To prepare for installing Jama Connect, you must first update the system that hosts the application. The
update consists of configuring memory settings for OpenSearch.

Requirements

e The memory settings must be configured on each server in the KOTS cluster for OpenSearch to run
on these servers. If you use the remote OpenSearch setting, the memory settings can be applied on-
ly to servers that are dedicated to OpenSearch.

¢ You must have admin permissions to configure the memory settings for OpenSearch.
To configure memory settings:

1. As an admin, open the /etc/sysctl.conf file, add the following line to the file, then save the file.
vm.max_map_count=262144
2. Reload the sysctl.conf file:
sudo sysctl -p
3. To confirm, type this command:
sudo sysctl -a | grep max_map_count
The system responds with:

vm.max_map_count=262144

The custom memory settings for OpenSearch are now configured on your application server.

Installing the software (KOTS)

KOTS is an open-source application for Kubernetes clusters that streamlines the process to remotely
install, manage, and update Jama Connect, all from the KOTS Admin Console or command-line interface
(CLI).

Important

KOTS and Jama Connect must be installed on a new cluster that is created during
installation and dedicated to KOTS.

Whether your organization is internet-enabled or requires an airgap installation, follow these instructions
to download, install, and configure the software you need for your Jama Connect instance.

The software includes:
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e KOTS Admin Console (Replicated)
e Jama Connect

Jama Software sends a Welcome email that includes your Jama Connect license file.
The installation process consists of these tasks:

e Install KOTS and Jama Connect (internet [480] or airgap [487])
¢ Provision your Jama Connect dataset [495]
e Create a Replicated Snapshot [496]

Depending on your environment, the process can also include these tasks:

e Configure KOTS to save tenant assets in Amazon EFS [504]

e Enable horizontal scaling [500]

e Configure dedicated OpenSearch nodes [503]

e Configure Federated Authentication for KOTS Admin Console [509]

Install Jama Connect and KOTS (internet)

The installation script and the installation wizard guide you through the process of installing the KOTS-
required software and Jama Connect, then configuring the KOTS Admin Console.

The license file is included in the Welcome email you received from Jama Software.
To install Jama Connect and KOTS on an internet-enabled server:

1. Open the Welcome email from Jama Connect, then save the attached license file on your local
system.
2.  Run the command on the application server provisioned for Jama Connect:

curl -sSL https://kurl._sh/jama-k8s-standardkots | sudo bash

Note

y kURL bundles and installs host packages without relying on external package repo-
sitories, except for on Red Hat Enterprise Linux 9 and Ubuntu 24. If kURL is unable
to install a required host package, the output notifies you. It this occurs, manually
install the missing package and then re-run the kURL installer to proceed.

3. After the command runs, save the KOTS admin URL, password, and other configuration options for
future reference. This is the only time these credentials appear, so make sure you save them.

4. In asupported browser, enter the URL for Kotsadm, which was generated when you installed KOTS.
5. Loginto the KOTS Admin Console using the password you just saved.
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6. Select the appropriate option:

o Have key/certificate — Select Choose file under Private key and Certificate, navigate to the files
and select them, then select Upload & Continue.

¢ No key/certificate — Select Self-Signed Cert.
7. Upload the license file that you saved on your local system.

8. Configure the settings for each group, as needed. Scroll down to see each group of settings.

e Database Settings — Select your database type (MySQL or Microsoft SQL Server), then use the
information from Preparing your database server [474] to complete the settings.
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¢ Host Name — Enter the base URL for Jama Connect. Ensure this domain name is routable on your
network.
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e TLS Key Pair Source — (Optional) If you have a custom key and certificate for the host name,
select Custom TLS Configuration. In the TLS Configuration section, upload the key and certificate.

o Assets Size — Enter the estimated size of the assets that you are planning to store in Jama
Connect.
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¢ OpenSearch Settings > Volume Size — Enter the amount of disk space that each OpenSearch
node is allowed to use.
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¢ Tenant Manager Settings — Enable this setting for optimal performance. Disable this setting if
background operations are required before you provision the tenant (for example, when reusing
traditional Replicated or using remote OpenSearch).
The Tenant Manager provisions, restores, upgrades, and sets licenses during application startup.

Tenant Manager Settings

Enabled?

(Optional) From the Config tab in the KOTS Admin Console, follow the steps to configure KOTS to
save tenant assets in the Amazon EFS [504].
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Important

To use Ubuntu 22.04, you must update the memory or OpenSearch fails. From the
KOTS Admin Console, adjust the memory settings so that Maximum Memory is 6G
and Maximum Memory for Container is 8G.

10. Scroll to the bottom of the page and select Continue.
The system performs the Preflight checks.

11. From the Preflight checks screen, select Continue to open the KOTS Admin Console.
The process can take up to an hour. When the system is available, the status changes to Ready.
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12. Log in to Jama Connect as root using the hostname configured for Jama Connect.

Jama Connect and KOTS are now successfully installed.

Important

Before you allow your users access to Jama Connect, you must provision a Jama Con-
nect dataset [495]. If you need the link to the dataset, contact your Customer Success
Manager.

Install Jama Connect and KOTS (airgap)

The installation script and the installation wizard guide you through the process of installing the KOTS-
required software and Jama Connect, then configuring the KOTS Admin Console.

The following is included in the Welcome email you received from Jama Software:

e License file
e URL to the airgap-safe portal for downloading the Jama Connect application file
¢ A unique password to access the airgap-safe portal

Note
y When you configure Jama Connect, accept the default settings, unless instructed other-
wise by Jama Support.

To install Jama Connect and KOTS for an airgapped environment:
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1. Open the Welcome email from Jama Connect and save the attached license file to your local system.
2. Login to the download portal, select the Embedded cluster option, then download the Embedded
Kubernetes Installer and App Bundle to your local system.

Move the downloaded Embedded Kubernetes Installer to your application server.
4. Replace <installer-name> with the name of the downloaded installer in the following commands,
then run these commands to extract the installer and run it:

w

tar -zxvf <installer-nane>_tar.gz
cat install_sh | sudo bash -s airgap

Note

é’ kURL bundles and installs host packages without relying on external package repo-
sitories, except for on Red Hat Enterprise Linux 9 and Ubuntu 24. If kURL is unable
to install a required host package, the output notifies you. It this occurs, manually
install the missing package and then re-run the kURL installer to proceed.

5. After the command runs (which might take several minutes), save the KOTS admin URL, password,

and other configuration options for future reference. This is the only time these credentials appear,

so make sure you save them.
6. In asupported browser, enter the URL for Kotsadm, which was generated when you installed KOTS.

7. Login to the KOTS Admin Console using the password you just saved.
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8. Select the appropriate option:
o Have key/certificate — Select Choose file under Private key and Certificate, navigate to the files
and select them, then select Upload & Continue.
¢ No key/certificate — Select Use Self-Signed Cert.
9. Upload the license file saved on your local system.
10. Upload your jama-k8s airgap bundle, then select Continue.

The Config tab in the KOTS Admin Console opens, where you can configure Jama Connect.
11. Configure the settings for each group, as needed. Scroll down to see each group of settings.
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Note
é’ Accept the default settings, unless instructed otherwise by Jama Support.

e Database Settings — Select your database type, then use information from Preparing your data-
base server [474] to complete the settings.

¢ Host Name — Enter the host name for the cluster.
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o TLS Key Pair Source — (Optional) If you have a custom key and certificate for the host name,
select Custom TLS Configuration. In the TLS Configuration section, upload the key and certificate.

o Assets Size — Enter the estimated size of the assets that you are planning to store in Jama
Connect.
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¢ OpenSearch Settings > Volume Size — Enter the amount of disk space that each OpenSearch
node is allowed to use.
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¢ Tenant Manager Settings — Enable this setting for optimal performance. Disable this setting if
background operations are required before you provision the tenant (for example, when reusing
traditional Replicated or using remote OpenSearch).
The Tenant Manager provisions, restores, upgrades, and sets licenses during application startup.

Tenant Manager Settings

Enabled?

12. (Optional) From the Config tab in the KOTS Admin Console, follow the steps to configure KOTS to
save tenant assets in the Amazon EFS [504].
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Important

To use Ubuntu 22.04, you must update the memory or OpenSearch fails. From the
KOTS Admin Console, adjust the memory settings so that Maximum Memory is 6G
and Maximum Memory for Container is 8G.

13. Scroll to the bottom of the page and select Save config.

The system performs the preflight checks.

14. From the Preflight checks screen, select Continue to open the KOTS Admin Console.
15. In the Application section of the dashboard, wait until the status changes to Ready.
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16. Log in to Jama Connect as root using the hostname configured for Jama Connect.

Jama Connect and KOTS are now successfully installed.

Important

Before you allow your users access to Jama Connect, you must provision a Jama Con-
nect dataset [495]. If you need the link to the dataset, contact your Customer Success
Manager.

Provision your Jama Connect dataset (KOTS)

Although optional, we strongly recommend that you provision an industry dataset. It ensures that your
organization has a sample framework as you begin to use Jama Connect.

If you don't provision an industry dataset in your installation, you don’t see sample data or an industry

framework when you log in and begin using Jama Connect. Otherwise, your use of Jama Connect isn’t
impacted.

Your purchase confirmation email includes the .jama license file and a link to the industry dataset. If you
don't have this link, contact your Customer Success Manager.

Requirements

¢ Jama Connect must be installed before you provision your dataset. Otherwise, the provisioning will
fail.

e |f the /data/restore directory doesn't exist, you must manually create it.

To provision your dataset:

495



Installing Jama Connect (KOTS)

Using the link that was included in your purchase confirmation email, download the .jama license file
for the industry dataset.

Copy the .jama file to a host system with a node within the KOTS cluster.

On the host system, copy the .jama file to the /data/restore directory:

kubectl cp -c core <path to .jama archive> default/core-0:/data/restore/
Configure the permissions for the file to be read by all users:

kubectl exec --tty -c core pods/core-0 -- chmod 644 /data/restore/
<fil ename>_jama

Delete the tenant properties file:

kubectl exec --tty -c core pods/core-0 -- rm /home/contour/tenant/
tenant.properties
kubectl exec --tty -c core pods/core-0 -- rm /home/contour/tenant.properties

Remove the resources:

kubectl delete sts/core

kubectl delete job/tenant-manager

kubectl delete pod/hazelcast-0

Drop the current database and create a new database, SQL Server [476] or MySQL [475], with the
same name. If you decide to create a database with a new name, update the database settings in the
config tab of the KOTS Admin Console.

From the KOTS Admin Console in the Restore Jama Backup section, enter the path to the backup
file, then select Save.

Select Go to updated version, then select Deploy.

In the Application section of the dashboard, the status changes to Ready. The provisioning of your
dataset is complete.

Create a Replicated Snapshot (KOTS)

Taking a full snapshot creates a backup of the KOTS Admin Console and application data. It can be used
for full Disaster Recovery by restoring over the same instance or in a new cluster. Tenant assets are
included in the snapshot. OpenSearch data is included by default.

A Replicated Snapshot can be taken while Jama Connect is running without interruption.
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Requirements

e Replicated Snapshots must be enabled for your Replicated customer license.

e KOTS Admin Console 1.79 and later.

e Replicated Snapshots don't include your database. You must use a proprietary backup/restore system
for your type of database, MySQL or SQL Server.

Important considerations

¢ When restoring from a snapshot in a new cluster, you must reinstall KOTS.

e Recommended — Include OpenSearch data in snapshots to avoid having to reindex your data after
performing a restore. However, if your snapshot is not recent, we recommend reindexing your data.

e Replicated Snapshots don't support IAM authentication against EFS. Saving Replicated Snapshots in
EFS requires that you use the default file system policy to allow all nodes in the cluster to mount the
EFS.

To create a Replicated snapshot:

1. Capture the KOTS installer.

2.  (Recommended) Include OpenSearch data in snapshots: From the KOTS Admin Console under the
OpenSearch Settings section, select Include OpenSearch in Replicated Snapshots.

3. Airgap only — Capture the IP address of the private registry, which is the IP address value in the
Cluster-IP column:
kubectl get service/registry -n kurl

4. Configure the storage destination:
a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. From the Destination drop-down menu, select a storage destination for your snapshots.
o For AWS S3 — The IAM role assigned to the underlaying servers or the user associated with
the credentials (access and secret key) must have the Policy template attached.
Use the following template to create a policy, replacing the <arn-S3> parameter with ARN of
the S3 bucket. For example: arn:aws:s3:::;jama-snapshots.

{
"Version': '"2012-10-17",
"Statement™: [
{
"Effect': "Allow",
"Action™: [
"s3:PutObject”,
"'s3:GetObject",
"'s3:AbortMultipartUpload"”,
""'s3:DeleteObject",
"s3:ListMultipartUploadParts™
1.
"Resource': ''<arn-s3>/*"
3,
{
"Effect: "Allow",
"Action": "s3:ListBucket",
"Resource': '<arn-s3>"
}
1
}

e For NFS — If using EFS as an NFS server, the Server field = the DNS name of the EFS and the
Path field = a directory inside the EFS, writable by the user:group 1001:1001.

c. Select Update storage settings to save your preferences.
5. Schedule Full Snapshots:
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a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. Select Enable automatic scheduled snapshots, then select Update schedule.
6. Create a Full Snapshot (follow the steps provided by Replicated).

The KOTS Admin Console and application data are now backed up and available for a full Disaster
Recovery.

Capture KOTS Installer (KOTS)

When you restore a snapshot in a new cluster, the version of KOTS and its add-ons must match those of
the original cluster. Capture each KOTS Installer that was used to create or update your clusters.

Why capture the kurl URL?

A hashed kurl URL (for example, https://kurl.sh/c601b1e) points to a website where you can get the
installation script or Kubernetes airgap bundle. Both require you to install the same version of KOTS
and add-ons. You must capture this kurl URL because the Replicated Channel URL that was used to
install KOTS always pulls the latest KOTS installer that has been promoted. If you rerun the installer
from the channel to enable an advanced option or you create a cluster to restore a snapshot, you might
accidentally update the KOTS version and it's add-ons.

Note

ﬁ Replicated Vendor maintains a history of every installer that has been promoted to a
channel. If for any reason the kurl URL captured in this procedure doesn't work, it can
be provided to Jama Software and we might be able to find a similar installer in our
KOTS Installer History.

To capture the KOTS Installer:

1. Use the following installer resource information to create a .yaml file named installer.yaml:

cat <<EOT >> installer.yaml
apiVersion: cluster.kurl.sh/vlbetal
kind: Installer
metadata:

name: latest
EOT

2. Get all installer resources in your cluster, and copy down the name of the installer that you used to
download it:
kubectl get installers
3. Gather the installer details, replacing the <installer-name> parameter:
kubectl get installers <installer-nane> -o yaml
4. From the results, copy the spec section and paste it at the end of the installer.yaml file that you
created.
The file looks similar to this example of a KOTS Installer:
apiVersion: cluster._kurl._sh/vlbetal
kind: Installer
metadata:
name: latest
spec:
certManager:
version: 1.9.1

containerd:
version: 1.6.24
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contour:
version: 1.25.2
ekco:
version: 0.28.3
flannel:
version: 0.22.3
kotsadm:
applicationSlug: jama-k8s/standardkots
version: 1.103.3

kubernetes:

version: 1.27.6
metricsServer:

version: 0.6.4
minio:

version: 2023-09-30T07-02-29Z7
openebs:

isLocalPVEnabled: true
localPVStorageClassName: local
version: 3.9.0

prometheus:

version: 0.68.0-51.0.0
registry:

version: 2.8.3
velero:

version: 1.11.1
5. Send the installer.yaml file to the create installer APl from Replicated to receive a hashed URL:

curl -X POST -H "Content-Type: text/yaml'" --data-binary "@installer._.yaml™ \
https://kurl _sh/installer && echo "

6. Save the kurl URL that is displayed. It looks similar to https:/kurl.sh/c601b1le.

The KOTS installer is now available for restoring a Replicated snapshot in a new cluster.

Restore KOTS Admin Console and Jama Connect from a Replicated Snapshot
(KOTS)

When you set up a new application server for Jama Connect, you can restore the KOTS Admin Console
settings that you saved in a Replicated Snapshot.

Snapshots include the registry images and data for Jama Connect.

Requirements

If restoring to a new cluster, it must match these specifications and settings of the cluster where the
backup was taken:

e Number of nodes

¢ Inbound and outbound traffic rules

¢ Virtual memory settings for OpenSearch

e Connectivity to external services and resources (for example, AWS EFS, AWS S3)

To restore from a snapshot:

1. Configure servers for a new cluster:

a. After the servers for the cluster are provisioned, install KOTS on one node using the captured
KOTS Installer. You must pass the same flags to the installation script that were passed to the
original cluster.

e Restoring an online cluster — Run the appropriate installation script that was generated from
the captured KOTS installer.

e Restoring an airgap cluster — Download the appropriate KOTS installer bundle, replacing
<ip> with the IP address of the private registry from the original cluster:
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cat install_sh | sudo bash -s airgap kurl-registry-ip=<i p>
b. When the installer has finished, run the command displayed on the screen so the other servers
join the cluster. If required, label the nodes dedicated for OpenSearch.
c. Install any add-ons that were manually installed in the cluster. For example, the EFS Driver.

2. Configure the storage destination: From the KOTS CLI, point the cluster to the storage destination
where the Replicated Snapshots were saved.

AWS S3 See configure-aws-s3.
Azure See configure-azure.
GCP See configure-gcp.

S3-Other See configure-other-s3.

NFS See configure-nfs. If the cluster uses EFS or NFS, also see Configuring an NFS Storage Destination.

Note: If using EFS as an NFS server, Server field = DNS name of the EFS and Path field = a directory inside the
EFS, writable by the user:group 1001:1001.

3. Locate the snapshot and restore it: From the KOTS CLI, run a backup Is and full restore.
backup Is
This can take a few minutes. If the snapshots don’t appear, rerun this command.

4. If you changed the host name for Jama Connect:
a. Update the Host Name field in the KOTS Admin Console and deploy the change.
b. From your browser, log in to Jama Connect and change your URL.

5.  View scheduled jobs to verify that the list isn't empty.

6. If the OpenSearch data wasn't included in the snapshot or if the snapshot isn't recent, reindex all
search items.

7. Verify that you can locate your assets.

The new application server for Jama Connect is successfully set up.

Enable horizontal scaling (KOTS)

To avoid performance issues, you can enable horizontal scaling and add more instances of Jama Connect.
For each KOTS node, configure each Jama Connect instance to use more CPU and memory.

Important considerations
e This task is optional.
Requirements

e Jama Connect must already be installed and running before enabling this option.

e If restoring your environment from a backup, restore it without horizontal scaling enabled.

¢ To use horizontal scaling, you must provide a new database schema and user.

¢ Once you increase the number of replicas for each instance role, don't decrease the number.

Important

To avoid performance issues, use the recommended requirements [470] for horizontal
scaling, rather than minimum requirements.

To enable horizontal scaling:

1. On the KOTS Admin Console, go to the Config tab.
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2. Scroll to the Core Jama Application Settings section, and select Enable Horizontal Scaling.
Extra fields are displayed for setting horizontal scaling.

3. Specify the number of nodes that you want per role (default is 1). For recommended values, see
Application server requirements [470].
¢ Minimum number of ingress nodes
¢ Minimum number of job nodes
¢ Minimum number of report nodes

4. Adjust the maximum memory and CPU for each node. For recommended values, see Application
server requirements [470].

5. Scroll down to the Database Settings section and specify the Quartz database schema information.
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You can use the following scripts as a base to create the schema for Quartz in your database. They
were created assuming that you already set up your database [474].

In the scripts, change the schema name, username, or user password to match what you specified in
the KOTS Admin Console.

MySQL: CREATE DATABASE quartz;
CREATE USER “"quartzuser®@"%" IDENTIFIED BY "password”;
GRANT ALL PRIVILEGES ON quartz.* TO “quartzuser™@"%";
Microsoft SQL: USE master:
CREATE LOGIN quartzuser with password = "password®;
GO
USE jama;
EXEC ("CREATE SCHEMA quartz*);
GO
USE jama;
CREATE USER quartzuser for LOGIN quartzuser with DEFAULT_SCHEMA=quartz;
GO
EXEC sp_addrolemember N"db_owner®, quartzuser;
GO

6. Select Save config.

7. Deploy the new version: Select the Version history tab and select Deploy in the row of your newly
configured version.

8. Verify the status of your application: Select the Dashboard tab and make sure the status is Ready.
9. (Optional) Verify that the new pods are ready:

kubectl get pods -o wide

Horizontal scaling is now enabled and configured on your application server.
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Configure dedicated OpenSearch nodes (KOTS)

Your primary KOTS server (node) is referred to as a KOTS stack. To run OpenSearch, you must add one
or more secondary nodes where OpenSearch will run, and configure the nodes to run OpenSearch.

Important considerations

e This task is optional .

¢ You must have a functioning primary KOTS server and a secondary server where Replicated KOTS has
not yet been installed. For secondary node specifications, see Application server requirements [470].

o This task is appropriate for a new node and an existing node.

e Contact Support to enable remote OpenSearch for your Replicated license.

To configure your nodes:

1. Make sure communication is established between primary (KOTS stack) and secondary (where
OpenSearch will run) KOTS nodes. For more information, see Prepare your application server [474].
2.  On the secondary node, configure the memory settings for OpenSearch [479].
echo "vm.max_map_count=262144" | sudo tee -a /etc/sysctl._conf
sudo sysctl -p
3.  On the Admin Console of the primary node below Version history, select Check for updates to
synch the changes made to your license.
4. Select the Config tab and, if you see the following message, select Edit the latest config.

5. Scroll down to the OpenSearch Settings section and follow the steps shown to add a dedicated
OpenSearch node.

6. Set the number of OpenSearch nodes to match the number of dedicated KOTS nodes that you
configured.

7. Adjust the maximum memory and CPU that each OpenSearch node can use based on the specifica-
tions of each dedicated KOTS node set up for OpenSearch. For more information, see Application
server requirements [470] and Resource sizing for application server [471].
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8. Select Save config.
9. Deploy the changes.
10. When the OpenSearch cluster is up and running, reindex all items.

The secondary nodes are now configured to be able to run OpenSearch.

Configure KOTS to save tenant assets in Amazon EFS

When you configure KOTS to save tenant assets in Amazon EFS, the tenant assets are saved if a cluster
fails. EFS provides automatic backups of the tenant assets and EFS is automatically scaled as you add
and remove assets.
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Important

Complete this task before Jama Connect is deployed. Otherwise, if you want to move
your assets to EFS, you must first back up tenant assets to a TAR in KOTS [508].

Requirements

e A KOTS cluster must be up and running.

You must be able to create and modify these AWS resources: IAM roles, IAM policies, security groups,
EC2 instances, and EFS file systems.

The cluster must have internet access to download the EFS driver and associated containerd images.
Ports 9909 and 9809 must be available for the EFS driver to function successfully.

Create a new EFS dedicated to your KOTS stack because each Persistent Volume requires an EFS
point, and access points are limited. Currently, each EFS can have a maximum of 120 access points. A
dedicated EFS allows you to future-proof the cluster. The steps are provided below.

Note
y Make sure you copy the Amazon Resource Names (ARNSs) for the IAM role that is
assigned to the EC2 instances included in the KOTS cluster.

To save tenant assets:

1. Create a new security group for the EFS that allows inbound access for the TCP protocol on the NFS

port (2049) from all EC2 instances that are included in the KOTS cluster.

a. Select a security group that is assigned to the EC2 instances as the source.

b. Confirm that the EC2 instances included in the KOTS cluster have a security group that allows
outbound access on the NFS port to the security group created in the previous step.

2. Create the Amazon EFS file system:

a. From the Amazon EFS Management Console, select Create file system.

b. Inthe Create file system page, select Customize.

c. On the File systems setting page, configure the following, then select Next:
¢ Name — Enter a name that allows you to easily identify the EFS.
e Availability and Durability — Regional.
e Automatic backups — Enable automatic backups during off hours to avoid backup inconsis-

tencies.

o Performance mode — General Purpose.
e Throughput mode — Bursting.
e Encryption — Enable encryption of data at rest.

d. On the Network access page, configure the following, then select Next:
e Virtual Private Cloud (VPC) — Enter the name of the VPC where the KOTS cluster is running.
o Mount targets — Verify that a mount target is created per Availability Zone, then assign the

security group you created earlier.

e. Using the template below, generate a file system policy for the EFS, replacing the <arn-cluster-

role> parameter with the ARN of the cluster role. Then, attach the policy to the EFS.

{
"Version': ""2012-10-17",

"Statement™: [
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{
“"Effect': "Deny",
"Principal™: {
UAWST L e
.
"Action': "*",
"Condition™: {
"Bool": {
"aws:SecureTransport™: "false™

3
},
{
"Effect'": "Allow",
"Principal™: {
"AWS": "<arn-cluster-rol e>"

}

"Action': [
"elasticfilesystem:ClientRootAccess",
"elasticfilesystem:ClientWrite",
"elasticfilesystem:ClientMount”

1
}
1
}

f.  On the Review and create page that opens, review the file system configuration groups, then
select Create to create your file system and return to the File systems page.
3. Edit the cluster role:

a. Generate the ARN of the newly created EFS, replacing <region>, <account-id>, and <file-sys-
tem-id> parameters:

arn:zaws:elasticfilesystem:<regi on>:<account -i d>:File-system/<fil e-systemi d>
b. Generate the ARN for the access points, replacing <region> and <account-id> parameters:
arn:aws:elasticfilesystem:<regi on>:<account - i d>:access-point/>

Important
The template must be used as is, with the policy targeting all access points.

c. Use the following template to create a new IAM policy, replacing the <arn-efs> with the
ARN generated in step 3a and replacing the <arn-access-points> parameters with the ARN
generated in step 3b. Then, attach the new policy to the cluster role.

{
"Version': ""2012-10-17",
"Statement: [
{

"Effect': "Allow",

"Action": [
"ec2:DescribeAvailabilityZones"

1.

""Resource™: ""*"

}.
{

"Effect': "Allow",

"Action": [
"elasticfilesystem:DescribeAccessPoints",
"elasticfilesystem:DescribeFileSystems",
"elasticfilesystem:DescribeMountTargets"

1.
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""Resource': '"<arn-efs>"

},

{
"Effect: "Allow",
"Action': "elasticfilesystem:CreateAccessPoint",
""Resource': '<arn-efs>",

"Condition™": {
"StringLike”: {

"aws:RequestTag/efs.csi.aws.com/cluster': "true"
}
}
}.
{
"Effect": "Allow",
"Action': "elasticfilesystem:DeleteAccessPoint",
""Resource™: ''<arn-access-poi nts>",

"Condition": {
"StringEquals™: {
"aws:ResourceTag/efs.csi.aws.com/cluster™: 'true”

Install the AWS EFS driver version 1.3.8 in your cluster:

kubectl apply -k "github.com/kubernetes-sigs/aws-efs-csi-driver/deploy/
kubernetes/\

overlays/stable/?ref=tags/v1.3.8"

The following containerd images are downloaded to your EFS driver: amazon/aws-efs-csi-driv-

er, public.ecr.aws/eks-distro/kubernetes-csi/node-driver-registrar, public.ecr.aws/eks-distro/kuber-
netes-csi/livenessprobe.

Verify that the driver was successfully installed:

kubectl get daemonset.apps/efs-csi-node csidriver/efs.csi.aws.com deployments/\
efs-csi-controller -n kube-system

NAME DESIRED  CURRENT  READY  UP-TO-DATE  AVAILABLE  NODE SELECTOR AGE
daemonset .apps/efs-csi-node 1 1 1 1 1 beta.kubernetes.ioc/os=1linux  26m

NAME ATTACHREQUIRED  PODINFOONMOUNT  STORAGECAPACITY  TOKENREQUESTS  REQUIRESREPUBLISH

csidriver.storage.k8s.io/efs.csi.aws.com false false false <unset> false

NAME READY  UP-TO-DATE  AVAILABLE  AGE
deployment.apps/efs-csi-controller 1/2 2 1 26m

Enable the EFS Storage Class.

a. Login to the KOTS Admin Console, select the Config tab, then scroll to the AWS Resources
section.

b. Select Enable EFS Storage Class.

In the AWS EFS Storage Class section under File System ID, enter the ID of the newly created
EFS.

Remove existing PVC and assets.

Important

If Jama Connect has been deployed and you want to move your assets to EFS, you
must first back up tenant assets to a TAR in KOTS [508].

a. From the primary node, delete the StatefulSets of the core pods:
kubectl delete sts/core sts/core-ingress sts/core-reports sts/core-jobs
b. Delete the PVC that contains the assets, so that a new PVC can be created that points to EFS:
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kubectl delete pvc/tenantfs

8. Save assetsin EFS.
a. From the KOTS Admin Console, scroll to the Storage section, then in the Assets Storage Class
field, enter the name assigned to the EFS Storage Class.
b. Save your changes and deploy Jama Connect.
c. (Optional) Once the core pods are running, restore tenant assets from a TAR in KOTS [509].
9. Run this command:

kubectl get pvc/tenantfs
The output displays storage class as the name assigned to the EFS storage class.

Back up tenant assets to a TAR file in KOTS

If Jama Connect was deployed to KOTS and you want to move your assets to EFS, you must first back up
tenant assets to a Tape Archive file (TAR) in KOTS.

Important

You must have a core-0 pod running, unless you have horizontal scaling enabled for
jamacore, then a core-ingress-0 pod is running.

To back up tenant assets:

1. Set an environment variable with your tenant name [517]:
export TENANT_NAME=jama

2. Copy the assets from a core pod to an assets local directory in the KOTS node. To reduce the
backup size, exclude the tempreports.

kubectl cp -c core default/core-0:/home/contour/tenant/${TENANT_NAME}/
attachments assets/attachments

kubectl cp -c core default/core-0:/home/contour/tenant/${TENANT_NAME}/avatars
assets/avatars

kubectl cp -c core default/core-0:/home/contour/tenant/${TENANT_NAME}/diagrams
assets/diagrams

kubectl cp -c core default/core-0:/home/contour/tenant/${TENANT_NAME}/equations
assets/equations

kubectl cp -c core default/core-0:/home/contour/tenant/${TENANT_NAME}/reports
assets/reports

kubectl cp -c core default/core-0:/home/contour/tenant/${TENANT_NAME}/
tempreports assets/tempreports

3. List the contents of the assets directory inside the core pod:

kubectl exec --tty -c core pods/core-0 -- Is -la /home/contour/tenant/$
{TENANT_NAME}/

4. Verify that the commands from step 2 included every folder and file displayed.
5. Create a TAR file from the local directory:

tar -zcvf assets.tar.gz assets/
6. Copy the TAR file from the node to a different system and review its content:
scp <user >@<i p- anot her - machi ne>:<desti nati on- pat h> assets.tar.gz
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You now have a backup file that includes all the assets.

Restore tenant assets from TAR in KOTS

Follow this process when you have an existing cluster and want to save your tenant assets on an external
storage device.

Requirements

¢ In EFS, the tenant assets must be backed up in a TAR file [508] and restored once EFS has been
configured.

e Make sure that you use our process to create the TAR file; the restore commands expect a TAR file
with a certain structure.

To restore tenant assets:

1. Set an environment variable with your tenant name [517]:
export TENANT_NAME=jama
2. Copy the TAR file from its current location to a master node:
scp assets.tar.gz <user >@<i p- mast er - node>:~/assets.tar.gz
3. Login to the master node and extract the TAR file:
tar -xvzf assets.tar.gz
4. Copy the assets to a core pod:

cd assets

kubectl cp -c core . default/core-0:/home/contour/tenant/${TENANT_NAME}/
kubectl exec --tty -c core pods/core-0 -- chmod -R 755 /home/contour

kubectl exec --tty -c core pods/core-0 -- chown -R tomcat:tomcat /home/contour

5. Verify that the assets were copied:

kubectl exec --tty -c core pods/core-0 -- Is -la /home/contour/tenant/$
{TENANT_NAME}/
kubectl exec --tty -c core pods/core-0 -- du -shc /home/contour/tenant/$

{TENANT_NAME}/

Your tenant assets are now saved on an external storage device.

Configure Federated Authentication for KOTS Admin Console

By default, you can log in to the KOTS Admin Console with a shared password. To improve security,
configure this feature so that KOTS admin authentication is managed by your Identity Provider.

Requirements

¢ You must have the KOTS software installed.
¢ |dentity Service must be enabled by Jama Software Support for your Replicated license.
¢ You must have an Identity Provider that is compatible with OpenlID.

Important considerations

¢ When you enable identity provider access to the KOTS Admin Console, shared password authentica-
tion is disabled. To reset authentication and reenable shared password authentication:

kubectl kots identity-service enable-shared-password --namespace default
To configure Federated Authentication:

1. Update the KOTS license if Support enabled Identity Service for your license. (See "Update the
KOTS license" in Jama Connect 9.35.x User Guide).

2. Connect KOTS Admin Console to the Identity Provider.
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a. Login tothe KOTS Admin Console, then select the Access tab.
b. In the Configure Identity Provider section:
o Verify that the Admin Console URL matches the URL for your KOTS Admin Console.
e Connector name — Enter a name that works best for your team.
o Issuer — Enter the Issuer or OpenID Configuration URL from your IdP application.
o Client ID and Client secret — Enter the Client ID and Client Secret from your IdP application.
c. Select the Access tab to expand the Advanced options menu, complete the following, then
selectSave provider settings:
e Scopes — Enter the OpenlD, profile, and email.
o Skip email verification — Enable or disable this option based on your organization's needs
and IdP support.
¢ Remaining fields — Use the default values.
d. Select Logout.

You are redirected to a new login screen, where you can log in to Jama Connect. If a "Failed to attempt
login" error appears, see Troubleshooting KOTS errors [510].

After installing Jama Connect (KOTS)

Whether your environment is internet-enabled or airgap, after you install Jama Connect you can contin-
ue to set up your Jama Connect environment.

Follow any post installation instructions that apply to your organization.
The setup tasks to configure your environment include:

e Add Organization Admin account

Modify organization details

Configure email/collaboration settings

Configure user authentication

Create XML backups (optional)

Update the license for KOTS environments (optional)

If you have further questions about Jama Connect installation and setup, visit the Jama Support Com-
munity or contact Support.

Troubleshooting your installation (KOTS)

If you run into problems with your KOTS installation, here are some resources that might help.

e Connection errors [511]

Federated Authentication errors [511]

Backup and restore errors [512]

Installation errors [510]

e Generate a support bundle [512]

e Configure Liveness and Readiness Probe settings [513]

Installation errors (KOTS)

If any errors occurred during installation, use this table to fix the issues.

Error message Solution

This webpage is not avail- Verify that the "Host Name" section of the settings was correctly entered to point to the application
able server.
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Error message

Solution

Not private or Not secure

This might happen if you chose a self-signed certificate or uploaded an invalid certificate. Verify that
you correctly entered the Custom TLS configuration in the Host Name window.

If this happens only for other users and not the system administrator, and the Admin Console is using
a self-signed certificate, you might have already told your web browser to "Proceed ... (unsafe)" or "Add
exception,” while other users haven't. Verify that you selected the setting you want for Reuse admin
console TLS configuration in the Host Name window.

Problem: Cannot create
database jama: Connec-
tions could not be ac-
quired from the underly-
ing database!

Most likely, something is wrong with your Admin Console database settings (for example, bind-address,
DBO credentials), or the connection between the application server and the database server. Double-
check your database settings in the Admin Console.

Connection errors (KOTS)

The KOTS installation process includes using the kubectl command line tool. If you see an error message
that relates to kubectl, use the workaround tips for the issue.

Error message Reason Workaround

The connection to the server local- kubectl might not be configured * Wrong user — Switch to the user that installed

host:8080 was refused - did you properly for the user and/or node KQOTS or to root (sudo su -), then rerun the ku-

specify the right host or port? er- where you tried to use it. bectl command.

ror: error loading config file "/etc/ku- e Wrong node — Switch to the server where

bernetes/admin.conf": open /etc/kuber- KOTS was installed initially or to a primary

netes/admin.conf: permission denied node, then rerun the kubectl command.
kubectl can be configured for other users and no-
des but it requires some research. See Embedded
Cluster: How to get kubectl working for other
users.

Waited for 1.184446141s due to cli- When using kubectl with Ubuntu Log in to Jama Connect as the root user (sudo su

ent-side throttling, not priority and fair- 18.04, you might see this warning -).

ness message.

Application status is not accurate This error usually occurs when Redeploy the latest license version from the Ver-
the cluster is restarted or if a sion history tab in the KOTS Admin Console.
cluster was restored from a snap-
shot. The Application status in
the KOTS Admin Console might
differ from what you see in the
Ul when using kubectl.

Federated Authentication errors (KOTS)

The "Failed to attempt login" error can occur when you log in to the KOTS Admin Console from a
browser for the first time. This error can occur if you didn't specify the host name and chose to upload
custom certificates, or you specified the host name but it wasn't retained by the KOTS Admin Console.

To resolve this issue:

If provided, the KOTS Admin Console uses the custom certificate. If none was provided, a new self-sign-
ed certificate is generated with the host name you specified. The KOTS Admin Console retains the host

name.

1. Review the KOTS Admin pod logs:
a. Check the name for your KOTS Admin pod:

kubectl get pods -o wide
b. Check the logs for your KOTS Admin pod:
kubectl logs -T pods/<kot sadm pod- nane>

Review the logs and confirm that the following error appears:

{

"level™:

error™,

ts'': "2022-08-25T18:36:03Z2",
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"msg': "failed to get kotsadm oidc provider: failed to query provider
\"https://<your - kot s- adm n- host nanme>:8800/dex\"": Get \"https://<your -
kot s- adm n- host nane>:8800/dex/ .wel I-known/openid-configuration\": x509:
certificate is valid for kotsadm, kotsadm.default, kotsadm.default.svc,
kotsadm.default.svc.cluster, kotsadm.default.svc.cluster.local, not <your-
kot s- admi n- host nanme>"'
}
2. Restore the ability to configure the TLS certificates:
kubectl -n default annotate secret kotsadm-tls acceptAnonymousUploads=1 --
overwrite

3. Restart the kurl-proxy pod:

kubectl delete pod $(kubectl get pod | grep kurl-proxy | awk "{print $1}~)
4. Open the KOTS Admin Console with this link: http:/<your-kots-admin-hostname>8800/tls
5. Choose one:

e Select Skip & continue if you don't want to provide custom certificates.

e Upload the files and select Upload & continue if you want to provide custom certificates.

Backup and restore errors (KOTS)

Replicated has documented the following scenarios.

Error message Reason Workaround
Error executing hook When a cluster is restarted, some pods might be in a Shut- Delete the pods that are in a Shut-
down state, meaning they were likely replaced by new pods. down state: kubectl delete pods/
<pod-name>
Connect is not reacha- If you restored a cluster on a new server with a different host Delete the httproxy resource for
ble after a restore even name than the original, and updated the Host Name field in the nginx and redeploy it: kubectl de-
when pods are ready KOTS Admin Console and deployed it, the httpproxy resource lete httpproxy/nginx

for nginx might not have been updated.

Generate a support bundle (KOTS)

To troubleshoot and diagnose problems with application deployments, you can generate a support
bundle to collect and analyze data from your environment.

Jama Support uploads the support bundle to the Replicated vendor portal to view and interpret the
analysis, and can open a support request ticket if needed. Severity 1 issues are resolved three times
faster when submitted with support bundles.

To generate a support bundle:

1. Forinternet environments, generate a support bundle from the CLI:
a. Login to the KOTS Admin Console, then select the Troubleshoot tab.
b. Scroll down to the Analyze Jama Connect for support section, then select If you'd prefer to get
a command to manually generate a support bundle.
A cURL command appears.
c. Copy the command.
d. From the CLI, run the command to generate a support bundle.
2. For airgap environments, generate a support bundle from the CLI:
a. Login to the KOTS Admin Console, then select the Troubleshoot tab.
b. Scroll down to the Analyze Jama Connect for support section, then select If you'd prefer to get
a command to manually generate a support bundle.
A cURL command appears.
c. Remove the following code from the cURL command:
curl https://krew.sh/support-bundle | bash

Your command looks like this:
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kubectl support-bundle secret/default/kotsadm-jama-k8s-supportbundle --
redactors=configmap/\

default/kotsadm-redact-spec/redact-spec, configmap/defaul t/kotsadm-jama-k8s-
redact-spec/redact-spec

d. Copy the command.
e. From the CLI, run the command to generate a support bundle.

The support bundle is generated and available for Jama Support to upload to the Replicated vendor
portal.

Configure Liveness and Readiness Probe settings (KOTS)
Liveness and Readiness Probes are an effective tool for recovering from application failures and must be
used with caution.

Liveness Probes check if a container is running correctly. They identify and fix issues if a container
becomes unresponsive or gets stuck. If a liveness probe fails, Kubernetes restarts the container.

Readiness Probes check if a container is ready to accept incoming traffic. If a Readiness Probe fails,
Kubernetes stops sending traffic to the container until it passes. A Pod is only considered ready when all
its containers are ready.

For more information, see Kubernetes Configure Probes.

Important

Configure these settings carefully to ensure they reflect unrecoverable application
failures, such as deadlocks. Adjustments to Liveness and Readiness Probe default set-
tings must consider how your KOTS environment is currently performing. Contact Jama
Support before changing these settings from their defaults.

Requirements
¢ Your environment must be running Jama Connect 9.6.7 or later.
To configure Liveness and Readiness Probe settings:

1. On the KOTS Admin Console, go to the Config section.
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2. Scroll to the Core Jama Application Settings section, and select Show Advanced Settings.

3. Scroll to the Liveness Probe section and complete the settings.
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Initial Delay (in seconds)

Period (in seconds)

Timeout (in seconds)

e Success Threshold (in seconds)

¢ Failure Threshold (in seconds)

Scroll to the Readiness Probe section and complete the settings.
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e |nitial Delay (in seconds)

e Period (in seconds)

e Timeout (in seconds)

e Success Threshold (in seconds)

¢ Failure Threshold (in seconds)

Scroll to the Advanced Database Settings section, select Show advanced database settings, and
complete the settings.
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o Database connection parameters
¢ SAML database schema connection parameters
¢ OAuth database schema connection parameters
6. Scroll to the bottom of the page, and select Save config.

A message confirms that your settings were saved.

Your changes take effect after you deploy the new sequence.

KOTS FAQ
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Question

Answer

What is my tenant

name?

Your tenant name is the text you entered as the database name from the Config tab in the KOTS Admin
Console.

How can | find the

name

of a node?

Run this command, then check the Name column:

kubectl get nodes -o wide

How do | shut down
my cluster?

Ideally, your cluster is always up and running. If all nodes require maintenance, shut down and perform
maintenance on one node at a time. The KOTS installer deploys EKCO, which is a utility tool to perform
maintenance operations on the cluster.

Run this command to prepare the node for a reboot:

sudo /opt/ekco/shutdown.sh

When the process is finished, shut down the node.

Does Jama Connect

suppo

rt NFS?

If running Jama Connect in AWS, you can configure the application to save your tenant assets in EFS, or
configure KOTS to save Replicated Snapshots to an NFS server.
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Upgrading Jama Connect (KOTS)

Upgrading Jama Connect to 9.35.x requires that you first update the Jama Connect KOTS platform,
which optimizes how data is stored in Jama Connect and how KOTS resources communicate with one
another. The updated KOTS platform includes version updates for many of the underlying platform
components, including Kubernetes.

Important considerations

e Upgrading your current environment involves significant maintenance downtime and requires that you
have a recovery plan in case you need to revert to the original environment. Instead, we recommend
that you install a new Jama Connect environment (referred to as a clean installation), then copy
elements of your current environment to the new environment.

e After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

¢ Jama Connect now uses OpenSearch for indexing and search instead of Elasticsearch. Before upgrad-
ing, remove the existing Elasticsearch StatefulSets and PVCs, delete the existing labels from the
Elasticsearch nodes, and record the Elasticsearch settings from the KOTS Admin Console. The upgrade
process removes these settings, and you will need them later when updating the OpenSearch settings.
Instructions for completing these steps are included in Update the Jama Connect KOTS platform
(internet) [522] and Update the Jama Connect KOTS platform (airgap) [528].

e Supported upgrade paths include Jama Connect 9.6.x, 9.17.x, 9.22.x, and 9.28.x.

e If you are upgrading from an older version of Jama Connect KOTS (9.0.1-9.0.3 and 8.79.1-8.79.6), see
Update the Jama Connect KOTS platform from Longhorn-based deployments to OpenEBS (internet [524]
or airgap [531]).

Supported upgrade scenarios

e (Recommended) Clean installation of Jama Connect KOTS platform — This recommended scenario
requires that you install a clean Jama Connect KOTS instance on a new application server, then copy
data assets from your current environment to the new environment. The new instance must point to a
restored backup of your database.

¢ In-place upgrade of Jama Connect KOTS platform — This scenario requires upgrading your current
environment in place, which involves significant maintenance downtime and requires that you have a
recovery plan in case you need to revert to the original version. Upgrading from Jama Connect 8.79.1-
8.79.6 and 9.0.1-9.0.3 requires that you run a pre-upgrade script before running the Kubernetes
(kURL) installer.

Perform a clean installation of Jama Connect

Whether your environment is internet-enabled or airgapped, we recommend that you first install a new
Jama Connect environment (referred to as a clean installation) to support new versions of the Jama
Connect application.

The process includes using a new application server and a database instance that was restored from a
backup of your current production instance. Once the new environment is up and running, you must
copy elements of your current environment to the new environment (move from one KOTS environment
to another KOTS environment).

To perform a clean installation:

1. Install the KOTS software.
2. Provision your tenant in Jama Connect KOTS:
a. From the KOTS Admin Console, select the Config tab.
b. Configure the settings for each group, as needed. Scroll down to see each group of settings.
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Important
Use the settings from your current environment as a guide when configuring
the new settings.

Make sure that the current Host name, Database name, Username, and Pass-
word are configured correctly in the KOTS Admin Console. When you install
KOTS in a new environment, you must point to the newly installed database
host or the deployment fails.

o Database Settings — Select your database type (MySQL or Microsoft SQL Server), then use
the information from "Preparing your database server" in Jama Connect User Guide 9.35.x to
complete the settings.

e Host Name — Enter the base URL for Jama Connect. Ensure this domain name is routable on
your network.

e TLS Key Pair Source — (Optional) If you have a custom key and certificate for the host
name, select Custom TLS Configuration. In the TLS Configuration section, upload the key and
certificate.

o Assets Size — Enter the estimated size of the assets based on the current data assets size of
your environment and its projected growth.

e OpenSearch Settings > Volume Size — Enter the amount of disk space that each OpenSearch
node is allowed to use.

Scroll to Tenant Manager Settings and deselect the Enabled checkbox to disable it. This action

lets you pause provisioning while copying data assets from the existing KOTS environment to

the new KOTS environment.

Scroll to the bottom of the page and select Save config.

The preflight checks run.

From the Preflight checks screen, select Deploy to deploy the Jama Connect application and
services.

When the system is available, the status in the KOTS Admin Console changes to Ready.

The deployment process can take at least an hour.

From the application server CLI, verify that the Kubernetes pods were successfully created:
kubectl get pods

The status of the pods change to Ready and Running.
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root@1p-18-59-0-175:~# kubectl get pods
MAME READY  STATUS RESTARTS
activemg-@ 171 Running
core-@ 171 Running
diff-@ 111 Running
elasticsearch-@ 111 Running
hazelcast-@ 111 Running

ingress-nginx-controller-ntGm 111 Running
kotsadm-78b7coBb96-rpks54 171 Running
kotsadm-rglite-@ 171 Running
kurl-proxy-kotsadm-7f7868fcc7-mOwvh 171 Running
oauth-6869499c44-kwwlh 171 Running
saml-574edd9bdb-hxknm 111 Running
search-@ 111 Running

2528999888883

=

g. Copy the data assets from the original instance to an accessible location on the new application
server:

i. Inthe terminal of the application server, use the kubectl tool to create a bash session inside
the core pod.
kubectl exec -it core-0 -- /bin/bash

ii. From the bash prompt, change your directory.

cd /home/contour/tenant/jama
tar -zcvf assets.tar.gz avatars/ attachments/ diagrams/ reports/ \
equations/ tempreports/

iii. Exit the core pod bash prompt and use the kubectl tool to copy the TAR file to the local
application server.
exit
kubectl cp core-0:/home/contour/tenant/jama/assets.tar.gz ./assets.tar.gz
iv. Copy assets.tar.gz to the new application server.
h. On the application server, set the tenant name for the environment (the tenant name, usually
jama, is the name of the Jama Connect database schema):
export TENANT_NAME=<t enant _nane>

i.  On the application server:
i.  Copy and extract the previously preserved data assets into the running core pod and
change the ownership permissions:

kubectl cp -c core /tmp/contour/assets.tar.gz \
default/core-0:/home/contour/tenant/${TENANT_NAME}/

kubectl exec --tty -c core pods/core-0 -- tar -xvzf \
/home/contour/tenant/${TENANT_NAME}/assets.tar.gz -C /home/contour/\
tenant/${TENANT_NAME}/

kubectl exec --tty -c core pods/core-0 -- chmod -R 755 /home/contour
kubectl exec --tty -c core pods/core-0 -- chown -R tomcat:tomcat /home/
contour

ii. Delete the core stateful set to recreate the core pod:
kubectl delete sts/core

j. From the KOTS Admin Console, select the Config tab, enable the Tenant Manager Settings that
were previously disabled, then select Save config.
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Note
é’ Your changes are applied only when you deploy a new sequence in the Dash-
board or Version history sections of the KOTS Admin Console.

k. Remove entries from the Jama Connect database tenantstate table to prepare for a new deploy-
ment:

DELETE FROM tenantstate;

I.  After the preflight checks run successfully, deploy the new version of Jama Connect:

i.  From the KOTS Admin Console, select Deploy next to the newly saved version of Jama
Connect.

ii.  When the deployment is complete and all pods are running, log in to Jama Connect as root
using the host name configured for Jama Connect.

iii. If upgrading with new servers:
e Configure SAML authentication in the new Jama Connect KOTS environment (see "Con-

figure SAML authentication" in Jama Connect User Guide 9.35.x).

e Update the base URL before performing a full reindex (see "Change URL" in Jama Con-
nect User Guide 9.35.x).

m. Perform a full reindex [536] in Jama Connect to complete the deployment (see "Reindex all
search items" in Jama Connect User Guide 9.35.x).

Your clean installation of Jama Connect is complete.

Performing an in-place upgrade of Jama Connect (internet)

Upgrading Jama Connect to 9.35.x requires that you first update the Jama Connect KOTS platform,
which optimizes how data is stored in Jama Connect and how KOTS resources communicate with one
another.

Important considerations

e After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

e Upgrading your current environment involves significant maintenance downtime and requires that you
have a recovery plan in case you need to revert to the original environment. Instead, we recommend
that you install a new Jama Connect environment (referred to as a clean installation), then copy
elements of your current environment to the new environment. See Perform a clean installation [519].

To perform an in-place upgrade of Jama Connect (internet), use the instructions for your environment:

e Update the Jama Connect platform (internet) [522]
¢ Update the Jama Connect KOTS platform for non-supported KOTS version (internet) [524]

Update the Jama Connect KOTS platform (internet)

Before you can deploy Jama Connect 9.35.x, you must first update the Jama Connect KOTS platform
(referred to as an in-place upgrade).

Important considerations

¢ Jama Connect now uses OpenSearch for indexing and search instead of Elasticsearch. To ensure a
successful update process, you must remove the existing Elasticsearch StatefulSets and PVCs, and de-
lete the existing labels from the Elasticsearch nodes. Make note of the Elasticsearch settings (they are
removed as part of the update process), so you can refer to them when you update the OpenSearch
settings. Instructions for completing these steps are included in this task.

e After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

e Expect downtime. Upgrade during off hours to minimize the impact.
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e The Kubernetes (kURL) installer is interactive and prompts you to confirm some of the steps. Depend-
ing on the number of remote nodes in your environment, expect this part of the upgrade process to
take at least two hours.

¢ |f you have dedicated Elasticsearch nodes, you are prompted to run separate installer commands on
the secondary nodes during the installation.

¢ Run the install commands inside a terminal multiplexer session to keep the session active in the event
that the connection is dropped or the terminal is closed.

To update the Jama Connect KOTS platform:

1.  Back up your Jama Connect instance.
2. Delete all Elasticsearch StatefulSets and PersistentVolumeClaims on all nodes:
kubectl delete sts elasticsearch

kubectl delete pvc volume-elasticsearch-0
kubectl label node <node- nane> jamasoftware.net/service=opensearch

3. Run the kURL installer:

Important

The kURL installer is interactive and prompts you to continue several times
throughout the upgrade process. Kubernetes is upgraded incrementally in steps
from version 1.31 and requires you to confirm several of the steps before proceed-
ing to the next version.

a. From the command line on the primary node/application server, enter the following command
to initiate the installation:

curl -sSL https://kurl.sh/jama-k8s-standardkots | sudo bash -s

6‘-" Note

kURL bundles and installs host packages without relying on external package
repositories, except for on Red Hat Enterprise Linux 9 and Ubuntu 24. If kURL
is unable to install a required host package, the output notifies you. It this
occurs, manually install the missing package and then re-run the kURL installer
to proceed.

b. Prepare your instance for the new Jama Connect release. This command deletes targeted KOTS
resources, which is required before deploying the new version of Jama Connect.

kubectl delete sts/activemq sts/core sts/diff sts/elasticsearch \
sts/hazelcast sts/oauth sts/saml deployment/oauth deployment/saml \
sts/search sts/nginx sts/core-ingress sts/core-reports sts/core-jobs \
Jjobs/tenant-manager pvc/volume-oauth-0 pvc/volume-saml-0

4. Upgrade Jama Connect [527].

5. In the KOTS Admin Console, scroll to OpenSearch Settings and enter the new OpenSearch configu-
ration settings.

% Tip

Refer to the Elasticsearch settings you recorded earlier in this task.
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6. Label the new OpenSearch nodes:
kubectl label nodes <node-nane> jamasoftware.net/service=opensearch
7. Reindex all search items [536].

Once you've updated the Jama Connect platform, you can upgrade the application.

Update the Jama Connect KOTS platform from Longhorn-based deployments to

OpenEBS (internet)

Before you can upgrade Jama Connect KOTS platform from 9.0.1-9.0.3 or 8.79.1-8.79.6, you must first
run a pre-upgrade script. These versions used Longhorn as the storage solution, while newer versions
use OpenEBS.

Running the pre-upgrade script prepares the existing environment for the OpenEBS storage configura-
tion required by the target version. Before you can deploy Jama Connect 9.35.x, you must first update
the Jama Connect KOTS platform (referred to as an in-place upgrade) to help ensure the platform storage
components transition correctly.
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Important considerations

Jama Connect now uses OpenSearch for indexing and search instead of Elasticsearch. To ensure a
successful update process, you must remove the existing Elasticsearch StatefulSets and PVCs, and de-
lete the existing labels from the Elasticsearch nodes. Make note of the Elasticsearch settings (they are
removed as part of the update process), so you can refer to them when you update the OpenSearch
settings. Instructions for completing these steps are included in this task.

When upgrading from Jama Connect 9.0.1-9.0.3 and 8.79.1-8.79.6, you must first run a pre-upgrade
script, then run the Kubernetes (kURL) installer. Only then can new versions of Jama Connect can be
deployed from the KOTS Admin Console. When upgrading from Jama Connect 9.04 and later, 8.79.7
and later, or 9.6.0 and later, you don't need to run a pre-upgrade script.

After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

Expect downtime. Upgrade during off hours to minimize the impact.

The Kubernetes (KURL) installer is interactive and prompts you to confirm some of the steps. Depend-
ing on the number of remote nodes in your environment, expect this part of the upgrade process to
take at least two hours.

If you have dedicated Elasticsearch nodes, you are prompted to run separate installer commands on
the secondary nodes during the installation.

Run the install commands inside a terminal multiplexer session to keep the session active in the event
that the connection is dropped or the terminal is closed.

To update the Jama Connect KOTS platform for non-supported KOTS version (internet):

Back up your Jama Connect instance.

Download prepare-for-longhorn-to-openebs-upgrade.sh from GitHub.

Skip this step if you are upgrading from Jama Connect 9.0.4 and later, 8.79.7 and later, or 9.6.0 and
later.

On the primary node, run the shell script downloaded in step 2 as a user with adequate privileges:
bash upgrade-for-longhorn-to-openebs-upgrade.sh

Important

Skip this step if you are upgrading from Jama Connect 9.0.4 and later, 8.79.7 and
later, or 9.6.0 and later.

Before proceeding, delete all Elasticsearch StatefulSets and PersistentVolumeClaims on all nodes:

kubectl delete sts elasticsearch
kubectl delete pvc volume-elasticsearch-0
kubectl label node <node- nane> jamasoftware.net/service=opensearch

Run the kURL installer:

Important

The kURL installer is interactive and prompts you to continue several times
throughout the upgrade process. Kubernetes is upgraded incrementally in steps
from version 1.31 and requires you to confirm several of the steps before proceed-
ing to the next version.

a. From the command line on the primary node/application server, enter the following command
to initiate the installation:

curl -sSL https://kurl_sh/jama-k8s-standardkots | sudo bash -s
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ﬁ’;’ Note

kURL bundles and installs host packages without relying on external package
repositories, except on Red Hat Enterprise Linux 9 and Ubuntu 24. If kURL
is unable to install a required host package, the output notifies you. It this

occurs, manually install the missing package and then re-run the kURL installer
to proceed.

b. Prepare your instance for the new Jama Connect release. This command deletes targeted KOTS
resources, which is required before deploying the new version of Jama Connect.

kubectl delete sts/activemq sts/core sts/diff sts/elasticsearch \
sts/hazelcast sts/oauth sts/saml deployment/oauth deployment/saml \
sts/search sts/nginx sts/core-ingress sts/core-reports sts/core-jobs \
Jjobs/tenant-manager pvc/volume-oauth-0 pvc/volume-saml-0

Upgrade Jama Connect [527].

In the KOTS Admin Console, scroll to OpenSearch Settings and enter the new OpenSearch configu-
ration settings.

% Tip

Refer to the Elasticsearch settings you recorded earlier in this task.
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8. Label the new OpenSearch nodes:
kubectl label nodes <node-nane> jamasoftware.net/service=opensearch
9. Reindex all search items [536].

Once you've updated the Jama Connect platform, you can upgrade the application.

Upgrade Jama Connect with KOTS (internet)

When a new version of Jama Connect is available, you can apply and deploy it from the KOTS Admin
Console.

Important

If you experience issues with your Jama Connect deployment, see Troubleshooting your
upgrade [537].
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To upgrade Jama Connect with KOTS:

1. From the KOTS Admin Console, select the Version history tab, then select Check for update.

2.  When the preflight checks are complete, find your Jama Connect upgrade version, then select
Deploy.

The new version is tagged as Currently deployed version.

Performing an in-place upgrade of Jama Connect (airgap)

Upgrading Jama Connect to 9.35.x requires that you first update the Jama Connect KOTS platform,
which optimizes how data is stored in Jama Connect and how KOTS resources communicate with one
another.

Important considerations

e After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

e Upgrading your current environment involves significant maintenance downtime and requires that you
have a recovery plan in case you need to revert to the original environment. Instead, we recommend
that you install a new Jama Connect environment (referred to as a clean installation), then copy
elements of your current environment to the new environment. See Perform a clean installation [519].

To perform an in-place upgrade of Jama Connect (airgap), use instructions for your environment:

e Update the Jama Connect KOTS platform (airgap) [528]
e Update the Jama Connect KOTS platform for non-supported KOTS version (airgap) [531]

Update the Jama Connect KOTS platform (airgap)
Before you can deploy Jama Connect 9.35.x, you must first update the Jama Connect KOTS platform
(referred to as an in-place upgrade). This method requires that you first run a pre-upgrade script, then run

the kURL installer. After you run the script and installer, new versions of Jama Connect can be deployed
from the KOTS Admin Console.

See also: Updating Embedded Clusters.
Important considerations

¢ Jama Connect now uses OpenSearch for indexing and search instead of Elasticsearch. To ensure a
successful update process, you must remove the existing Elasticsearch StatefulSets and PVCs, and de-
lete the existing labels from the Elasticsearch nodes. Make note of the Elasticsearch settings (they are
removed as part of the update process), so you can refer to them when you update the OpenSearch
settings. Instructions for completing these steps are included in this task.

e Expect downtime. Upgrade during off hours to minimize the impact.

e The Kubernetes (kURL) installer is interactive and prompts you to confirm some of the steps. Depend-
ing on the number of remote nodes in your environment, expect this part of the upgrade process to
take at least two hours.

¢ [f you have dedicated OpenSearch nodes, you are prompted to run separate installer commands on the
secondary nodes during the installation.

¢ |f your Jama Connect deployment fails with a HorizontalPodAutoscaler error, you must manually
update the Kubernetes secret associated with the deployed Helm release and redeploy Jama Connect.
See Troubleshoot PersistentVolumeAccessMode errors if Jama Connect deployment fails [537].

e After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

¢ Run the install commands inside a terminal multiplexer session to keep the session active in the event
that the connection is dropped or the terminal is closed.

To update the Jama Connect KOTS platform:
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1. Login to the airgap portal, select Embedded Cluster, then download the Embedded Kubernetes In-
staller files to your local system.

2. Extract (untar) the kURL installer:
tar -xzvf jama-k8-standardkots.tar.gz
The following contents are extracted: kurl directory, install.sh, join.sh, tasks.sh, and upgrade.sh
scripts.
3.  Run the kURL script to ensure all required images are available:
sudo bash tasks.sh load-images
4. Before proceeding, delete all Elasticsearch StatefulSets and PersistentVolumeClaims on all nodes:

kubectl delete sts elasticsearch
kubectl delete pvc volume-elasticsearch-0
kubectl label node <node-nanme> jamasoftware.net/service=opensearch

5. Run the kURL installer:

Important

The kURL installer is interactive and prompts you to continue several times
throughout the upgrade process. Kubernetes is upgraded incrementally in steps

and requires you to confirm several of the steps before proceeding to the next
version.
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a. From the command line on the primary node/application server, enter the following command
to initiate the installation:

sudo bash install.sh airgap

ﬁ‘;’ Note

kURL bundles and installs host packages without relying on external package
repositories, except for on Red Hat Enterprise Linux 9 and Ubuntu 24. If kURL
is unable to install a required host package, the output notifies you. It this

occurs, manually install the missing package and then re-run the kURL installer
to proceed.

b. When the installation is complete, prepare your instance for the new Jama Connect release.
This command deletes targeted KOTS resources, which is required before deploying the new
version of Jama Connect.

kubectl delete sts/activemq sts/core sts/diff sts/elasticsearch \
sts/hazelcast sts/oauth sts/saml deployment/oauth deployment/saml \
sts/search sts/nginx sts/core-ingress sts/core-reports sts/core-jobs \
Jjobs/tenant-manager pvc/volume-oauth-0 pvc/volume-saml-0

Upgrade Jama Connect [535].

In the KOTS Admin Console, scroll to OpenSearch Settings and enter the new OpenSearch configu-
ration settings.

% Tip

Refer to the Elasticsearch settings you recorded earlier in this task.
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8. Reindex all search items [536].
9. Label the new OpenSearch nodes:

kubectl label nodes <node-nane> jamasoftware.net/service=opensearch
Once you've updated the Jama Connect platform, you can upgrade the application.

Update the Jama Connect KOTS platform from Longhorn-based deployments to
OpenEBS (airgap)

Running the pre-upgrade script prepares the existing environment for the OpenEBS storage configura-
tion required by the target version. Before you can deploy Jama Connect 9.35.x, you must first update

the Jama Connect KOTS platform (referred to as an in-place upgrade) to help ensure the platform storage
components transition correctly.

Before you can upgrade Jama Connect KOTS platform from 9.0.1-9.0.3 or 8.79.1-8.79.6, you must first
run a pre-upgrade script. These versions used Longhorn as the storage solution, while newer versions
use OpenEBS.

See also: Updating Embedded Clusters.
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Important considerations

e Jama Connect now uses OpenSearch for indexing and search instead of Elasticsearch. To ensure a
successful update process, you must remove the existing Elasticsearch StatefulSets and PVCs, and de-
lete the existing labels from the Elasticsearch nodes. Make note of the Elasticsearch settings (they are
removed as part of the update process), so you can refer to them when you update the OpenSearch
settings. Instructions for completing these steps are included in this task.

If upgrading from Jama Connect 9.0.1-9.0.3 and 8.79.1-8.79.6, make sure that the file system on
your primary node/application server has enough free space to support a data migration of the assets
associated with your Jama Connect instance. Measure the disk space occupied by the var/lib/longhorn
directory (du /var/lib/longhorn) and confirm that the disk has twice that amount available.

Expect downtime. Upgrade during off hours to minimize the impact.

The Kubernetes (KURL) installer is interactive and prompts you to confirm some of the steps. Depend-
ing on the number of remote nodes in your environment, expect this part of the upgrade process to
take at least two hours.

If you have dedicated OpenSearch nodes, you are prompted to run separate installer commands on the
secondary nodes during the installation.

If your Jama Connect deployment fails with a HorizontalPodAutoscaler error, you must manually
update the Kubernetes secret associated with the deployed Helm release and redeploy Jama Connect.
See Troubleshoot PersistentVolumeAccessMode errors if Jama Connect deployment fails [537].

After upgrading to Jama Connect 9.35.x, you must perform a reindex [536].

Run the install commands inside a terminal multiplexer session to keep the session active in the event
that the connection is dropped or the terminal is closed.

To update the Jama Connect KOTS platform for non-supported KOTS version (airgap):

Log in to the airgap portal, select Embedded Cluster, then download the Embedded Kubernetes In-
staller files to your local system.
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From an internet-enabled system, download prepare-for-longhorn-to-openebs-upgrade.sh from Gi-
tHub.

Important
Skip this step if you are upgrading from Jama Connect 9.0.4 and later, 8.79.7 and
later, or 9.6.0 and later.

On the primary node, run the shell script downloaded in step 2 as a user with adequate privileges:

bash prepare-for-longhorn-to-openebs-upgrade.sh

Important
Skip this step if you are upgrading from Jama Connect 9.0.4 and later, 8.79.7 and
later, or 9.6.0 and later.

Extract (untar) the kURL installer:
tar -xzvf jama-k8-standardkots.tar.gz

The following contents are extracted: kurl directory, install.sh, join.sh, tasks.sh, and upgrade.sh
scripts.
Run the kURL script to ensure all required images are available:

sudo bash tasks.sh load-images
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Run the kURL script to ensure all required images are available:

kubectl delete sts elasticsearch

kubectl delete pvc volume-elasticsearch-0

kubectl label node <node-nane> jamasoftware.net/service=opensearch
Run the kURL installer:

Important

The kURL installer is interactive and prompts you to continue several times
throughout the upgrade process. Kubernetes is upgraded incrementally in steps

and requires you to confirm several of the steps before proceeding to the next
version.

a. From the command line on the primary node/application server, enter the following command
to initiate the installation:

sudo bash install.sh airgap

ﬁ’;’ Note

kURL bundles and installs host packages without relying on external package
repositories, except for on Red Hat Enterprise Linux 9 and Ubuntu 24. If kURL
is unable to install a required host package, the output notifies you. It this

occurs, manually install the missing package and then re-run the kURL installer
to proceed.

b. When the installation is complete, prepare your instance for the new Jama Connect release.

This command deletes targeted KOTS resources, which is required before deploying the new
version of Jama Connect.

kubectl delete sts/activemq sts/core sts/diff sts/elasticsearch \
sts/hazelcast sts/oauth sts/saml deployment/oauth deployment/saml \
sts/search sts/nginx sts/core-ingress sts/core-reports sts/core-jobs \
Jjobs/tenant-manager pvc/volume-oauth-0 pvc/volume-saml-0

Upgrade Jama Connect [535].

In the KOTS Admin Console, scroll to OpenSearch Settings and enter the new OpenSearch configu-
ration settings.

% Tip

Refer to the Elasticsearch settings you recorded earlier in this task.
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10. Reindex all search items [536].
11. Label the new OpenSearch nodes:

kubectl label nodes <node-nane> jamasoftware.net/service=opensearch
Once you've updated the Jama Connect platform, you can upgrade the application.

Upgrade Jama Connect with KOTS (airgap)
When a new version of Jama Connect is available, you can apply and deploy it from the KOTS Admin
Console.

Important
If you experience issues with your Jama Connect deployment, see Troubleshooting your
upgrade [537].

To upgrade Jama Connect with KOTS:
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1.  From the air-gap safe portal, download the new jama-k8s airgap bundle for embedded clusters.

2.  From the KOTS Admin Console, select the Version history tab:
You must complete this step if the new airgap bundle hasn't been uploaded yet.
a. Select Upload new version.
b. Select the new airgap bundle.
A new version is created, and the system performs the preflight checks.
3. When the preflight checks are complete, select Deploy.

The new version is tagged as Currently deployed version.

Reindex all search items

Search indexes get out of sync with the database due to large batch updates, APl updates, or database
updates. During a full index, all search indexes are rewritten to the current values in the database.

Note

i You must have system administrator permissions to complete this task while logged in
as root. While organization admins and project admins can index project items [744],
they can't index all search items.
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Important considerations

Files over 25 MB aren't indexed, so their content isn't searchable.

Filetypes that can be indexed: PDF, DOC, DOCX, PPT, PPTX, TXT, RTF.

Filetypes that can't be indexed: XLSX, XLS, XML, HTML, HTM.

During the index process, the application automatically enters maintenance mode [580]. Users can't
log in during this time and users who are already logged in receive a message about the maintenance.

To sync your search indexes:

1. Notify users before initiating an index.
2. Disable all integrations including legacy connectors and the Jama/Tasktop Integration Hub.
DWR, SOAP, and REST API calls are automatically blocked during the reindex.

Note
é’ The system admin doesn't have access to disable integrations. Work with an organ-
ization admin or integrations admin [723] to disable those services.

w

Log in to Jama Connect as the root user [573].

4. Select the Index/Search tab and select Index items.
The system displays a count of items in the application and the estimated time to complete the
index.

5. Select Yes to continue.

You see an alert when indexing is complete and maintenance mode is automatically disabled.

Troubleshooting your upgrade (KOTS)

If you run into problems with your KOTS upgrade, here are some resources that might help.

Troubleshoot HorizontalPodAutoscaler errors if Jama Connect deployment fails [537]
Troubleshoot PersistentVolumeAccessMode errors if Jama Connect deployment fails [539]
Troubleshoot KURL installer errors if node connectivity tests fail [540]

Troubleshoot ingress errors if Jama Connect deployment fails [541]

Troubleshoot HorizontalPodAutoscaler errors if Jama Connect deployment fails

In previous versions of Jama Connect with Kubernetes 1.27.6, the HorizontalPodAutoscaler resources
for horizontal scaling were deprecated. If your Jama Connect deployment fails with the following error,
you must manually update the Kubernetes secret associated with the deployed Helm release and rede-
ploy Jama Connect.

Important
This process applies only to environments with horizontal scaling enabled.
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To modify the Kubernetes Helm release secret:

1. Retrieve the name of the secret associated with the latest deployed Helm release:

kubectl get secret -1 owner=helm,status=deployed,name=application | awk "{print
$13}" | grep -v NAME

2. Use the secret to save the latest deployed release details to a file:
kubectl get secret <secret-nane> -o yaml > release.yaml
3. Create a backup of the file you created:
cp release.yaml release.bak
4. Decode and generate output of the release object (JSON) found in the file you created:

cat release.yaml | grep -oP "(?<=release: ).*" | base64 -d | base64 -d | gzip
-d > release.data.decoded

5. Using an editor tool, edit the release object data by changing all occurrences that reference the
deprecated API version (autoscaling/v2betal) with the new value (autoscaling/v2) found in the
manifest field.

6. Encode the modified release object:
cat release.data.decoded | gzip | base64 | base64

7. If the output contains line breaks, you must remove them before you can continue.

8. Using an editor tool, replace the JSON property value “data.release” in release.yaml with the newly
encoded release object value you just created.

9.  Apply the release file:

kubectl apply -f release.yanml
10. Deploy Jama Connect.

The Kubernetes secret is updated and Jama Connect is redeployed.
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Troubleshoot PersistentVolumeAccessMode errors if Jama Connect deployment
fails

If you configured Jama Connect to use a third-party storage class to save assets, you might get the
following deployment error.

To modify Assets PVC Access Mode:
1. From the Config tab in the KOTS Admin Console, set the Assets PVC Access Mode to ReadWrite-
Many.

Important

Select ReadWriteMany only if the configured storage provider supports that access
mode.
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2. Deploy Jama Connect.

The application is redeployed.

Troubleshoot kURL installer errors if node connectivity tests fail

When the kURL installer runs, internal tests confirm that all nodes can communicate with each other. If
these tests fail, the Linux "fs.inotify.max_user_instances" host setting must be updated.

The Linux "fs.inotify.max_user_instances" is a host setting that defines user limits on the number of
available inotify resources on the application server.

If the connectivity tests fail, these error messages are displayed:
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For more information, see How to increase the inotify.max_user_watches and inotify.max_user instances
syssctls on a Linux host.

To update the Linux host setting:

1. Check the current inotify user instance limit:
cat /proc/sys/fs/inotify/max_user_instances
2. To update the limits temporarily (the value is set to 65536 in this example):

sudo sysctl fs.inotify.max_user_instances=65536
sudo sysctl -p

3. To apply the changes permanently, add fs.inotify.max_user_instances=65536 to the file /etc/
sysctl.conf.

The Linux host setting is updated.

Troubleshoot ingress errors if Jama Connect deployment fails

If your Jama Connect deployment fails with the following error, wait until the new ingress-nginx-control-
ler pod is in a running state and redeploy the release. This error occurs because the ingress and ingress
controller were upgraded simultaneously.
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To redeploy Jama Connect:

1.  Wait until the ingress-nginx-controller pod is in a running state:
kubectl get pods
2. Redeploy the release from the KOTS Admin Console.

The application is redeployed.

542



Administration

Administration

Jama Connect administrators have special roles in working with your organization's content.

A role is a set of permissions granted to a user so that they can perform particular functions.

e System administrators [554] set up and install Jama Connect. They are able to access the server
settings and log in as the root user. Jama Connect manages system administration for hosted custom-
ers. For self-hosted customers, this role holds the initial license and can't be assigned.

e Organization administrators [619] have the highest level of permissions in Jama Connect and can
configure settings for the organization. All Jama Software customers have at least one organization
administrator, and there might be multiple within a single organization. They must have a creator
license.

e Project administrators [725] have the necessary permissions to manage many aspects of a project
that those with create/edit permissions can't. They must have a creator license.

e Review administrators [192] have the necessary permissions to manage reviews. They must have a
creator or reviewer license.

e Reuse administrators [355] have the necessary permissions to create advanced reuse and synchroniza-
tion rules. They must have a creator license.

e Process administrators [671] have the necessary permissions to configure content and connections in
Jama Connect. They must have a creator license.

e User administrators [646] have the necessary permissions to manage licenses, users, and groups.
They must have a creator license.

e Report administrators [462] have the necessary permissions to upload and manage reports and ex-
ports. They must have a creator license. This role is available only for self-hosted customers.

Authentication methods

Jama Connect supports a wide range of authentication methods to keep your data safe and secure by
authenticating users. The default method, Basic authentication, verifies users with the login data that is
stored in the Jama Connect database.
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Supported combinations for self-hosted and cloud

e SAML for SSO and OAuth for REST
e Multi-mode for user authentication and OAuth for REST

For information about using the Jama Connect REST API with OAuth, see Set API credentials [26].

Supported third-party authentication methods

e SAML [584] — Open standard for transferring identity data between two parties: an identity provider

(IdP) and a service provider (SP).

Electronic signatures are enabled by default, but can be disabled by a system admin.

To set up SAML, your company must meet these requirements:

e Have a SAML 2.0-compliant Identity Provider (IdP).

o |dentify a technical person, often an IT administrator, who can provide the URL of the Identity
Provider. Name this person before engaging with Jama Software and, for testing purposes, provide
them access to Jama Connect.

o |f you're on a version of Jama Connect earlier than 8.62, you must follow instructions for that
release instead of the instructions here. Contact Support for help accessing the correct instructions
and with the process.

e LDAP [589] — Self-hosted option. Centralizes the management of user accounts. Jama Connect
includes a built-in integration of LDAP and Microsoft Active Directory.

e Crowd [594] — Self-hosted option from Atlassian. Manages users and groups within a single a
system. Jama Connect accepts user details from Crowd, then syncs them with authentication data in
the application.

Internal authentication methods

e Basic [583] — The default authentication for Jama Connect. Basic authentication uses a username
and password that’s stored in the Jama Connect application database.

e Basic + IdP [586] — The combination of Basic and SAML creates multi-mode authentication, so
you can separate your internal users from your external partners, vendors, and contractors. Multi-
mode authentication provides access for external users so they can be part of the requirement,
approval, and tracking process in Jama Connect.

Note
y To use multi-mode authentication [586], you must be running Jama Connect 8.62 or
later.

As a self-hosted user, you can update or change the authentication type for an organization. To do this,
log in as root user and select System Properties > Authentication Properties.

SCIM provisioning for user management

System for Cross-domain Identify Management (SCIM) is a standard for automating the exchange of user
identity information between identity domains or IT systems. (source)

SCIM provides a predefined schema for common user attributes like name, username, first name, last
name, and email address. Attributes for organization-level groups are included to create and delete
groups and manage group membership. This schema allows your organization to automatically provision
users into your Jama Connect environment directly from your identity provider (IdP). It also helps you
manage users within the application.

New user creation is a one-way synchronization with SCIM from your IdP to Jama Connect. Adding a
new user in Jama Connect won't create a new user in your IdP.
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Supported identity providers

Jama Connect currently supports SCIM provisioning with the following IdPs:

e Okta Custom Application
e Microsoft Azure AD

For more information, see Jama Connect SCIM configuration with Okta.

Configure SCIM provisioning

Self-hosted customers — Contact Support to assist with enablement and ensure successful implementa-
tion.

Note
é’ Before enabling SCIM provisioning, some data sanitization is required.

REST API

REST APl is an application program interface to assist developers in a straightforward integration with
Jama Connect.

Important

Access to the REST APl is limited to users with a Named Creator Jama Connect license,
which includes endpoints within v1, labs, and SCIM. Users without a Named Creator
Jama Connect license, including those with a Creator Float license, do not have access.

Jama Software provides two approaches to accessing REST API:

e Allow all members in your organization to access REST API (default).
e Use the REST API Access Control feature to limit access to only authorized users and groups.

The REST API feature is enabled by default. To disable the REST API feature for your organization,
contact Support.

Access Control can be used to limit access to specific users and groups. A wizard walks you through the
steps to opt-in to Access Control, then you can configure access. Access changes take effect immediate-
ly.

e Manage REST API access for users and groups [549]
Monitoring REST API usage

The REST API monitoring feature provides visibility into REST API usage across your system by associat-
ing activity with specific users.

e Monitor REST API usage [552]
Licensing requirements — REST API access policy

Access to the REST API is controlled in the following way:
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e Access to the REST APl is limited to users with a Named Creator Jama Connect license, which includes
endpoint within v1, labs, and SCIM. Users without a Named Creator Jama Connect license, including
those with a Creator Float license, do not have access.

Configure the REST API Access Control feature

By assigning specific permissions to individual users and groups, only authorized personnel have the
necessary privileges to use REST API.

Important

Access to the REST APl is limited to users with a Named Creator Jama Connect license,
which includes endpoints within v1, labs, and SCIM. Users without a Named Creator
Jama Connect license, including those with a Creator Float license, do not have access.

Important considerations

e REST API Access Control is optional.

By default, all users have access to REST API once it is enable in root admin. When you opt-in to
Access Control, you must manually add users and groups.

e Once you opt-in to Access Control, you must manage access for all users and groups. To disable Access
Control, select ADMIN > Organization > Details, then select No next to REST APl Managed Access is
enabled.

e Previously, new users were automatically granted access if REST API was enabled. With Access
Control, you must manually add users and groups for access. Don't opt-in to this feature if you want
everyone in your company to have access.

e |f access to REST API stops working, organization admins can notify the system admin to see if it's
disabled in root admin. The ability to manage users and groups is still available, but REST API can't be
used until it is re-enabled.

O Best Practice
- Rather than granting REST API access to individual users, create a dedicated REST API
user group to simplify management.

To configure REST API Access Control:
1. (Recommended) Add a dedicated REST API user group [647].
Important

Complete this step prior to configuration to prevent interruptions in REST API
access.

2. Configure REST API Access Control:

a. From the Jama Connect header, select ADMIN > Organization > REST API, then select Config-
ure access control.
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The configuration wizard opens, starting the process of opting in to Access Control. Until you
finish the configuration wizard, all users can access REST API.

b. Select Managed access, then select Next.
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c. (Optional) Search for or enter the name of the users or groups you want to add, then use the
arrow to add them to the Selected groups/users column.

d. Select | understand this change might impact integrations.
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3. Select Save.

The groups or users you added now have access and appear on the REST API page. If no users or groups
were added, you must add access because no users currently have it.

Manage REST API access for groups and users

After you configure Access Control, you can add and remove groups and users to manage access to REST
API.

Important

Access to the REST API is limited to users with a Named Creator Jama Connect license,
which includes endpoints within v1, labs, and SCIM. Users without a Named Creator
Jama Connect license, including those with a Creator Float license, do not have access.

G Best Practice
- Rather than granting REST API access to individual users, create a dedicated REST API
user group to simplify management.

To create a new user and a new group, see Add a user group [647] and Add a user [649].
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Important considerations

To access this feature, admins must complete the Access Control configuration wizard. For details, see
Configure the REST API Access Control feature [546].

When an organization admin changes a user's permissions from Organization > Users > Add user in-
stead of modifying their existing permissions, all previously granted permissions are reset. As a result,
you must reassign REST API access to the user.

To remove a user, make sure you remove them from all groups with REST API access where they are
members. Otherwise, they still have access to REST API.

All searches are exact, meaning a search doesn't return a match for users who are only in a group. For
example, if you search for “Jeff” and they are only in a group, they don't appear in the search results.
This is another reason to manage users within groups rather than individually.

If REST API access is disabled, you see the message “REST API access is disabled in root administra-
tion. Until it's re-enabled, groups/users won't be able to utilize it.” You can still manage access, but you
can't access REST API until it's re-enabled.

To add REST API access for groups and users:

1.
2.

From the Jama Connect header, select ADMIN > Organization > REST API, then select Add access.
From the Groups/users column, select or search for the groups or users you want to give access to,
then use the arrow to add them to the Selected groups/users column.
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3. Select Add access.

A message appears, confirming that REST API access was added for the selected users or groups.
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To remove REST API access for users and groups:

1.  From the Jama Connect header, select ADMIN > Organization > REST API.
2. Select the group or user you want to remove, then select Remove access.

A confirmation message appears.
3. To confirm the access change, select Remove access.

A message appears, confirming that the REST API access was removed from the selected user or group.

Monitor REST API usage

The REST API User Activity timeframe setting provides improved visibility into how REST APl is used
across the organization for monitoring, security, and operational efficiency. When an organization admin
adjusts this setting, they can view the client ID and the number of REST API calls made over a defined
timeframe.

Important

Access to the REST APl is limited to users with a Named Creator Jama Connect license,
which includes endpoints within v1, labs, and SCIM. Users without a Named Creator
Jama Connect license, including those with a Creator Float license, do not have access.

Important considerations

¢ |f you don't see a Client ID, it's because the user is being authorized with basic auth instead of OAuth
or the user has accessed the REST API via Swagger.

To view REST API user activity:

1. From Admin > Organization, select REST API.
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2. Select User Activity, then select a timeframe:
e Last 1 hour

Last 24 hours

Last 7 days

Last 30 days

Last 90 days

ff’ Note

The default timeframe is the last hour. You can select and apply other timeframes,
but these changes are not saved once you leave the page.

3. Select Apply.

When the screen is refreshed, it lists the user by Name, Username, Client ID, and the number of REST
API calls depending on the duration you selected.
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Supported image extensions and attachment types

Jama Connect only allows attaching file types that exist in the Allow List, which provides improved
security and prevents uploading harmful file types that aren’t blocked.

To prevent uploading file types that might be harmful, Jama Connect filters the file types that you can
upload as an attachment.

Uses this method to filter attachment types... Supported version
Allow List Cloud, Jama Connect 2015.2 and later
Block List Jama Connect 2015.1 and earlier

Supported Jama Connect attachment types

We collected this list based on the usage pattern of our current customers. Each type has been screened
for potential security risks.

APK, AVI, BMP, CSV, DOC, DOCM, DOCX, DOT, DOTX, DWG, GIF, GZ, JAMA, JPEG, JPG, MD, MOV, MP3, MP4, MPEG, ODG, ODP,
ODS, ODT, PAGES, PDF, PGP, PNG, PPT, PTM, PPTX, RAR, RTF, TGZ, TIF, TIFF, TRA, TXT, VCS, VSD, VSDX, VSS, WAR, WAV, WMA,
WMV, WPS, XCF, XLS, XLSB, XLSM, XLSX, XLT, XPS, ZIP, ZIPX

System administrator (KOTS)

System administrators are in charge of the following tasks:

e Logging in to the application server operating system and Jama Connect as root user
Installing, updating, and maintaining the Jama Connect platform

Setting up the database and application servers

Installing the admin console and Jama Connect

Configure settings such as authentication and mail servers

e Regular maintenance such as updates and uploading custom reports

Ideally a system administrator has expertise in these areas of administration:

e Database

System administrators set up and administer the database including database sizing, resource alloca-
tion, recommended backups, and availability of the database engine.
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e Linux
Jama Connect must be installed on a Linux based system. System administrators need to use Com-
mand Line Interface (CLI) for basic navigation, file manipulation, permissions, and network configura-
tion when they are installing, upgrading, allocating resources, and maintaining availability and security
of the server.

¢ Directory server
If you're not using Jama Connect native authentication, system administrators must perform setup and
administration or your organization's supported directory server [583].

¢ Mail server
If you're using these functions in Jama Connect, system administrators perform setup and administra-
tion of your organization's mail server.

System administration is necessary for customers who are self-hosting Jama Connect. For cloud cus-
tomers, Jama Software manages system administration. If you're interested in an implementation that
doesn't require system administration at your organization, contact your sales representative regarding
our cloud solution.

Configuring the Admin Console settings

Jama Connect uses Replicated KOTS technology to deliver all microservices to self-hosted customers.
Replicated software is a container orchestration tool that provides the interface, Admin Console, for
Jama Connect.

Replicated and Jama Connect are hosted on the same application server, running on different ports.

The Admin Console stores settings, such as SSL certificates and database connection information, that
Jama Connect uses to start and run correctly. Some of its functions include:

e Manage the run state of Jama Connect
e Perform upgrades
e Synchronize license renewals

Many of the settings for the Admin Console are configured during installation. However, you can make
changes to the settings whenever you need.

Application server overview

Your application server hosts the Jama Connect application, Kubernetes pods and accompanying stateful
sets, and the Admin Console (Replicated software). It also stores data such as attachments, images,
reports, and a micro-service cache.

Docker containers — A standalone executable package of software that includes code, runtime, system
tools, system libraries, and settings. See https:/www.docker.com/resources/what-container for details.

Replicated KOTS — A Kubernetes Off-The-Shelf (KOTS) platform for easily deploying cloud native
applications inside customers' environments to provide greater security and control. The Admin Console
is the user interface for installing the Jama Connect application. See https:/www.replicated.com/ for
details.

¢ Jama Connect users access Jama Connect by browsing to the instance URL (https://jamainstan-
ceurl.customer.com/).

e System administrators access the Admin Console by browsing to the same instance URL, but on port
8800 (https:/jamainstanceurl.customer.com:8800/).

e Replicated updates Jama Connect and the license via API calls for internet-enabled environments.
Our airgap option removes the need for remote API calls.

¢ Any content added to your Jama Connect instance is stored in the database. Uploaded artifacts are
saved inside a Kubernetes volume. To extract them, you must run kubectl commands.
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Create a Replicated Snapshot (KOTS)

Taking a full snapshot creates a backup of the KOTS Admin Console and application data. It can be used
for full Disaster Recovery by restoring over the same instance or in a new cluster. Tenant assets are
included in the snapshot. OpenSearch data is included by default.

A Replicated Snapshot can be taken while Jama Connect is running without interruption.
Requirements

e Replicated Snapshots must be enabled for your Replicated customer license.

e KOTS Admin Console 1.79 and later.

e Replicated Snapshots don't include your database. You must use a proprietary backup/restore system
for your type of database, MySQL or SQL Server.

Important considerations

¢ When restoring from a snapshot in a new cluster, you must reinstall KOTS.

e Recommended — Include OpenSearch data in snapshots to avoid having to reindex your data after
performing a restore. However, if your snapshot is not recent, we recommend reindexing your data.

¢ Replicated Snapshots don't support IAM authentication against EFS. Saving Replicated Snapshots in
EFS requires that you use the default file system policy to allow all nodes in the cluster to mount the
EFS.

To create a Replicated snapshot:

1. Capture the KOTS installer.

2. (Recommended) Include OpenSearch data in snapshots: From the KOTS Admin Console under the
OpenSearch Settings section, select Include OpenSearch in Replicated Snapshots.

3. Airgap only — Capture the IP address of the private registry, which is the IP address value in the
Cluster-IP column:

kubectl get service/registry -n kurl

4. Configure the storage destination:
a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. From the Destination drop-down menu, select a storage destination for your snapshots.
e For AWS S3 — The IAM role assigned to the underlaying servers or the user associated with
the credentials (access and secret key) must have the Policy template attached.
Use the following template to create a policy, replacing the <arn-S3> parameter with ARN of
the S3 bucket. For example: arn:aws:s3:::;jama-snapshots.

{
"Version': '""2012-10-17",

"Statement": [
{
"Effect': "Allow",
"Action": [
"s3:PutObject",
"'s3:GetObject",
""s3:AbortMultipartUpload™,
"'s3:DeleteObject”,
"s3:ListMul tipartUploadParts™
1.
"Resource': ''<arn-s3>/*"
)
{
"Effect": "Allow",

"Action': "s3:ListBucket",
""Resource': '<arn-s3>"
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}
o For NFS — If using EFS as an NFS server, the Server field = the DNS name of the EFS and the
Path field = a directory inside the EFS, writable by the user:group 1001:1001.
c. Select Update storage settings to save your preferences.
5. Schedule Full Snapshots:
a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. Select Enable automatic scheduled snapshots, then select Update schedule.
6. Create a Full Snapshot (follow the steps provided by Replicated).

The KOTS Admin Console and application data are now backed up and available for a full Disaster
Recovery.

Restore KOTS Admin Console and Jama Connect from a Replicated Snapshot
(KOTS)

When you set up a new application server for Jama Connect, you can restore the KOTS Admin Console
settings that you saved in a Replicated Snapshot.

Snapshots include the registry images and data for Jama Connect.

Requirements

If restoring to a new cluster, it must match these specifications and settings of the cluster where the
backup was taken:

Number of nodes

Inbound and outbound traffic rules

Virtual memory settings for OpenSearch

Connectivity to external services and resources (for example, AWS EFS, AWS S3)

To restore from a snapshot:

1. Configure servers for a new cluster:
a. After the servers for the cluster are provisioned, install KOTS on one node using the captured
KOTS Installer. You must pass the same flags to the installation script that were passed to the
original cluster.

e Restoring an online cluster — Run the appropriate installation script that was generated from
the captured KOTS installer.
e Restoring an airgap cluster — Download the appropriate KOTS installer bundle, replacing
<ip> with the IP address of the private registry from the original cluster:
cat install_sh | sudo bash -s airgap kurl-registry-ip=<i p>
b. When the installer has finished, run the command displayed on the screen so the other servers
join the cluster. If required, label the nodes dedicated for OpenSearch.
c. Install any add-ons that were manually installed in the cluster. For example, the EFS Driver.

2. Configure the storage destination: From the KOTS CLI, point the cluster to the storage destination
where the Replicated Snapshots were saved.

AWS S3 See configure-aws-s3.
Azure See configure-azure.
GCP See configure-gcp.

S$3-Other See configure-other-s3.

NFS See configure-nfs. If the cluster uses EFS or NFS, also see Configuring an NFS Storage Destination.

Note: If using EFS as an NFS server, Server field = DNS name of the EFS and Path field = a directory inside the
EFS, writable by the user:group 1001:1001.

3. Locate the snapshot and restore it: From the KOTS CLI, run a backup Is and full restore.
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6.

7.

backup Is

This can take a few minutes. If the snapshots don’t appear, rerun this command.

If you changed the host name for Jama Connect:

a. Update the Host Name field in the KOTS Admin Console and deploy the change.

b. From your browser, log in to Jama Connect and change your URL.

View scheduled jobs to verify that the list isn't empty.

If the OpenSearch data wasn't included in the snapshot or if the snapshot isn't recent, reindex all
search items.

Verify that you can locate your assets.

The new application server for Jama Connect is successfully set up.

Configure database settings
Database settings can be configured as part of your initial installation of Jama Connect or any time you
need to make changes.

To configure settings for your database:

1.
2.

In the header of the KOTS Admin Console, select Application > Config to open the settings page.
Scroll to the Database Settings section of the page.

Select the type of database you're using, MySQL [475] or Microsoft SQL [476], then complete or
change the database settings as needed.
(Optional) If you need to connect to your database through an SSL-encrypted connection, provide
additional connection string parameters. These parameters specify key/value pairs in the format
appropriate to your database.
e MySQL

useSSL=true&requireSSL=true
e SQL Server

ssl=require;appName=jama;bufferMinPackets
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More options are available for MySQL and SQL Server

5. Scroll to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important
Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Configure web server settings

Web server settings can be configured as part of your initial installation of Jama Connect or any time you
need to make changes.

The web server configuration allows the use of SSL (TLS) or plain text connections.
To configure the web server settings:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.

2. Scroll down to the Web Server section of the page.

3. Enter the context path for Jama Connect, for example, https:/<host_name>/. Don't use this config-
uration unless you need to specify a sub-path or sub-directory.

4. (Optional) Enter the context path.
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5. (Optional) Set the TLS and plain text port as needed.
6. Scroll to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important

Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Configure host name

Your host name settings can be configured as part of your initial installation of Jama Connect or any time
you need to make changes.

Important considerations

¢ To ensure correct TLS Certificate Validation during Server Name Indication (SNI), host names must be
Fully Qualified Domain Names (FQDNs).

e [f possible, choose a host name that's meaningful to users. Be sure the domain name matches your TLS
certificate.

¢ |If you need to change this host name, you must also change the base URL [608].

If possible, choose a host name that's meaningful to users. Be sure the domain name matches your TLS
certificate.

To configure the host name:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.
2. Scroll down to the Host Name section of the page.
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3. Enter or change the host name.

4. (Recommended) Select Reuse Admin Console TLS Configuration to use the same certificate config-
ured in the KOTS Admin Console.

5. Scroll to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important
Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Bypass browser TLS warning
A Transport Layer Security (TLS) or Secure Sockets Layer (SSL) certificate is required to establish a link
between the Admin Console (Replicated) and your browser.

When configuring the KOTS Admin Console for the first time, you see a TLS warning with an option to
bypass it with a self-signed certificate. If you have a trusted certificate, you can configure the certificate
at any time [563]. If you continue with the self-signed certificate, you see a warning every time you
access the Admin Console.

You can upload a TLS certificate and provide a private key if you have one. Private keys can't be
password-protected. The key and primary certificate must be in PEM format, that's a base64 encoded
x509 certificate.

To bypass browser TLS warning:

1. Open the KOTS Admin Console, then select Continue to setup.
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2. Choose one:

¢ To upload now — Select Choose private key and Choose SSL certificate, then select Upload &
continue.

o To upload later — Select Choose SSL certificate.

The KOTS Admin Console login page opens.
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Configure TLS certificate
The settings for the TLS certificate can be configured as part of your initial installation of Jama Connect
or any time you need to make changes.

You can provide custom private key and TLS certificates to secure the application, or you can reuse the
Admin Console certificate. You can also update your certificate [607] if it expires.

The certificate ensures that Jama Connect trusts the issuer.
To configure the TLS certificate:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.
2. Scroll down to the Host Name section of the page.
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3. Select Custom TLS Configuration to open the TLS Configuration section.

4. To link Jama Connect to a service protected by a certificate (self-signed or issued by a local authori-
ty):
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e Private Key — Select Browse files for Private Key and select your private key.
o Certificate — Select Upload a file and select your self-signed certificate.

5. Scroll down to the Trusted Certificates section, and select Use trusted certificate file to upload
a PEM-formatted public certificate or multiples that are concatenated into a single file. These
certificates are added to the default Java trust store. You might need this functionality to connect to
your MySQL, SQL Server, LDAP, Crowd, IMAP, SMTP, or other internal servers from Jama Connect.

6. Scroll down to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important
Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Configure memory settings
Memory settings can be configured as part of your initial installation of Jama Connect or any time you
need to make changes.

Use the advanced memory settings to change the memory allocation of containers that are running Java
processes.

Note

y When changing memory settings, make sure you don't over-allocate the total memory
of the application server [470]. Monitor usage [604] and make sure to leave enough
memory for system processes to run smoothly. For information, see Resource sizing for
your application server [471].

To configure memory settings:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.
2. Scroll down to the Core Jama Application Settings section of the page.

565



Administration

3. Select Show Memory and CPU Settings.

4. Enter the default values. If you have performance issues, contact Support for help configuring these
values.
5. Scroll to the bottom of the page and select Save config.
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A message confirms that your settings were saved.

Important

Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Configure advanced startup settings

Startup settings can be configured as part of your initial installation of Jama Connect or any time you
need to make changes.

Enable Java Management Extensions (JMX) and set additional Java Virtual Machine JVM options
(JAVA_OPTS) for the following containers that are running Java processes:

e The jamacore application
e Search service
e OpenSearch

Important

Each of these containers already adds a number of their own JVM options that might
clash with additional JVM options configured here.

Use JMX support in a secure environment, because JMX ports have no authentication on the JMX ports
when JMXis enabled.

To configure advanced startup settings:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.
2. Scroll down to the Startup Settings section of the page, and select Show advanced startup settings.
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w

7.

8.

Startup Settings

Show advanced startup settings

Advanced Startup Settings

[] Enable JMX remote for core Jama application

Adcditional JVM options for core Jama application

[] Enable JMX remote for search service

Adcditional JVM options for search service

[ Enable JMX remote for OpenSearch

Additional JVM options for OpenSearch

Select Enable JMX remote for core Jama application.

Enter the JMX remote port number for the core Jama application.

Don't overlap JMX ports between containers and don't overlap other ports that are already in use
on the application server.

(Optional) Enter additional Java JVM options for Jama core, search service, and OpenSearch.

Enter a Java RMI server hostname.

A single Java RMI server hostname can be given that works across all containers that have JMX
enabled. The host IP address is used by default. However, if the host IP address isn't accessible by
the JMX client for the configured JMX ports, the public hostname or the public host IP is set here. If
an SSH tunnel is used, set the hostname to "localhost."

(Optional) In the Add services configuration field, add services configuration specific to Jama Con-
nect, such as throttling.

Scroll to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important
Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.
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. Tip
% Garbage collection logging (GC logging) is automatically enabled for containers that
are running Java processes. GC log files are available alongside other log files for the
respective container [613]. When you restart Jama Connect, previous GC log files are
packaged as a ZIP file. Typically, the default GC logging configuration is sufficient, but
it's possible to override GC logging parameters through the Additional JVM options for

Jama core field in Admin Console advanced startup settings.

Configure Search Service Settings

Search service settings can be configured as part of your initial installation of Jama Connect or any time
you need to make changes.

Configure index settings for OpenSearch. Making changes to these settings requires re-indexing.
To configure settings for Search Service:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.
2. Scroll down to the Search Service Settings section of the page.

3. Enter the default values.
4. Scroll to the bottom of the page and select Save config.
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A message confirms that your settings were saved.

Important

Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Set a custom location for the MathType Equations Editor

Settings for the MathType Equations Editor can be configured as part of your initial installation of Jama
Connect or any time you need to make changes.

Note

ﬁ The MathType Equations Editor requires a separate license. After your organization has
purchased the license, and the system administrator sets up a location for the editor,
users can access the editor in the Rich Text Editor [104] in Jama Connect.

Airgap or self-hosted instances of Jama Connect can add math and chemical equation options to the rich
text editor without making calls to an external server.

Requirements
Before enabling the MathType Equations Editor, you must:

e Designate a server inside your environment that can listen for MathType calls and responses. Check for
the latest supported version on the Community.
e Acquire a MathType license from Jama Software.

To configure settings for MathType Editor:

1. Inthe header of the KOTS Admin Console, select Application > Config to open the settings page.
2. Scroll down to the WIRIS Connection Settings section of the page.
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3. Select Use custom WIRIS connection to override default settings for communication with the
WIRIS cloud servers.

4. Enter the following information for your designated MathType server:
o WIRIS Host (Required) — Enter the hostname of your MathType server. This must be accessible
from both the Jama Connect application server and the user's browser. Don't include the port or
protocol.
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e WIRIS Path — Enter the context path followed by "render." Depending on how your server is set
up, it might look like this:
/editor/render

o WIRIS Port — The defaults are 80 for http and 443 for https. You can override these values by
entering a different port number.

e WIRIS Protocol — This is https or http. If you use https to link to Jama Connect, you must also use
https for WIRIS.

Note

i Additional settings for proxy are available but haven't been fully tested. You can
use these settings if your Jama Connect instance needs to use a proxy to connect
to the MathType server. However, these settings don't change how your browser
connects to the MathType server.

5. Scroll to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important
Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Setting up Jama Connect
Once you finish installing Jama Connect, continue with a few tasks for the initial setup of the application.

When logged in as root, you can access the System Administration page. From there you can complete
the tasks for setting up and maintaining Jama Connect.

Administrator tasks

System admins complete basic setup and maintenance tasks on the System Administration page. Some of
these tasks can also be completed by an organization admin.

Task System admin Organization admin
Modify organization details [578] X
Configure general properties [580] X
Configure authentication properties [583] X
Manage users [646] X X
Manage permissions [751] X X
Manage reports [458] X
Monitor license usage [659] X X
Create editor templates [697] X X
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Task System admin Organization admin
Create a backup [598]
Reindex search [612]
View log and profile [616]
Clear cache [612]
View scheduled jobs [611]

X | X | X| X X|X

View applied patches [612]

Log in as root for the first time
As a system administrator, you are the root user with a unique set of permissions [656] that allow
you to access the System Administration page in Jama Connect.

The first time you log in as root, change the default password for the root user and edit any details in the
My Profile page, such as email address, phone number, or location.

To log in as root for the first time:

1. From the Jama Connect login page, enter the default credentials for root, then select Sign In.
¢ Username = root
¢ Password = password

2. Inthe top right header, select root.

3. On the root user's My Profile page, select Change Password.
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4. Enter the existing password, enter and confirm a new secure password, then select Save.
5. (Optional) Select Edit Settings to configure the root user email and any other details as needed.
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6. Select Save, then select Close.

Your changes are saved.

Assign a new user as organization admin

Only system and organization admins can assign roles or grant permissions to other users. If you config-
ure an organization admin right after you install Jama Connect, you can share the tasks of setting up user
accounts and permissions.

Important
You must be have system admin permissions to complete this task.

To assign an organization admin:

1. Loginto Jama Connect as the root user [573] or as an organization admin.
2. Select Users > Add user.

3. Select a user if LDAP is enabled [589]:

575



Administration

a. From the LDAP column that is added, select Add user from LDAP, enter the name of an existing
LDAP user in the search box, then press Enter.

. #u.r Tip
o You can add wildcards to a search but don't add them at the beginning of a
search term. Wildcards at the beginning can result in slow performance. For
large directories, expect several minutes.

b. From the search results, choose a user, then select Add.

4. Select a user if LDAP isn’t enabled — Select Add user.
5. In the Create User page that opens, complete the information for a single user.

6. For License Type, select Creator.
7. Under Groups, select Organization Admin from the list.
8. Select Save.

Your changes are saved.

Grant permissions to users

Permissions allow users access to create, read, and edit items. They are granted at different levels in your
environment.

Types of permissions Level Notes
Roles [670] and access permissions Organization level Org-level permissions are passed on to lower levels.
Project admin permissions Project level
Access permissions Container level and above
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Tip

% Organization admin permissions can't be overridden. In releases prior to Jama Connect
8.62, there was the appearance that you could control an organization admin’s access.
However, that user could still see all projects and content, and if they wanted they
could give themselves access. The addition of User, Process, and Add project roles
decreases the need for a large group of organization admins. No updates or overrides
that you created in the past have been removed, so we recommend that you remove
them as your organization adopts these new admin roles.

You can create new permissions for a user or group as well as modify existing permissions.
To grant permissions to users:

1. Loginto Jama Connect as the root user [573] or as an organization admin.
2. Select Admin > Permissions.

3. Inthe Project Selector on the left, choose the level where you want to access permissions.
e Organization (System)
e Individual project
¢ Container
The main page displays current permissions.
4. To change existing permissions for a user or group:
a. Select Modify in the row of the user or group you want to change, select the permissions you
want to include, and deselect what you don't want to include.
b. Select Remove in the row of the user or group where you want to delete permissions.
5. To add permissions for a user or group:
a. Select Add permissions in the top right.
b. Inthe Add permissions page that opens, select Add user or Add group.
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o Existing user or group — Select a user or group from the list on the left, then under Permis-
sions, select the role (access permissions) for that user or group.
o New user or group — Select New user or New group in the top right corner of the page.
Then under Permissions, select the role or access permissions for that user or group.
c. Select Save.

Your changes are saved.

Edit organization details

As a system admin, you can change your organization’s information such as the name, description, or re-
turn email address.

To change any organization details:

1. Login to Jama Connect as the root user [573].
2. Select Organizations > Details > Edit.
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Enter or change any of the following information:

¢ Organization name — Typically the name of your company or team. This name appears in the
application as well as in reports.

e Description — Additional information about your company.

¢ Return email — Email notifications automatically sent by the application. Typically, the organiza-
tion administrator's email address is used or noreply@example.com.

e Base URL — The base URL is used to create URLs sent in email notifications and embed images in
exports.

¢ Rich text image max width (px) — Maximum pixel width setting that shrinks all images embedded
into rich text fields. Default 0 means no max width is applied.

¢ Rich text image max height (px) — Maximum pixel height setting that shrinks all images embedded
into rich text fields. Default 0 means no max height is applied.

Note

i Images retain their aspect ratio when adjusted to fit the maximum setting of
height or width. The adjustment only happens during an upload or document
import. Images that already exist on the server are not adjusted. Compres-
sion is based on the width and height setting applied.

o Allow project admins to subscribe to others — Allows project administrators to subscribe other
users to items.

¢ Allow users to mute subscriptions — Allows users to turn off a subscription that was subscribed
to by another user.

¢ Allow non-administrators to delete items/containers — Allows a user to delete items even if they
don't have organization admin permissions. Default is On.

¢ Include unexecuted test run in status calculations (Not retroactive) — Jama Connect uses all
associated test runs to automatically calculate test case status.
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Note

é’ For test cases associated with a single plan, test case status reflects the status of
the test run with the most recent activity, which includes unexecuted tests (if ena-
bled). When the case is associated with multiple plans, the most urgent status is
chosen in this priority order: unexecuted, failed, blocked, scheduled, passed.

Select this box to include unexecuted test runs in the calculation of test case status (default).
Uncheck this box to remove unexecuted test runs from the status priority order.
If you don't include unexecuted test runs and there are no executed test runs, the system defers
to including unexecuted test runs.
¢ Allow multiple items with the same Global ID in a single project — Allows items to be reused
multiple times within one project. Default is off.
4. Select Save.

Your changes are saved.

Configure general properties

The general properties need to be configured for all Jama Connect installations. Properties include
configuring email and any messages you want to display on the login page.

To configure general properties:

1. Login to Jama Connect as the root user [573].

2. Select the System properties tab in the Jama System Administration panel, then select Edit in the
top, right corner.

3. Change any of the following settings.

e Enable HTML Tag Security Cleaning — Prevents suspicious HTML tags from being added to
new and modified rich text fields and test steps. Doesn’t clean up data retroactively. Enabled by
default.

e SMTP Settings — Settings that affect notifications and subscriptions.

SMTP Enabled Select Yes to use SMTP.

SMTP Host The domain address of your SMTP server.

SMTP Port The port for SMTP access.

SMTP User User account to access SMTP.

SMTP Password Password for the user account.

Authorization Required Select Yes if authorization is required for the SMTP server.

Use TLS? Select Yes if your mail server uses TLS. Jama Connect supports only Explicit (Opportunistic)
SSL/TLS connections for SMTP.

e System "From" address — Enter an address for the system to use when it sends notifications or
other system messages (for example, info@mycompany.com).

e Collaboration "From" address — IMAP must be supported to enable reply-to e-mails in the
stream [248]. The Collaboration "From" address must match the email address used for IMAP,
so replies to stream emails are sent to the same account that processes incoming mail (for
example, replyto@mycompany.com). To enable IMAP, see Configure Inbound email (IMAP) set-
tings [582].

¢ Allow Project Administrators to add groups — Select Yes for project administrators to add
groups [745]. Otherwise, only system and organization administrators can add groups.

¢ Allow Project Administrators to set project permissions — Select Yes for project administrators
to grant project permissions [748]. Otherwise, only system and organization administrators can
grant permissions.
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e Allow access to REST API — Enables users to perform actions in Jama Connect from outside the
user interface.

e Attachment file extensions — List of file types (lowercase, separated by commas, periods, spaces,
or newline characters) that can be uploaded as an attachment.

Note

y Files are rejected if the content of the file doesn't match the file extension, or
if the MIME type is not understood by the system, even if the file type is listed
here. To allow files of an unknown type, set the option to a blank string.

File extensions must be lowercase even if the actual extension on the file is
uppercase. Learn more.

¢ Notice on login page — Displays a notice to users below the login page and in a yellow bar at the
base of the application page.

Note
y This login page might not be visible if you are using SSO or SAML logins.

¢ Maintenance mode — Logs out and locks out all users except the root user until this option
is disabled.

e Set header color — Helps to differentiate test or staging instances from the production instance of
Jama Connect.

e Set Batch Synchronous Index Limit — Select a limit that determines whether items in a batch
update are indexed synchronously or asynchronously. Synchronous indexing can add time to the
index process, so the default value is set to 1000. The added time depends on the number of
items and the complexity of fields for those items.
¢ Synchronous indexing — The number of items in a batch update is equal to or less then the

limit.
¢ Asynchronous indexing — The number of items in a batch update is greater than the limit.
4. Select Save.

Your changes are saved.
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Configure Inbound email (IMAP) settings
Before configuring IMAP, verify that your email server supports IMAP. Your server must support IMAP to
enable reply-to emails in the stream [237].

For more information, see Authenticate an IMAP, POP or SMTP connection using OAuth.

To configure IMAP:

1. Login to Jama Connect as the root user [573].
2. Select System Properties > Inbound Email (IMAP).
3. Select Edit, then select Is IMAP enabled.
4, Configure the following settings:
Host Enter the IMAP server URL.
User account Enter a user account for someone with access to the folder where IMAP emails are saved.
Password Enter the password for the user account or the OAuth secret.
Port The port for IMAP connection, typically different from SMTP. Standard ports are Non-SSL:143,
SSL:993.
Is SASL XOAuth2 Ena- Select to enable OAuth authentication and token-based authorization for Microsoft based IMAP
bled connections.
Is SSL Enabled Select to enable SSL IMAP connections.
Is TLS Enabled Select to enable TLS IMAP connections.
OAuth Client ID Enter the client ID (Microsoft AAD Application ID).
OAuth scopes Enter the resource URLs defining the token authorization request.
OAuth authority Enter the URL of the authenticating authority or security token service.
Microsoft security token service example: https:/login.microsoftonline.com/{microsoft_ten-
ant_id}
Incoming mail folder (Required) Enter the name of the mail folder to read collaboration replies from.
Error mail folder (Required) Enter the name of the mail folder to move unknown emails to. Unknown emails are
non-collaboration emails.
Is debugging enabled Select to enable debug level logging for failing IMAP connections. After enabling, check the
server logs and test the connection.
5. Select Save.

Your changes are saved.

Configure Outgoing Email (SMTP) settings
Before configuring SMTP, verify that your email server supports SMTP. Your server must support SMTP
to enable reply-to emails in the stream.
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For more information, see Authenticate an IMAP, POP, or SMTP connection using OAuth.

To configure SMTP:

1. Loginto Jama Connect as the root user.

2. Select System Properties > Outgoing Email (SMTP).
3. Select Edit, then select Is SMTP enabled.

4. Configure the following settings:

System "From:" Address

Enter the name for the "from" user account.

Collaboration "From:"
Address

Enter the name of the mail folder to read collaboration replies from.

Host Enter the SMTP server URL.

User account Enter a user account for someone with access to the folder where SMTP emails are saved.
Password Enter the password for the user account or the OAuth secret.

Port The port for SMTP connection. Standard ports are Non-SSL: 25, SSL:587.

Is SASL XOAuth2 Ena-
bled

Select to enable OAuth authentication and token-based authorization for Microsoft based
SMTP connections.

Is TLS Enabled

Select to enable TLS SMTP connections.

OAuth Client ID

Enter the client ID (Microsoft AAD Application ID).

OAuth scopes

Enter the resource URLs defining the token authorization request.

OAuth authority Enter the URL of the authenticating authority or security token service.
Microsoft security token service example: https:/login.microsoftonline.com/{microsoft_ten-
ant_id}
5. Select Save.

Your changes are saved.

You might need to clear your cache for these setting to take immediate effect. For more information, see

Clear cache [612].

OAuth settings only work with Microsoft SMTP services.

Configure Basic authentication

The default authentication method is Jama Connect Basic, which authenticates users by their username

and password that are stored in the Jama Connect database. Passwords are encrypted before they are
stored in the database.

583



https://learn.microsoft.com/en-us/exchange/client-developer/legacy-protocols/how-to-authenticate-an-imap-pop-smtp-application-by-using-oauth

Administration

é’ Note
You must be a system administrator to complete this task.

To configure the Basic authentication properties:

1. Loginto Jama Connect as the root user [573].
2. Select System Properties > Authentication Properties > Basic.

3. Configure the authentication properties for the method you are using.

¢ Enable basic authentication — Enabled by default. You must deselect this option to use LDAP or
Crowd.

¢ Enable "Forgot Password" functionality — Users who forget their password can request a new
password without notifying the system admin.

¢ Allow users to change their username — Users can change their username when they manage
their profile.

e Password requirements — Set the required password strength for all future passwords. New user
passwords must meet the required password strength to be saved. Changes to these settings do
not affect passwords already in the system.

4. Select Save.

Your changes are saved.

Configure SAML authentication

To configure SAML authentication, you must first update the authentication properties.
Important considerations

¢ To connect multiple instances of Jama Connect to the SAML service, you must create unique metadata
or applications for each instance through the identity provider. This is true for any combination of
production, sandboxes, or self-hosted instances. The entity ID is a unique value that allows the service
and identity provider to locate each other and send users to the correct Jama Connect instance.

¢ We recommend testing an integration instance before using SAML on a production instance. For
example, disable a sandbox instance from SAML before connecting on a production instance.
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e Starting with Jama Connect 8.48, organizations that use SAML can use electronic signatures [258],
which are enabled by default. If your identity provider (IdP) can't process the re-authentication, you
can disable signatures.

e You can enable a different authentication method at any time. If you do, SAML is disabled.

¢ You can control the auto-provisioning of new SAML users in both single SAML and multi-mode. If
your users are set up in SAML but not yet added to your Jama user table, this option allows you to
control whether users can auto-provision in Jama Connect.

When this option is selected and properties are saved, your SAML users (SAML and multi-mode) can’t
sign in to Jama Connect until you add them to the Jama user table. A message tells them to finish the
authentication process with their administrator.

This option is selected by default after you upgrade to 8.62.

To configure SAML authentication:

1. Login to Jama Connect as the root user [573].
2. Select System Properties > Authentication Properties > SAML.
3. Before you enter data, select Enable SAML, then select Save.

Note

é’ The following selections for the Match on field configuration are beta features
that are under development: Username, Custom identifier (NamelD), and Custom
identifier (Attribute). For now, use the default Email selection. If you're interested
in beta testing the Username or Custom identifier selections, contact your account
manager.
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4. Contact your identity provider for the metadata URL or XML, then paste it in the appropriate field.
If a connection is established, the last three read-only fields are auto-populated with a URL.
¢ SP metadata URL — https:/saml-or.jamacloud.com/saml/metadata/alias/defaultAlias
e ACS / single-sign-on URL — https://saml-or.jamacloud.com/saml/SSO/alias/defaultAlias

e SP entity ID / Audience restriction — https:/saml-or.jamacloud.com/saml/metadata/alias/defaul-
tAlias

If the connection doesn't work, you might need to adjust the information in the ACS binding, First
name attribute mapping, and Last name attribute mapping fields or contact support.

#g_r Tip
. The mapping fields serve as the key that connects user identity between Jama Con-
nect and your identity provider. If name attribute mapping fields aren't specified,
then a new user's full name defaults to their email address.

5. Select Save.

Once SAML is enabled, Jama Connect redirects all users to the identity provider's login page. The Jama
Connect login page is only accessible for system administrators if they log in as the root user with this
URL:

https://your-jama-url/casper/login.req
Configure multi-mode authentication

The combination of Jama Connect Basic and SAML authentication (Basic + IdP) provides extra security
by separating your internal users from external partners.
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To configure multi-mode authentication:

1. If you haven't entered the SAML metadata in the root menu, go to the SAML tab and enter it there.
¢ Contact your identity provider for the metadata URL or XML, then paste it in the appropriate
field. If a connection is established, the last three read-only fields are auto-populated with a URL.
e SP metadata URL — https:/saml-or.jamacloud.com/saml/metadata/alias/defaultAlias
e ACS / single-sign-on URL — https://saml-or.jamacloud.com/saml/SSO/alias/defaultAlias
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e SP entity ID / Audience restriction — https://saml-or.jamacloud.com/saml/metadata/alias/de-
faultAlias

If the connection doesn't work, you might need to adjust the information in the ACS binding,
First name attribute mapping, and Last name attribute mapping fields or contact support.

. #q_r Tip
. The mapping fields are the key that connects user identity between Jama
Connect and your identity provider. If name attribute mapping fields aren't
specified, a new user's full name defaults to their email address.

2. Login to Jama Connect as the root user [573].
3. Select System Properties > Authentication Properties > Basic + IdP.

4. Select Enable BOTH Basic authentication and SAML, then select Save.
The Basic + IdP tab transitions can now accept input. While the Basic and SAML tabs are now
read-only This type of input is the same on both tabs: Basic and SAML.

5. Complete the Basic and SAML sections in the Basic + IdP tab:
Basic — Fill out the the Basic Authentication section.

SAML — If you haven't entered the SAML metadata in the root menu, complete the following steps
in the SAML section of the Basic + IdP tab.

Note

i The following selections for the Match on field configuration are beta features
that are under development: Username, Custom identifier (NamelD), and Custom
identifier (Attribute). For now, use the default Email selection. If you're interested
in beta testing the Username or Custom identifier selections, contact your account
manager.

6. Select Save.
7. Confirm the configuration was successful: Select the Users tab, then verify that the Authentication
Type column appears in the table.

If you see the Authentication Type column, Basic + IdP authentication is now enabled.
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Configure LDAP authentication

LDAP (Lightweight Directory Access Protocol) is a tool for organizations to centralize the management of
user accounts. Jama Connect includes a built-in integration for LDAP and Microsoft Active Directory.

LDAP must be configured before it can be used in Jama Connect to authenticate users against your
LDAP server.

To configure LDAP authentication:

1. Login to Jama Connect as the root user [573].
2. Select System Properties > Authentication Properties > LDAP.

3. Configure the authentication properties for the method you are using.

¢ Enable LDAP — Select this to enable LDAP and disable the default Jama Connect authentication.
Save the settings for changes to take effect.

¢ Enable Self Registration — Users can register themselves by logging in to Jama Connect using
their LDAP credentials. If successfully authenticated, they get a prompt to register for Jama Con-
nect. Without self-registration, users must be added manually by an organization administrator.
Once registered, users will be assigned a license type based the rules below. An organization or
project administrator must then assign permissions for that user.
¢ |f there are available creator licenses, they are assigned a creator license.

e If there are no named creator licenses, users are assigned floating creator licenses (shared
among others).

e |f there are no creator or floating creator licenses available, you can still create users, but
they are set to inactive. An organization administrator must manually assign the user an active
license when one becomes available.

¢ Default organization for self-registered user — Select the organization that self-registered users
are assigned by default. There should only be one option.

e Default user group for self-registered user — Select the default group to which a self-registered
user should be assigned. Organization administrators will need to assign permissions to self-regis-
tered users.

4. You can configure multiple directories with LDAP authentication. To add a new provider, select Add

AD Provider or Add LDAP Provider, depending on the LDAP tool you use.

5. Inthe window that opens, provide the server information used to connect to the Active Directory or

LDAP server, then select Next.
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Name — Name of the connection that will appear in the Jama Connect interface.

Description — Description of the connection that will appear in the Jama Connect interface.

URL — The URL to the Active Directory or LDAP server.

Bind DN — The reference to the account that Jama Connect will use to perform all actions against
the Active Directory or LDAP server. This field accepts the Distinguished Name of the account
("cn=John Doe,ou=Users,dc=jamasoftware,dc=com").

Some Active Directory servers support the use of Full Name ("John Doe") or Email ("jdoe@do-
main.com").

Bind Password — The password of the Bind DN account.
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¢ Test Configuration — Select Test configuration to test for a successful connection to the specified
server and bind account information. If successful, a "Configuration Successful" message will
display in the window and the Base DN selection screen will expand.

¢ Select the Base DN — The Base DN is the directory where users in Active Directory or LDAP
exist that need to be added to Jama. Successfully tested configurations will load a radio button
selection list of all available Base DNs.

Specify the attributes in Active Directory and LDAP that automatically populates the Jama Connect

user attributes.

Add/Edit Provider
LDAP User Mapping o

Map the correct fields for this user

Username: adrnin
Lsername samaccountname
Aftribute:

Map Contour user fields to their corresponding LOAP attributes

Contour Field LDAP Attribute Clear

First Name W Clear L
Last Name w Clear

Full Mame W Clear

Email ¥ | |Clear

Location w Clear

Phone W Clear

Title ¥ | |Clear

Advanced Setup Back Save Close

e Username — Enter the username of a sample user that exists in the specified Base DN.

¢ Username Attribute — Enter the attribute where the username value is stored (for example,
Active Directory commonly uses "samaccountname").

Select Next to validate that the provided username and username attribute exist. If successful, the

window expands to show a selection list of all available attributes for each of the Jama Connect user

attributes.

¢ Jama User Attributes — First Name, Last Name, Full Name, Email, Location, Phone, Title.

o LDAP attribute — The selection drop-down shows all available directory attributes that are con-
nected to the provided username. Select the correct value in the selection list that matches the
Jama Connect user attribute.

Select Advanced setup if you know all the details of the connection and user attribute values. If you

choose this option, you must add the Full Name Attribute or errors will result.
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Add /Edit Provider

Mame: Jama Software Active Directory
Description: This connects to the Portland office.

LRL:
Base DN:
Bind DM:

Bind Passward: EERRRERRY

[] Enable JNDI Referrals

Lsername samaccountname
Attribute:

Full Mame displayMame
Aftribute:

First Mame givenMame
Attribute:

Last Mame &n
Attribute:

Email Attribute: mail

Location:
Phone:

Title:

Test Configuration

Back Save Close ]

9. Select Save.
10. Select Synchronize Now to manually sync all existing users in Jama Connect to LDAP. This updates
user information with attributes from LDAP.

The user information is updated with attributes from LDAP.
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Important

Any Jama Connect users who aren't registered in LDAP are deactivated. Users in LDAP
that don't already exist in Jama Connect aren't synchronized. New users must be added
manually [575] with existing LDAP credentials.

Troubleshooting LDAP errors
If any errors occurred during installation, use this table to troubleshoot the issues.

Error message Reason
Unable to communicate with LDAP server; nested exception is Can't connect to the server. Check the URL and make sure port 389
javax.naming.CommunicationException: localhost:389 [Root is open.
exception is java.net.ConnectException: Connection refused:
connect]
Obperation failed; nested exception is javax.naming.Authenti- The BindDn or password is incorrect.

cationException: [LDAP: error code 49 - Invalid Credentials]

Can't find user Indicates that the Base Dn, Bind Dn, and Bind Password can be
connected to accurately (a good connection to LDAP). Either the
Login Name Attribute was not filled in correctly or the Sample User
does not exist in the Base Dn indicated.

Can't authenticate user The sample user password is incorrect. However, this message indi-
cates a successful connection to LDAP and that the sample user was
found in the Base Dn.

Operation failed; nested exception is javax.naming.Partial- The cause is usually the base URL is incomplete (too broad).
ResultException: Unprocessed Continuation Reference(s); re-
maining name

Operation failed; nested exception is javax.naming.ServiceU- Either SSL isn't supported by Spring LDAP or the certificate is incor-
navailableException: adunit:636; socket closed. Port 636 is for rect.
SSL.

Solution: Try using Idap protocol. For example: Idaps:/myserver.ex-
ample.com:636.

Make sure you entered the correct information for the type of LDAP you are configuring:

e Active Directory
URL: 'ldap://localhost:389"
Base Dn: 'ou=Users,dc=<domainname>,dc=com'
Bind Dn: 'cn=Admin,ou=Admin Users,dc=<domainname>,dc=com'
Bind Password: 'password'
Login Name Attribute: 'sAmAccountName'
Email Attribute: 'email’
User Name Attribute: 'displayName'
Sample User: 'admin'
Sample User Password: 'password'
e LDAP
URL: 'ldap://localhost:389"
Base Dn: 'ou=Users,dc=<domainname>,dc=com’
Bind Dn: 'cn=Admin,ou=Admin Users,dc=<domainname>,dc=com'
Bind Password: 'password'
Login Name Attribute: 'uid'
Email Attribute: 'mail’
User Name Attribute: 'cn'
Sample User: 'admin’
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Sample User Password: 'password'

Important

If you are using SSL, you must use the ldaps protocol. For example, Idaps:/myserver.ex-
ample.com:636

The Base Dn and Bind Dn values won't accept a domain-only value. At least one additional level is
required, such as the 'ou=Users' shown in the example above.

Take note of the "Can't find/authenticate user" errors. Errors often indicate a successful connection, but
the Sample User/Password are incorrect.

Important

The Sample User and Password fields are deleted every time the configuration window
is closed.

Configure Crowd authentication

Use Crowd to manage users and groups within a single system. Jama Connect can accept user details
from Crowd and sync them with authentication data in Jama Connect.

To configure Crowd authentication:

1. Login to Crowd as an administrator.

2. Select Applications > Add Application, fill in the fields for a new application and select Next.
X CROWD
Applications Users Groups Roles Directories Administration
Search Applications Add Application
Add Application
1. Details
Application Type: = Generic Application -
Are you connecting JIRA to Crowd, or perhaps Confluence or Bamt
MName: *  jama
The a a appica auth cale againstir a as acl
Description:
A Ci applicati ften a LR
Password: T sessssse
Confirm Password: * sessesse

Mext = ] [ Cancel

e Application type — Generic Application.
¢ Name — "jama" or any other unique name that identifies Jama Connect as the application.
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5.

4

Note

The name must match. For example, lower case "jama" in the above example.

e Description — (Optional) Provide a short description of the application.

3.

e Password — Create a new password that Jama Connect uses to access Crowd.
Enter the URL and IP address for Jama Connect, then select Next.

4. Select the directories that control access to Jama Connect, then select Next.

4

Note

These directories must exist prior to inclusion.

Select the particular groups in the Crowd Directory you want to have access to Jama Connect, or
choose "all users in the directory" if you want all users to have access, then select Next.

Applications

Search Applications

Add Application

Groups Roles Directories Administration

Add Application - contour1

1. Details 2. Connection 3. Directories 4, Authorisation

Either allow all users access from a given directory to the ‘contour?” application, or choose the specific groups from each directory.
Directory — CrowdContourTest

Allow all users to [

authenticate: et all users in this directory authenticate against the ‘contourt’ application.

Authorised Groups: crowd-administrators (remove)
Directory Groups: TestGroup - Add Group
Mext = ] [ Cancel
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6. Review your configuration, then select Save.

7. Login to Jama Connect as the root user [573].

8. Select System Properties > Authentication Properties and complete the following fields.
General Properties Authentication Properties

Basic SAML Basic + IdP LDAP Crowd

Crowd Properties

Enable Crowd:

Crowd Location: mcarneiro
Crowd Application Name: | root
Crowd Application Password: | sesesessesces

Enable SSO: ]

Validation Interval: 100

Sync Crowd Users/Groups: ]

Sync Interval (Minutes): | 30

Default Organization for Users: v

¢ Enable Crowd — Select to enable or disable Crowd Connector. When disabled, the Jama Connect
database is used for users and passwords.

¢ Crowd location — Enter the URL for the Crowd server.

¢ Crowd application name — Name of the application created in step 2 above.

e Crowd application password — Enter the password for Jama Connect that was created in Crowd.

¢ Validation interval — The amount of times a user can access the application prior to re-authenti-
cating. The larger the number, the less communication with Crowd.

¢ Sync Crowd users and groups — Select this option to push Crowd Groups and Users into Jama
Connect at regular intervals. Make sure you understand how users and groups in Crowd interact
with Jama Connect [597] before you do this.
When syncing with Crowd, Jama Connect assigns licenses as follows:
o [f there are available named creator licenses, users are assigned a named creator license.
e [f there are no available creator licenses, users are assigned a float license.
e If there are no available creator or float licenses, the user is skipped and it appears in the log.
When Crowd is synced, Jama Connect runs through its list of users, adds new users, and modifies
existing users in the Jama Connect userbase. When that's complete, Jama Connect runs through
the list again to see if there are any existing users in the Jama Connect userbase that need to be
deactivated.
Since Jama Connect makes two passes at adding and deactivating users, you might need to sync
twice consecutively for it to work. For example, if you reach your license threshold, don't use float
licenses, try adding a new user and deactivating an existing user, or must sync twice consecutively
before the new user is given a named license.
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Important

You can also select Manual Sync at the bottom of the window to manually syn-
chronize all users and groups. Manual sync removes all Jama Connect configured
Users and Groups and insert Crowd users and groups.

¢ Sync interval — Enter the timing interval you would like for Crowd to synchronize groups and
users with Jama Connect. This defaults to 30 minutes.

e Default Organization for User — Only required when multiple organizations are setup with Jama
Connect.

9. Select Save.
10. Select Test Connection to test if the configuration values are valid.

Crowd authentication is configured.

Users who are registered in Jama Connect, but not in Crowd, can't access Jama Connect. Other users
can't add disabled users to reviews or notifications.

How users and groups work in Crowd

How users and groups function is impacted when you synchronize users and groups in Crowd connec-
tor [594].

The following actions change:

o All groups and users in Crowd that aren't in Jama Connect are added to Jama Connect. New users are
assigned the most licenses available. When no licenses are available, users are created and Inactive.
All groups in Jama Connect that aren't in Crowd are removed.

All users that are in Jama Connect, but not in Crowd, are deactivated.

Going forward, all user and organizational group management activities are performed in Crowd.
Organization admins no longer create or edit users and organizational groups in Jama Connect be-
cause they are automatically created from Crowd.

The following actions stay the same:

e Organization admins retain the ability to assign a license type [655] to users.
e Users can continue to upload avatar icons.
¢ Organization and project admins continue to manage project groups [745] within individual projects.

Important

Project level project groups are only managed in Jama Connect and aren't visible in
Crowd.

¢ An organization or project admin continues to manage user and group permissions [667] in Jama
Connect.

Action in Crowd Result in Jama Connect

Group(s) added to “Jama” Application in Group created.

Crowd
The name of the group is reused if it already exists.

Users added to the "Jama" group in Crowd Users added.
Attributes in Jama Connect are overwritten by values from Crowd if a user already
exists.

Group attributes modified Group attributes are modified.

User attributes modified User attributes are modified.
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Action in Crowd Result in Jama Connect

User added to group User is added to group.

User removed from group User is removed from group.

Group deleted Group is deleted.

User is deactivated User is deactivated.

User activated User is activated.
If the user doesn't exist, a new user is created. The new user is assigned the
highest available license. If a license isn't available, the user is inactive.

Backing up and restoring your data

Backing up your data is an essential part of maintaining and securing your self-hosted environment. With
regular backups, you can easily restore settings and content when you update your application server
hardware or if you lose data.

é’ Note
This information applies to self-hosted environments only.

You can back up and restore your data using several methods:

¢ Replicated snapshot — A function of Replicated software that creates a backup of the Admin Console
environment. It includes all Admin Console settings, the Replicated database, Docker images, and
Docker container volumes.

e .jama or XML file — A method with built-in automation, recommended for migrations and refreshes.
A .jama file includes the database and /data directory. An XML file includes only the database.

¢ Native database backup — The proprietary backup/restore system for MySQL and SQL Server databa-
ses. Recommended only if your database is extremely large.
e Backup of user data directories [613] — Where all physical artifacts [613] are stored.

Important

Create a backup regularly: daily, weekly, or monthly. Include in your regular backup a
Replicated snapshot (Admin Console environment) and a .jama or XML file backup (da-
tabase and /data directory).

Create a Replicated Snapshot (KOTS)

Taking a full snapshot creates a backup of the KOTS Admin Console and application data. It can be used
for full Disaster Recovery by restoring over the same instance or in a new cluster. Tenant assets are
included in the snapshot. OpenSearch data is included by default.

A Replicated Snapshot can be taken while Jama Connect is running without interruption.
Requirements

¢ Replicated Snapshots must be enabled for your Replicated customer license.

e KOTS Admin Console 1.79 and later.

e Replicated Snapshots don't include your database. You must use a proprietary backup/restore system
for your type of database, MySQL or SQL Server.
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Important considerations

e When restoring from a snapshot in a new cluster, you must reinstall KOTS.

e Recommended — Include OpenSearch data in snapshots to avoid having to reindex your data after
performing a restore. However, if your snapshot is not recent, we recommend reindexing your data.

e Replicated Snapshots don't support IAM authentication against EFS. Saving Replicated Snapshots in
EFS requires that you use the default file system policy to allow all nodes in the cluster to mount the

EFS.
To create a Replicated snapshot:

1. Capture the KOTS installer.

2. (Recommended) Include OpenSearch data in snapshots: From the KOTS Admin Console under the
OpenSearch Settings section, select Include OpenSearch in Replicated Snapshots.
3. Airgap only — Capture the IP address of the private registry, which is the IP address value in the

Cluster-1P column:

kubectl get service/registry -n kurl
4. Configure the storage destination:

a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. From the Destination drop-down menu, select a storage destination for your snapshots.
o For AWS S3 — The IAM role assigned to the underlaying servers or the user associated with
the credentials (access and secret key) must have the Policy template attached.
Use the following template to create a policy, replacing the <arn-S3> parameter with ARN of
the S3 bucket. For example: arn:aws:s3:::;jama-snapshots.

{
"Version': "'2012-10-17",
"Statement": [
{
"Effect': "Allow",
"Action": [
"s3:PutObject”,
"s3:GetObject",
"s3:AbortMultipartUpload"”,
"s3:DeletelObject”,
"s3:ListMultipartUploadParts"
1.
""Resource': '<arn-s3>/*"
-
{
"Effect':
"Action": "s3:ListBucket",
""Resource': '<arn-s3>"
b
1
b

e For NFS — If using EFS as an NFS server, the Server field = the DNS name of the EFS and the
Path field = a directory inside the EFS, writable by the user:group 1001:1001.
c. Select Update storage settings to save your preferences.

5. Schedule Full Snapshots:

a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. Select Enable automatic scheduled snapshots, then select Update schedule.
6. Create a Full Snapshot (follow the steps provided by Replicated).

The KOTS Admin Console and application data are now backed up and available for a full Disaster

Recovery.
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Restore KOTS Admin Console and Jama Connect from a Replicated Snapshot
(KOTS)

When you set up a new application server for Jama Connect, you can restore the KOTS Admin Console
settings that you saved in a Replicated Snapshot.

Snapshots include the registry images and data for Jama Connect.

Requirements

If restoring to a new cluster, it must match these specifications and settings of the cluster where the
backup was taken:

e Number of nodes

¢ Inbound and outbound traffic rules

¢ Virtual memory settings for OpenSearch

¢ Connectivity to external services and resources (for example, AWS EFS, AWS S3)

To restore from a snapshot:

1. Configure servers for a new cluster:

a. After the servers for the cluster are provisioned, install KOTS on one node using the captured
KOTS Installer. You must pass the same flags to the installation script that were passed to the
original cluster.

e Restoring an online cluster — Run the appropriate installation script that was generated from
the captured KOTS installer.

o Restoring an airgap cluster — Download the appropriate KOTS installer bundle, replacing
<ip> with the IP address of the private registry from the original cluster:
cat install_sh | sudo bash -s airgap kurl-registry-ip=<i p>

b. When the installer has finished, run the command displayed on the screen so the other servers
join the cluster. If required, label the nodes dedicated for OpenSearch.

c. Install any add-ons that were manually installed in the cluster. For example, the EFS Driver.

2. Configure the storage destination: From the KOTS CLI, point the cluster to the storage destination
where the Replicated Snapshots were saved.

AWS S3 See configure-aws-s3.
Azure See configure-azure.
GCP See configure-gcp.

S3-Other See configure-other-s3.

NFS See configure-nfs. If the cluster uses EFS or NFS, also see Configuring an NFS Storage Destination.

Note: If using EFS as an NFS server, Server field = DNS name of the EFS and Path field = a directory inside the
EFS, writable by the user:group 1001:1001.

3. Locate the snapshot and restore it: From the KOTS CLI, run a backup Is and full restore.
backup Is

This can take a few minutes. If the snapshots don’t appear, rerun this command.

4. If you changed the host name for Jama Connect:
a. Update the Host Name field in the KOTS Admin Console and deploy the change.
b. From your browser, log in to Jama Connect and change your URL.

5.  View scheduled jobs to verify that the list isn't empty.

6. If the OpenSearch data wasn't included in the snapshot or if the snapshot isn't recent, reindex all
search items.

7. Verify that you can locate your assets.

The new application server for Jama Connect is successfully set up.
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Back up to .jama or XML file

We recommend backing up to a .jama or XML file for migrations and refreshes because this method has
built-in automation. You can avoid manual changes which can impact the integrity of the data.

A .jama file backup includes the database and /data directory. An XML file backup includes only the
database.

Important considerations

o If SAML is enabled, disable it before backing up your data. After you restore your instance of Jama
Connect, you must re-enable SAML.

e Backups must be done manually; they can't be scheduled automatically.

e Make sure you have enough available disk space [604].

e Make sure Jama Connect is in maintenance mode [580] before you create a backup.

e If you are using a version of Jama Connect prior to version 8, generate backups during a maintenance
window and inform users, including API users, not to use the application.

¢ Regardless of what version you are using, all integrations must be disabled.
To back up to a .jama or XML file:

1. Login to Jama Connect as the root user [573].
2. Select the Backup tab to see the backup options.

3. Choose a backup method (listed here in recommended order).

Method Scenario Select...
Save .jama file to the application server. Migrating between versions later than 8.0. Save .jama File to
server

Save XML file to the application server. o Migrating between different types of databases Save XML File to
* Migrating version earlier than 8.0 Server

Download XML database backup to your e If you can't access the application server Download XML

workstation. e For smaller databases

Download document type definition (DTD) If all other methods fail Download DTD

to your workstation.

The backup process is complete.

Restore to a new server from .jama or XML

When you set up a new server, you can install Jama Connect and restore data using the .jama or XML file
backup you created. See Back up to .jama or XML file [601].
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Important

If you use SAML in your environment, it was disabled before you created the .jama or
XML backup. When you install Jama Connect on a new server, it will be running Basic
authentication. You must re-enable SAML to use that authentication method.

To restore a new server from .jama or XML:

1. Login to Jama Connect as the root user [573] on the new server.
2. Install Jama Connect [480]:
a. Inthe header of the KOTS Admin Console, select Application > Config to open the settings
page.
b. Scroll down to the Database Settings section of the page, then select select the database you
are using: MySQL or SQL Server.

c. Under Restore Jama Backup, enter the file path for the backup you created, (for example, /da-
ta/restore/your_backup.xml). Select Check conditions to make sure the path to your backup file

meets the conditions listed onscreen.
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Important
You must have an empty database for the restore process to complete.

For non-.jama file backups: Move existing data folders to the new application server.

Save and restart Jama Connect.

Log in to Jama Connect as the root user [573]

If your new application server has a different URL than the old one, update the base URL to reflect
the change.

7. To sync your indexes with the database, index all items.

ok w

Your new server is set up with Jama Connect and restored data from your backup file.

Backing up MySQL or SQL Server database

If your MySQL or SQL Server database is extremely large, use the native backup method that comes
with your database. Doing so avoids possible data corruption.

Follow instructions for whichever system you are using, MySQL or SQL Server.

Important

If you are migrating from one type of SQL server to another, for example SQL Server to
MySQL, use the .jama or XML file backup [601].

Maintaining your Jama Connect environment
A system administrator is responsible for keeping the system up and running and at peak performance.

Maintaining your environment consists of ongoing tasks that are done regularly and important tasks that
are done infrequently.
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Ongoing/regular tasks Infrequent but important tasks

® Monitor memory usage [604] o Update the license [606]

e Maintaining your Jama Connect database [604] e Update the certificate [607]

e Back up your data [598] e Change [608] or fix URL [609]
o View scheduled jobs [611] e Delete an organization [610]
o Clear cache [612] o Reindex all items [536]

e Remove old Docker images [610] e Upgrade Jama Connect [519]
e Remove unused container images [611]
o View applied patches [612]

e Reset Admin Console password [605]

e Deactivate and reactivate users [605]

Monitoring memory usage

Make sure you have allocated an appropriate amount of memory for your organization's usage. Check
and adjust usage regularly to keep your environment running for best performance.

Several factors affect the amount of memory that Jama Connect requires, including:

e Size of your dataset
e Number of concurrent users
e Users' common workflows

If any of the pods’ memory consumption is close to the maximum available memory, you can adjust those
values. These containers in order require the most memory:

e jamacore
e OpenSearch
e searchservice

Make sure that you don't over-allocate the total memory of the application server. Also, leave approxi-
mately 5 GB of available memory (headroom) for system processes. For help in estimating your applica-
tion server size, use the tables in Resource sizing for your application server [471].

Use one of these methods to monitor usage, then adjust your memory settings [565] as needed.

Log in to Jama Connect as the root user.

Select the License management tab to view usage by license type.

Use the Admin Console monitoring graphs.

Use any Java application monitoring tool that supports JMS.

Use JavaMelody, which comes preconfigured with the Jama Connect application. To access JavaMelo-
dy, log in to Jama Connect as the root user [573] and navigate to [your.jama.url]/javamelody.

Maintaining your Jama Connect database

Follow these recommendations to maintain your Jama Connect database, which includes having a data
backup plan and ensuring the appropriate memory is allocated to the database server.

1. Create a data backup plan — Back up your database server at least daily and implement backup
strategies as needed.

2. Allocate appropriate memory to the database server — Have your Database Administrator monitor
memory usage and allocate memory in advance to prevent running out of memory.

3. Configure system variables and server properties based on usage — For details, see the documenta-
tion for MySQL or SQL Server.

4. Check or analyze databases and tables every 6 months — We recommend that you review or
analyze your databases at least every 6 months, or after you write, change, or delete a substantial
amount of data. Pay extra attention to table or index size because Jama Connect is a write-heavy
application. If a table has grown out of size or the index is too large, it might need to be rebuilt.

Use these resources to determine if an index or table must be rebuilt:
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e Leverage MySQL and SQL Server statistic gathering to detect the need to repair or analyze
databases or tables.

e Run mysglcheck to check, repair, optimize, or analyze tables in MySQL. For details, see mysql-
check — A Table Maintenance Program.

e Use the Maintenance Plan Wizard tool to manage backups, data integrity checks, and statistic
gathering in SQL Server. For details, see Use the Maintenance Plan Wizard.

Deactivate and reactivate users

Users can't be deleted from Jama Connect, but you can deactivate users if they are no longer active
members of the team. When you deactivate a user, their account becomes inactive and their named
license is freed up for another user. You can also reactivate the user as needed.

Important
You must have organization or system administrator permissions to deactivate and

reactivate a user.

To deactivate and reactivate users:

1. Login to Jama Connect as the root user [573].

Select the Users tab.

3. To deactivate a user, select Deactivate in the Action column next to the user you want to deacti-
vate.
The deactivated user disappears from the list.

4. To reactivate a deactivated user:
a. Select View inactive users to view all users, then select Activate in the Action column next to

the user you want to reactivate.

N

b. Inthe User license type window, select a license type and select Save.
The reactivated user now appears in the list.

Reset Admin Console password
You can reset the password for the Admin Console if, for example, the administrator forgot it.

To reset the password for the Admin Console:

1. To remove the current password, run this command on the application server:
replicated auth reset

2. To change your password:
a. From the KOTS Admin Console, select the circle ellipsis icon, then select Change password.
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b. Update the password information, then select Change Password.

The new password takes effect immediately.

Update the license

When you renew your license or change the number of available seats, you must update your license.
You receive a single key for your organization, called a license key, which specifies the type and number
of licenses you have.

b_r Tip
o Schedule a license update during a maintenance window because the process involves
an interruption to the Jama Connect application.

To sync your license:

1. Open the KOTS Admin Console: https://<your hostname>:8800.

2. Inthe KOTS Admin Console, select the Applications tab, select License, then make the following
changes:
¢ Internet installation — Select Sync license.
e Airgap installation — Select Upload license, then select the latest license.
The KOTS Admin Console checks for updates to your license and creates a new version.

3. Select Version history and deploy the new version with your license changes.

4. Log in to Jama Connect, then select License Management to verify that the license updates were
successful.

The license is updated.
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Update the certificate
If a certificate expires, it becomes invalid and must be replaced. The certificate ensures that Jama
Connect trusts the issuer.

To update the certificate:

1. In the header of the KOTS Admin Console, select Application > Config.
2. Scroll down to the Host Name section of the page.

3. Select Custom TLS Configuration to open the TLS Configuration section.
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4. To link Jama Connect to a service protected by a certificate (self-signed or issued by a local authori-
ty):
e Private Key — Select Browse files for Private Key and select your private key.
o Certificate — Select Upload a file and select your self-signed certificate.
5. Scroll down to the Trusted Certificates section, and select Use trusted certificate file to upload
a PEM-formatted public certificate or multiples that are concatenated into a single file. These
certificates are added to the default Java trust store. You might need this functionality to connect to
your MySQL, SQL Server, LDAP, Crowd, IMAP, SMTP, or other internal servers from Jama Connect.
6. Scroll to the bottom of the page and select Save config.

A message confirms that your settings were saved.

Important

Your changes aren't applied until you deploy a new sequence in the Dashboard or
Version history pages of the KOTS Admin Console.

Change URL

The Base URL is the first part of all web addresses that Jama Connect installations use, beginning
with http and ending with a slash (/).
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You might want to change your Base URL if a company changes its name or if you need to create a test

instance.

To change your Base URL:

1. Login to Jama Connect as the root user [573].

2. Select the Organizations tab.

3. Select Change URL from the Action column.

4. Enter the new URL in the New Base URL text box.

5. Select Change URL.

6. Update all URL references [609] in the application to the new value.
If this step isn't completed, the application still contains old URL references, which can result in
unpredictable behavior such as images not being displayed in exports.

7. If you're using SAML authentication, disable and re-enable SAML settings to update the base URL in

our SAML services.

The new URL is updated and active.

Update URL references after changing URL

The option Fix URL References updates all URL references in the application to reflect a new URL. After
you change a URL [608], always run this function.

Important

The Fix URL References option doesn’t modify items in archived projects. It also doesn’t
change the URL used to connect the application server to your database server; that
URL is stored in your database.properties file. The Base URL (baseurl field) is only
updated in the database organization table by the Change URL [608] option.

Use the Fix URL References option if:

¢ You notice images are not being displayed in exports.
e A login prompt appears after URL redirection.
¢ An error message is displayed when you run exports.

To update all URL references in the application:

1.
2.
3.

Log in to Jama Connect as the root user [573].
Select Organizations > Fix URL References.
Select Fix URL References from the Action column.

Enter the new URL in the text box, To this URL.
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5. Select Fix URL References.
6. When prompted, select Yes to finish.

The URL references are updated.

Delete an organization
Deleting an organization is an activity that is done only when more than one organization exists.

Important considerations

e Overall system performance might be affected during the delete process, depending on the size of the
organization to be removed. Schedule the deletion during off-peak hours

¢ Deleting an organization completely removes all data about the organization including projects, set-
tings, and users. Deleted organizations can't be recovered. If you need to preserve the non-production
organizations, contact your account representative.

To delete an organization:

1. Back up your data [601].
Log in to Jama Connect as the root user [573].
3. Enable maintenance mode [580] under the System properties tab.
The option to delete an organization is only available when maintenance mode is enabled.
4. Under the Organizations tab, select the Delete action in the row of the organization to be removed.
5. When prompted, select Yes to confirm you are deleting the organization.

N

The organization no longer appears in the list on the Organizations tab.

Remove old Docker images

Old Docker images from previous versions of Jama Connect use up storage space and might cause
indexing to fail. To avoid this, periodically remove old Docker images from your system to keep it running
smoothly.

You can also remove dangling volumes, which are volumes associated with a container that no longer
exists. Jama Connect creates new containers and volumes when you restart the application. These
volumes can fill up your disk space.

Important

Make sure Jama Connect is running so that you delete only images that are not in

use. The commands in this task clean only images and volumes loaded with the Docker
storage driver in use. Files that were written with other storage drivers remain on the
volume until separate commands are run for that storage driver.

To clean up your volumes:

1. Identify how much space is being used on your server:
sudo docker system df

2. List out all Docker images on your server:
sudo docker images

Images are displayed on the screen, listed by their ID in the IMAGE ID column.
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3. Remove an image by its ID:
sudo docker rmi IMAGE_ID

4. ldentify the dangling volumes:
docker volume Is -qf dangling=true

5. Remove any dangling volumes from the Docker data root directory:
docker volume rm $(docker volume Is -qf dangling=true)

The specified images are removed.

ﬁ:’ Note
When you run these commands to remove an image that is currently in use, an error
is displayed. For self-hosted customers with internet access, any missing images are
downloaded again when you restart Jama Connect. For airgap customers, you must
manually load the images.

Remove unused container images

After upgrading, your system might have unused service images that are no longer needed. Deleting
these unused images can free up disk space and clean up environments.

Important considerations

¢ When you run sudo crictl rmi -prune, all dangling images are deleted from the container runtime
managed by crictl.

e Make sure the upgrade was successful before running the commands to remove unused images.
To remove unused images:

1. Check the current images on the system:
sudo crictl images
2. Delete the unused images:

sudo crictl rmi -prune
The specified images are are removed.

View scheduled jobs

Some jobs can impact performance. When you view scheduled jobs, you can identify which jobs are
currently running, when jobs are scheduled to run, and how much memory they require. Knowing this
information helps you prepare for any performance hit.

To view scheduled jobs and their details:

1. Loginto Jama Connect as the root user [573].

2. Inthe Jama System Administration panel, select Scheduled jobs to view jobs, their group, class, and
firing time.

The scheduled jobs and their details are listed.
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View applied patches

You might need to check which patches have been installed on your application server. For example, you
can see if any patches were missed, or you might need to let support know about your current environ-
ment.

To view applied patches and their details:

1. Login to Jama Connect as the root user [573].

2. Inthe Jama System Administration panel, select Applied Patches to view the unique ID, run date,
and status.

Applied patches and their details are listed.

Clear cache

If you notice latency or slow performance of Jama Connect, you can free up disk space and memory by
clearing the cache.

To clear you cache:

1. Loginto Jama Connect as the root user [573].
2. In the Jama System Administration panel, select Cache statistics.
3. Clear items from the cache:
o All items — Select Clear all cache to clear all cache items from the cache.
e Specific item — Select Clear Cache on a specific cache item to clear it from the cache.

The selected items are cleared from the cache.

Reindex all search items

Search indexes get out of sync with the database due to large batch updates, APl updates, or database
updates. During a full index, all search indexes are rewritten to the current values in the database.

Note

é’ You must have system administrator permissions to complete this task while logged in
as root. While organization admins and project admins can index project items [744],
they can't index all search items.

Important considerations

e Files over 25 MB aren't indexed, so their content isn't searchable.

¢ Filetypes that can be indexed: PDF, DOC, DOCX, PPT, PPTX, TXT, RTF.

e Filetypes that can't be indexed: XLSX, XLS, XML, HTML, HTM.

¢ During the index process, the application automatically enters maintenance mode [580]. Users can’t
log in during this time and users who are already logged in receive a message about the maintenance.

To sync your search indexes:

1. Notify users before initiating an index.
2. Disable all integrations including legacy connectors and the Jama/Tasktop Integration Hub.
DWR, SOAP, and REST API calls are automatically blocked during the reindex.
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w

5.

Note
é’ The system admin doesn't have access to disable integrations. Work with an organ-
ization admin or integrations admin [723] to disable those services.

Log in to Jama Connect as the root user [573].
Select the Index/Search tab and select Index items.

The system displays a count of items in the application and the estimated time to complete the
index.
Select Yes to continue.

You see an alert when indexing is complete and maintenance mode is automatically disabled.

Folder locations

You can use an exported filesystem, such as NFS, for mounting the following directories, provided the
path remains the same.

The following two directories are on the application server:

/data
Stores physical artifacts, like attachments, reports, avatars, diagrams, and metrics. Exported file sys-
tems, like NFS, are supported for use with the /data directory.
/logs
Contains all log files of the Jama Connect components such as the following:
¢ /logs/tomcat
Apache Tomcat log files, logs all activities [243] in the application
¢ /logs/tomcat/contour
Core Jama Connect log files
¢ /logs/OpenSearch
OpenSearch log files
o /logs/search
Search service log files
¢ /logs/nginx
Nginx log files (note that currently only error logging is provided for Nginx)

Note

ﬁ You cannot change the location where log files are written to, however, you can change
the appenders and logging levels for different components of the Jama Connect applica-
tion. The core Jama Connect application log configuration can be updated in:
/data/log4jconfig/log4j -properties

The log configuration for OpenSearch and search service can also be found in

/data/config

Changes to these configuration files persist when you restart Jama Connect and are
applied in a few seconds.
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Important
Replicated snapshots are stored in the following location by default:

/var/lib/replicated/snapshots

However, if you change the path to include /data it will be easier to include these
snapshots in your regular backups of Jama Connect data at /data/directory, as such:

/var/lib/replicated/data/snapshots
Note that /snapshots should have three times the space allocated as the rest of /data.

Upgrading from Jama Connect traditional to KOTS

Jama Connect is a Linux-based application that runs on Docker containers and uses Replicated software
to "orchestrate" deploying applications. The current version of Jama Connect uses Replicated KOTS,
while older versions use traditional Replicated software. The process of upgrading Jama Connect from
traditional to KOTS includes planning, preparing your environment, and installing the software.

Upgrade scenarios

Upgrade with new servers (recommended) — This recommended scenario uses new application and
database servers to support your KOTS Replicated environment. It requires you to:

e Copy targeted data from the existing application server into the new environment.
e Restore a backup of your current database to the new database server.

While this scenario results in the temporary overhead of supporting two separate environments, it
comes with less risk of unwanted downtime.

Upgrade with existing servers — This scenario reuses the current application and database servers from
your traditional Replicated environment. This scenario:

e Requires you to uninstall elements of the traditional Replicated platform before you can install the
KOTS Replicated platform.

¢ Can cause significant maintenance downtime. Make sure to inform your users of this maintenance
window. Also have an emergency plan in place to revert back to the traditional Replicated environment
if necessary.

Before you upgrade

e Contact your Customer Success Manager to request a KOTS internet or airgap license.

e Choose the upgrade scenario that works best for your organization. Whichever scenario you choose,
expect production downtime while the new instance is configured. Best to upgrade during off hours.

¢ Follow the instructions in the planning [782] and preparing [789] sections to ensure a successful
upgrade.

Components and what they do

Replicated KOTS — A container-based platform for easily deploying cloud native applications inside cus-
tomers' environments, providing greater security and control. The KOTS Admin Console is the interface

for installing, configuring, and administering the KOTS deployment of the Jama Connect application and
required services. See https:/www.replicated.com/ for details.

Docker containers — A standalone executable package of software that includes code, runtime, system
tools, system libraries, and settings. See https:/www.docker.com/resources/what-container/ for details.
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Jama Connect KOTS license — Contact your Customer Success Manager to request a KOTS license. Save
the license file to a location you can access easily; you will need it when installing Jama Connect.

For more information about KOTS, see https:/www.replicated.com/blog/announcing-kots/

Note

y Replicated KOTS is the only supported platform for Jama Connect 9.0 and later. To
upgrade Jama Connect traditional to KOTS, see Upgrade from Jama Connect traditional
to KOTS workflow [782].

Troubleshooting

ﬁ:’ Note
This information applies to self-hosted environments only.

You can avoid troubleshooting by following regular maintenance practices [603], but if you run into
problems here are some resources that might help:

For issues with installation, log in to Jama Connect as the root user [573], and select the System Info
tab to see a quick overview of your installation.

View log and profile [616]

Clear cache [612]

View scheduled jobs [611]

Index all items [536]

Remove old Docker images [610]

Reconnect to the Wiris server [618]

Generate a support bundle [512] and contact support@jamasoftware.com

Thread dump

A thread dump is a snapshot of the state of your Jama Connect processes at a point in time.

Jama Support might request a thread dump for troubleshooting performance issues.

Any time you generate a support bundle [512], the bundle includes three thread dumps taken at 5-sec-
ond intervals.

u Tip
o Take multiple thread dumps over an interval of time. A single thread dump on its own
doesn'’t provide complete information about an issue.

You can create a thread dump from the command line or the from the Logging Configuration window.
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Manually (command line) Logging configuration window [616]

Select Logging > Configuration

Jjamacli jamacore-thread-dump

Note
ﬁ You can create thread dumps only for containers that are the core Jama Connect
application.

View and configure logging

Log files record information from the application and can help with troubleshooting. Information is
captured in the contour.log file.

Entries in the log file are noted by the [jama.AccessLog] package and include this information:

Date of request

e Server processing time to handle the request

The user who submitted the request

The organization ID of the user who submitted the request
e The user session ID of the user who made the request

e The server address that the request was made to

Enabling the profiler logging enhances logging in Jama Connect. However, profiler logging might require
additional resources to generate this content. For best performance, use the profiler for troubleshooting
purposes.

The profiler prints out the following information:

User who submitted the call

Organization the user belongs to

Java thread ID of the call

Stack trace of the call that includes processing time and memory usage of each trace

To view the log and configure logging:

1. Login to Jama Connect as the root user [573].

2. Select Logging > Log Viewer to view the log. As needed, select Refresh at the top right to refresh
the log.

3. Select Logging > Configuration.
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#g_r Tip
. By default all logging levels are set to Info and reset to that default when the
application is restarted.

To permanently change the logging level and appenders, edit the file:

/data/config/log4j .properties

The log configuration for OpenSearch and search service can also be found in:

/data/config

You cannot change the location to where log files are written. Changes to these
configuration files are applied within a few seconds and are persisted across re-
starts the application.

4. To change the logging level from the default setting of Info, select Edit.

5. To log additional content for every log entry in the contour.log file, scroll to Profiling at the bottom
of the page and select Enable profiler.
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Profiling is indicated in the log file as the [jama.Profiler] package.

Here is a sample log entry:

2011-04-28 09:37:19,865 INFO [org.directwebremoting. impl_DefaultRemoter] -
Exec: projectSvc.getExtTreeNodeForProject()

2011-04-28 09:37:19,869 INFO [jama.-Profiler] - user:admin org:2 thread:96
start:2011-04-28 09:37:19,866

[3ms] [+88K/-88K 837755K/254041K]-

com. jamasoftware.Jama.dwr.impl .DwrProjectServicelmpl .getExtTreeNodeForProject
[3ms] [+88K/-88K 837755K/254041K]-

com. jamasoftware.contour.service.impl.ProjectServicelmpl .getExtTreeNodeForProjec
t

[2ms] [+88K/-88K 837755K/254041K]-

com. jamasoftware.contour._service. impl _DocumentTypeServicelmpl _getAvailableDocume
ntTypesForProject

6. To capture information for all user requests and all locked-out users in Jama Connect, select Access
log, then select Enable access logging.
Information is captured in the contour.log file. Here is a sample log entry:

2014-08-29 16:24:59,370 INFO http-bio-8080-exec-17 [jama.AccesslLog] - [3 ms]
PRBDIJN9 1 - 083BBES5B1E8C481033DA7AFBBEF023A5 160 http://localhost:8080/contour/

7. To capture a one-time dump of the current running java threads being executed, select Dump
threads information under Thread dump.

Information is captured in contour-threaddump.log.

If Jama Connect seems to hang, run a thread dump and send the log file to support@jamasoft-
ware.com.

Use the captured information for troubleshooting, for example to identify long running processes.

Reconnect to the Wiris server (self-hosted only)

If your connection to the Wiris server is interrupted, you can fix the issue by modifying the Wiris
settings, restarting your system, then returning the settings to their original values.

To reconnect to the Wiris server:

1. Modify the Wiris settings:
a. Inthe Admin Console, select Settings > WIRIS Connection Settings.
b. Select Use custom Wiris connection.
c. Make the following changes:
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o Wiris Host — Add “xx” to the end of the string
o Wiris Path — Add “xx” to the end of the string
e Wiris Port - Change to 44311
2. Select Save and restart your system.
3. Test the connection. Use Jama Connect in a field that calls the Wiris MathType Editor:
a. InJama Connect, select Projects, and choose the item you want to modify.
b. From the Add drop-down menu, select New item > Text.
c. Inthe Add item window, select the Math Editor icon.
d. Add an equation using the equation editor. As expected, this action fails.
4. Inthe KOTS Admin Console, reset the modified Wiris setting to the original values.
Select Save and restart your system.
6. Test the connection. Use Jama Connect in a field that calls the Wiris MathType Editor:
a. InJama Connect, select the item you want to modify.
b. From the Add drop-down menu, select New item > Text.
c. Inthe Add item window, select the Math Editor icon.
d. Add an equation using the equation editor.

v

This action now succeeds.

Organization administrator

The organization admin controls all aspects of configuring Jama Connect, including its users [646],
groups, content [620], collaborations [707], and integrations [723]. It is a role that can be assigned to
an individual or a group.

Most organization admin tasks are accessed under ADMIN in the top-level navigation.

When you edit configurations on the organization admin pages, many changes require you to sign out
before they take effect. By default, Jama Connect creates a group called Organization Admin and assigns
it all Administration and Access permissions across the organization.

Monitoring changes with the Admin Activity stream
The Admin Activity stream provides an audit trail of updates made by organization and project admins.

To open the Activity stream panel, select ADMIN, then select the Activity stream button on the right
side of the panel.

Search for activities by entering the search term, like the name of a pick list or the user who performed
the action.
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Managing content
There are many areas of the application that require organization admin permissions to set up and
maintain content for the broader group of users.

Some common tasks for managing content on an admin level include:

e Change Global ID [620]

e Configure baselines status for pick lists [622]
¢ Unlock items locked by another user [624]

e Configuring reuse and synchronization [627]

Change Global ID

A Global ID is a unique identifier of items that are connected through synchronization. While every item
has its own unique ID [731], two items that are synchronized can share a Global ID.

You can change or add a prefix, as well as an optional item type key, in front of the Global ID assigned to
items.

O Organization Admins Only

You need organization admin permissions for this task.

To change the Global ID:

1. Select ADMIN > Details > Edit.
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2. Select whether to allow multiple items with the same Global ID in a single project,
¢ Yes — One item can be synchronized with other items in the same project.
* No — (Default) Items can only be synchronized to items in other projects.

3. To change the prefix for your Global ID, select Edit next to Global ID prefix.

621



Administration

4. Inthe window that opens, enter a new value for the prefix and select the options you need.
¢ Change only future prefixes — Change the Global ID Prefix and select Update. No current IDs are
affected. Future IDs include the new prefix.
e Change ALL prefixes (past and future) — Select Apply prefix to existing items, then select
Update. All existing prefixes are changed if they match the old prefix, and new IDs contain the
new prefix. If the past Global IDs didn't have a prefix, the new prefix is appended to those IDs.

Old Prefix |OId ID New Prefix New ID

us US-REQ-1023 |NZ NZ-REQ-1023
us EU-REQ-1023 |[NZ EU-REQ-1023
No prefix  |REQ-1023 NZ NZ-REQ-1023
MNo prefix  [U5-1023 NZ NZ-US-1023
us US-REQ-1023 |No prefix REQ-1023

us Us-1023 Mo prefix 1023

us 1023 Mo prefix 1023

¢ Include item type in the global ID — Enter a new prefix value and select Include Item Type Key,
then select Update .
5. To change the value for the Global ID next counter, select Edit next to Global ID next counter.

6. Set the counter that assigns Global IDs, then select Update. If you set the counter to a value
that's being used, the counter uses the next available ID as its starting point when the next item is
assigned.

Your changes appear on the Organization Details page.

Configure baselines status for pick lists
Once you create a baseline-specific pick list, you can enable the baseline status to select that pick list.
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O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e The baselines status pick list can't be edited after you configure it.
¢ From ADMIN > Pick lists, you can edit the pick list that's in use but you can't delete it.
¢ You can disable the pick list when you no longer need it.

To enable and configure the baselines status:

1. Create a dedicated pick list that is used only for baselines.
2. Select ADMIN > Organization > Details, then select Enable next to the Baselines status option.

3. In the Configure baselines status window that opens, select Enable baselines status pick list, then
choose the baseline pick list you created.
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4. Select Save.

Once the pick list is enabled, users can apply this option when editing a baseline. The pick list values
appear in the Baselines List View and View details headers.

Unlock items locked by another user

Organization and project admins can unlock items that were locked by another user. However, project
admins can only batch unlock items from List View or Single Item View.

O Organization Admins Only

You need organization admin permissions for this task.

To unlock items locked by an organization admin:

1. Select the link with your name in the header to open the My Profile window. This button is disabled
if you selected ADMIN in the header.

2. Select the My locked items tab and select Show All Locked Items.
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3. Locate and select the item in the list you want to unlock. then select Unlock.

To unlock items locked by a project or organization admin:
From List View

1. Select the item you want to unlock, then select Batch edit.
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2. In the Batch update window, select Locked Status > Unlock all items, then select Next.
3. (Optional) Add a comment and notify users.
4. Select Commit.

From Single Item View

e Select the item you want to unlock, then select the Unlock item icon.

Note
ﬁ If you are an organization or project admin, you can also access the system-locked items
tab to unlock system-locked items [626].

Unlock system-locked items

Anyone can view the list of system-locked items, regardless of permissions. However, only an organiza-
tion or project admin can unlock items that are system-locked.

e Organization admins can unlock all system-locked items.

¢ Project admins can unlock only system-locked items where they have admin permissions to those
items.

To unlock system-locked items:

1. Select your name in the header to open the My Profile window.
2. Select the System Locked Items tab to see all items that were automatically locked [236] (blue lock).
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3. Select the items you want to unlock, then select the Unlock icon in the top right corner of the
window.

The previously system-locked items are now available.

Configuring reuse and synchronization
You must have write permissions [667] to modify items through synchronization. Items with a user
lock [624] or system lock [626] can't be modified through synchronization.

O Organization Admins Only

You need organization admin permissions for this task.

As an organization admin you can:

e Grant permissions to a reuse admin [667]
e Configure global ID [620]

¢ Sync or remove Compare Views [370]

e Enable synchronization of widgets [691]

View a system health report
The system health report is an optional feature that notifies you of areas in the application that can
affect performance and user experience.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

¢ The system health report can be emailed weekly to designated users.
e Some of the reported issues that can affect Jama Connect include projects that are too large, reports
that contain too many items, and syncing too many items at a time.
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Best Practice

- For best system and Jama Connect performance, limit your reviews to a maximum of
250 items.

To view a system health report:

1. Select ADMIN > Organization, then select System health report.
2. Select Add or change recipients to specify who receives the report

3. Enter the email addresses, then select Apply.

4. Inthe Reports section, to set a threshold for each of the areas (Projects, Reviews, Reports, and Test
Plans), select edit the threshold.

5. Enter a value between 1 and 600, then select Apply.

The report is sent to the recipients you specified.

Plugins

Plugins provide tools that help speed up the process for setting up Jama Connect.
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O Organization Admins Only

You need organization admin permissions for this task.

You can install two plugins:

e Relationship Import Plugin [629]
e User Import Plugin [635]

Relationship Import Plugin

The Relationship Import plugin helps you batch create relationships between existing items in Jama
Connect using a comma separated file as input.

The process of using the Relationship Import Plugin consists of these actions. Your role determines the
actions you can take.

Preparing your CSV file [132] (admin or user)

Gathering information for the Relationship Import Plugin [630] (admin only)
Configuring the Relationship Import Plugin [632] (admin only)

Importing relationships from Excel [133] (admin or user)

HPoObdpR

Important considerations

e The Relationship Import Plugin must be configured and enabled by an organization admin.

e When importing relationships, the applied Relationship Type is determined by the default type selec-
ted by the admin [642].

e The Relationship Import Plugin entry is required for each pairing of upstream and downstream item
types. For example, to use the plugin to import Market Requirement to System Requirements relation-
ships and System Requirements to Verifications, you must configure two plugin entries, one for each
upstream/downstream item type pairing.

¢ To import requirements before creating relationships, see Importing content into Jama Connect [106].

Preparing your CSV file
The Relationship Import Plugin uses a CSV file with UTF-8 encoding as input.

When working with the CSV file in Excel, the worksheet must contain only two columns:

e Column A — Unique information about upstream items such as item ID
e Column B — Unique information about downstream items
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Important considerations

e Data can be written only in Columns A and B.

e The worksheet must not have any merged cells.

e Every row must have an upstream/downstream pair.

¢ Import relationships in small batches. Create each worksheet with fewer than 500 relationships.

e Although you don't need to use IDs generated by Jama Connect, the data in the CSV file must already
be in Jama Connect and unique to each item.
For example, if you are importing existing requirements from a spreadsheet, use a custom field in Jama
Connect (such as a text field named “Legacy ID") to store the existing IDs. You can then refer to this
Legacy ID field for the relationship import and use the values from the spreadsheet to build your CSV
file.

If you use an existing Trace Matrix from Excel to create your CSV file of relationships, you might need to

reformat the spreadsheet. Be sure data is only in Columns A and B and there are no merged cells: every
row must have an upstream/downstream pair.

(Admin only) Go to the next action: Gathering information for the Relationship Import Plugin [630].

Gathering information for the Relationship Import Plugin
Before you configure the Relationship Import Plugin entry, you must first collect specific information
from Jama Connect.

Here's the information you must collect:

e |[tem Type API-IDs
e Unique Field Names
e Project API-IDs (if the items you are relating to are in two projects)

Note
ﬁ You must have organization or process admin permissions to collect this information.

Item Type API-IDs — Sets the parentType (upstream) and childType (downstream) parameters in your
plugin.

e Select Admin > Organization > Item types to locate the API-ID for the upstream item and downstream
item.
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Unique Field Names — Sets the parentField (upstream) and childField (downstream) parameters in your
plugin.

For both the upstream and downstream item types, navigate to their Field listings and locate the Unique

Field Name value. Make a note of the Unique Field Name for the field that contains the information in
the CSV file.

Project API-IDs — Sets the parentProjectld (upstream) and childProjectld parameters in your plugin
when items to be related by the plugin are in different projects.

¢ Select Admin > Project and select each project. Make a note of the API-ID value in the project’s
Details tab.
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Go to the next action: Configure the Relationship Import Plugin [632]

Configure the Relationship Import Plugin

The Relationship Import Plugin helps you batch create relationships between existing items in Jama
Connect.

The plugin can be configured to import relationships between items in the same project or across two
projects. The plugin uses different classes and parameters, depending on whether your items are in one
project or two.

Note
y You must have organization or process admin permissions to complete this task.

To configure the Relationship Import Plugin:

1. Select ADMIN > Organization, then select Plugins > Add plugin entry.

2. Inthe window that opens, enter the following information.
This screenshot shows an example of a plugin entry configured for a single-project import.
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This screenshot shows an example of a plugin entry configured for a cross-project import. The
cross-project import configuration utilizes a different package name and includes two additional
required parameters.

Edit plugin entry
Mame: Cross Project Relationship Import Test
Enabled:
Class: com jamasoftware.contour. plugin jama.ImportRelationshipsCrossProject
Type: Import v
Parameters: parentType=23;

childType=27;

parentField=documentkey;
childField=documentkey:
parentProjectid=132;
childProjectld=36;

Plugin Notes:

Save Cancel

e Name — Enter a name visible to users. For example, Market = System Requirement Relationship
Plugin.

e Enabled — Make the plugin available for use.

e Class — Enter the appropriate class from below. Determine the class based on if your importing
for items in a single project or across two projects.
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e Foritems in a single project, enter:
com. jamasoftware.contour.plugin. jama. ImportRelationships
e For items in two projects, enter:
com. Jamasoftware.contour._plugin.jama. ImportRelationshipsCrossProject
e Type — Select Import.

e Parameters — Use the information you collected in Gathering information for the Relationship
Import Plugin [630]. Replace the bracketed text with the appropriate value. The Parameters field
is case-sensitive and requires a semicolon at the end of each line. Make sure there is no additional
space at the end of each line.

parentType=[API1-ID of upstream ltem Type];
childType=[API-1D of downstream ltem Type];
parentField=[Unique Field Name from upstream ltem Type];
childField=[Unique Field Name from downstream ltem Type];

If importing relationships for items contained in two projects, copy this section into the Parame-
ters field below the parameters list and replace the bracketed text with the appropriate value:

parentProjectld=[API-1D of project containing upstream items];
childProjectld=[API-ID of project containing downstream items];

¢ Plugin notes — Add any details that are useful when viewing the plugin in the Admin area.
3.  When the information is complete, select Save.

The Relationship Import Plugin is now configured and available for use.
Go to the next action: Import relationships from Excel [634]

Import relationships from Excel
To import relationships to Jama Connect, use the CSV file you prepared.

Important considerations

The Relationship Import Plugin must be configured [632] and enabled by your admin.
A CSV file must include correct parent and child field values and must have the .csv extension.
Import relationships in small batches. Create each worksheet with fewer than 500 relationships.

Check that your parameters are written correctly and reference the right API ID or field. For more
information, see Configure Import Relationships Plugin [632].

To import relationships from Excel:

1. From the Project drop-down menu, select Import > Custom Import.

2. In the window that opens, enter the following information:

e Select a destination — This is a required field. Your selection doesn't affect the outcome, so select
any set of items in the project.

o Select custom importer — Select the plugin entry you previously created.
¢ Field delimiter — Comma.
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¢ Optional Encoding — UTF8.
o Select file to import — Choose the CSV file you created for this plugin.

3. Select Import.

The Activity Stream and Trace View display the relationships that you created in Jama Connect.

Configure the User Import Plugin
With the User Import Plugin, you can add multiple users at once by importing a spreadsheet. Imports
don't delete users from Jama Connect.

O Organization Admins Only

You need organization admin permissions for this task.

If the import fails it might be because:

e A user that already exists was set to add (rather than update).
¢ A user that doesn't exist was set to update (rather than add).
e One or more of the records is incorrect.

¢ A required field was missing.

To configure the plugin:

1. Select ADMIN > Organization, then select Plugins > Add plugin entry.
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In the Add plugin entry window that opens, enter the following information and select Save.

Add plugin entry
Mame:

Enabled:

Class:

Type: w

‘Event

Parameters:
Impaort

Plugin Motes:

Save Cancel

e Name — User Import
e Enabled —Make the plugin available to users
e Class (case-sensitive) — Enter the name of the object defined in the source code:
com. jamasoftware.contour.plugin.jama.UserImportPlugin
e Type — Event or Import
e Parameters — Leave this field blank
¢ Plugin Notes — Add any notes you have here. This isn't visible to the end user.
Create a CSV document with no header row that contains the following values in columns A through
K:
e Username — If LDAP or CROWD is enabled, the username must match what is listed in the
directory.
First name
Last name
Email
Password
Title
Location
Phone number
License type — Values must be one of the following:

Value Meaning

N Named creator
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Value Meaning

C Float creator

FC Float collaborator
Stakeholder

R Reserved collaborator

Float reviewer

RV Reserved reviewer
NV Named reviewer
TR Test runner

e Add/Update — Values must be one of the following:

Value Meaning

Add Add as a new user

Update Update an existing user

e Company
e Groups — If a user belongs to multiple groups you can add them in columns L and up.
For example:

4. Select Project > Import > Custom import.

5. In the Custom Import window that opens, enter the following information:
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e Select a destination — This is a required field. Your selection doesn't affect the outcome.
e Select Custom Importer — User Import

¢ Field Delimiter — Comma

e Optional Encoding — UTF8

e Select file to import — Choose the CSV file you created in step 3, that contains the list of users to
be imported.

6. Select Import.

Each user that's added with the user import plugin receives a welcome email with the Jama Connect
URL.

Upload custom reports and exports
You can upload reports [458] and exports [378] so that other users can access them.

O Organization Admins Only
You need organization admin permissions for this task.

Important considerations

e If uploading a Velocity or Office Template export that uses preselected (context-sensitive) data in the
main project view, the exports appear under Exports > View all export options.

¢ [f uploading Velocity reports that pull data at a project or cross-project level, the exports appear under
Reports in the Jama Connect header. For more information, read about Jama Connect and Velocity
here.

e Report criteria is unique to each report.
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. ﬁ Tip
o Before uploading a report or export, check with the person who created it for the
best settings to use.

e For templates with Microsoft Word or HTML formats, you can also export to PDF. For Velocity and
HTML templates, PDF export results might vary.

e For Office Templates, any user with a creator license can add a custom export [390], which appears
under Export > View all export options.

To upload custom reports or exports:

1. To add or edit a Velocity or Office template report, select ADMIN > Reports.

2. Select Add report in the top right corner.

3. Inthe Add/Edit Report window that opens, define the report. Available options depend on the type
of report you choose.

Report Name — Enter a name so that others can identify the custom report or export template.
Report Type — Select Velocity or MS Office Template.

Report Formats — Select HTML, PDF, Microsoft Word, or Microsoft Excel.

Excel Format — Select XLS format (legacy) or XLSX format.
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e Data Access — Select Limit data availability or Allow all data to be reported on regardless of user
permission.

e Restrict to Group — Select whether and how to limit access (by user permissions or user group) to
run custom reports.

e Report File Name — Select Browse and select the report or export template to upload. Velocity
reports have file extension .vm.

e Description — Enter an optional description to define the output.

e Scope — Define whether the report or export template is available to all users (Organization) or
only to users in a particular project (Project). Default for Jama Connect reports is System.

e Organization — Select the organization from the drop-down menu.

¢ Visible to Users — Select Visible to Users if you want other users to see the report.

e Context Sensitive — Select Context Sensitive if you have an export that uses preselected (con-
text-sensitive) data in the main project view.
This export appears in the window that opens when users select Exports > View all export
options.

¢ Class name and path — Enter the class name and path for custom plug-ins for Velocity reports.
Otherwise, leave blank.

4. In the Criteria section, select + to add report criteria.

a. From the Select Parameter Type drop-down menu, select the type of data you want to include.

Release — Select the project release parameters as needed.

e Location — Select a location for each parameter.

Baseline Parameter — Select one baseline for each baseline parameter.

String Parameter — Enter the string parameter.

Date Parameter — Enter the date.

Boolean — Select True or False. The value is sent to the reporting engine.

Test Plan — Select a test plan from the list of test plans in the selected project. Jama Connect

passes the database ID to the report.

Review — Select a review from the list of reviews in the selected project. Jama Connect

passes the ID to the report.

b. Under Display, enter the label you want users to see when publishing and exporting the report
from Jama Connect.

c. Under Name, enter a unique case-sensitive name that is passed to the report or export tem-
plate.
When you publish a report or export Jama Connect content, these parameters are displayed in
alphabetical order by the name field, not in the order shown in the report setup screen.

Important
If you change the Name criteria, you must also change the reference to the criteria
in your report or export template. Otherwise, the report or export template fails.

5. Select Save to upload the report or export template and save your changes.

The report or export is saved and appears in the Reports table.
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Managing relationships
As an organization admin, you can use several tasks to manage relationships.

Edit relationship widget [691] in an item type

Set the relationship types [642]

Configure the Import Relationships Plugin [632]

Set up relationship rules [644] at an organizational level

Configure relationships

Before setting up relationships (traceability) between your artifacts, you need to set up the types and
options available to users.

O Organization Admins Only

You need organization admin permissions for this task.

To configure relationships:

1. Select ADMIN > Organization, then select Relationships > Edit.

2. To change the relationship options from No to Yes, select each option:
e Show Status in Relationship Grid?
e Show Note in Relationship Grid?
¢ Allow relationship changes between two locked items?
The Note and Status columns are added to the table in the bottom panel. The Note and Status fields
are only editable when the relationship type is set to Show Note and Show Status.
3. Configure relationship types:
a. Inthe Relationships widget of an item, select a relationship to edit its type, direction, status, and
note.
b. Use the toolbar at the top of this panel to edit, add, or delete types.
c. Include a description to specify how and when this type is used.
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4. Set up relationship rules [644].

The relationship types and options are now available to users.

Set relationship types

One part of the initial traceability setup is configuring the available relationship types.

O Organization Admins Only

You need organization admin permissions for this task.

To set relationship types:

1. Select ADMIN > Organization, then select Relationships.

2. Under Relationship Types, use the icons to add, edit (pencil), delete (X) or reorder (arrows) relation-
ship types.

3.  When adding a new relationship type, enter a display name and description. The description is only
visible in this edit window.
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(Optional) Select Show Note and Show Status to allow users who create a new relationship using
this relationship type to enter a note and a status for that relationship.
Status and notes are visible any time you reopen the Add/edit relationship window.

Status and notes are also visible in the bottom panel of Single Item View when Relationships is
selected.

In an impact analysis [319], you can filter by status or note.
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5. If you delete a relationship type, choose a replacement type for affected relationships.
Delete Relationship Type

Relationships with this type will be replaced. Please choose a replacement value.

Replacement Relationship | Related to hd
Type:

Delete Cancel

The configured relationship types are now available to users.

Set up relationship rules

Relationship rules help maintain the project structure by preventing problems with relationships [309].
The rules help users know when relationships are required and in which directions.

O Organization Admins Only
You need organization admin permissions for this task.

When relationship rules are set up, the Relationship Status Indicator [310] alerts users when their rela-
tionships don't match the relationship rules.

Rule sets are created at the organization level, and can then be applied to one or more projects.

To set up relationship rules:
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Decide with your team which relationships to include, the relationship types, and whether
the rules are exclusive and included in coverage calculations for the project.
Select ADMIN > Organization > Relationships and scroll down to the section labeled Traceability

Information Model Configuration to see any previously created rule sets.

3. Scroll to the bottom and select Add rule set.
a. Select New Rule Set and edit the name to describe your set.

b. Add a rule by selecting the item type for Upstream, Downstream, and Relationship type from
the drop-down menus. Select For coverage if you want this relationship included for coverage.

ﬁ" Note
Configure the same rule set across projects that share relationships. If you
relate items across projects with different rule sets, the source project's rule

set is applied.

c. Select Save.
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As the rule is saved, it is added to the diagram, indicating the relationship.
d. (Optional) Select Add another relationship to include another relationship for this rule set.
As rules are created, the diagram is updated to show the relationships. Solid lines between

items indicate a coverage (required) relationship. Dashed lines indicate relationships that aren't
for coverage.

Note
y Once you set relationship rules for a project, you can also view the relationship
rules diagram in Single Item View or on the dashboard [765].

4. To delete arule, select the X at the end of the rule's row. To delete an entire rule set, select the X at
the top right of the rule set. After editing or deleting a rule, the rule set diagram is updated with any
changes made.

5. Select Add project to apply the rule set to one or more projects. If a rule set is applied to a project
with existing items, nothing changes in that project, even if the existing relationships break the
new rules. Only future relationships are required to conform with the rule set.

Important

A project can have only one rule set. If a rule set has already been applied to a
project and you try to apply another, the application removes the first rule set from
the project and applies the second one.

6. (Optional) Select Allow any item type not mentioned in this rule set... to allow users to create rela-
tionships outside the rule set you applied to the project.

Rules are between item types. If you don't define a rule for a particular item type, that item type can
have a relationship with anything (or nothing if the user chooses), even if the rule set is exclusive.

Managing users and groups
Organization admins and user admins can can set up user access for your organization.

Add user groups [647]

Add users [649] and assign them to one or more groups

Edit user details [655]

Edit user and group subscriptions [655]

Reset user password [656]

e Open projects and assign users and groups access rights [748]
You can also assign this task to a project administrator.
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User groups

User groups are an efficient way to manage notifications, permissions, access, and actions for multiple
users at a time.

A user can be assigned to multiple groups.
Groups allow you to efficiently accomplish many tasks:

e Grant access permissions [667]

e Grant role permissions [670]

e |nitiate a review [163]

e Subscribe users to items [231]

o Notify users of changes [230]

o Send workflow notifications [736]

e Grant access to projects workflow [696]
e Add signer roles to reviews [260]

Types of groups

Jama Connect includes two types of groups:

¢ Organization group — These groups have no project context and are available to all projects in the
organization when adding permissions.

¢ Project group — These groups are created in the context of a project and are available to that specific
project when adding permissions.

Jama Connect comes with several predefined organization groups and project groups. For example, the
group Organization Admin is a default group that has organization and project rights.

Group names

You can create and name groups based on users' roles, permissions, or position. For example, you can
name groups by:

¢ Internal structure — Job title, work group
e Access permission — Read only, read/write
¢ Roles — Reuse admin, review admin, project admin

Note
y If you use signer roles [260] for electronic signatures [258], signer roles for electronic
signatures, the group name is used as the signer role.

Actions for each admin type
The type of admin you are determines your ability to manage groups:

Organization admin — Add, delete, and edit user groups available to all projects.
System admin — Add groups.

Project admin — Add groups at a project level.

User admin — Manage members of a group where you are also a member.

Add a user group

With user groups, you can efficiently manage notifications, permissions, access, and actions for multiple
users at a time. A user can be assigned to multiple groups.
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Important

If this is a new installation of Jama Connect, create user groups before adding individual
users.

Important considerations

¢ Organization admins and system admins can add user groups that are available to all projects.

¢ Only organization admins can delete user groups or make changes to an existing group's members,
details, or subscriptions.

¢ Project admins can add groups at a project level [745].
e User admins can manage members of a group only where they are also a member. This restriction
ensures they don't unintentionally provide or remove access to unknown or existing projects

To add a user group:

1. Select ADMIN > Organization > User groups, then select Add group.

6:’ Note

A user's membership in project groups determines which groups are available for
signer roles.

2. Inthe Add group window that opens, enter a name and description for the group, and select
members from the left column. Large lists are searchable.
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Selected users appear in the right column.
3. Select Save.

The new group appears in the list of user groups. Now, a review moderator can edit a review and give a
user a signer role [260].

Add a user

When you add one user to Jama Connect, you define the username and license type, assign the user to
groups, and optionally generate an email with the account information.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e If you install and configure the user import plugin [635], you can add multiple users at the same time.
e If this is a new installation of Jama Connect, add user groups [647] before adding users.

To add a single user:

1. Select ADMIN > Organization, then select Users to display a list of active users.
If you don't see the user you're looking for, select View inactive users.
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5.

If LDAP is enabled [589], you can select Add user from LDAP and search for an existing LDAP user
in the search box. Jama Connect searches LDAP against the configured "Login Name Attribute" and
the "User Name Attribute."

':I Tip
o You can add wildcards to a search, but if you add them at the beginning of a search
term, they can result in slow performance. For large directories, expect the search
to take several minutes.

From the toolbar, select Add user.

In the Add user window that opens, fill in the required fields.

e Username — Enter a unique name, as in an email address (recommended).

¢ License type — Consider the number of licenses purchased [656] and the expected usage [659]
by the user when assigning license types.

o User groups — Select the appropriate groups for this user.

¢ Send user welcome email — (Optional) Send an email to the user with username and URL link to
authenticate, allowing them to change their password.

Select Save.

The new user appears in the list of users and, if configured, receives a welcome email with username and
Jama Connect URL.

Configure the User Import Plugin
With the User Import Plugin, you can add multiple users at once by importing a spreadsheet. Imports
don't delete users from Jama Connect.
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O Organization Admins Only

You need organization admin permissions for this task.

If the import fails it might be because:

A user that already exists was set to add (rather than update).
A user that doesn't exist was set to update (rather than add).
One or more of the records is incorrect.

A required field was missing.

To configure the plugin:

1. Select ADMIN > Organization, then select Plugins > Add plugin entry.

2. Inthe Add plugin entry window that opens, enter the following information and select Save.

Add plugin entry
Mame:

Enabled:

Class:

Type: w

‘Event
Parameters: :

Impart

Plugin Motes:

Save Cancel

e Name — User Import
e Enabled —Make the plugin available to users
e Class (case-sensitive) — Enter the name of the object defined in the source code:

com. jamasoftware.contour.plugin. jama.User ImportPlugin

e Type — Event or Import
e Parameters — Leave this field blank
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¢ Plugin Notes — Add any notes you have here. This isn't visible to the end user.
3. Create a CSV document with no header row that contains the following values in columns A through
K:
e Username — If LDAP or CROWD is enabled, the username must match what is listed in the
directory.
First name
Last name
Email
Password
Title
Location
Phone number
License type — Values must be one of the following:

Value Meaning

N Named creator

C Float creator

FC Float collaborator
Stakeholder

R Reserved collaborator

Float reviewer

RV Reserved reviewer
NV Named reviewer
TR Test runner

e Add/Update — Values must be one of the following:

Value Meaning

Add Add as a new user

Update Update an existing user
e Company
e Groups — If a user belongs to multiple groups you can add them in columns L and up.
For example:

4. Select Project > Import > Custom import.

5. In the Custom Import window that opens, enter the following information:

652



Administration

¢ Select a destination — This is a required field. Your selection doesn't affect the outcome.
e Select Custom Importer — User Import
¢ Field Delimiter — Comma
e Optional Encoding — UTF8
e Select file to import — Choose the CSV file you created in step 3, that contains the list of users to
be imported.
6. Select Import.

Each user that's added with the user import plugin receives a welcome email with the Jama Connect
URL.

Add users to multi-mode authentication

Multi-mode authentication allows you to add a new Basic user, so you can differentiate between IdP and
Basic users.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e Authentication methods must match to use electronic signatures in baselines and reviews. An organi-
zation admin can change authentication methods.

e Users can't use the same email between the two different authentication types.
To add users to multi-mode authentication:

1. Select ADMIN > Organization, then select Users to display a list of active users.
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2. Select Add user.

3. Inthe Add user window that opens, select the authentication type you want for this user:
¢ Basic authentication — Select Use basic authentication for this user.
¢ IdP authentication — Deselect Use basic authentication for this user.

[_] Use basic authentication for this user

[T] Send user welcome email

*Username: | | *Email address:
*First name: Title:
*Last name: Phone number:
Location:
“License type: (") Creator

(") Creator (float)
() Stakeholder
() Test runner

() Reviewer
4. Select Save.

Jama Connect runs a check to see which authentication method was used. Initially, the Authentication
Type for the user you added is blank. When the user logs in for the first time, the column is populated
with Basic or IdP.

You can also verify the Authentication Type from ADMIN > Organization > Users.
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Edit user details

Depending on your organization's type of authentication, you can edit basic details for Jama Connect
users.

O Organization And User Admins Only

You need organization or user admin permissions for this task.

To edit user details:

1. Select ADMIN > Organization, then select Users to display a list of active users. If you can't find
them, select View Inactive Users.

2. Select Edit in the Action column of the user you want to edit.

3. In the Edit User window that opens, make changes to the user's details as needed.
4. Select Save.

Your changes are saved.

Edit user and group subscriptions

Users and groups can subscribe to and control their own email notifications. However, if a subscription
was added by someone other than the user, only an admin can change that subscription.

Organization admins can unsubscribe a user; project admins can only mute a user's subscriptions.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.
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To edit a user's or group's subscriptions:

1. Select ADMIN > Organization, then select Users.
To edit a group subscription, select ADMIN > Organization > User groups.
2. Select Subscriptions in a user/group row to open the Edit subscriptions window.

3. Select a user/group from the left column to display their current subscriptions in the right column.
e To remove a single subscription, select Unsubscribe in the Action column.s
¢ To remove multiple subscriptions for a user, select the subscriptions in the Notifications column,
then select Unsubscribe selected in the top right corner.

Your changes are saved.

Reset user password

If your organizations is using Jama Connect with basic authentication, you can update users' passwords
as needed.

O Organization And User Admins Only

You need organization or user admin permissions for this task.

Note
y You must have system, organization, or user admin permissions to complete this task.

To reset a user password:

1. Select ADMIN > Organization, then select Users to view a list of users. If you can't find the user you
want, select View Inactive Users.

2. Select Password in the Action column for the user needing a new password.

3. In the Edit password window that opens, enter and confirm a password that meets the default
authentication requirements.

Your changes are saved. Inform the user of the change.

License types and permissions

Organization admins and user admins assign license types to users. They can also view the current
license [664] assigned to users, as well as assign users license types [655].

The type of license limits the possible permissions and roles that can be granted to a user. License types
include creator, stakeholder, test runner, and reviewer.
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Regardless of the assigned license type, each user has a unique login consisting of username and
password.

Creator and reviewer licenses can be named licenses or float licenses; test runner licenses and stakehold-
er licenses are named only.

Types of licenses

License type Definition Named li- Float license
cense

Creator Gives full read and edit rights and full access to reviews to active users X X
who daily manage items and projects.

Test runner Gives basic permissions to read and review, as well as the ability to X
create test plans and defects, to execute test runs, and to add attach-
ments to test runs during execution.

Stakeholder Gives read-only privileges to those who need visibility into a project, X
but don't need editing rights. Stakeholders can view items, provide
comments, and act as reviewers.

Reviewer Grants permission to participate in reviews, act as approver or review X X
admin, and to respond to comments in the stream. Reviewers can't
initiate reviews or access items in the core project.

Temporary Grants non-licensed users with temporary 30-day access, so they can X X
trial Jama Connect. This license is available only when a user is invited
via email to a review or to comment in the stream. The only default
permissions are for the discussion thread or review to which they were

invited.
Collaborator A legacy license; gives read-only privileges to users needing visibility X X
(Legacy) into a project, but not editing rights. They can view items, provide

comments, participate in (but not create) reviews, execute test runs,
and log defects.

Permissions by license type

The type of license assigned to you defines your permissions, which in turn determine your ability to
create and edit items and to access items as read-only.

With a creator license and read-only permissions to a project, you can:

e Execute test runs
e Log defects from the test run execution window

Permissions Creator Stakeholder Collaborator (lega- Test Runner Reviewer
cy)

Read/Write
Create test plans X X
Execute test runs X X X
Log defects (from test run window) X X X
Manage attachments X xX*
Manage relationships X X*
Add baselines X
Edit, delete, restore user-created baselines X
Add and edit items X X*
REST API access X
Read-only
Share filters X
Share custom report templates X
View baselines X X X X
Create filters X X X X
Export reports X X X X
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Permissions Creator Stakeholder Collaborator (lega- Test Runner Reviewer
cy)
Read and initiate stream threads X X X X
Comment on items X X X X
View items in projects X X X X
View dashboards X X X X
Review
Initiate X
Moderate X X
Participate X X X X X
Approve X X X X X
Electronically sign X X X X X
Reply to stream comments X X X X X

* The Test Runner user has permissions for these actions, but only for the item types where they have
access.

Configure Jama Connect for test runner license

Users with a test runner license can edit and manage attachments and relationships only for test-related
items such as test plans, test cycles, test groups, test runs, and item types used as defects [401]. They
can't manage attachments or relationships for any other item types in the project, nor can they edit items
outside the test-related items listed here.

O Organization And User Admins Only

You need organization or user admin permissions for this task.

To configure Jama Connect for a test runner license:

1. Configure item types to be used as a defect [693].
2. Assign access permissions [667].

Batch update license types

Occasionally, you might want to update many users at once. For example, several users might be
assigned a temporary license that's about to expire and you need to assign creator licenses.

If you select more users than the available number the selected license type, that license type isn't
available when batch updating.

O Organization And User Admins Only

You need organization or user admin permissions for this task.

To batch update license types:

1. Select ADMIN > Organization, then select Users.
2. To sort the users by license type, select the field name header at the top of the user grid.
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3. Select the users you want to update. Use Shift to select multiple users.
4. Select Batch Update User(s).

5. In the window that opens, select the license type, then select Commit.
The license type is changed for the selected users.

Monitor license usage
Access to license details, like expiration dates and usage threshold, helps prevent disruptions and allows
for proactive planning.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e We display warning indicators in the statistics cards to notify users when specific metrics require
attention or are nearing the threshold set by the user. These warnings are intended to highlight key
data trends and do not signify system errors.

¢ You can view results from today to the last 365 days, including the number of licenses being used on
a daily basis, the number of days where you reached your maximum threshold, and if any users were
downgraded in license type or denied access due to a lack of license availability.

¢ When you export the license usage details, two key metrics are captured: user inactivity and license
inactivity. How a user's connection ends affects how these metrics are recorded:

Manual logout — If a user logs out manually, both the user inactivity timeout and the corresponding
license inactivity timeout are recorded based on their actual active duration.

User inactivity timeout — If a session ends due to user inactivity, the user inactivity timeout duration
is recorded up to the point of timeout. However, the associated license inactivity timeout remains
active until the license timeout is reached and is not counted in the actual duration.

To monitor license usage:

1. Select ADMIN > Organization, then select Licenses.
The center panel displays the daily usage by license type for a particular time period, as well as
current usage details.
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2. Inthe License usage section, use the drop-down menus to adjust the settings for license type and
time period. By default, the Apply button is disabled until changes are made.
a. From the license type drop-down menu, select the license type.

b. From the time period drop-down menu, select the duration.

c. Select Apply to save your changes.
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The graph and statistics cards automatically update to reflect the settings you selected.

3. Select one of the chart lines to see an hourly breakdown of user sessions throughout that day. From
the hourly view, select a specific hour of the day to see a minute-by-minute breakdown.

Note

J The states of the statistics cards vary based on the user's selected license type,
time frame, and configurable threshold settings. Multiple visual states indicate
warnings and highlight key statistics related to the account or the currently selec-

ted licenses.

Daily

Hourly
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Minute-by-minute

4. To adjust the threshold, select Threshold settings (gear icon).

Important

The threshold setting is designed to set a percentage of licenses in use, triggering a
notification to customers once the threshold is reached. This setting affects these
statistics cards: Average daily license usage, Peak license usage, and Days over li-
cense threshold.

Based on calculations for each statistic, all statistic cards might display minor and
major warning states: a red exclamation indicates a major warning, while a yellow
exclamation signifies a minor warning. The warnings are intended to highlight im-
portant statistics. Depending on your selections, the label "Non-applicable" might
appear on one or more cards.

a. Use the calculated statistics on this page, then make your changes.

b. (Optional) Select Notify me when this threshold is met and enter an email address to send
notifications when usage surpasses the specified threshold.

c. Select Save.
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5. Adjust the user inactivity timeout setting: From the User inactivity timeout drop-down menu, select
the duration you want.
This setting adjusts the time frame that a user can remain inactive in Jama Connect.

Note
i The User inactivity timeout menu setting doesn't change or affect the License
inactivity timeout setting. These two settings are independent of each other.

The setting you selected is automatically saved.

6. To download your license data usage to Excel, select Export, select the destination for the exported
file, then select OK.

7. To print your license data usage, select Print, select the destination, then select Save.

Scroll down to view all your licensing details, including license type, expiration date, number of licen-
ses owned, and any integrations purchased by your organization. For more information, see View
license [664].
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Licensing details

Customer license Jason
contact:

Client Jama
organization:
Product name: Jama

Product edition: Enterprise

License type
Creator

Creator (float)
Collaborator
Stakeholders
Test runners
Reviewers
Reviewers (float)

WIRIS equation editor

View license details

View your license details, such as the types of licenses and expiration date.

License type: Nan-Production

License creation 07/22/2020
date:

License expiration 12/31/2050
date:

Maintenance 12/31/2050
expiration date:

Owned
Unlimited
Unlimited

1]
Unlimited
Unlimited
Unlimited

0

Unlimited

O Organization Admins Only

You need organization admin permissions for this task.

To view license details:

Modules:« Review Center
« WIRIS Equations
Editor
= Hazard and Risk
Analysis

Assigned Available

33

5

0 Unlimited

e To view your current license information, select ADMIN > Organization, then select Licenses.
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The table provides details about the license, such as user license activity, license type, and license
expiration date. Counts are also provided by specific user license type.

A CSV export is available for analyzing license usage trends within Excel. The exported data represents a
UTC time zone.

For organizations with floating licenses, information about floating license usage is available above the
table (more information is available here [659]).

Organize and manage project folders

The Add Project permission allows organization and project admins to create project folders and project
subfolders. Admins can edit project folders and move projects between the folders where they have
project admin access.

For information about the Add Project permission, see Grant permissions [667].

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e Folders can represent a part of your organization, such as a project team or product line.

¢ Folders can be used to organize logical groupings of projects, such as projects used as templates or
libraries.

¢ Projects can be organized by dragging them from one project folder to another.

¢ Permissions are inherited. If you give a user group read-only permissions to your entire organization,
they have read-only permissions to every project in Jama Connect, regardless of where the folder in
the project lives.
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Common scenarios

¢ If you need to control access for a group of users to a specific folder of projects, you can grant
permissions to the user group on the folder of projects only and those permissions are inherited for all
the projects in the folder.

¢ |f you have a group like "All Users" that you've given read-only access at the organization level, that
read-only permission is inherited by all projects in the organization, regardless of what folder they're
in.

e If you increase a group’s access to a project folder, that increased access applies to all projects within
that folder.

To organize and manage folders:

1. Add a project folder:
a. Select ADMIN > Project, then select Add > Add Folder.

b. Enter the name of the folder, complete the fields as needed, then select Save.

2. Add a subfolder: From the Explorer Tree, select the folder you want to add as a subfolder, then drag
it to the project folder.

3. Move a project to a folder: From the Explorer Tree, select the project you want to move, then drag it
to the project folder.

4. Edit a project folder:
a. From the Explorer Tree, select the project folder you want to edit.
b. Select Edit.
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c. Update the fields as needed, then select Save & done.

Your changes are saved.

Grant permissions

Permissions control how users experience Jama Connect. They allow users to access, modify, and delete

items or to perform other specific tasks. They also restrict actions that users can perform or content that
users can see.
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O Organization And User Admins Only

You need organization or user admin permissions for this task.

Important considerations

Project admins [748] grant only project-level permissions. Project admins can access users outside
of their project to give access when the option Allow project administrators access to all users and
organization groups is enabled.

System admins can grant limited permissions.

Before assigning permissions, consider setting up groups [647] to make this task more efficient.
Permissions are inherited from higher levels in the organization structure. For example, if you assign
a group access at the organization level, all projects, components, and sets within the organization
inherit the permissions.

When a group or user's Inherited column contains the value "true" and is highlighted in green, that
user or group has received its permissions from a higher level.

Certain permissions are allowed with each license type [656]. You might need to assign the correct
license type [655] to change permissions. Also, be aware of how permissions work with related
items [310].

If a user is part of multiple user groups with conflicting permissions, the user is granted the highest
permissions that are set.

While items within sets fall under the permission rules of the set, attachments to those items don't.
Attachments can still be accessed by outside users who have access permission to the project
while adding attachments [96] or inserting rich text links [101].

To grant permissions:

1.

Select ADMIN > Organization, then select Permissions.

In Project Selector on the left, select the level where you want to access permissions: organization,
an individual project, or container.

o Organization (System)

¢ Individual project

e Container

The main page displays the current permissions.
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':I Tip
o Permissions set at the organizational level are passed on to lower levels, but might
be overridden for individual projects, components, or sets. For simplicity, set per-
missions at the highest acceptable level.

Organization admins can also grant project permissions in the configure project
window [748].

w

To edit current user or group permissions, select Modify or Override.

To add a new user or group, select Add permissions in the top right corner of the window.

5. In the Assign permissions window that opens, select the groups or users you want to add.

You can also add a new group or user by selecting Add user or Add group in the top right corner of

the window, then select the role or access permissions [749] you want to add from the bottom of
the window.

»

6” Note
Roles [670] and access permissions can be granted at an organizational level.
Project administrator permissions can be granted at a project level. Access permis-
sions can be granted at a container level and greater.

6. Select Save.

7. To completely remove access to a project, component, or set, select Remove at the level that access
was granted by unselecting all permissions.
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Important

Remove functions differently at lower levels in the hierarchy. If the user's or group's
permissions were previously overridden at that level, the Inherited column reads
"false," and selecting Remove reverts the permissions to the original inherited
permissions. If the user's or group's permissions weren't previously overridden,

the Inherited column reads "false," and selecting Remove completely removes the
group or user from a project or set. If the group or user's permissions are inherited,
the Inherited column reads "true" and permissions can only be removed at the
higher level where they were assigned.

Your permission settings are saved.

Roles

A role is a set of permissions that allows a user to perform specific functions. Each permission type
defines the functions it allows.

An admin grants permissions by role [752] to an individual or to a group.

Note
i Permission roles are different from other types of roles such as review roles [159] and
Signer roles [260].

Types of roles

Role Definition

System admin [554] Handles installation, setup, and configuration of Jama Connect, and has no access to projects.
System admin is a special user that isn't a role for other users. It doesn't require a license and logs

(self-hosted only) in to the system with the username "root."

Organization admin [619] Controls all aspects of configuring Jama Connect, its users, and its groups.

User admin [646] Manages licenses, users, and groups; can see all users and organization groups in the system.

Process admin [671] Configures content and connections within Jama Connect; controls item types, pick lists, relation-
ship rules, Review Center, and workflow; delegates these responsibilities to appropriate users and
groups.

Project admin [725] Focuses on permissions, project groups, and workflow customization.

Add Project Allows a user to create a new project or duplicate an existing project where that user is project
admin.

Review admin [192] Has access to a review's content when the review is public. A review admin is also a reviewer,
approver, or moderator in the review. Permissions must be assigned by an organization admin.

Reuse admin [355] Manages reuse. Requires read access to the synchronized items they are working with, and write
permissions to edit, synchronize, reuse, or duplicate those items.

Report admin [638] Allows the report developer to upload and manage BIRT, Velocity, and Word templates. Reports
are assigned to specific projects where the report admin has project management rights.

(self-hosted only)

User admin limitations

e Can set permissions only for groups/users on projects where they are project admin.

¢ Can manage organization group membership only for groups where they are a member.

¢ Can't make changes or additions to users or groups that have been assigned to organization or process
admins except for activation/deactivation and license management.
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e Can manage only members of a group where they are also a member. This restriction ensures they
don't unintentionally provide or remove access to unknown or existing projects.

Important

Users must have the license type [656] that allows for the permissions granted with
each role.

Deactivate and reactivate users

Users can't be deleted from Jama Connect but they can be deactivated. When you deactivate a user, the
user becomes inactive and frees up named assigned licenses associated with that user.

O Organization And User Admins Only

You need organization or user admin permissions for this task.

To deactivate and reactivate a user:

1. Select ADMIN > Organization, then select Users.
2. Inthe Action column for the user you want to deactivate, select Deactivate.

Deactivated users disappear from the list until you select View inactive users.

3. To reactivate a user, select Activate, then select a license type in the User license type window and
select Save.

Your changes are saved.

Managing process

Jama Connect can be configured to align your processes and artifacts to suit your unique organization
needs. You can control fields, picklists, relationships, templates, and workflow.

These settings tend to evolve over time as teams mature and new groups are brought into Jama Connect.
The admin role delegates these responsibilities to the appropriate users and groups.

Item types [687]

Fields [672]

Set up editor templates [697]
Configure views [697]
Manage relationships [699]
Manage tests [707]
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Fields

A field holds a basic unit of data in an item type.

Fields contain values. In List View, each column represents a different field. Individual users can configure
which fields they see. For more information, see Configure Compare View for synchronized items [374]
and Configure fields [31].

An organization admin can add new fields to an item type [674] and configure the behavior for those
fields.

Jama Connect includes these types of fields:

Field type Description Created by...

Predefined fields Fields that are indexed and can be searched without using the Organization admin
database field name.

Custom fields Fields that are similar to predefined fields, or can be multi-se- Organization admin
lect fields, URL fields, calculated, rollup, and item of type fields.

System fields Fields that are necessary for system functionality and can't be Automatically generated
removed from an item. For example, Name, test steps [405],
test case status [408], and review status [763].

. u Tip
o Predefined fields are similar to custom fields. If you plan on doing a lot of reporting with
your data, predefined fields simplify the document type's underlying schema and make
it easier to use those fields in reporting.

Predefined fields
An organization admin can add predefined fields [672]. They are indexed and can be searched without
using the database field name.

If you frequently use reporting with your data, predefined fields simplify the document type's underlying
schema and make is easier to use those fields in reporting.

When adding fields [674], you must select the database location where the lookup value is stored from
predefined fields. This selection doesn't affect users. However, custom report writers must know the
mapping of the fields to the database.

These are the predefined fields you can choose:

Type Details

Text Rich text can be enabled in text fields.

Dates Each field (datel through date5) limits the user entry to a valid date and provides a pop-up calendar
picker.

Integer The fields originalEstimate, remainingEstimate, and timeSpent allow only whole number positive numer-
als.

Flag Flag fields are displayed as checkboxes. By default, all flags are marked as No (false).

String Includes the predefined fields Short Name, ID, and string1 through string15.

Pick list In the Add field window, fields such as status, priority, and lookup 1-10 prompt you for a has been
pick list. If that option isn’t available, you select a non-pick list type from the drop-down list. Once a
predefined field is used for a pick list, it's no longer available in the list. If additional fields are needed,
use custom fields.
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Type Details

Release Each pick list is populated by the list of releases created within each project. Some item types are
configured with a release field by default. If the release field is removed from the item type, it becomes
available in the predefined field list.

User Item types with a user field include a pop-up list of users. Only one user can be selected from the list.

Custom fields

Organization admins can add custom fields that are unique to their organization. Custom fields can be
similar to predefined fields, or they can be multi-select, URL, calculated, rollup, and item of type fields.

To find a field, search using the field name because they aren't indexed.
You can add a custom field [674] of these types:

¢ Item of Type — Create a new pick list field that is populated by a list of existing items in the current
project that are the specified item type. In this manner, users can reference items of another type.
Only one item can be selected in an Item of Type pick list.

¢ Flag — Flag fields are displayed as checkboxes to those working with the item type. By default, all flags
are labeled No (false).

¢ Integer — Allows only whole number positive numerals.

e Release — Each pick list is populated by the list of releases created within each project. Some item
types are configured with a release field by default. If the release field is removed from the item type,
it's available in the predefined field list.

e Pick List — A set of specific values that can be entered in a field.

¢ Float — Use float fields to accurately capture numeric values. The float field follows IEEE 754. These
fields can be positive or negative.

e Multi-select pick list — Allows the user to select multiple values in a pick list.

e URL — Similar to a regular text box, a URL field performs some minor validation of text entered in the
field to check that it's a URL and displays the text as a link when submitted.

¢ Text field — Holds plain text strings with no line breaks. If line breaks are required, use the Text box
field.

¢ Text box — Holds more data than a typical Text field in plain text or rich text, Can include line breaks
and have a template applied to it.

e Rollup — Shows progress on downstream items without having to open each downstream item. You
can opt to open a filter with any downstream items included in the rollup calculation. Progress on the
downstream item is tracked by a pick list (often a Status pick list).

Indicate the downstream item type, the pick list field on that downstream item type, and the pick list
value that shows that progress is complete.

¢ Calculated field — Allows admins to configure automated calculations using addition, multiplication,
average, Weighted Shortest Job First (Scaled Agile prioritization model), and simple logic (2D lookup
matrix). You can add calculated field results to the List View and use them for sorting and filtering.

Note

y American or British-style decimals must be used in the fields where the calculations
are derived. Otherwise, errors occur. If a calculation is based on a related item, the
calculated field isn't update until the item containing the calculated field is edited.

You must select the following options:

e Calculation type — Average, Multiply, Sum, Weighted Shortest Job First, or Lookup matrix.
e Calculation source — This item or Related item(s).

e Related item type

e Relationship direction — Upstream or Downstream.
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¢ Fields upon which to base the calculation — Displays pick list, multi-select, integer, other calculated
fields from the same item, number of upstream or downstream relationships, and number of com-
ments fields.

o Pick list field — Value used in the calculation.

o Multi-select field — Value used is the sum of the value of each selected item.

e Calculated field — Result is used in the calculation. Once a calculated field is chosen as an input
for a calculated field, it can't be used as an input in additional calculated fields.

o Number of decimals to display — Up to 4.

o Whether to require all values to be present before the calculation is performed — If you don't
select this option, the calculation is performed each time a value is entered into one of the selected
fields.

e Copy destination (inherited field) — Copies a value from one item to a corresponding field in a related
item. This option is available only for supported custom fields and can't be used with predefined fields.
e Supported custom fields — Date, Flag, Float, Integer, Text box, Text field, and URL.

o Unsupported custom fields — Calculation, Rollup, Picklist, Multi-select, Item of Type, Release, and
User.

Similar to calculation and rollup fields, the inherited value won't create a version or activity when

updated. However, the value remains filterable and searchable.

If multiple relationships exist, the field inherits the value from the most recently related item.

Important
Once a field is added, you can't enable the inheritance option afterward.

The inherited value can be updated later if the relationship changes — previously set
values are updated automatically.

Add, edit, or delete fields
When editing an item type [687], you can add, change, or delete fields.

é’ Note
You must have organization admin permissions to complete this task.

Important considerations

¢ When you toggle a field between rich text and text, the text doesn't retroactively change data that
was previously entered in that field. Each type is saved in a different format (HTML vs plain text). A
large scale data translation isn’t supported — data might have accumulated over years and with poten-
tially millions of records, so the update might break compliance rules, version history, integrations, or
review comments.
¢ Things to know before you delete a field:
¢ Once a field is deleted from an item, all values related to that field are deleted from the database
and can’t be recovered. The field and its existing values are deleted from this item type across
projects, reviews, baselines, and versions. Affected items are re-indexed, which can take a while.
This action can'’t be undone.
o [f the field was used to relate synced items, such as JIRA KEY, proxy, a duplicate item is created if
you try to create the sync again.
o If the field is mapped in an integration, it is no longer updated and might cause errors in your
integration tool.
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o [f a filter used the field, update the filter before removing the field to avoid inaccurate filter results.

o |f the deleted field raised suspect links, relationships are affected. Because the field no longer exists,
users can't see the changes that created the suspect link.

¢ |f you try to restore a previous version of an item that still contains the deleted field, the field's con-
tents aren't restored. Even if you recreate the field before the version rollback, data isn't restored.

o [f you still want to delete a custom field, consider exporting a copy of the field values via a report or
the APL.

To add, edit, or delete a field:

1. Select ADMIN > Organization > Item types.
A list of existing fields is displayed with information about each field.
2. Select a row to highlight it in blue, then select an action icon in the top toolbar.

Action icons include:
¢ Pencil — Edit a field
¢ Green arrows — Re-order fields
e Red X — Delete a field
¢ Green Add field — Open the Add field window
3. If you selected Add or Edit, select Predefined Fields or Custom Fields, then use the drop-down list
to select a field type.
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Both field types can be used in the same item type. (This section does not appear when editing
fields).

Important

You can only use the system predefined Release field to show items in the Releases
tab. If you use a custom Release field to designate an item to a release, that item
doesn't appear in the Releases tab.

Complete these options to define or edit the field type:

Field label — The field name that users see. The application automatically uses this value as the
unique field name in the database, which can't be changed. Avoid leading with an underscore;
some unique field names might conflict with OpenSearch fields (such as _source or _ID) and
prevent proper functioning.

Infotip — (Optional) Visible to users when they hover over this field label.

Unique Field Name — The name of the field in the database, which the application uses automati-
cally.

Read Only — Prevents users from editing the field.

Allow API overwrite — Fields that are configured to be read-only have the option to be editable
via the REST API. System fields like modifiedDate or rollup don't allow the option to overwrite.
Is Required — Required fields are string, text or date fields that are configured so that the user
must enter data into the field before saving an item.

Use to Trigger Suspect — Suspect links [317] is triggered when specific fields update in an item.
This option lets you determine which field changes flag an item as suspect.
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¢ Synchronize — When items are synchronized to other items, a change in a field with this checkbox
flags this item as out of sync in the synced items window and in Single Item View [761].
e Text Components — (Custom Fields > Text Box only) Choose whether you want rich-text capabili-
ties.
¢ Pick list, Multi-select, Calculated fields — If a field requires lookup or a pick list for input, add the
pick list or lookup matrix.
5. Select Save.

By default, new fields are added to the bottom of the item type fields list, but you can reorder using the
green arrows.

Enable test case item

If testers need more formatting options when they edit their test cases, specifically for steps, a WYSI-
WYG editor that is similar to the one used in most item Description fields is available.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e When you disable rich text, no data is lost, but images and rich text are replaced with HTML tags.
Users don’t see any existing steps break and the content is still rendered. The user must decide which
formatting tags to remove.

e The application doesn’t automatically strip tags, and renders correct HTML tags in steps with or
without the rich text mode enabled.

¢ To hide the test case status from view, see Hide test case status field [678].

To enable test case item:

1. Select ADMIN > Organization, then select Item types.
2. Select the item type you want to use, which is a Test Case [401] type.
3. Inthe right panel, select the Steps field, then select the Edit pencil icon.

4. In the Edit field window that opens, select Allow Rich Text to enable the feature.
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Edit fleld
Field label: Steps
Use to Trigger Suspect:
Synchronize:
Allow Rich Text:
Save Cancel

5. Select Save.
The test case item and the rich text feature are enabled.

Hide test case status field
Test case status is a system-managed field that can't be deleted, however it can be hidden from view.

O Organization Admins Only

You need organization admin permissions for this task.

To hide the status field for a test case:

1. Select ADMIN > Organization, then select Item types.
2. Select the item type that you want to use, which is a Test Case [401] type.
3. Inthe right panel, select the Test Case Status field, then select the Edit pencil icon.

4. In the Edit field window that opens, select Hide test case status to enable the feature.
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Edit field

Field label: Test Case Status

Use to Trigger Suspect:

Status settings

Hide test case status:

Save Cancel

5. Select Save.
The test case status field for the item type you selected is now hidden from view.

Pick lists

Pick lists are a set of specific values that you can enter into a field. This feature ensures that all users
enter field content correctly. Pick lists are also useful when you create lookup matrices and calculated
fields.

Each pick list must be assigned a name. An optional description defines how the pick list is used.

Each option in a pick list can be assigned the following:

e Order — The arrangement of options in a field drop-down menu list.

¢ Display — The words users see when they select pick list options.

¢ Infotip — (Optional) Custom text that provides context for that value and is visible when a user hovers
over this field label.

¢ Description — Explanation of an option's meaning. For example, a display of High might be described
as "over 5000 items," "625-750 degrees," or "at least 72 miles."

¢ Pick list type — Standard type pick lists can be used for pick list, multi-select, calculated, or status
fields. Only Lookup matrix type pick lists can be used to configure lookup matrices.

¢ Value — The addition of a numerical value or weight to each option, which is useful in creating
calculated fields.

e Color — A means to visually distinguish pick list options at a glance, visible in different views across
the application. For example the test case status [408] field colors are green (passing), red (failing), and
orange (blocked).
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e Default status — The status value that appears by default. A pick list can have only one default status.

Manage pick list values
A pick list can have multiple values, which can be organized, color-coded, and set as a default.

A value can include an optional infotip, which is custom text that provides additional context for that
value.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

¢ Changing a pick list value — Might affect other fields if the value is included in a calculated field.

¢ Archiving a pick list value — Removes the option from a selectable option, but preserves the historical
selection of the value. Archived pick lists can't be unarchived.

e Deleting a pick list value — Removes the selected value from all items in the system. Each item is
versioned and updated with the replacement value. Previous versions retain the deleted value. The
deleted value is no longer available for filtering. Each pick list must retain at least one value and that
value can't be deleted. Deleting a value from a lookup matrix type pick list might require updating any
dependent lookup matrices.

¢ Selecting a pick list type — Use the default or standard pick list types unless the pick list is intended
for configuring a lookup matrix.

To manage pick list values:

1. Select ADMIN > Organization > Pick lists, then select the pick list row you want to modify.

2. In the table, select the item row you want to modify, then select the icon for one of the following
actions.

e Plus icon (add item) — Enter the name and optional characteristics like infotip, description, value,
and color.
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¢ Pencil icon (edit item) — Make your changes.

e Box icon (archive item) — If you archive an item, the value's row is removed from view. This action

can't be undone and is only visible on versions of items before it was archived.
¢ Xicon (remove item) — Select a replacement value, then select Delete.
The value is saved to items in the system where the deleted value is selected.
3. Select Save.

The table is updated to reflect your changes.

Add a lookup matrix
A lookup matrix serves as a source for logic-based calculations in lookup matrix type calculated fields.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

¢ To add a logic-based calculated field to an item, you must first add the lookup matrix and give it a
name. Adding an optional description defines how the lookup matrix is used in calculated fields.

¢ To configure a lookup matrix, you must select a pick list for the matrix columns, rows, and results.
To add a lookup matrix:

1. Create pick lists [679] for the calculation inputs (matrix rows and matrix columns) and the calcula-
tion results (matrix values):
a. Select Lookup matrix as the pick list type.

b. (Optional) To change the table color from default gray, select a row in the Pick list values table,
select Edit value, and select a color.
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2. Select ADMIN > Organization > Lookup matrices.

3. Select Add lookup matrix.

682



Administration

4. Enter a name and optional description for the lookup matrix.
5. Configure the lookup matrix settings:
a. Under Matrix Configurations, use the drop-down selectors to configure the matrix columns,
rows, and values/result.
b. Select Generate matrix, then select matrix values for each matrix cell according to the logic-
based calculation outcomes you need.
For example, when the P-total field has a value of High and the Severity field has a value of
Low, the calculated field for Risk Score returns the result Tolerable in orange.

6. Select Save & done.

Select from an existing item type or add a new item type, then select Add field.

8. Confirm that the calculation input fields were added to the item: make sure the pick lists match the
configuration pick lists used for the calculation lookup matrix source you want.

9. Inthe Add field window that opens, select Lookup matrix as the calculation type.
Select from an existing lookup matrix as the calculation source, then select from available fields as
calculation inputs.

N
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10. Select Save.

The lookup matrix is now available for use in logic-based calculations.

Configure organization details
Early in the setup process, configure the details for your organization, including organization name and
description, base URL, how subscriptions are handled, and more.

O Organization Admins Only

You need organization admin permissions for this task.

To configure details for your organization:
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1.

Select ADMIN > Organization, then select Details.

Select Edit, then configure these details for your company:

¢ Organization name — The name of your company or team. Each instance of Jama Connect can
have only one organization. The organization name is also used for reports.

o Description — An explanation and additional information about your company.

e Return email — A return address for email notifications. Typically the organization admin's email
address is used or noreply@example.com.

¢ Base URL — When email notifications include links to items, the link is created from the base
URL for your Jama Connect installation. For example, http://localhost:8080/contour. Attachments
(images etc) depend on this setting being accurate.

¢ Rich text image max width (px) — Maximum pixel width setting that shrinks all images embedded
into rich text fields. Default is O, no maximum width is applied.

¢ Rich text image max height (px) — Maximum pixel height setting that shrinks all images embedded
into rich text fields. Default is O, no maximum height is applied.

Important

Images retain their ratio when adjusted to fit the maximum setting for height
or width. The adjustment only happens during an upload or document import.
Images that already exist on the server aren't adjusted. Compression occurs
based on the width and height settings.

o Allow users to subscribe others — Users can subscribe other users to items.

o Allow users to mute subscriptions — Users can turn off a subscription that another user subscri-
bed them to.

¢ Allow item/container deletion by non-Org Admin users — Users who have create/edit permis-
sions can delete items. When disabled, only organization admins can delete items.

¢ Allow project administrators access to all users and organization groups — Project admins can
see all projects' users and groups. When disabled, project admins can see only their own project's
groups and users.

¢ Include unexecuted test runs in status calculations (not retroactive) — (Default) Jama Connect
includes all associated test runs to automatically calculate test case status. When deselected,
unexecuted test runs are not included unless there are no executed test runs.
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Note

é’ For test cases associated with a single plan, test case status reflects the status
of the test run with the most recent activity, which includes unexecuted tests
if this option is enabled. When the case is associated with multiple plans, the
most urgent status is chosen, in this priority order: unexecuted, failed, blocked,
scheduled, passed.

Deselect this box to remove unexecuted test runs from that priority order.

¢ Allow multiple items with the same global ID in a single project

¢ Allow deletion of fields and data from item types — By default, this setting is disabled. The
purpose of this setting is to prevent users from accidentally deleting fields in item types without
verifying whether the deletion could impact data used in baselines.

¢ Allow "Quick Add" and "Inline Insert" — By default, this setting is enabled. To disable it and
prevent the "Quick Add" and "Inline Insert" options from appearing, deselect the checkbox.

e REST API and MCP Managed Access is enabled — By default, this setting is disabled, and all users
with a Named Creator License can access the REST APl or MCP. When enabled, only the specified
users and group members have access.

¢ Java Date Time Format — Formats include month/day/year (default), year/month/day, and day/
month/year.

e Change global ID [620] — Change or add a prefix or an optional item type key in front of the
global ID assigned to items.

¢ Configure the baselines status for pick lists — After you create a baseline-specific pick list, you
can enable the baseline status to select the pick list. The baselines status pick list can't be edited
after you configure it.

Once you create a baseline-specific pick list, you can enable the baseline status to be able to
select the pick list. The baselines status pick list can’t be edited after you configure [622] it.

e MathType and ChemType editor format — When the equation format is changed, existing equa-
tions keep their current format until they are edited.

Best Practice
- For the best results, use PNG format with a quality setting of 300 dpi.
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3. Select Save.

A message confirms your configuration details were saved.

Item types

Item types are the templates for sets used within each project.

While sets are unique to each project, item types can be used in projects [727] across the entire
organization. Item types can't be customized for individual projects.

Each item type can be configured [687] to best fit your organization and methodology.

Additionally, every item type is automatically assigned an API ID for reporting purposes, which can't be
specified or changed.

Best Practice
- The fewer item types that your organization creates, the easier it is to manage items.

Add and edit item types

You can create a new item type, add or delete fields [674] in an existing item type, or change the item
type details. Once an item type is created, users can add it to their project.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

e Changes to an item type affect that item type in all projects. Item types can't be customized for
individual projects.

e Jama Connect comes with a core set of item types that can't be deleted. When you select ADMIN >
Organization > Item types, core item types don't include a Delete option.

¢ You can see a list of core item type fields in Admin > Organization > Iltem Types > Core > Views >
Projects List View - Mixed Item Types. Custom fields can't be selected for visibility in mixed item type
views.
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Projects List View with Mixed ltem Types - Mixed item types

I Projects List View with Mixed ltem Types Iv

Drag and drop to hide/show and re-order fields

Hidden fields Visible fields
Heading ltem Type

APLID Locked
Description IO

Last Locked By Mame

Last Locked Connected Users
Release # of Comments
Assigned To Relationship Status
Created By

Created Date

Modified By

Modified Date

Project

Global 1D

Last Activity Date
# of Upstream Relationships

Save Close

e Before a new item type can be used in a project, it must be added to that project by a project or
organization admin.

O Best Practice
- As much as is possible, standardize your use of Jama Connect and limit the team-by-
team configuration of item types. Fewer item types means easier management of the
configuration, reporting by item types across projects, and standardization across the
organization. When a new configuration need arises, look at how existing item types
can be used across teams. However, it is also important not to over-configure a single
item type with fields that might not be used by all teams.

To add or edit an item type:

1. Select ADMIN > Organization, then select Item types.
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2. Add (Add item type) or edit an existing item type (Edit next to the item type you want to modify).

3. Inthe Add item type window that opens, select or modify the following options:
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Display — (Required) Name for a single item of this item type.

Display plural — (Required) Name for multiple items of this item type.

Description — Explanation for how this item type is used or how it is distinguished from other
item types.

Type key — (Required) The default ID Prefix that is shown when creating a set using the item type.
It can be overwritten.

Use as — Option if you are using this item type for special use for test [401]. (If you're using the
REST API to create an item type, it refers to this as a Category).

Widgets — Small embedded applications that add functionality to item types. Read more about
widgets [774] or how to enable or disable them [691].

Image — (Required) The icon displayed for this item types. Icons are used as the set icon, the list
view icon, and the icon at the upper-left of the item view.

Library icon and Custom icon — (Required) The icon for the item type you're editing. Icons are
used for set (container), List View, and in the upper left corner in Single ltem View.

Admins can use default icons or upload their own custom 16x16 pixel icon. Custom icons can't be
reused and must be uploaded for each item type.

Note
y A custom icon must be deleted by an admin to revert to a library icon.
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e APIID — A reference ID that is automatically assigned to an item type for API reporting purposes.
You can see this ID by selecting ADMIN> Item types, but it cannot be specified or changed.

4. Select Save.

Your changes are saved and any new item types are now available to users.

Important

You can delete an item type but you are prompted to delete any existing items of that
type before you delete it. To delete, choose the item type you want to remove and
select Delete.

Enable or disable item widgets
Widgets are small embedded applications that add functionality to item types.

O Organization Admins Only

You need organization admin permissions for this task.

Available widgets include:

e Activities [243]
Attachments [96]
Change request [269]
Relationships [309]
Synchronized items [363]
Tags [92]

Versions [264]

To enable or disable widgets:

1. Select ADMIN > Organization, then select Item types.

2. Select Edit in the row of the item type where you want to enable or disable widgets.

3. To enable a widget, select the widget's name [774] in the Inactive widgets column to move it to
the Active widgets column.
Each widget in the Active widgets column has a synchronize toggle button next to its name (gray =
disabled; black = enabled).
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Note
é’ Adding the relationship widget automatically also adds the Relationship Status
Indicator [310]. They can’t be used separately.

4. To indicate that a widget can be synchronized, select its synchronize toggle button

Note

i If you disable synchronization for a specific widget, when an item of that type is
synchronized, that widget isn't included in synchronization, nor is that widget taken
into account when sync status is calculated.

5. To disable a widget, select the X next to the widget's name in the Active widgets column.
6. Select Save.

Your changes are saved and any new item widgets are now available to users.
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Use a different item type as a test case or defect

You can use any item type as a defect or a test case. When you select test case, test steps and test case
status are added to that item type.

O Organization Admins Only

You need organization admin permissions for this task.

To change the item type for test case or defect:

1. Select ADMIN > Organization > Item types.
2. Select Edit in the row of the item type you want to change to a test case.

3. Inthe Add/Edit item type window that opens, select the drop-down menu next to the Use as field
and select one of the options: Test case or Defect.
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4. Select Save.
Your changes are saved and the new item type is now available as a defect or test case.

Enable test case item

If testers need more formatting options when they edit their test cases, specifically for steps, a WYSI-
WYG editor that is similar to the one used in most item Description fields is available.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

¢ When you disable rich text, no data is lost, but images and rich text are replaced with HTML tags.
Users don’t see any existing steps break and the content is still rendered. The user must decide which
formatting tags to remove.

e The application doesn’t automatically strip tags, and renders correct HTML tags in steps with or
without the rich text mode enabled.
¢ To hide the test case status from view, see Hide test case status field [678].

To enable test case item:

1. Select ADMIN > Organization, then select Item types.
2. Select the item type you want to use, which is a Test Case [401] type.
3. Inthe right panel, select the Steps field, then select the Edit pencil icon.

4. In the Edit field window that opens, select Allow Rich Text to enable the feature.
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Edit fleld
Field label: Steps
Use to Trigger Suspect:
Synchronize:
Allow Rich Text:
Save Cancel

5. Select Save.
The test case item and the rich text feature are enabled.

Change a set key
You can edit a set key or renumber items in a set at any time.

O Organization And Project Admins Only
You need organization or project admin permissions for this task.

To change a set key:

1. Select PROJECTS > Project, select the set you want to modify, then select Change set key.

2. Inthe window that opens, enter the new set key (1-16 characters, consisting of only letters,
numbers, and underscores).

3. Select Regenerate Item IDs to reset the counter to 1 and to apply new numbering to all existing
items.

Important
Don't select Regenerate Item IDs to restart numbering on newly created items.
Leave existing items as they are.

4. Select Submit.
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Your changes are saved.

Configure workflow for item type

Workflows aren't project-specific. When you configure a workflow, it applies to the item type across
projects.

O Organization And Process Admins Only

You need organization or process admin permissions for this task.

Important considerations

e If the organization admin selects Allow project managers to override workflows on a project, the
project admin for each project can set up the workflows.

¢ Selecting Allow project managers to override workflows on a project might impact system perform-
ance.

e If you disable a workflow, Jama Connect stores your settings for later use.
e An organization admin can disable a workflow from the Workflow Administration section.
e Workflow applies to all projects using the selected item type and can't be disabled at a project level.

To configure workflow for an item type:

1. Select ADMIN > Organization, then select Workflow.

2. Select options to enable workflow for all projects that use this item type:
e Enable workflow for this organization.
¢ Allow project managers to override workflows on a project.
3. Under Workflow Administration:
e To start a new workflow, select Add/Edit.
¢ To edit a workflow, select Config in the Action column.
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From here, a project admin can continue to set up the project workflow [736].

Set up editor templates
Editor templates can be applied to any rich text field and must be configured before use.

O Organization Admins Only

You need organization admin permissions for this task.

To set up editor templates:

1. Select ADMIN > Organization, then select Editor templates.
¢ To create new template with a rich text editor, select Add editor template and give it a name and
description.
¢ To edit an existing template, select a template, then select Edit.

2. Create or edit the template as you want it to appear in other items.
3. Select Save.

The template is now available to other users [104].

Configure views
You can configure the default fields in Projects List View, Reviews Single Item View, and Reviews Reading
View.

You can also configure views in Projects that contain mixed item types, such as views created from a tag,
filter, or component, by selecting Projects List View with mixed item types.

Note
ﬁ You must have organization admin permissions to complete this task.

Configuring fields for a view [31] overrides the default and becomes the standard order of visible fields
for that user, in all similar views, for that item type.

To configure views:
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1. Select ADMIN > Organization, then select Item types > Views.

2. Inthe Project List View window that opens, select the view you want to configure.

Projects List View - Components
| Projects List Wiew| |v
. Projects List View .

Drag and drop to hide/show and re-order fields  Projects List View with Mixed ltem Types
Hidden field Vi Projects Document View

idden fields I ) . i
Heading D Review Center Single ltem View

AP ID ltel Review Center Reading View

Last Locked By Locked
Last Locked Mame

Created By Categories
Created Date

Modified By
Medified Date
Project
Description
Glokal 1D

& &

Steps

Connected Users
# of Comments
Relationship Status

Save Close

3. Use the arrows to move fields between the Hidden and Visible columns. Select and drag field names
up or down to reorder them.

4. Select Save.

The default fields you configured are now available to users.

y Note

You can only select core item type fields when you configure List View for mixed item
types. For a list of core item type fields, see ADMIN > Item types > Core > Views.
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Managing relationships
As an organization admin, you can use several tasks to manage relationships.

Edit relationship widget [691] in an item type

Set the relationship types [642]

Configure the Import Relationships Plugin [632]

Set up relationship rules [644] at an organizational level

Configure relationships
Before setting up relationships (traceability) between your artifacts, you need to set up the types and
options available to users.

O Organization Admins Only

You need organization admin permissions for this task.

To configure relationships:

1. Select ADMIN > Organization, then select Relationships > Edit.

2. To change the relationship options from No to Yes, select each option:
e Show Status in Relationship Grid?
e Show Note in Relationship Grid?
¢ Allow relationship changes between two locked items?
The Note and Status columns are added to the table in the bottom panel. The Note and Status fields
are only editable when the relationship type is set to Show Note and Show Status.
3. Configure relationship types:
a. Inthe Relationships widget of an item, select a relationship to edit its type, direction, status, and
note.
b. Use the toolbar at the top of this panel to edit, add, or delete types.
c. Include a description to specify how and when this type is used.
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4. Set up relationship rules [644].
The relationship types and options are now available to users.

Set relationship types
One part of the initial traceability setup is configuring the available relationship types.

O Organization Admins Only

You need organization admin permissions for this task.

To set relationship types:

1. Select ADMIN > Organization, then select Relationships.

2. Under Relationship Types, use the icons to add, edit (pencil), delete (X) or reorder (arrows) relation-
ship types.

3.  When adding a new relationship type, enter a display name and description. The description is only
visible in this edit window.
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(Optional) Select Show Note and Show Status to allow users who create a new relationship using
this relationship type to enter a note and a status for that relationship.
Status and notes are visible any time you reopen the Add/edit relationship window.

Status and notes are also visible in the bottom panel of Single Item View when Relationships is
selected.

In an impact analysis [319], you can filter by status or note.
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5. If you delete a relationship type, choose a replacement type for affected relationships.
Delete Relationship Type

Relationships with this type will be replaced. Please choose a replacement value.

Replacement Relationship | Related to hd
Type:

Delete Cancel

The configured relationship types are now available to users.

Set up relationship rules

Relationship rules help maintain the project structure by preventing problems with relationships [309].
The rules help users know when relationships are required and in which directions.

O Organization Admins Only

You need organization admin permissions for this task.

When relationship rules are set up, the Relationship Status Indicator [310] alerts users when their rela-
tionships don't match the relationship rules.

Rule sets are created at the organization level, and can then be applied to one or more projects.

To set up relationship rules:
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Decide with your team which relationships to include, the relationship types, and whether
the rules are exclusive and included in coverage calculations for the project.
Select ADMIN > Organization > Relationships and scroll down to the section labeled Traceability

Information Model Configuration to see any previously created rule sets.

3. Scroll to the bottom and select Add rule set.
a. Select New Rule Set and edit the name to describe your set.

b. Add a rule by selecting the item type for Upstream, Downstream, and Relationship type from
the drop-down menus. Select For coverage if you want this relationship included for coverage.

ﬁ" Note
Configure the same rule set across projects that share relationships. If you
relate items across projects with different rule sets, the source project's rule

set is applied.

c. Select Save.
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As the rule is saved, it is added to the diagram, indicating the relationship.

d. (Optional) Select Add another relationship to include another relationship for this rule set.
As rules are created, the diagram is updated to show the relationships. Solid lines between
items indicate a coverage (required) relationship. Dashed lines indicate relationships that aren't
for coverage.

Note
é’ Once you set relationship rules for a project, you can also view the relationship
rules diagram in Single Item View or on the dashboard [765].

4. To delete a rule, select the X at the end of the rule's row. To delete an entire rule set, select the X at
the top right of the rule set. After editing or deleting a rule, the rule set diagram is updated with any
changes made.

5. Select Add project to apply the rule set to one or more projects. If a rule set is applied to a project
with existing items, nothing changes in that project, even if the existing relationships break the
new rules. Only future relationships are required to conform with the rule set.

Important

A project can have only one rule set. If a rule set has already been applied to a
project and you try to apply another, the application removes the first rule set from
the project and applies the second one.

6. (Optional) Select Allow any item type not mentioned in this rule set... to allow users to create rela-
tionships outside the rule set you applied to the project.

Rules are between item types. If you don't define a rule for a particular item type, that item type can
have a relationship with anything (or nothing if the user chooses), even if the rule set is exclusive.

Configure the Relationship Import Plugin
The Relationship Import Plugin helps you batch create relationships between existing items in Jama
Connect.

The plugin can be configured to import relationships between items in the same project or across two
projects. The plugin uses different classes and parameters, depending on whether your items are in one
project or two.
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Note
é’ You must have organization or process admin permissions to complete this task.

To configure the Relationship Import Plugin:

1. Select ADMIN > Organization, then select Plugins > Add plugin entry.

2. Inthe window that opens, enter the following information.
This screenshot shows an example of a plugin entry configured for a single-project import.

This screenshot shows an example of a plugin entry configured for a cross-project import. The
cross-project import configuration utilizes a different package name and includes two additional
required parameters.
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Edit plugin entry
Mame: Cross Project Relationship Import Test
Enabled:
Class: com jamasoftware.contour. plugin jama.ImportRelationshipsCrossProject
Type: Import v
Parameters: parentType=23;

childType=27;

parentField=documentkey;
childField=documentkey:
parentProjectld=132;
childProjectld=36;

Plugin Notes:

Save Cancel

o Name — Enter a name visible to users. For example, Market = System Requirement Relationship
Plugin.

e Enabled — Make the plugin available for use.

e Class — Enter the appropriate class from below. Determine the class based on if your importing
for items in a single project or across two projects.
¢ For items in a single project, enter:

com. jamasoftware.contour._plugin. jama. ImportRelationships
e Foritems in two projects, enter:
com. Jamasoftware.contour._plugin. jama. ImportRelationshipsCrossProject

e Type — Select Import.

e Parameters — Use the information you collected in Gathering information for the Relationship
Import Plugin [630]. Replace the bracketed text with the appropriate value. The Parameters field
is case-sensitive and requires a semicolon at the end of each line. Make sure there is no additional
space at the end of each line.
parentType=[AP1-ID of upstream ltem Type];
childType=[API-ID of downstream ltem Type];
parentField=[Unique Field Name from upstream ltem Type];
childField=[Unique Field Name from downstream ltem Type];

If importing relationships for items contained in two projects, copy this section into the Parame-
ters field below the parameters list and replace the bracketed text with the appropriate value:
parentProjectld=[API-1D of project containing upstream items];
childProjectld=[API-ID of project containing downstream items];

e Plugin notes — Add any details that are useful when viewing the plugin in the Admin area.

3.  When the information is complete, select Save.

The Relationship Import Plugin is now configured and available for use.

Go to the next action: Import relationships from Excel [634]
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Managing tests

As an organization admin you can do the following to manage tests:

e Include unexecuted test runs in status calculations [684]
e Enable rich text in test steps [677]
e Use an item type as a test case or defect [693]

Test run item
A test run is a system item and can't be deleted. It serves as the record of a test being executed.

When a test case is associated with a test cycle, a test run is automatically created in that cycle. An
automatic association is created between that test run and its originating test case, test cycle, test group,
and test plan. These associations contextualize the test run.

A test run’s name, description, and steps are the same as its originating test case at the time the run was
created.

Status — Available statuses

Passed and Failed are required statuses that can't be changed or disabled. "Not applicable" is an optional
status that can be enabled when certain test steps and/or tests might not be applicable to all testing
scenarios. Not applicable status in a step or test run is excluded from any result calculation.

Status — Default behavior for completing steps out of order

Select one of the three options for how the system might behave when a tester skips a test step and
does not assign it a status:

e Assign “Passed” to all skipped steps
¢ Do not assign status to any skipped steps
¢ Allow tester to select status for skipped step (for example, ignore, pass, fail)

Managing collaboration

Collaboration includes emails [230], electronic signatures [258], the stream [237], reviews [159], and
workflows [232].
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Configure organization details

Early in the setup process, configure the details for your organization, including organization name and
description, base URL, how subscriptions are handled, and more.

O Organization Admins Only

You need organization admin permissions for this task.

To configure details for your organization:

1. Select ADMIN > Organization, then select Detsails.

2. Select Edit, then configure these details for your company:

¢ Organization name — The name of your company or team. Each instance of Jama Connect can
have only one organization. The organization name is also used for reports.

e Description — An explanation and additional information about your company.

o Return email — A return address for email notifications. Typically the organization admin's email
address is used or noreply@example.com.

e Base URL — When email notifications include links to items, the link is created from the base
URL for your Jama Connect installation. For example, http:/localhost:8080/contour. Attachments
(images etc) depend on this setting being accurate.

¢ Rich text image max width (px) — Maximum pixel width setting that shrinks all images embedded
into rich text fields. Default is O, no maximum width is applied.

¢ Rich text image max height (px) — Maximum pixel height setting that shrinks all images embedded
into rich text fields. Default is O, no maximum height is applied.

Important

Images retain their ratio when adjusted to fit the maximum setting for height
or width. The adjustment only happens during an upload or document import.
Images that already exist on the server aren't adjusted. Compression occurs
based on the width and height settings.
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o Allow users to subscribe others — Users can subscribe other users to items.

¢ Allow users to mute subscriptions — Users can turn off a subscription that another user subscri-
bed them to.

¢ Allow item/container deletion by non-Org Admin users — Users who have create/edit permis-
sions can delete items. When disabled, only organization admins can delete items.

¢ Allow project administrators access to all users and organization groups — Project admins can
see all projects' users and groups. When disabled, project admins can see only their own project's
groups and users.

¢ Include unexecuted test runs in status calculations (not retroactive) — (Default) Jama Connect
includes all associated test runs to automatically calculate test case status. When deselected,
unexecuted test runs are not included unless there are no executed test runs.

Note

y For test cases associated with a single plan, test case status reflects the status
of the test run with the most recent activity, which includes unexecuted tests
if this option is enabled. When the case is associated with multiple plans, the
most urgent status is chosen, in this priority order: unexecuted, failed, blocked,
scheduled, passed.

Deselect this box to remove unexecuted test runs from that priority order.

¢ Allow multiple items with the same global ID in a single project

¢ Allow deletion of fields and data from item types — By default, this setting is disabled. The
purpose of this setting is to prevent users from accidentally deleting fields in item types without
verifying whether the deletion could impact data used in baselines.

¢ Allow "Quick Add" and "Inline Insert" — By default, this setting is enabled. To disable it and
prevent the "Quick Add" and "Inline Insert" options from appearing, deselect the checkbox.

e REST API and MCP Managed Access is enabled — By default, this setting is disabled, and all users
with a Named Creator License can access the REST APl or MCP. When enabled, only the specified
users and group members have access.

¢ Java Date Time Format — Formats include month/day/year (default), year/month/day, and day/
month/year.

o Change global ID [620] — Change or add a prefix or an optional item type key in front of the
global ID assigned to items.

¢ Configure the baselines status for pick lists — After you create a baseline-specific pick list, you
can enable the baseline status to select the pick list. The baselines status pick list can’t be edited
after you configure it.

Once you create a baseline-specific pick list, you can enable the baseline status to be able to
select the pick list. The baselines status pick list can’t be edited after you configure [622] it.

¢ MathType and ChemType editor format — When the equation format is changed, existing equa-
tions keep their current format until they are edited.
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Best Practice
- For the best results, use PNG format with a quality setting of 300 dpi.

3. Select Save.

A message confirms your configuration details were saved.

Edit user and group subscriptions

Users and groups can subscribe to and control their own email notifications. However, if a subscription
was added by someone other than the user, only an admin can change that subscription.

Organization admins can unsubscribe a user; project admins can only mute a user's subscriptions.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To edit a user's or group's subscriptions:

1. Select ADMIN > Organization, then select Users.
To edit a group subscription, select ADMIN > Organization > User groups.
2. Select Subscriptions in a user/group row to open the Edit subscriptions window.
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3. Select a user/group from the left column to display their current subscriptions in the right column.
¢ To remove a single subscription, select Unsubscribe in the Action column.s

¢ To remove multiple subscriptions for a user, select the subscriptions in the Notifications column,
then select Unsubscribe selected in the top right corner.

Your changes are saved.

Manage Stream comments

Decide whether you want to use Jama Connect for collaboration within and across projects and items.
The Stream is the method for sharing comments on items and making and closing decisions.

O Organization Admins Only

You need organization admin permissions for this task.

To manage Stream comments:

1. Select ADMIN > Organization, then select Stream.

Note
i Separate domains with a comma and don't add a space between the comma and
next domain.

2. Configure these settings as needed:

¢ Disable Stream and project comments — Turns off the Stream.

¢ Enable new comments in global Stream — Displays comments when you access the Stream from
the header.

¢ Allow users to invite new users to Jama Connect by email — Gives users the ability to add users
outside of Jama Software with @mention.
Those who accept invitations automatically receive a temporary license [656] but only have rights
to view the discussion threads to which they have been invited. Organization admins can give
them more rights, but must change the license type to a permanent one before their 30 day
license expires. An organization has unlimited temporary licenses, which have full creator permis-
sions.
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¢ Only allow email addresses with these domains — Restricts invitations to email addresses within a
specific domain. Separate multiple domain entries with a comma.

¢ Comment update frequency — Controls how often the Stream is updated with new comments.
3. Select Save settings.

Your settings are saved.

Managing reviews

As an organization admin, you can manage many aspects of a review, including permissions, access,
licenses, and more.

Users with reviewer, test runner, collaborator, and stakeholder licenses can participate in reviews but
can't create reviews. When a user is invited to participate in a review, they automatically get a reviewer
license. Reviewer licenses don't automatically grant read- or write-access to project data.

To manage reviews, you can:

e Grant permissions to a review admin [667]

e Assign reviewer licenses [655]

e Configure access to reviews [712]

e Configure item workflow for Approval Reviews [714]

e Determine which default fields are visible in reviews [697]
e Manage permissions by license type [656]

Configure review access

You might want to configure access to a review for certain members of your team to see the review. If
your company follows specific processes, you can tailor the review access accordingly.

O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

® You must be an organization admin to configure review settings.
e Reviews created before Jama Connect 8.61.x with the setting Reviews can be public disabled and later
enabled, those reviews become public.

e Reviews created after Jama Connect 8.61.x with the setting Reviews can be public disabled and later
enabled, those reviews remain private.

¢ For information about license types and reviewer roles, see Permission by license types [656].
To configure access to reviews:

1. Select ADMIN > Organization, then select Review center.
2. Select the options you want and scroll down to select Save settings.
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¢ Disable reviews — Blocks access to reviews.
¢ Reviews can be public — (Default) Allows reviews to be viewed (read-only) by users with review
access to public reviews. Select who can see public reviews.
¢ Anyone with access to reviews — Lets anyone, regardless of project permissions, to see all
items in the review.
¢ Only those with permission to ALL items in the review — Lets users see a public review if they
have access to all items in the review.

Important

When you select the Only those with permission to ALL items in the review
option, a pop-up message appears listing all open reviews that could be affec-
ted by the change in visibility permissions. Not every review that is listed is
necessarily impacted.
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You are limiting who can see public reviews

This means only people who have permission to all items being reviewed
will see a public review. Some who previously saw public reviews may not
see them now.

These 2 reviews will be affected when you save.

Review Mame Moderator
review with peer and approval toggled off SaraR
test SaraR
Close

¢ Enable review moderators to invite users outside their project — Lets review moderators give
reviewers access to specific items in a project.

¢ Allow approvers to add other reviewers and approvers — (Default) Lets approvers include other
users and assign them roles as reviewer or approver.

¢ Allow approvers to delegate their approval — (Default) Lets approvers appoint a reviewer to
approve and sign for them.
¢ Allow review moderators to invite new users to Jama by email — Lets moderators include non
Jama Connect users. When they accept, they are automatically granted a reviewer license.
¢ Only allow email addresses with these email domains — Limits invitees to users with email
domains you enter here. Leave it blank to allow any domain.

Your selected team members are now able to access the review.

Item workflow for Approval Reviews

When you integrate Approval Reviews with your item workflow, you ensure that reviews are consistent
and up to date. When enabled by an organization admin, moderators can use templates for Approval and
Peer reviews.

y Note
You have organization admin permissions to complete this task.

This overview describes the process for using item workflow with review templates.
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ok

Organization admin — From ADMIN > Organization > Review center:

1. Select Enable Approval review template. Approval reviews are required to integrate the work-
flow for your review process

2. (Optional) Select Enable Peer review template. Peer reviews can be transition to Approval
reviews.

3. Select Save settings.

Organization admin — From ADMIN > Organization > Workflow:

1. Select Enable a workflow transition to be enabled by a finalized Approval review.

2. Configure the workflow transition status, notifications, lock state, and permissions that apply to
the new approval review transition.

Moderator — Create a review, then select the Peer review template in the review wizard.

Moderator — View a Peer review and transition it to an Approval review.

Moderator — When the Approval review is done, select Finalize Approval review.

Moderator — After viewing the review overview and workflow transitions, select Finalize re-

view to confirm the transition.

Types of review templates

The review templates are optional. You can use none, one, or both types. You don't need a Peer review
template to finalize an Approval review.

Note
é’ Review templates are disabled by default. You must enable the Approval and Peer
review templates to use them.
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e Approval review template — Use when you want to collect signatures and need a review signed off. If
workflow is enabled, you can batch update items [74] to an approved state.

o Peer review template — Use when you have a review with ongoing itera-
tions and when changes to items are always in the “ready for approval” state.

Organizing projects
A project is a way of organizing your data in Jama Connect and is made up of items, filters, baselines, re-
leases, reports and tests.

As an organization admin you can complete the project-level tasks of a project admin or you can grant
project admin permissions [725] to a user who manages a particular project and its users.

Some tasks, such as the following, are related to projects and must be done by the organization admin:

e Add a project [716] (available for project admins with Add Project role)
Duplicate a project [719] (available for project admins with Add Project role)
Archive a project [720]

Grant project permissions [748] (if disabled for project admins)

Add or delete groups [647] (if disabled for project admins)

Set up projects workflow [736]

Set up relationship rules [644]

Add a project

If your organization has many projects or products, you can create a folder called "Product Line" with
projects for major releases. You can also create a project to hold a library of common requirements or
documents that you can reuse [355].
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é’ Note

You must have organization or project admin permissions with the Add Project role to
complete this task.

To add a project:

1. Select ADMIN > Project, then select Add project.

2. (Optional) Add a folder to organize your projects.

3. Set up relationship rules for the project [644]. Only one rule set can be applied to each project.
4. Set up project's workflow [736] as needed.

The newly added project appears in the project list.

Edit project details

Update the name, key contributors, and other high-level details for a project.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To edit the details of a project:

1. Select ADMIN > Project, then select Details > Edit.

2. Make your changes, then select Save.
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Your changes are saved.

Note
y The Project Summary widget on the project dashboard uses the End date value in the
Project Details window to calculate the number of days until the project is complete.

Change a project key

When you update a project key, the ID for all items in the project is regenerated.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To change a project key:

1. Select ADMIN > Project, navigate to the project with the key you want to change, then select
Details > Change project key.

2. Enter the new project key. It must be 1-16 characters long, consisting of letters, numbers, and
underscores.
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3. Select Submit.

Once the project key is updated, the Unique ID [731] of all project items is updated to contain the
new key.

Duplicate a project
You can duplicate a project to reuse its requirements, permission settings, tags, and attachments, or to
start a new project from a template.

When you duplicate a project, its test plans, test cycles, and test runs are not copied to the target
project.

Note
é’ You must have organization or project admin permissions with the Add Project role to
complete this task.

To duplicate a project:

1. Select ADMIN > Project, then select the project you want to duplicate.
2. Select Actions > Duplicate Project.
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3.

4.

Select the items you want to copy and whether to synchronize them.

Duplicate project Semiconductor Project 2.0 =8

MNew Project Name:  Duplicate of Semiconductor Project 2.0

New Project Key: S1_S2

Check items to include in the copy Synchronize with original items
Project Setlings: D Synchronize duplicated project: |:|
Project Permissions: [~
Existing Relationships: ] Create relationships to original items
Public Filters: ] Check to create relationships: D
Tags: D Downstream from Original:
Releases: [ Upstream from Original:
Project Groups: [*] Relationship Type:
Workflow: [7]
URL Links: []
Aftachments: ]
236 items Duplicate Project Cancel

Project Settings — Settings in the ADMIN > Project area. For example, visible item types, relation-
ship rule, and Explorer Tree maximum count.

Project Permissions — Project-level permissions that were applied are carried over to the copied
project.

Existing Relationships — Relationships between items in the project are copied to the new
project.

Public Filters — Public filters created by users or project admins are copied to the new project.
Tags — Tags created by users are copied to the new project.

Releases — Release values in the Releases tab are copied to the new project, which also maintains
the release values in the standard “Release” field on items.

Project Groups — Project-level groups are copied to the new project.

Workflow — Workflow customizations (notifications, lock settings, transition permissions) are
copied to the new project.

URL Links and Attachments — Hyperlinks and attachments to items, using the links/attachments
widget, are copied to the new project.

Synchronize Duplicated Project — All copied items receive a new project ID but maintain the
same Global ID as the original project. This allows teams to compare differences between the
source project and copied project. Common use cases are for parallel development of variant
products or branches of a products release.

Create Relationships — All copied items include a trace relationship to the original item. You can
set the direction and relationship type.

Select Duplicate Project.

A message appears confirming the project was successfully duplicated.

Archive a project
You can archive a project to clean up your workspace or to hide it from most users' view.

When you archive a project, it remains in the database but is hidden from immediate view from most
users. Organization admins still see the archived project in the project tree with "(ARCHIVED)" in the

title.
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O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

¢ Archived projects and their content don't appear in filters or search results. When a project is archived,
all releases associated with the project are archived.

¢ Project groups aren't deleted when a project is archived. If a project is no longer needed, delete it
before it is archived.

e Select Actions > Unarchive to unarchive a project.

¢ When you archive a project, related items from external projects no longer appear. If you unarchive
the project, those related items reappear.

To archive a project:

1. Select ADMIN > Project, then select the project you want to archive.

2. Select Actions > Archive project.

3.  When prompted, select Yes.

The project is archived and it no longer appears in filters or search results.

Delete a project

When a project is no longer needed, you can delete it, which completely removes the project and all its
data from the database.
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O Organization Admins Only

You need organization admin permissions for this task.

Important considerations

¢ Project folders must be empty before they can be deleted.
e Once a project is deleted, there's no way to restore the project. When a project is deleted, all the
data in that project is deleted. However, this doesn't automatically free up space in the database. A
database admin must manually compress the database.
¢ To clean up your workspace or to remove a project from view, archive the project rather than delete it.
e Projects can be stored in empty folders.

To delete a project:

1. Select ADMIN > Project, then select the project you want to delete.

2. Select Actions > Delete Project.

3. Review the list of items, confirm the deletion, then select Delete Project.
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The project is deleted in the background, so you can continue working. You receive an email when the
deletion is finished.

Note

é’ The project isn’t removed immediately. A daily task runs at midnight UTC to permanent-
ly remove data from the database. Once the project is permanently removed from the
database, you can remove item types associated with that project.

Any reused items that link to attachments or images in rich text owned by the deleted
project are no longer available.

Integrations
To best support product development teams, Jama Software offers a number of integration platforms for
customers to connect to other application lifecycle management (ALM) software.

Jama Software currently offers OpsHub Integration Manager (OIM) and Tasktop Integration Hub (TIH),
which provide the necessary platform to manage the integration. These integrations hubs manage
information between Jama Connect and your third-party applications in a bi-directional manner.

These solutions can be managed in self-hosted environments. or, in the case of the OIM, hosted by
OpsHub in their cloud.

For more information:

e Integrations — Visit the Community
e Purchasing a solution — Contact <sales@jamasoftware.com>

Integrate OSLC Model Connector with Jama Connect
Open Services for Lifecycle Collaboration (OSLC) is an open-source set of specifications that enables and
simplifies tool integration in software development.

Note
y You must have organization admin permissions to complete this task and give access to
users in your organization.

723


https://community.jamasoftware.com/kb/articles/15-integration

Administration

Integrating OSLC provides traceability between Jama Connect and OSLC domains, applications, and
organizations. The partnership between the Smartfacts Model-Based Systems Engineering (MBSE) plat-
form and Jama Connect helps product development teams increase their level of collaboration and
communication.

The result of this collaboration is the OSLC Model Connector, which provides:

e Complete traceability for requirements throughout the product development lifecycle
e Clear visibility into MBSE design artifacts in real-time
¢ Ability to link requirements to various modeling tools

For more information, see Jama Connect OSLC Model Connector Datasheet.

Important

Contact your Jama Software account manager to set up access to the OSLC Model
Connector and to MID Smartfacts.

To set up and use the OSLC Model Connector:

1. Enable OSLC Model Connector.
a. Login to Jama Connect, then select ADMIN > Organization > OSLC.
b. Select Enable OSLC > Save settings.
A pop-up message confirms that OSLC was successfully enabled.
2. Grant OSLC Model Connector permissions.
a. Select ADMIN > Organization > Permissions.
b. Inthe row for the user or group you want to provide access, select Modify.
c. Inthe Edit permissions window, select OSLC, then select Save.
A checkmark is displayed in the OSLC column for that user or group. The OSLC permission automat-
ically inherits the permissions that are set for those users or groups.
3. Configure specific item types for OSLC Model Connector.
a. Select ADMIN > Organization > Item types.
b. Inthe row for the item type you want to configure, select Edit.
c. Inthe Inactive widgets column of Widgets table, select OSLC Artifacts.
OSLC Artifacts move to the Active widgets column.
d. Select Save.
A checkmark is displayed in the OSLC column for that user or group. The OSLC permission automat-
ically inherits the permissions that are set for those users or groups.

To use the OSLC Model Connector with Jama Connect:

1. Open your project and select the item where you want to add a new item.

Select Add > New item > <item type>.

3. Inthe Add item window, enter a name for the item, then select Save and Close.
The OSLC Artifacts widget appears in Single Item View.

4. Inthe OSLC Artifacts widget, select + to add links to OSLC Artifacts that you configured in Smart-
facts.
You now see links in the OSLC Artifacts widget.

5. Select a link.

N

A panel slides out to display the artifact.
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Example of the OSLC Artifacts Widget in Jama Connect

Project administrator

The project admin controls permissions, project groups, and workflow customization. It is a role that can
be provided for all projects or for a specific project.

To configure your projects, access the administrator tasks under ADMIN > Project.

All your projects are available from the Project tab. The last project you viewed is selected by default.
As a project admin, you can:

e Manage project releases [733]

e Configure project item types [727]
e Manage project users [745]

e Manage project groups [745]

e Manage project permissions [748]
e Manage project attachments [734]
e Manage project tags [734]

e Perform a project cleanup [743]

¢ Index project data [744]

e Manage workflows [735]

Monitor changes with the Admin Activity stream (project admin)
The Admin Activity stream provides an audit trail of all the updates you make.
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O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To open the Activity stream panel:

1. Select ADMIN > Project, then select the project you want to view.
2. Select the Activity stream button on the right side of the panel.

When the Activity stream opens, you can enter a search term to find activities.

The Activity stream includes:

Tab Available information
Settings e Changes in version items.
e Maximum number of items displayed in the Explorer Tree.
e Where to save test run defects.
Item Types Item types that transition from visible to hidden and from hidden to visible.
Release List What was added, edited, deleted, archived, and unarchived in a project release.

Project Permissions

* Modifications to inherited permissions.
e Added and removed permissions at the project level.

Workflow e Overriden items and who overrode them.
e Removed and configured workflows per item type in a project.
Attachments Attachments added from the Attachments tab of the Project admin panel.

Tag Management

What was added, deleted, and edited in a project tag.

Index

When a project level index was initiated.

Clean up

When project cleanup and project baselines cleanup were initiated.

Managing projects

You have permissions to modify, set up, and organize various aspects of the project and its content.

You can also manage users [745] who participate in the project, as well as manage the project dash-
board [451], although the dashboard doesn't require project admin permissions.
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Edit project details

Update the name, key contributors, and other high-level details for a project.

O Organization And Project Admins Only
You need organization or project admin permissions for this task.

To edit the details of a project:

1. Select ADMIN > Project, then select Details > Edit.

2. Make your changes, then select Save.

Your changes are saved.

Note
y The Project Summary widget on the project dashboard uses the End date value in the
Project Details window to calculate the number of days until the project is complete.

Configure item types for a project

A hidden item type prevents users from creating new items or sets of that type. If sets or items are
created under a visible item type and are then hidden, they are still functional in Jama Connect.
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O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Important considerations

¢ By default, a moved item type is placed at the end of the list. Drag and drop item types to reorder
them.

¢ An organization admin can also configure views [697] for all projects.
¢ An individual user can configure fields [31] for their personal settings.

To configure item types for a project:

1. Select ADMIN > Project, then select Item Types.

2. Select an item type and use the arrows to move it between the Hidden item types and Visible item
types columns.
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3. SelectApply.

Your changes are saved.

Configure default Explorer Tree settings
You can define the way the Explorer Tree appears by default, which allows users to customize their
Explorer Tree options.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To configure default settings for Explorer Tree:

1. Select ADMIN > Project, then select the gear icon at the top of the Explorer Tree.

2. Select the Default settings tab, then select the settings to define the default Explorer Tree view.
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e Show item IDs — Displays the unique ID [731] (as in PROJ-REQ-25) before each item.

¢ Display global ID — Displays the global ID (as in GID-8845) before each item. This is helpful if the
item is copied and synchronized.

¢ Show only folders / hide items — Hides items from view in the Explorer Tree. Components, sets,
and folders are still displayed.

O Best Practice

- Use this setting to improve performance when your project has a large number of
items.

¢ Show outline numbering — Displays a number scheme of order and depth in the Explorer Tree.
Root-level items have numbers like 1, 2, or 3. Child items contain the parent item number as well
as its own number, like 1.1, 1.2, or 1.1.5.

* Show relationships in Explorer Tree — Displays downstream relationships of items in the Explorer
Tree. Select the green downstream arrow to open the related items in List View.

Important

Don't relate items back to themselves to avoid an infinite loop that causes the
Explorer Tree to expand.

3. Select Apply and Close.

These default settings are now available to users when they customize their Explorer Tree options.

Project key

The project key is a unique identifier that is automatically created with each project. It makes up the first
part of each item's unique ID.

Project or organization admins can change a project key [718]. Changing a project key generates the ID
for all items in a project.
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Unique ID

A unique ID, also called item ID, identifies each item. It consists of a project key, a set key, and a set
counter. Unique IDs remain the same even if the item name or content is changed. They can't be edited
or duplicated.

¢ Project key — Identifies which project an item belongs to. Project keys must be unique to each
project, and must be 1-16 characters long, consisting of letters, numbers, and underscores. A project
or organization admin can change the project key [718], but that doesn't reset the numbering of items.

o Set key — Identifies item sets for each project. You can use the same set key across sets or projects.
Project or organization admins can change a set key [695] to better meet your organization's needs.

¢ Set counter — A number automatically added to the item. Unlike the global ID counter, you can reset
the set counter when you change the set key.

You can use the set key across multiple sets of the same item type. However, be aware that the set
counter is shared across all items using the same set key.

Change a project key

When you update a project key, the ID for all items in the project is regenerated.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To change a project key:

1. Select ADMIN > Project, navigate to the project with the key you want to change, then select
Details > Change project key.
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2. Enter the new project key. It must be 1-16 characters long, consisting of letters, numbers, and
underscores.

3. Select Submit.

Once the project key is updated, the Unique ID [731] of all project items is updated to contain the
new key.

Change a set key

You can edit a set key or renumber items in a set at any time.

O Organization And Project Admins Only
You need organization or project admin permissions for this task.

To change a set key:

1. Select PROJECTS > Project, select the set you want to modify, then select Change set key.

2. Inthe window that opens, enter the new set key (1-16 characters, consisting of only letters,
numbers, and underscores).

3. Select Regenerate Item IDs to reset the counter to 1 and to apply new numbering to all existing
items.
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Important

Don't select Regenerate Item IDs to restart numbering on newly created items.
Leave existing items as they are.

4. Select Submit.

Your changes are saved.

Manage releases

A release is a group of items that are developed together and mapped to a specific completion date.
Users can view releases and assign items to a release.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Admins can set up and manage releases that others use. The releases in the release list are used to

populate the pick list for an item's Release field. Releases are automatically sorted by release date in the
release list and in pick lists.

Admins can also configure default release settings [275] that show how releases are displayed.

To manage your releases:

1. Select ADMIN > Project, then select Release List.

2. Select the option you need:

e Add arelease — Select the green Add release button in the toolbar to open the Add/edit release
window. Type the name, description, and release date, then select Save.

ﬁ:’ Note

You can also add a release from the Releases tab at the top of the left panel.

o Edit a release — Select Edit in the Action column for the release you want to edit. This opens the
Add/edit release window, where you can edit the name, description and release date, then select
Save.

e Delete a release — Select Delete in the Action column for the release you want to delete. Select
Yes to confirm. Releases can't be deleted if any items are assigned to them. To remove all assigned
items, select the Releases tab and move all assigned items from that release to another release.
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¢ Archive a release — Select Archive in the Action column for the release you want to archive.
Select Yes to confirm. You can view archived releases by selecting View archived releases in the
toolbar, where you can select Unarchive.
Archived releases don't appear in filters or search results, but items assigned to any archived
release do. The Release field for these items is populated and has "(Archived)" appended to the
release's Version field.

The Release List is updated to reflect your changes.

Manage attachments
You can control which attachments users can add to their projects.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To manage your attachments:

1. Select ADMIN > Project, then select Attachments.

2. From the toolbar, add, delete, or edit an attachment.

3. Inthe Add/Edit File Attachment window that opens, complete or change the information about the
attachment. To compare versions of the attachment, select the History bar at the bottom of the
window.

4. Select Upload and Save.

From Single Item View, any user can now add that attachment [96].

Manage tags

From the Tag Management tab, you can view, edit, and create tags. Once you add a tag, users have
access to it for their project.

You can also allow enable the Allow tag management for locked items option for a project, allowing
users to add or remove tags from user-locked items and system-locked items.
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O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To manage your tags:

1. Select ADMIN > Project, then select Tag Management to add, edit, delete tags, or enable the Allow
tag management for locked items option.

2. Select the option you want to modify the tag.

e Add tag — Select Add tag, enter the tag name, then select Save.

¢ Delete tag — Select the tag you want to delete, then select Delete tag.

o Edit tag — Select the tag you want to edit, select Edit tag, change the tag name, then select Save.
¢ Enable tag management for locked items — Select Allow tag management for locked items.

If you enabled Allow tag management for locked items, this functionality is now available for users in
that project’s Single Item View, List View, batch edit, and via the REST API.

Manage workflows
If your organization admin has configured the Override option for workflows, you can change the
settings for an existing project workflow.

Before you can edit a workflow, the organization admin must configure the Override option to be
selected.
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O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To manage project workflows:

1. Select ADMIN > Project.

2. Select the Workflow tab, then select Override in the Action column for the workflow you want to
edit.

3. In the Workflow Configuration section, set up a project workflow [736], then select Save.
The changes you made to the project workflow is saved.

Set up a project workflow

If your organization admin has configured the Override option for workflows, you can change the
settings for an existing project workflow.

O Organization And Project Admins Only
You need project or organization admin permissions for this task. Before you can edit a
workflow, the organization admin must configure the Override option to be selected.

To configure the workflow for a project:

1. Select ADMIN > Project.
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2. Select the Workflow tab, then select Override in the Action column of the workflow you want to
edit.

3. In the Workflow Configuration section, select the following options for the workflow you're setting
up.
¢ Enable workflow for this organization
¢ Allow project managers to override workflows on a project

f’ Note
Selecting this option might impact system performance.

o Workflow for Item Type
o What pick list field should workflow apply to
¢ Version items on workflow status change

Note
J You can associate only one pick list field per item type. The field must be a pick list
field; multi-select lists don't work.

4. Inthe first row of the Current Status table, specify an initial state for the item when it's created. This
is the default status of the item, and it overwrites the default field status if one is set.
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5. In the following rows, specify the workflow, who is allowed to make those transitions, and the
actions that occur when an item changes status. For example, locking the item or sending an email.

a. Use the drop-down menu to move the current status to a new status and trigger related actions
or notifications.

b. Edit the Action text as needed to make messaging useful and clear.

c. Use the green plus button or the red minus button to add or remove transitions in your
workflow.

d. Select the lock icon to lock or unlock the item when it reaches a certain status such as "draft,"
"approved," or "complete."
This lock is a "system lock," which is different from a user lock. Only admins can unlock a
system-locked item.

O Best Practice
- Instead of having an admin unlock a system-locked item, use transitions to
move an item to a state where it can be edited again.

Select the link in the Transition Permissions column to define who can make these transitions.
f.  Select the link in the Notifications column to send an email notification when a user transitions
the status of an item.

If you send a notification, a message appears where you can document the transition and the
reason for changing the status.
6. Select Save.

The changes you made to the project workflow are saved.
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Configure workflow for item type

Workflows aren't project-specific. When you configure a workflow, it applies to the item type across
projects.

O Organization And Process Admins Only

You need organization or process admin permissions for this task.

Important considerations

e [f the organization admin selects Allow project managers to override workflows on a project, the
project admin for each project can set up the workflows.

Selecting Allow project managers to override workflows on a project might impact system perform-
ance.

If you disable a workflow, Jama Connect stores your settings for later use.
¢ An organization admin can disable a workflow from the Workflow Administration section.
Workflow applies to all projects using the selected item type and can't be disabled at a project level.

To configure workflow for an item type:

1. Select ADMIN > Organization, then select Workflow.

2. Select options to enable workflow for all projects that use this item type:
¢ Enable workflow for this organization.
¢ Allow project managers to override workflows on a project.
3. Under Workflow Administration:
¢ To start a new workflow, select Add/Edit.
¢ To edit a workflow, select Config in the Action column.
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From here, a project admin can continue to set up the project workflow [736].

Lock items in a workflow (organization or project admin)
To avoid unwanted changes, you can lock items in a workflow. For example, a project admin might want
to leave items unlocked while in "draft" status, but lock them when they reach "approved" status.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Important considerations

¢ |tems that are automatically locked by the workflow [232] display a gray lock after their name and a
blue lock in List View.

e System-locked items are unlocked when they transition through the workflow or are transitioned by
an organization or project admin.

To add an automatic lock to the workflow:

1. Select ADMIN > Project > Workflow.
2. For the item you want to lock, select Override.
3. In the Lock? column, select the lock icon to include (or remove) an automatic lock in the workflow.
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4. Select Save settings.

The items you selected are now locked and can't be changed.

Unlock system-locked items

Anyone can view the list of system-locked items, regardless of permissions. However, only an organiza-
tion or project admin can unlock items that are system-locked.

e Organization admins can unlock all system-locked items.

e Project admins can unlock only system-locked items where they have admin permissions to those
items.

To unlock system-locked items:

1. Select your name in the header to open the My Profile window.
2. Select the System Locked Items tab to see all items that were automatically locked [236] (blue lock).
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3. Select the items you want to unlock, then select the Unlock icon in the top right corner of the
window.

The previously system-locked items are now available.

Configure project settings
You can control settings for projects such as automatic versioning, the maximum number of items
displayed in the Explorer Tree, and where to save test run defects.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To configure settings for a project:

1. Select ADMIN > Project > Settings, then select Edit.

2. On the Settings page that opens, configure the following options as needed:
¢ Version items — Turns automatic versioning on and off when using the Save and Close option.

.O. Best Practice
- Initial import and setup can result in unwanted versions of items. To minimize
the number of versions, turn off versioning during your initial import and data
manipulation. Once it is complete, enable versioning to capture actual edits to
the items.

e Max items displayed in Explorer Tree — Sets the maximum number of items that are displayed per
container (project, component, set, or folders) when using the Explorer Tree.
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u Tip
. Setting this option can improve performance when you work with large data sets.

e Save test run defects here — Automatically sends defects that are recorded in the Test execution
window to this location in the project. The Defect item types must be a Visible item type for them
to appear. See Configure project item types [727].

The project settings are saved.

Clean up your project and baselines
Project cleanup can remedy issues that occur from inconsistent references or inactive items.

For example, users might experience inconsistencies between the Explorer Tree, List View, or filter
results, or they might see these messages: "This item was deleted" or "You don't have permission to
perform this action."

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Important considerations

e Project cleanup recalculates sort orders and compares them with the database to solve these prob-
lems. It doesn't require re-indexing or downtime.

e Self-hosted customers can ask a system admin to verify the results in the log.

% Tip

Perform a cleanup at a time of low usage to avoid impacting your users.

To clean up your project and baselines:

1. Select ADMIN > Project > Clean Up.
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2. Select Clean up project or Clean up project baselines.

Project admin Help

Semiconductor Project 2.0 W24

4 I8 Item Types Release List Users Groups Project Permissions Workflow Aftachments Tag Management Index Clean Up

Clean up a project

Clean up will force a manual update of your project explorer tree.
You can confirm the output of this action in server logs. Contact your local Jama Software administrator or Jama Support for this data.

Clean up project

Clean up project baselines

Clean up will force a manual update of your project baselines tree.
You can confirm the output of this action in server logs. Contact your local Jama Software administrator or Jama Support for this data.

I Clean up project baselines ]

A confirmation message appears when the process is finished.

Index project items
Sometimes project indexes get out of sync due to field configuration changes, large batch updates, API
updates, and other functions. When this happens, you need to re-index your project items.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

Important considerations

¢ Index your project items if you see data that's incorrect or missing. For example, failed batch updates
or if an item shows a value in a field, but a search for that field value doesn't return the item.
e Large files over 25 MB aren't indexed, so their content isn't searchable. The following filetypes are

indexable: PDF, DOC, DOCX, PPT, PPTX, TXT, RTF. The following filetypes aren't indexable: XLSX,
XLS, XML, HTML, HTM.
To index your project items:

1. Select Project > Index.

2. Select Index items.
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Project admin Help

Semiconductor Project 2.0 W24
4|5 ltemn Types Release List Users Groups Project Permissions Workflow Attachments Tag Management Index Clean Up

Index/Re-index ltems

Index items

Your project items are re-indexed. If the problem isn't resolved, ask the system admin to run a full index
of items [612].

View project users

From the Users tab, you can view information about each user, such as email, license type, login
information, and user status. You can also unsubscribe notifications for an individual or a group.

Individual users are able to manage their own subscriptions in their profile [27].

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To view project users:

1. Select ADMIN > Project, then select Users.

2. (Optional) Select Subscriptions to unsubscribe notifications for individuals or for groups.

Any changes to user or group subscriptions are saved.

Manage project-level groups
Project-level groups are useful when you are fine-tuning permissions or creating email lists.

O Organization And Project Admins Only
You need organization or project admin permissions for this task.
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Important considerations

¢ A system admin must enable the option [580] for the project admin to be able to add groups.

¢ You can manage groups of users that already have access to a project. You can edit the group name,
description, and members, as well as edit the group's subscriptions. You can also delete the group.

¢ You can manage only project-level groups, not organization-level groups. Only an organization admin
can add, delete or edit groups [647] at the organization level.

To manage project-level groups:

1. Select ADMIN > Project, then select Groups.

2. To create a new group:
a. Select Add Group in the top right toolbar.

b. Inthe window that opens, give the group a name and description, select users for the group,
then select Save.
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3. To edit or delete an existing group, use the buttons in the Actions column for the group you want to
edit.

Your changes are saved and are reflected in the group list.

Edit user and group subscriptions

Users and groups can subscribe to and control their own email notifications. However, if a subscription
was added by someone other than the user, only an admin can change that subscription.

Organization admins can unsubscribe a user; project admins can only mute a user's subscriptions.

O Organization And Project Admins Only
You need organization or project admin permissions for this task.

To edit a user's or group's subscriptions:

1. Select ADMIN > Organization, then select Users.
To edit a group subscription, select ADMIN > Organization > User groups.
2. Select Subscriptions in a user/group row to open the Edit subscriptions window.

3. Select a user/group from the left column to display their current subscriptions in the right column.
¢ To remove a single subscription, select Unsubscribe in the Action column.s

¢ To remove multiple subscriptions for a user, select the subscriptions in the Notifications column,
then select Unsubscribe selected in the top right corner.

Your changes are saved.
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Grant project permissions
The project admin can grant project permissions to users and groups.

O Organization And Project Admins Only

You need organization or project admin permissions for this task.

To grant project permissions:

1. Select ADMIN > Project > Project Permissions.

2.  From the Project tab, select the project, component, set, or item for which you want to grant
permissions.

3. Use the toolbar to select any of the following, as needed:
¢ Select Add permissions to add a new user or group.
e Select Modify in the row of a user or group you want to edit.
e Select Remove in the row of any user or group for which you want to delete permissions.
e Select Override to change the inherited permissions for this user or group.

Note

i When a row contains the value True in the Inherited column and is highlighted in
green, the group or user has inherited its permissions from a higher level. Select-
ing Override in the Actions column changes these inherited permissions.

4. Inthe Add/Edit access window that opens, grant permissions and select Save.
e Grant the permissions that come with the role of project admin.
¢ Grant access permissions for the selected item, set, or component.

5. (Optional) Select Remove to take away all permissions from the user or group for that project, set, or
folder.

Your changes are saved and are reflected in the Project Permissions list.
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Jama Connect provides several tools and topics that help you use the application and quickly find
answers, whether you're a new or experienced user.

e Glossary of terms [775]

e Quick find [756]

e Best practices and guardrails [770]

e Application performance testing [772]
e Keyboard shortcuts [770]

e Permissions by license type [656]

e Get help [773]

Permissions

Permissions allow users to do things such as access, modify, and delete items, as well as to perform other
specific tasks. Permissions control how users experience Jama Connect by restricting actions they can
perform and the content they can see.

What determines permissions?

e License type [656] assigned to a user
e Roles [752] (permission sets) granted to a user
e Access permissions [755] granted to a user for specific projects or containers

Who grants permissions?

e System administrator [576]
¢ Organization administrator [667]
e Project administrator [748]

License types and permissions

Organization admins and user admins assign license types to users. They can also view the current
license [664] assigned to users, as well as assign users license types [655].

The type of license limits the possible permissions and roles that can be granted to a user. License types
include creator, stakeholder, test runner, and reviewer.

Regardless of the assigned license type, each user has a unique login consisting of username and
password.

Creator and reviewer licenses can be named licenses or float licenses; test runner licenses and stakehold-
er licenses are named only.

Types of licenses

License type Definition Named li- Float license
cense

Creator Gives full read and edit rights and full access to reviews to active users X X
who daily manage items and projects.

Test runner Gives basic permissions to read and review, as well as the ability to X
create test plans and defects, to execute test runs, and to add attach-
ments to test runs during execution.
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License type

Definition

Named li-

cense

Float license

Stakeholder

Gives read-only privileges to those who need visibility into a project, X
but don’t need editing rights. Stakeholders can view items, provide
comments, and act as reviewers.

Reviewer

Grants permission to participate in reviews, act as approver or review X
admin, and to respond to comments in the stream. Reviewers can't
initiate reviews or access items in the core project.

Temporary

Grants non-licensed users with temporary 30-day access, so they can X
trial Jama Connect. This license is available only when a user is invited
via email to a review or to comment in the stream. The only default
permissions are for the discussion thread or review to which they were
invited.

Collaborator
(Legacy)

A legacy license; gives read-only privileges to users needing visibility X
into a project, but not editing rights. They can view items, provide
comments, participate in (but not create) reviews, execute test runs,
and log defects.

Permissions by license type

The type of license assigned to you defines your permissions, which in turn determine your ability to
create and edit items and to access items as read-only.

With a creator license and read-only permissions to a project, you can:

Execute test runs

Log defects from the test run execution window

Permissions

Creator

Stakeholder

Collaborator (lega-
cy)

Test Runner

Reviewer

Read/Write

Create test plans

Execute test runs

Log defects (from test run window)

Manage attachments

X*

Manage relationships

X*

Add baselines

Edit, delete, restore user-created baselines

Add and edit items

X*

REST API access

X | X| X | X|X|X|X| X|X

Read-only

Share filters

Share custom report templates

View baselines

Create filters

Export reports

Read and initiate stream threads

Comment on items

View items in projects

View dashboards

XX | X | X|X|X|X| X|X

X | X | X|X| X| X|X

X | X | X|X| X| X|X

X X | X|X| X| X|X

Review

Initiate

Moderate

Participate

Approve

Electronically sign

Reply to stream comments

X | X | X| X| X| X

X | X | X| X

X | X | X | X

X | X | X| X| X

X | X | X| X
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* The Test Runner user has permissions for these actions, but only for the item types where they have

access.

Error messages — Licensing issues
The Ul displays specific messages depending on the number and types of available licenses.

Scenario

Error message

Solution

License was downgraded

When you attempt to log

in with a floating Creator li-
cense and all licenses of that
type are already in use, but
a floating Reviewer license is
available, you are downgra-
ded to a floating Reviewer
license and see this message
when logged in.

If you need an available
floating Creator license, log
out and try later to see if
one is available. You can
also contact the admin to
see who is logged in and

if someone can free up a li-
cense.

Locked out

When you attempt to log

in with a floating Creator
license and all licenses of
that type are already in use,
and no floating Reviewer li-
censes are available, you are
locked out of Jama Connect.

When you attempt to log

in with a floating Creator li-
cense and all licenses of that
type are already in use, and
you don't own any floating
Reviewer licenses, you are
locked out of Jama Connect.

When you attempt to log in
with a floating Reviewer li-
cense and all licenses of that
type are already in use, you
are locked out of Jama Con-
nect.

Contact the admin to see
who is logged in and if
someone can free up a li-
cense.

License out of compliance

When the number of as-
signed licenses exceeds the
number of purchased licen-
ses, this message is dis-
played.

Contact the admin to

change enough users to a
different available license
type to meet compliance.

Roles

A role is a set of permissions that allows a user to perform specific functions. Each permission type

defines the functions it allows.

An admin grants permissions by role [752] to an individual or to a group.

Note
ﬁ Permission roles are different from other types of roles such as review roles [159] and

Signer roles [260].
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Types of roles

Role

Definition

System admin [554]

(self-hosted only)

Handles installation, setup, and configuration of Jama Connect, and has no access to projects.
System admin is a special user that isn’t a role for other users. It doesn't require a license and logs
in to the system with the username "root."

Organization admin [619]

Controls all aspects of configuring Jama Connect, its users, and its groups.

User admin [646]

Manages licenses, users, and groups; can see all users and organization groups in the system.

Process admin [671]

Configures content and connections within Jama Connect; controls item types, pick lists, relation-
ship rules, Review Center, and workflow; delegates these responsibilities to appropriate users and
groups.

Project admin [725]

Focuses on permissions, project groups, and workflow customization.

Add Project

Allows a user to create a new project or duplicate an existing project where that user is project
admin.

Review admin [192]

Has access to a review's content when the review is public. A review admin is also a reviewer,
approver, or moderator in the review. Permissions must be assigned by an organization admin.

Reuse admin [355]

Manages reuse. Requires read access to the synchronized items they are working with, and write
permissions to edit, synchronize, reuse, or duplicate those items.

Report admin [638]

(self-hosted only)

Allows the report developer to upload and manage BIRT, Velocity, and Word templates. Reports
are assigned to specific projects where the report admin has project management rights.

User admin limitations

Can set permissions only for groups/users on projects where they are project admin.
Can manage organization group membership only for groups where they are a member.

Can't make changes or additions to users or groups that have been assigned to organization or process

admins except for activation/deactivation and license management.
Can manage only members of a group where they are also a member. This restriction ensures they
don't unintentionally provide or remove access to unknown or existing projects.

Important
Users must have the license type [656] that allows for the permissions granted with

each role.

Permissions granted by role

A set of permissions is included with the user's license type [656]. Users can also be assigned roles [670]
that grant additional permissions.

The role of system admin only applies to self-hosted customers.

Roles
Permissions Sys- Or- User Proc- Project Add Re- Re- Re-
tem gani- ess Project view use port
zation
Setup
Install the application X
Configure email serv- X
ers
Re-index system X
X

Configure authentica-
tion
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Roles
Permissions Sys- Or- User Proc- Project Add Re- Re- Re-
tem gani- ess Project view use port
zation
Upload reports (self- X X
hosted)
Write
Add, edit, delete reuse X
rules
Add and edit item X X
types
Add users X X X
Add projects X X
Configure reports X X X
(self-hosted)
Configure organiza- X X
tion
Configure process X X
(item types, pick lists,
rules)
Set project permis- X X X X
sions
Edit, delete, or recover X X
any baseline
Delete or recover X X
baseline sources
Add releases X X
Create dashboards X X
Select item types for X X
projects
Manage permissions X X
for existing users
Review
Recover a deleted re- X X
view

For role-related permissions to work, users must have the required license type.

Required License Type by Role

Required License Type

Roles Creator Stakeholder Collaborator Test Runner Reviewer None

System admin X

Organization admin

Project admin

Reuse admin

Review admin

X | X | X | X| X

Report admin

Roles and permissions

Permissions and roles control how users experience Jama Connect. They restrict users' actions or the
content users can see.

Roles provide access to the administrative features of Jama Connect. Roles are assigned by administra-
tors to individual users or to groups.
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Permissions control read and write access to your project. You can be granted permission to an entire
project, to a project’s folders, or to a collection of items in a project. Permissions are assigned to
individual users or to groups.

Permissions are inherited from higher levels in the organization structure and can be set at different
levels:

e Organization
e Folder
¢ Project

Once permissions are set on a project, they can be adjusted based on the organization of the project
Explorer Tree.

Note
é’ To be able to access the project, admins must set the permissions before adjusting a set
or component.

Best practices for admins

e Set permissions at the highest level possible to help track existing permissions for a user or group
when many one-off changes are made.

e Use groups instead of individual users to reduce the volume of entries and ensure consistent setup of
users who require similar access.

Permission questions and scenarios

Question | want to provide general user management to my IT group, but how do | restrict access to sensitive projects and project
groups?
Answer Assign the user admin role. This role is limited to viewing and administering project-level permissions on projects only

where they are a project admin.

They can still create users, deactivate existing users, manage their participation in organization groups, and configure
licenses.

Question Can a user admin grant themselves or others the process role or organization admin role? Can they change their own
permissions?

Answer No, only an organization admin can set the org and process roles.

A user admin must be a project admin to adjust permissions to a project. If they remove their own project admin role,
they no longer have access to that project’s permissions.

Question Why aren’t there any options to override permissions on certain users or groups?

Answer This restriction controls visibility and access across projects that might belong to different divisions or contains
sensitive information that you don’t want exposed to all users.

If you want your user admin (user or group) to have access to all projects and project groups, assign the project admin
role at the organization level.

Question Why can’t my user admin see all groups where a user is assigned?

Answer By default, user admins can’t access all projects. The user must be a project admin to access the groups for that
project.

Question Why can’t my user admin manage the membership in an organization group?

Answer User admins can only provide access to projects they can access. To access a project, they must be a member of that

project's organization group.

When they aren't a member of the organization group, the project isn't visible to them, so they can't provide access.

Question Why am | getting “no permissions” error when | try to add a user to a group?
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Answer The group might have permission to access projects that you don'’t.

Question Why can’t my process admin see all projects when assigning relationship rules?

Answer A project might contain sensitive information, so access is restricted. The list of projects shows only projects where
the process admin is also a project admin.
If you want your process admin (user or group) to have access to all projects and project groups, assign the project
admin role at the organization level.

Question Is there a way to limit the item types that a process admin is able to see?

Answer Not at this time. This is a future option under consideration.

Question | just made a user an organization admin. Why can’t the user access certain projects?

Answer The option to override an organization admin’s access is no longer available. To avoid confusion, remove any overrides
on organization admin users/groups that you made in the past.

Question Does the process admin have access to all projects and users?

Answer Process admins only have access to the projects where they are a project admin.
They do have access to users and organization groups for assigned workflow transitions.

Question The @mention feature isn’t working for my users, regardless of project permissions on the Stream page.

Answer The top-level option to create comments has a new configuration that disables this option by default. Context-free
comments (not made from a project or item) created confusion and exposed users and groups to all system users.
The @mention from the Stream page is now limited to include only users and groups that align with the commenter’s
project permissions. This change tightens security and eliminates accidental exposure of users or groups.

Question As a project admin, why can’t | add users to my project if they are in the same system?

Answer Your organization has configured the settings for Jama Connect to restrict project admins’ visibility of users and
groups to only their project’s permissions.
If you want your project admins to have access to all users and groups, your organization admin can configure the
setting on the Organization Detail page.

Question I've given a user with read/write permissions access to a set in my project, but they still can’t see the project.

Answer Permissions must first be set on the project. Once the user has read or read/write permissions to the project, they can
access the set. You can provide or remove permissions to other sets or components in the project to modify access.

Question | removed a user’s access to a component. Why can they still see it?

Answer Users receive the highest level of rights assigned to them. If a user is part of a group that has permissions to a
component, you can change that group’s permissions to exclude the component or remove the user from the group so
the individual entry is now the highest level of rights assigned.

Access permissions
With access permissions, a user can create, read, and edit items.

Levels of access permissions

e Read/Write — A user with these access permissions can read write edit and delete
e Read-only — A user with these permissions can read, but not create or edit items.

How permissions are granted

e Organization admin — Grant access permissions at an organizational level [667].
e Project admin — Grant access permissions at a project level [748].

Relationships and access permissions

Your ability to interact with relationships depends on your access permissions for each of the related
items. Read more about permissions [656].
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Permissions for Permissions for You can...
current item... related item...
Read/Write Read only o View trace relationships.
e View ID and name of related item.
¢ Modify relationships.
o Create new relationships.
o Navigate to related item and clear suspect links.
Read only or No permission o View trace relationships, but not modify or create new relationships.
Read/Write o See ID and name, but not navigate to related item.
Read only Read/Write e View trace relationships.
e Modify relationships.
o Create new relationships.
* Navigate to related items and clear suspect links.
Read/Write Read/Write o Create, modify, and delete relationships.
* Navigate to related items and clear suspect links.
Read only Read only o View trace relationships.

Navigate to related items, but not create or modify relationships between the two

items.

Quick find

Use this handy quick reference table to easily find the Jama Connect feature you need.

4

Note
When viewing Jama Connect on a small screen, icons are displayed as image-only,

without the text.

To find...

Baselines

Explorer Tree

Where?

Select...

Baselines tab
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To find... Where? Select...

Dashboard Upper left corner of the screen Project name

Explorer Tree

Homepage Top header from anywhere in Jama House icon
Connect
Impact Analysis Single Item View Single Item View > Impact analysis

¥ Impact analysis

Image-only version:

Strengthen cons

S ersion :
Impact analysis

L -~
- s

Item versions Single Item View (side toolbar) Versions widget
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To find...
Relationships

Relationship Status
Indicator

Relationship rules

Releases

Review status

Where? Select...
Single Item View (side toolbar) Relationships widget
Side toolbar Relationships widget
In a column in List View (when con-
figured)
Top number = Number of upstream items related to this item.
Bottom number = Number of downstream items.
Single Item View Relationships widget > Relate items in the bottom panel > Show
relationship diagram at the top of the right panel
See Find relationship rules [765].
Top of the left panel Releases
Header Reviews

Grid displays review status at the bottom of each card.

Table displays review status in the Review status column.
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To find... Where? Select...

Suspect links List View Find suspect links [766] from several places in Jama Connect.
Single Item View
Advanced filters

Explorer Tree

Test cases Explorer Tree Find test cases [768] from several places in Jama Connect.
Projects > List View

Projects > Trace View

Test plans Explorer Tree Test Plans tab > <plan name>

Trace View Projects Trace View button

=" Trace view

Find an item in the Explorer Tree

If you navigated to an item from search results, filter results, or tags, you can quickly locate that item in
the Explorer Tree.

Note
é’ If a component, set, or folder contains over 250 items, some items aren't visible in the
Explorer Tree.

To find an item in the Explorer Tree:

1. From Single Item View — Use the breadcrumb links to find a location in your project hierarchy.

2. From Explorer Tree — Navigate through your project and highlight the item you want to view.
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Find moved items
You can use the Activity Stream to find and access recently moved items.

To find moved items:

1. Open the Activity stream [239] and enter moved in the search field.

2. Select View Moved Items.

The results appear in List View.

To see the file path of an item, hover your mouse over the location.
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Find synchronized items
With synchronization, you can maintain a connection between reused items and containers, monitoring

them for differences and updating any that are out of sync.

To find synchronized items:

e Use one of these methods to find synchronized items:
o Explorer Tree — Select an item with a blue dot, which indicates that an item was synchronized.

¢ Sync items window — Use one of these methods to open the Sync items window:
e Select the Project drop-down menu, then select Sync items.

e Select any item in the Explorer Tree, then select View synched items from the menu.
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You can select any item or container on the left to see which other items have the same global
ID.

¢ Single Item View — Select the Synchronized items widget to open the bottom panel, which
displays all items currently synchronized with this item.

You can now perform any of these actions: synchronize items [367], break synchronization [365], or
connect items [369].

Find advanced filters

Once advanced filters are created and saved, you can view them in a list. Select the filter to see the
results, and bookmark it to view it in the list of bookmarked filters.

To find advanced filters:

1. From the project with the existing filters you want to view, select Filters.
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2. Hover your cursor over the filter name to see who created the filter.

The name of the user that created the filter is displayed.

Important
An organization admin can delete a filter when it's no longer needed. Before deleting a

filter, make sure it isn’t shared. When a shared filter is deleted, even if you're not the
creator, it's deleted for everyone.

Find review status
You can quickly find the status of a review in a table or visual layout of a card.

To find the status of a review:

e  From the Jama Connect header, select REVIEWS, then select your preferred view:
o Grid View — Select Grid to display the review status at the bottom of the card.
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¢ Table View — Select Table to display review status in the Review status column.

The review status is displayed at the bottom of the card (Grid View) or in the Review Status column
(Table View).

To edit the review, select the review to open it.

Find relationships
In Single Item View, you can select the Relationships widget to view relationships for a specific item.

To find relationships:

1. When viewing a specific item, select Relationships in the side toolbar, which opens the bottom
panel and displays related items in a table.
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2. To see a different perspective with links to more rapid actions, select Visual Layout in the bottom
panel.

Related items are displayed in the bottom panel, either as a table or as a visual layout.

Find relationship rules

Relationship rules are set up by an organization admin [644], but can be viewed by all users in two
places. View the relationship rule to see valid relationships for your project.

To find relationship rules:

1. InSingle Item View — Select PROJECTS > Project, then select the project with the items you want
to filter. The relationship diagram for the selected project appears in a pop-up window.
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2.  From the dashboard [451] — Select your project in the Explorer Tree. The dashboard tab displays the
relationship diagram when added by a project admin.

The relationship diagram is displayed in a pop-up window (Single Item View) or on the dashboard tab.

Find suspect links
You can use several methods to find and clear suspect links [317].

To find suspect links:

1. For a project — Select Project > Suspect links.
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The Suspect Links window opens where you can view details like ID, Name, and Item Type.

2. Foranitem — Open an item in Single Item View [21] and select Relationships in the side toolbar to
open the bottom panel.

The Suspect column reports if a linked item is suspect due to upstream changes.
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3. In List View or Single Item View — View suspect links in the Relationship Status Indicator [310].
4. Advanced filters — Find suspect links using advanced filters [150].

Once you find the suspect links, you can resolve them.

Find test cases
You can view test cases from several areas of the Ul.

To find a test case:

e Use one of these methods to find test cases:
e Select an item in the Explorer Tree, then select Trace View.

Test cases appear in relationship to items they test, along with associated test runs.

e Select an item in the Explorer Tree, select List View, then filter by item type name.
e Select Test Plans > Test Cases. Test cases appear in the test cases section of the plan.
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Once you locate your test case, you can perform any of the following actions: add test cases to a
plan [414], import test cases [400], or view and edit test case details [402].

Find test plans

You can view test plans on the Test Plans tab. This is the only place they appear in the Ul.

Although test plans are items, they aren't visible in the Explorer Tree. They are only visible on the Test
Plans tab. You can, however, find them with an advanced filter [150].

To find a test plan:

1. At the top of the Explorer Tree, select the Test Plans tab.

2. Select the plan you want to use to view details [415] of that plan.
3.  View and comment on test plans in review [417], as needed.

Any changes you made to the test plan are saved.

Tip
% Although test plans don't appear in the Explorer Tree,
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Best practices and guardrails

Best practices and guardrails provide proven guidance that helps you get the most out of your experi-
ence with the Jama Connect application.

Change/use
this...

For this result...

Explorer Tree

When your project has a large number of items, improve performance by changing the Explorer Tree settings

settings to only show folders and components [29].

Filters Filters that run against all projects find and display results for all items in your Jama Connect application. Filters
like these can return large data sets and degrade performance. To assure quality performance, make filters
more specific to return only the results you need.

Items and at- When working with more than 1,000 items per folder, hide items in the Explorer Tree [29] and work with them

tachments in List View [16] in the center panel. To move multiple items, multi-select in List View and drag them to their
new location in the Explorer Tree.

Files larger than 25 MB aren't indexed so their content isn't searchable.
Indexed file types: PDF, DOC, DOCX, PPT, PPTX, TXT, RTF
Non-indexed file types: XLSX, XLS, XML, HTML, HTM

Item field con- Limit the content of item fields to fewer than 10,000 characters (2,000 words). When you compare review

tent versions, the applications might skip fields with lengthy content.

Reuse and syn-
chronization

Reuse and synchronization of hundreds of items can affect system performance. When you try to reuse and
synchronize hundreds of items, a warning appears that performance is likely to be impacted.

To reuse and synchronize hundreds of items, rim tje reuse and synchronization options in smaller batches or
start the process during off hours when demand for resources is less.

Review items

Limit your reviews to fewer than 250 items. This threshold is in place to mitigate any performance issues from
a review with an excessive number of items.

Keyboard shortcuts

Use the following shortcuts to navigate throughout the Jama Connect application.

Note
é’ In general, Mac users can substitute the Cmd key for the Ctrl key and the Option key
for the Alt key. Depending on your keyboard, you might also have to press the Fn key.

Table 4. General navigation

Key command

Function

Esc Close an open window.

Tab Navigate from field to field in List View or Single Item View.

Enter Selects a highlighted button or open a selected item.

Arrow keys Scroll through items, tags, releases, baselines, or test plans in the left panel.

Table 5. Inline editing in List View

Key command Function

Esc Cancel unsaved changes.

Tab Move cursor between editable fields.

Enter Save changes and move to the next item in the list.
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Table 6. Rich text accessibility

Key command Function
Alt+0 Open window with accessibility instructions.
Alt + F10 Enter the toolbar or the tab list of the open window.

Ctrl + right-click (Windows)

control + command + click (Mac)

Access native browser spellcheck menu.

Tab Move to the right between groups of toolbar buttons.
Shift + tab Move to the left between groups of toolbar buttons.
Right arrow Move to the next button to the right.

Left arrow Move to the next button to the left.

Enter Activate a selected button or menu option.

Table 7. Rich text navigation

Key command Function

Home Jump to the beginning of the line.

Ctrl + Home Jump to the beginning of the document.

End Jump to the end of the line.

Ctrl + End Jump to the end of the document.

PgDn Scroll down the document by the length of the editing area.
PgUp Scroll up the document by the length of the editing area.
Ctrl +L Open the link window.

Table 8. Rich text writing and formatting

Key command Function
Shift + Enter Add a line break.
Ctrl +Z Undo the last change.
Ctrl +Y Redo the last change.
Ctri+C Copy a text fragment to the clipboard.

Ctrl + V, Shift + Insert

Paste a text fragment from the clipboard.

Ctrl + X, Shift + Del

Cut a text fragment to the clipboard.

Ctrl+B Apply or remove bold formatting.

Ctrl + 1 Apply or remove italic formatting.

Ctrl+U Apply or remove underline.

Ctrl + A Select all field contents.

Shift + Arrow Select text letter by letter.

Ctrl + Shift + Arrow Select text word by word.

Shift + End Select a text fragment from the cursor to the end of the line.

Shift + Home Select a text fragment from the beginning of the line to the cursor.

Ctrl + Shift + End

Select a text fragment from the cursor to the end of the document.

Ctrl + Shift + Home

Select a text fragment from the beginning of the document to the cursor.

Shift + PgDn Select a text fragment of approximately the length of the editing area, starting from the cursor and going
down.
Shift + PgUp Select a text fragment of approximately the length of the editing area, starting from the cursor and going

up.

Table 9. Review navigation

Key command

Tab Move from one highlighted comment to another.

Function
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Table 10. Test case authoring

Key command Function
Tab + Shift Move cursor between editable fields and row actions.
Esc Move focus from cell to row, row to table.
arrow-up and arrow-down When focus is placed on row, navigate up and down through table rows.

When focus is placed in cell, navigate through lines of text.

Enter When focus is placed in cell, enter a line return when rich text is enabled.
When focus is placed on row action, the action is performed.

When focus is placed on Add step, add a new step and move cursor to the first cell of new row.

Application performance testing

Jama Software runs daily performance testing of Jama Connect. The frequency depends on your envi-
ronment.

Self-hosted performance test results
Self-hosted environment — Daily performance testing

These performance test results indicate a large self-hosted environment with 1,250 concurrent users.

e All requests were serviced during the testing period of 90 minutes with no un-intentional errors.
e 82% of requests were serviced in under 1 second.
¢ Longer running operations (like bulk updates and copies) were serviced within tolerances.
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e Performance tests consider different user personas commonly found in our customer base, with the
most common and active users being Staff Engineers and Testers (Creators [749]).
¢ The total of unique, concurrent users spread across the personas was 1,250.

e This graph shows the distribution of serviced requests during the test with response times expressed
in milliseconds (ms).

e 79% of requests were serviced in under 305ms with 99.5% of requests serviced in the consumer web
target of under 3 seconds.

Getting help
Do you have a question that's not covered in the Jama Connect Help?

Visit our Support Community where you can find answers, start discussions, share ideas, and access
developer documentation.

As part of your contract, your organization can get additional help from our support staff. Your organiza-
tion's named support contact can submit tickets directly to our support staff.

If you have a large team to train quickly, need to integrate Jama Connect with other tools, or want to go
beyond the basics, Jama Software offers training courses and other professional services to help you be
more successful.

e Education and Tutorials
e How-To Videos and other Resources
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e Business Services

Let us know how we can help you.

Widgets

A widget is small embedded application that adds functionality to the dashboard or to item types.

This table includes all widget types, their definitions, and how they are used.

Widget
Activities*

A

o

Attachments*

Change Request*

W

J

Comments

Connected Users

29"

|

Items to be
changed

Y

Links*

LINKS:
© Add link...

Relationships*
T

Review comments

Definition

Lists all the changes users made to an item: adding, relating, editing, deleting, and restoring.
Activities are listed in chronological order.

Users can search their activity history and filter on activity types.

Shows external files attached to an item: images, documents, and spreadsheets.

If your organization has a document management system, link from a Jama Connect item to the file in your
document management system, rather than duplicating files in Jama Connect.

Indicates that the item is linked to one or more change requests.

Example: If the icon includes a number, the item is linked to that many change requests and is automatically
added if the item is linked to a change request.

Indicates that a user made comments on the item.

Generally used for day-to-day collaboration with colleagues and tracking questions, decisions, and issues
about items. These comments are only visible to users with permission to see the Jama Connect project.
Comments from reviews are separate and not included here.

Enabled by default.

Shows a creator, editor, or someone who has commented, subscribed, or is @mentioned in an item. Also
shows users on upstream or downstream traced items.

Enabled by default.

Indicates when a user links to requirements, tests, and other items that require a change.

Visible only on item types where the Change Request widget is enabled.

Adds links to an item by associating a link with that item or embedding a link in a rich text field within the
item.

Hyperlinks can also be added in any rich text field.

Shows items that are related for traceability.

Example: A requirement might be linked to upstream customer needs multiple downstream test cases.

Shows comments for reviews where this option is enabled.
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Widget

Sub items

|

Synchronized
Items*

Z

|

Tags*

TAGS:
© Add tag...

Test Runs

B

J

Versions*

|

Definition

Shows the number of items directly under a currently viewed item in the Explorer Tree.

Example: The "System" component has five sub items:

Monitors differences between reused items and containers.
The number of items that an item is synchronized with is displayed in the blue circle.

Example: If a source item version changes, all reused items are flagged as "out of sync" so you can compare
differences.

Labels items so you can find similar items quickly.
Any user with create and edit permissions can add a new tag.

Users with project admin permissions can edit or delete existing tags.

Shows the results from a Test Plan and Test Cycle.
Jama Connect allows one Test Case to many Test Run results.
The number indicates the number of active Test Runs.

Visible only on item types where the "Use as" setting is Test Case:

Shows the number of versions.

A new version is created each time you change an item. You can compare versions or revert to a past item.

* Widget is only visible on item types where an organization admin has enabled [691] it.

Best practices for widges
At minimum, enable these widgets:

Activities

Versions

Glossary

Relationships
Synchronized items

Term

Definition

actions

A tag that identifies a comment in a stream conversation as one of three types: decision, question, or issue.

approver

A role in the review process with the ability to approve or reject an item for correctness or completeness.

attachment

External files such as images, documents, and spreadsheets that can be attached to an item.
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Term

Definition

baseline

A fixed reference point that captures the state of selected items and their relationships within a project at a
specific point in time.

Baseline Com-
pared to Current
Report

A report that displays a side-by-side comparison of items and relationships in a baseline and their current
versions.

Baseline Compar-
ison Report

A report that displays a side-by-side comparison of items and relationships in two baselines.

baseline ID

A unique ID assigned to each baseline. Baseline IDs are automatically generated and numbered sequentially
in the order they were created. They can't be edited or duplicated.

batch transitions

A workflow feature that allows you to select multiple items of the same item type and transition them to a
different workflow status.

Bidirectional
Traceability Re-
port

A report that displays upstream and downstream relationships for a selected container of items.

bookmark

A link to content you view frequently at the top of your homepage.

bottom panel

A panel that slides in from the bottom of the center panel to give more detail on items such as relationships,
the activity stream, version history, and merged items.

change request

A formal proposal that identifies changes to items in a specific product or system.

child item

An item that falls hierarchically below a parent item of the same item type.

collaborator li-

A named or floating license that gives read-only privileges to users needing visibility into a project, but not

cense editing rights. These users can view items, provide comments, participate in (but not create) reviews, execute
test runs, and log defects.
comment A user-created message found in the stream or in reviews.

Compare View

A side-by-side view of content that helps you compare differences between versions of an item.

component A structural container used to organize a project into more manageable pieces.

container A Jama Connect unit for organizing document items. Containers include three types: components, sets, and
folders.

coverage The extent to which items are validated by another item.

Coverage Explor-
er

A tool to view or export a set of items, including related items that provide needed coverage.

creator license

A named or floating license that gives full read and edit rights, and full access to reviews, for those who are
active users managing items and projects on a daily basis.

dashboard A visual display of Jama Connect data. It can be configured to show key metrics about your project, to
highlight which areas might need attention.

dashboard widget A small embedded application that compiles and displays data from a single project or filter.

downstream A way to identify a relationship between items. If one item is downstream from another, it might be impacted

by that item.

electronic signa-
ture

A digital process that indicates a user’s acceptance of a document, item, or process. In Jama Connect,
electronic signatures are used to approve a review or baselines.

Explorer Tree

A method of structurally and visually organizing the sets, components, folders, and items in your project
hierarchy.

export An action that extracts data from Jama Connect to a Word or Excel document.

field A fixed location in a unit of data such as a record or computer instruction that has a specific purpose and
usually a fixed size.

filter A method to display subset of items, users, or reviews from a larger collection. These are available as simple
or advanced filters.

folder A type of container used to organize your work. Jama Connect uses item folders, baseline folders, and project
folders.

global ID A unique identifier of items connected through synchronization.

homepage The start page that is displayed when Jama Connect first opens. It can show links to your most relevant

content, like bookmarks, recent views, open reviews, and stream comments or actions.

Impact Analysis

In requirements management, a method to show the implications of a proposed change to all upstream and
downstream related items.

Import

An action that incorporates data into Jama Connect from an external source such as Microsoft Word, Excel,
and IBM doors.

Import Relation-
ships Plugin

A tool that helps you batch-create links between existing items in the application.

index

A list of information about each item that ensures proper display, sorting, filtering, and searching of data.
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Term

Definition

item

The building blocks of Jama Connect. Projects are made up of items. Items are made up of fields. Items can
be containers (sets, folders, components or parent items) or documents (features, requirements, test cases,
tasks, defects).

item counter

A tool that automatically assigns numbers to items as part of their ID.

item ID

Unique identifiers for each item that, unlike a Global IDs, can't be duplicated.

Items in a Set Re-
port

A report that displays a tabular list of items in a set.

item types The templates for sets used within each project.

item widget A graphical element of the Ul that adds functionality to an item type, for example, adding links, attachments,
relationships, and tags.

left panel The area of the Ul where you can find and organize your data. It contains the Explorer Tree, advanced filters,
releases, baselines, tests, and tags.

license The document that gives permission to an organization to install and run the Jama Connect application.

license type The possible permissions and roles that can be granted to a user (for example, creator, stakeholder, test
runner, and reviewer).

List View A way of viewing data from multiple items in a table with a different field in each column so you can sort,
select, and compare items at a glance.

lock A method to make items read-only. Locks can be set automatically or manually.

moderator A user who creates and manages a review. Moderators must have a creator license type.

notifications Optional emails sent to groups or individuals alert you when certain changes are made.

Office Templates Word documents and Excel spreadsheets that allow you to add formatting to your exports.

organization

A representation of the entire group of users who have access to your instance of Jama Connect as well as all
the projects, items, and data.

organization ad-
min

A role with administrative control of the Jama Connect application. An organization might have one or more
organization administrators.

permissions A way of allowing users the ability to access, modify, and delete items or perform other specific tasks.
pick list A set of defined values that can be entered into a field.
project A way of organizing your data in Jama Connect. A project is made up of items, filters, baselines, releases,

reports, and tests.

project admin

A role that has the necessary permissions to manage a particular project.

project key A unique identifier, automatically created with each project, which makes up the first part of each item's
Unique ID.

project workflow A well-defined sequence of the tasks and activities required to complete a specific project. In Jama Connect,
you set up a workflow in Projects, so that users can move project items along a similar path as they progress.

relationship A way of linking items together that can help you assess the impact an item or group of items can have on

other items.

Relationship Sta-
tus Indicator

A tool that shows the number of relationships an item has, as well as whether those relationships meet the
project's relationship rules.

release

A group of items that are developed together and mapped to a specific completion date.

Release Status
Report

A report that displays the current state of the items within a particular release.

Replicated snap-
shot

A backup of the Admin Console settings, Docker containers, and the Jama Connect license.

report

A document that helps you analyze the current status and progress in your work. Reports can include graphs,
tabular data, metrics, and other roll-ups.

required fields

String, text, or date fields that are configured so that the user must enter data into the field before saving an
item.

REST API An application program interface to assist developers in a clean, straightforward integration with the applica-
tion.

reuse The duplication of an item within a project or to a different project where it can be modified without
affecting the original item.

reuse admin A role with the permissions needed to manage reuse.

review A process that helps teams, stakeholders, and customers collaborate in Jama Connect discuss, review, revise

and approve information.

review admin

A role with the permissions needed to manage reviews.

Review Center
Stats Report

A report that displays the progress of a specific review.
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reviewer

A role that participates in a review to provide feedback.

reviewer license

A named or floating license that grants permission to participate in reviews, act as approvers, moderators,
or review administrators, and respond to comments in the stream. A reviewer license doesn't allow users to
initiate reviews or access items in the core project.

Reviews work-
flow

A tool for moderators to update the status of reviewed items. When configured, the reviews workflow
automatically updates field values for review items of the same type and review status.

right panel

A panel that slides out to provide more specific information about the data you selected.

search

A function or process of finding letters, words, files, or other data in an index of all database fields, as well as
text within Word, PDF, or text attachments, to display a list of resulting items.

signature mean-
ing

A system setting that states the meaning of the electronic signature. It's required for FDA 21 CFR Part 11
compliance. In Jama Connect, it defaults to "l approve this review" and can't be modified. The signature
meaning is visible in review invitations.

signer role A role for an approver in the review process. Approval is provided with an electronic signature. Signer roles
are created from user group names.

role A set of permissions granted to a user so that they can perform a particular job.

set A structural container with configurable access rights, used to group items of the same type. It can also
contain folders, text Items, child text items and child items of the same type.

set key The key that identifies item sets within your project. The key doesn’t have to be unique across sets or

projects.

stakeholder li-
cense

A named license that gives read-only privileges to those who need visibility into a project, but don’t need
editing rights. Stakeholders can view items, provide comments, and act as reviewers.

Single Item View

A way to display the information about one item in the center panel.

stream

A collection of the most recent comments and activities (adds, deletes, or edits).

suspect link

A link on an item that means the item might no longer be correct or complete, because changes were made
to items upstream.

synchronization

A method for monitoring for differences between reused items and containers. When differences exist, users
can update the data for those items or containers.

system admin

A role that handles the overall installation, setup, and configuration of Jama Connect. The system admin
doesn't have access to projects, doesn't require a special license, and is the only user who can log in to the
system as "root user."

system field

An automatically created field such as name, test step, test case status, and review status, which provides
system functionality and can't be disabled or deleted.

system health re-
port

An optional feature that notifies administrators of areas of the application that can affect performance and
user experience.

tag

A label that you can attach to items to help identify items that have something in common.

Task List with Es-
timates Report

A report that displays all item types and sums their estimates if applicable.

temporary license

A 30-day full creator license, automatically granted to a non-licensed individual whose email address is
used to invite them to a review or to comment in the stream. It has no default permissions except for the
discussion thread or review to which they were invited, although an organization administrator can add
permissions.

test case

Items that contain the tests needed to validate or verify product features or systems.

test case status

An automatically calculated status that indicates the state of the last edited test run associated with that test
case.

test cycle Groups of test cases converted into a series of test runs that are ready for execution.
test group A way to combine and label similar tests in a test plan.
test plan An item that documents the overall strategy for validating or verifying that a product or system meets its

design specifications and requirements.

Test Plan Detail
Report

A report that displays the details of a test plan.

test run

An item used to record results for a test case you ran against your product.

test runner li-
cense

A named license that includes basic permissions to read and review, as well as the additional ability to create
test plans and defects, and execute test runs.

test run status

An indicator of the current state of a test run, which is used in calculating test case status.

test step A distinct step used to run a test.

text item A specific and unique type of item that lives outside the boundary of other item types and doesn’t function
as a full feature. Unlike other item types, text items can be used as part of a mixed item set.

thread dump A snapshot of the state of your application's processes at a point in time.
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Term Definition

toolbar The part of the Ul that is located at the top of the center panel. From there you can switch views, filter items,
configure fields, and export your data.

traceability A method for showing the relationship between items that depend upon and define each other. You can
always travel upstream or downstream to get more context and trace product definition from high level
requirements all the way through final tests.

Trace Relation- A report that displays items with their downstream relationships.

ships Report

Trace View A way of displaying related upstream and downstream items, missing relationships, and item details in
context of their relationship.

trial license A 30-day license granted to new users who sign up for a trial of Jama Connect on jamasoftware.com.

upstream A way to identify a relationship between items. If one item is upstream from another, it might impact that
item.

unique ID An ID that identifies an item with a project key, set key, and a set counter. A unique ID (also called item ID)
remains the same even if the item name or content is changed. It can't be edited or duplicated.

user A basic role associated with a unique Jama Connect login. Each user has their own license type, groups, and
permissions.

user group A way to manage notifications, permissions, access, and actions for multiple users at a time.

User Import Plu- A tool that allows organization admins to add multiple users at once by importing a spreadsheet.

gin

User List Report A report that displays a list of all the active and inactive users associated with the organization.

version One of a sequence of copies of an item, each incorporating new modifications. There are versions of reviews
and versions of items.

widget A small embedded application that adds functionality to the dashboard or item types.

workflow An automated set of transitions from one status to another, over the course of an item's lifespan.

Jama Connect Interchange (JCI)

Jama Connect Interchange™ is an integration platform that seamlessly integrates Jama Connect with
other best of breed tools like Atlassian Jira and Microsoft Excel.

Unlike other integration tools in the marketplace, JCl is built, supported, and continually enhanced by
dedicated teams at Jama Software. This means JCl is deeply integrated with Jama Connect configura-
tions and workflows, providing you with a smart and seamless sync while you continue to work in your
tool of choice.

JClI supports both cloud-based and self-hosted instances of Jama Connect.

To access the JCl library of resources, including release notes and a dedicated user guide, visit the JCI
sub-community on the Jama Software Community site. To learn about the key benefits and common use
case, see the Jama Connect Interchange Datasheet and Jama Connect Interchange User Guide.

To find out whether JCI would be a good fit for your organization, contact your Customer Success
Manager.
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Jama Connect MCP™

Jama Connect MCP™

Jama Connect Model Context Protocol (MCP) allows you to connect approved MCP-compatible clients,
such as Integrative Development Environment (IDE) or Command-Line Interface (CLI) tools, to Jama
Connect to securely retrieve information and execute supported actions through controlled tool calls.

The process of setting up Jama Connect MCP includes reviewing the prerequisites and completing the
configuration steps. It is also helpful to review supported operations, validated workflows, and known
limitations here. For more information, see Jama Connect MCP.

Jama Connect MCP is a separate-purchase add-on for Jama Connect cloud and self-hosted customers.
Contact your Customer Success Manager for more information.
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Upgrading from Jama Connect traditional to KOTS

Jama Connect is a Linux-based application that runs on Docker containers and uses Replicated software
to "orchestrate" deploying applications. The current version of Jama Connect uses Replicated KOTS,
while older versions use traditional Replicated software. The process of upgrading Jama Connect from
traditional to KOTS includes planning, preparing your environment, and installing the software.

Upgrade scenarios

Upgrade with new servers (recommended) — This recommended scenario uses new application and
database servers to support your KOTS Replicated environment. It requires you to:

e Copy targeted data from the existing application server into the new environment.
e Restore a backup of your current database to the new database server.

While this scenario results in the temporary overhead of supporting two separate environments, it
comes with less risk of unwanted downtime.

Upgrade with existing servers — This scenario reuses the current application and database servers from
your traditional Replicated environment. This scenario:

e Requires you to uninstall elements of the traditional Replicated platform before you can install the
KOTS Replicated platform.

¢ Can cause significant maintenance downtime. Make sure to inform your users of this maintenance
window. Also have an emergency plan in place to revert back to the traditional Replicated environment
if necessary.

Before you upgrade

e Contact your Customer Success Manager to request a KOTS internet or airgap license.

e Choose the upgrade scenario that works best for your organization. Whichever scenario you choose,
expect production downtime while the new instance is configured. Best to upgrade during off hours.

e Follow the instructions in the planning [782] and preparing [789] sections to ensure a successful
upgrade.

Components and what they do

Replicated KOTS — A container-based platform for easily deploying cloud native applications inside cus-
tomers' environments, providing greater security and control. The KOTS Admin Console is the interface

for installing, configuring, and administering the KOTS deployment of the Jama Connect application and
required services. See https:/www.replicated.com/ for details.

Docker containers — A standalone executable package of software that includes code, runtime, system
tools, system libraries, and settings. See https:/www.docker.com/resources/what-container/ for details.

Jama Connect KOTS license — Contact your Customer Success Manager to request a KOTS license. Save
the license file to a location you can access easily; you will need it when installing Jama Connect.

For more information about KOTS, see https:/www.replicated.com/blog/announcing-kots/

Note

y Replicated KOTS is the only supported platform for Jama Connect 9.0 and later. To
upgrade Jama Connect traditional to KOTS, see Upgrade from Jama Connect traditional
to KOTS workflow [782].

781


https://www.replicated.com/
https://www.docker.com/resources/what-container/
https://www.replicated.com/blog/announcing-kots/

Upgrading from Jama Connect traditional to KOTS

Workflow for upgrading from traditional to KOTS

Whether your environment is internet-enabled or airgapped, the upgrade process consists of three
stages: planning, preparation, and installation.

Review the system and server requirements for your environment, then follow the instructions for each
stage.

Plan Prepare Install

Request a KOTS license Back up all your data Install KOTS software

Run the KOTS preflight installation Prepare application and database Provision your tenant in Jama
checks servers Connect KOTS

Preserve data assets and Install and configure database Create a Replicated Snapshot
tenant.properties file Configure memory settings for

Review system requirements Elasticsearch

Calculate resource sizing and
requirements for application and
database servers

Record existing settings for
traditional Admin Console

For this component... Follow these instructions
MySQL Install and configure MySQL [794]
Microsoft SQL Install and configure Microsoft SQL Server [795]
Internet Install KOTS software (internet) [798]
Airgap Install KOTS software (airgap) [800]
Local OpenSearch Included by default
Remote OpenSearch Configure dedicated OpenSearch nodes [797]

Planning your upgrade to KOTS

Before you upgrade from traditional to KOTS, make sure you have everything you need according to
your type of installation.

Important considerations

¢ We recommend that you use a new application server and database server. Once the KOTS Replicated
environment is installed successfully, the traditional Replicated environment can be removed.
¢ |f you plan to reuse the existing application server and database server when upgrading:
e Make sure you pay careful attention to resource sizing. System requirements for the KOTS Replica-
ted platform are different from the traditional Replicated platform.
o This scenario requires that you uninstall the traditional Replicated platform, resulting in potential
unwanted downtime.
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What you need

All envi- e The KOTS license file (submit a request to your Customer Success Manager).
ronments o Run the KOTS preflight installation checks [783] to ensure servers and settings are configured correctly.

e Record the size of existing data assets and database for application and database server requirements and resource
sizing. To check the current assets size, run the following command from the application server command line:
sudo du -shc /data/contour/*

e Record the existing settings from your traditional Replicated Admin Console. You can find the settings in the
support bundle (under /daemon/replicated/app-config.json). These settings are used to configure Jama Connect
after the upgrade to Jama Connect KOTS.

o An application server with the necessary preparation [787] and sizing requirements [787].

o A database server with the necessary preparation [793].

e Supported [785] 64-bit Linux distribution with a kernel of:

e 4.x or greater (recommended)
e 3.10 (minimum)
Airgap e The KOTS airgap license file (submit a request to your Customer Success Manager).
environ- e PDF of this installation guide for the version of Jama Connect you are installing.
ment
Important
If you lose the URL and password, contact Support to generate new ones.
Optional o TLS certificate and private key to secure the Admin Console and Jama Connect application.

Run the KOTS preflight installation checks

Whether your environment is internet-enabled or airgapped, run the KOTS preflight installation checks
to ensure your system is ready for upgrade.

Important considerations

¢ The preflight checks verify that all application server and database requirements are met to help avoid
installation and upgrade issues. When the results display green checkmarks for each test, you can
begin the installation process.

¢ Version three of the database script includes logic to verify the character set and collation settings
of the MySQL database. Running the script now requires additional arguments: tenant database, port
number, user, and password.
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To run preflight checks for internet-enabled environments:

1.

w

Run the command on your application server:

curl -s https://raw.githubusercontent.com/JamaSoftware/kots-preflights/main/v3/
non-airgap/\

application-server.sh | sudo bash

Run the command on your database server:

curl -s https://raw.githubusercontent.com/JamaSoftware/kots-preflights/main/v3/
non-airgap/\

database-server.sh -t <tenant _db> -i <host_i p> -0 <port_nunt -u <db_user> -p
<db_passwor d>] sudo bash

Press S to save the file, then review the results.

Submit an Installation Service Request Form (guided for Self-Hosted) and include your preflight
check results to help our technical services team support your installation needs. Include any
qguestions or concerns about the results in the ticket.

Your system is ready for upgrade.

To run preflight checks for airgapped environments:
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1. From an internet-enabled server
a. Download the preflight script files for the application server:

curl https://raw.githubusercontent.com/JamaSoftware/kots-preflights/\
main/v2/airgap/linux/airgap-host-preflight_linux.tar.gz --output airgap-
host-preflight_linux.tar.gz

curl https://raw.githubusercontent.com/JamaSoftware/kots-preflights/\
main/v2/airgap/linux/airgap-application-server_linux.sh --output airgap-
application-server_linux.sh

b. Download the preflight script files for the database server:

curl https://raw.githubusercontent.com/JamaSoftware/kots-preflights/\
main/v3/airgap/linux/airgap-host-preflight_linux.tar.gz --output airgap-
host-preflight_linux.tar.gz

curl https://raw.githubusercontent.com/JamaSoftware/kots-preflights/\
main/v3/airgap/linux/airgap-application-server_linux.sh --output airgap-
application-server_linux.sh

2. From your application server

a. Save both application server script files to a directory on the airgapped application server that
will host your KOTS installation, then configure the file permissions for the shell script:

chmod +x <path to the files>/airgap-application-server_linux.sh
b. Run the preflight installation check:

sudo bash <path to the files>/airgap-database-server_linux.sh -t
<t enant _db> -i <host _i p> -0 <port_nun> -u <db_user> -p <db_password>

c. Press S to save the file, then review the results.
3. From your database server

a. Save both database server script files to a directory on the airgapped Jama Connect database
server, then configure the file permissions for the shell script:

chmod +x <path to the files>/airgap-database-server_linux.sh
b. Run the preflight installation check:

sudo bash <path to the files>/airgap-database-server_linux.sh
c. Press S to save the file, then review the results.

4. Submit an Installation Service Request Form (guided for Self-Hosted) and include your preflight
check results to help our technical services team support your installation needs. Include any
guestions or concerns about the results in the ticket.

Your system is ready for upgrade.

System requirements and supported software (KOTS)

Make sure that your environment conforms to all requirements and recommendations before installing
Jama Connect software.

After reviewing the information on this page, see "Things to do before installation" in the Jama Connect
9.35.x User Guide.

Important

To use Ubuntu 22.04, you must update the memory or OpenSearch fails. From the
KOTS Admin Console, adjust the memory settings so that Maximum Memory is 6G and
Maximum Memory for Container is 8G.
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Application server

Use the information in this table for the server that runs the Jama Connect application. For details on
sizing your application server to your environment, see "Resource sizing for application server" in the
Jama Connect 9.35.x User Guide.

Component
Minimum Recommended
e 8CPU e 16 CPU
e 32 GBRAM * 64 GB RAM
e 200 GB storage per node e 256 GB storage
o Every node has the same storage space o Every node has the same storage space

Operating system

e Recommended — Ubuntu 22.04* and 24.04
e Red Hat 9.6 — Supported only when the RHEL Container Tools are not installed.

*To use Ubuntu 22.04, you must update the memory or OpenSearch fails. From the KOTS Admin Console, adjust the memory settings
so that Maximum Memory is 6G and Maximum Memory for Container is 8G.

Software installed with Jama Connect

e KOTS
e Containerd

Musts

e Dedicated server — Is running only Jama Connect
o Accessible by admin with permissions
e Uses only supported software and environments

Database server

Use the information in this table for the server that runs your database. For details on sizing your
database server to your environment, see "Resource sizing for database server" in the Jama Connect User
Guide.

Component
Minimum Recommended
e 4-8CPU e 8CPU
e 16-24 GB RAM e 24 GB RAM
e Dedicated volumes for data

Database software

e MySQL 8.4.x
o Microsoft SQL Server 2022

Musts

e Database is hosted on a server separate from the Jama Connect application.
e Database server can host other databases, but no other applications.

o Accessible by admin with permissions.

e Uses only supported software and environments.

e Databases must be able to accept a minimum of 300 concurrent connections.

Not supported

e Azure database

e MariaDB

e Custom configurations of Jama Connect databases (for example, query optimization and additional indexes that aren’t shipped with
Jama Connect)

Supported software
Make sure your environment uses only supported software.
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Component

Browsers Important

Browser zoom is supported only at 100%. Use of browser exten-

* Edge Chromium sions/add-ons or enabling Compatibility View is not supported while

e Firefox using Jama Connect.
e Google Chrome*
o Safari* Tip

To prevent session issues, use the application in a single browser

*Versions released over the past 12 months are supported. .
window.

Word processor and spreadsheet programs Office 365 is used for exports and reports.

o Office 365 for Mac
o Office 365 for Windows

MathType Equations Editor

® 7.7.1.6472
® 7.6.1.6408

Authentication

Jama Connect supports the following authentication options.

e Crowd 6.2.5
e LDAP
e SAML

Application server requirements (upgrading traditional to KOTS)
To install and run Jama Connect successfully, your application server must meet these requirements.

Requirement Notes

A dedicated application server Jama Connect is the only application running on the application server. External services can affect
stability of the application, for example by consuming memory resources.

Sufficient storage, CPU, and To estimate the size of and required resources for your application server, see Resource sizing for
memory for optimal perform- application server [787].
ance
Accessible by an admin with An admin must have proper permissions to maintain the application, perform upgrades, and access
permissions the server for regular maintenance.
Uses compatible software and Verify that you're using supported software and environments [787] compatible with the most
environments recent self-hosted release.

Resource sizing for application server (upgrading traditional to KOTS)
For optimal performance, estimate your application server needs before you install Jama Connect.

Requirements

e Each node must have a minimum volume of 200 GB. Increase this size based on the size of the assets
that you plan to save in Jama Connect. We recommend that every node has the same storage space.

e KOTS must be up and running before you configure the application settings in the KOTS Admin
Console.

Important

To avoid performance issues, use the recommended requirements for horizontal scaling,
rather than minimum requirements.
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Use the following tables to help determine resources for the primary node of your application server.

Minimum size (AWS instance sizing = m5.2xlarge)

CPU RAM

CPU + memory settings

CPU + memory setting with horizontal scaling jamacores

8 32GB

N/A jamacore application settings:

e Maximum CPU: 1000m

o Maximum memory: 2 G

e Maximum memory per container: 3 G
e Number of ingress nodes 2

Recommended size (AWS instance size = m5.4xlarge)

CPU RAM

CPU + memory settings

CPU + memory setting with horizontal scaling jama-
cores

16 64 GB

Supports:

e 1,250 users with a ramp-up time of 30 sec-
onds

Supports:

e 1,250 users with a ramp-up time of 10 seconds
e 2500 users with a ramp-up time of 30 seconds

jamacore application settings:

e Maximum CPU: 12000m
e Maximum memory: 48 G
e Maximum memory for container: 60 G

jamacore application settings:

e Maximum CPU: 3000m

e Maximum memory: 12 G

e Maximum memory for container: 15 G
e Number of ingress nodes: 2

OpenSearch settings:

e Maximum CPU: 8000m
o Maximum memory: 8 G
e Maximum memory for container: 10 G

OpenSearch settings:

e Maximum CPU: 8000m
e Maximum memory: 8 G
e Maximum memory for container: 10 G

Diff Service settings:

e Maximum memory: 2 G

Diff Service settings:

e Maximum memory: 2 G

Use the following table to help determine resources for the secondary node of your application server.

Secondary nodes dedicated to OpenSearch: Recommended size (AWS instance size = m5.2xlarge)

CPU RAM CPU + memory settings
8 32GB Supports:
e 2,500 users with a ramp-up time of 10 seconds
OpenSearch settings:
e Maximum CPU: 8000m
o Maximum memory: 8 G
e Maximum memory for container: 10 G
Tip

H
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Database server requirements (upgrading traditional to KOTS)

The database must be hosted on a server separate from the Jama Connect application. This server
can host other databases, but we don’t support running other applications on the same server as the
database.

Supported databases

e MySQL 8.4.x (recommended)
e Microsoft SQL Server 2022

What is not supported

e Azure database
e MariaDB

e Custom configurations of Jama Connect databases. Customizations such as query optimization and
additional indexes that aren’t shipped with Jama Connect aren’t supported.

Resource sizing for database server (upgrading traditional to KOTS)
For optimal performance, estimate your database server needs before you install Jama Connect.

Use the information in this table to determine resources needed for your database server.

Database server Small Medium Large Enterprise
Active items in system < 600,000 < 2 million 2-4 million 4 million+
Active projects <100 <500 < 1,000 1,000+
Concurrent users <50 <500 < 1,000 1,000+
CPU 4 8 16 Contact Support
Total systems of RAM 16 GB 32 GB 64 GB Contact Support

If your usage approaches the Enterprise threshold, contact Support for customized recommendations
and advanced, multi-server setup.

% Tip

Once you're up and running, you can monitor usage and adjust your settings as needed.

Important considerations

¢ Total system RAM for your database server can vary if you're using memory intensive workflows such
as reuse, exporting, moving items, integrations, and batch updates. Database sizing is based on your
usage patterns and platform. You must have a minimum of 4-8 cores and 16-24 GB of memory.
Consult with your database admin when determining database size.

e The memory allocation allows for minimum headroom. If you need to run additional software for mon-
itoring and analysis, consider the system requirements for that software. Configure dynamic memory
settings as needed in the Admin Console.

Things to do before upgrading from traditional to KOTS

Whether your environment is internet-enabled or airgap, make sure that your application server and
database server are ready before upgrading Jama Connect from traditional to KOTS.
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Important considerations and requirements

e If using the existing application server and database server, you must back up the Jama Connect
database and all project assets before proceeding with the upgrade.

e Recommended — Back up or create a snapshot of all relevant application servers in case you need to
revert to the traditional Replicated environment.

e Record existing Admin Console settings before you uninstall the traditional Replicated platform ele-
ments. These settings are used when configuring new settings for the KOTS environment.

Perform these tasks before you upgrade to KOTS

e Preserve data assets [790]

e Prepare your application server [790]

e Prepare your new or existing database server [793]

e Install and configure your database (MySQL [794] or SQL Server [795])
¢ Restore database backups from traditional Replicated to KOTS [797]

e Configure custom memory settings for OpenSearch [797]

Preserve data assets

You must preserve project data assets from the traditional Replicated environment before beginning the
upgrade and before uninstalling the traditional Replicated Docker containers.

f’ Note
These assets are used when you provision your tenant [803].

To preserve data assets:

1. Create a backup of your tenant and OAuth databases. If you are installing KOTS in an environment
with a new database server, you must restore the backups to the new server.

2. Save the backup file to a location you can access easily. You need access to this file when provision-
ing the tenant in the new KOTS Replicated environment.
3. Preserve the data assets and save them to an accessible location:

cd /data/contour
tar -zcvf assets.tar.gz avatars/ attachments/ diagrams/ reports/ equations/
tempreports/

The data assets are saved.

Prepare your application server (upgrading traditional to KOTS)

Make sure your application server meets all requirements. See System requirements and supported
software [469].

For users and admins to properly access Jama Connect, specific ports must be accessible to inbound
traffic. Work with your network admin to make sure your network is configured properly.
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Prepare an existing application server

1.
2.

Important
These steps apply only if you are upgrading with an existing server.

You must remove Replicated services and all Docker packages before you upgrade to
KOTS.

You must preserve the existing data assets before you uninstall the traditional Replicated
Docker containers.

Record the existing settings of your Admin Console.
Stop the Replicated services.

Ubuntu/Debian sudo service replicated stop
sudo service replicated-ui stop
sudo service replicated-operator stop
sudo docker stop replicated-premkit
sudo docker stop replicated-statsd
RHEL/Fedora

systemctl stop replicated replicated-ui replicated-operator
service replicated stop

service replicated-ui stop

service replicated-operator stop

docker stop replicated-premkit

docker stop replicated-statsd

Stop and remove remaining containerd containers:

docker stop $(docker ps -aq)
docker rm $(docker ps -aq)

Run the command for your operating system to remove traditional Replicated platform elements.
Removing these items does not remove data or assets associated with provisioned tenants.

Important
Jama Connect is offline during this process. Make sure to inform your users of this
maintenance downtime.

Ub”Pt”/ docker rm -f replicated replicated-ui replicated-operator replicated-premkit replicated-
Debian statsd retraced-api \

retraced-processor retraced-cron retraced-nsqd retraced-postgres

docker images | grep "quay\.io/replicated” | awk "{print $3}" | xargs sudo docker rmi -f

docker images | grep "registry\.replicated\.com/library/retraced” | awk "{print $3}" |
xargs sudo docker rmi -f

apt-get remove -y replicated replicated-ui replicated-operator

apt-get purge -y replicated replicated-ui replicated-operator

rm -rf /var/lib/replicated* /etc/replicated* /etc/init/replicated* /etc/init.d/
replicated* \

/etc/default/replicated*

/var/log/upstart/replicated* /etc/systemd/system/replicated*
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RHEL/

Fed docker rm -f replicated replicated-ui replicated-operator replicated-premkit replicated-
edora

statsd retraced-api \

retraced-processor retraced-cron retraced-nsqd retraced-postgres

docker images | grep "quay\.io/replicated” | awk "{print $3}" | xargs sudo docker rmi -f
docker images | grep "registry\.replicated\.com/library/retraced” | awk "{print $3}" |
xargs sudo docker rmi -f

yum remove -y replicated replicated-ui replicated-operator

rm -rf /var/lib/replicated* /etc/replicated* /etc/init/replicated* /etc/default/
replicated* \

/etc/systemd/system/replicated* /etc/sysconfig/replicated* \
/etc/systemd/system/multi-user.target.wants/replicated* /run/replicated*

5. Stop and remove any remaining Docker resources, including containers, images, and volumes. This
affects all containers on the system, not only those associated with Jama Connect and Replicated.
docker kill $(docker ps -q)
docker rmi -f $(docker images| awk "{print $3}")
docker volume rm $(docker volume Is -qf dangling=true)
docker system prune -a -Ff

6. Remove remaining Docker packages to prepare for the KOTS installer.

Ubuptu/ #dpkg, purge and remove
Debian dpkg -1 | grep -i docker
sudo apt-get purge -y docker-engine docker docker.io docker-ce docker-ce-cli docker-
compose-plugin
sudo apt-get autoremove -y --purge docker-engine docker docker.io docker-ce docker-
compose-plugin
#remove remaining docker files
sudo rm -rf /var/lib/docker /etc/docker
sudo rm /etc/apparmor.d/docker
sudo groupdel docker
sudo rm -rf /var/run/docker.sock
RHEL/

sudo yum remove docker-ce docker-ce-cli docker-scan-plugin docker-ce-rootless-extras
Fedora containerd.io
sudo yum remove docker \

docker-client \

docker-client-latest \

docker-common \

docker-latest \

docker-latest-logrotate \

docker-logrotate \

docker-engine

7. After removing Docker from the server, you must reboot the server before proceeding with the
upgrade.

Your existing application server is now ready for the upgrade to KOTS.
Prepare all application servers (existing and new)

1. Inbound rules and ports for nodes — Make sure the ports in the following table are accessible to
inbound traffic and the inbound rules are configured for each server in the KOTS cluster.

Protocol Port range Source* Inbound rule ap- Description
plies to node...
HTTPS 443 Anywhere All Jama Connect port for SSL/TLS communication

(HTTPS), which is used to access Jama Connect. It can
be disabled or the port number can be reconfigured.

HTTP 80 Anywhere All Jama Connect port for clear text communication
(HTTP), which is used to access Jama Connect. It can
be disabled or the port number can be reconfigured.

TCP 8800 Anywhere All Allows admins to access the KOTS Admin Console,
which is used to configure, install, and upgrade Jama
Connect.

SSH 22 Anywhere All Allows admins to make remote connections to the no-

des using SSH.
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Protocol Port range Source* Inbound rule ap- Description
plies to node...

TCP 6443 Anywhere Primary Allows admins and KOTS nodes to access the Kuber-

netes API server.**
Any node

TCP 2379-2380 Any node Primary Allows the KOTS nodes to access the etcd server client
APL**

TCP 10250 Any node All Allows the KOTS nodes to access the Kubelet API
server.**

UDP 8472 Any node All Allows KOTS (Flannel) to create a virtual network that

connects the services running inside the cluster.**

* Anywhere means anyone or anything that must consume the resources in the environment.

** Can be disabled in single node clusters.

2. User IDs — Verify that the following User IDs are available and unused on the application server.

e User ID 91 — Used by Tomcat to read and write to directories inside jamacore pods.
e User IDs 480-499 — Used by the various services.

3. Time sync setting — To ensure accurate time on the application server, set up a cron job to sync the
time on a routine schedule (for example, every day or hour). Use this command to set up the cron
job:

ntpdate pool.ntp.org

Your application server is now ready for the upgrade to KOTS.

Preparing your new or existing database server (upgrading traditional to KOTS)
The following information is needed when connecting the application server to the database server.

Information Requirements

Type/vendor Database must be one of the following:

e MySQL 8.4.x (recommended)
e Microsoft SQL Server 2022

Database hostname Example: jama.companydb.com

Listening ports The application server must be allowed to communicate remotely with the database server over the
listening ports.

Default ports are:

e MySQL = 3306
e Microsoft SQL Server = 1433

Database schema name The database owner must be able to create one:

* A new database schema
o Tables inside an existing database schema of the given name

The database name must follow these rules:

e Start with a letter (a-z)
e Contain any number of characters: a-z, 0-9 or an underscore ("_")
o Letters must be lowercase

Username jamauser

Password

Connections The database must be able to accept a minimum of 300 concurrent connections.
SAML schema username samluser

OAuth database user- oauthuser

name

The username and password for SAML and OAuth must match what's entered in the Microsoft SQL
Server upgrade preparation script. See Install and configure Microsoft SQL Server [795] for more
details.
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Install and configure MySQL (upgrading traditional to KOTS)

MySQL is the recommended database server. Follow these steps to install and configure the server.
Important considerations

¢ You must have full database admin permissions to the server hosting the MySQL database.
e For the Jama Connect installation to succeed, you must first create two additional database schemas.

Recommended settings and sample

The following recommended settings require 8 GB of memory allocated to MySQL Server for a typical
installation and 16 GB for an enterprise installation.

These settings can be added to your my.cnf file (Linux) or my.ini file (Windows).

Property Typical installation Enterprise installation
max_allowed_packet 1GB 1GB
tmp_table_size 2GB 2GB
max_heap_table_size 2GB 2GB
table_open_cache 512 512
innodb_buffer_pool_size 2 GB 12 GB
innodb_log_file_size 256 MB 256 GB
innodb_log_buffer_size 12 MB 12 MB
innodb_thread_concurrency 16 16
max_connections 151 351
wait_timeout 259200 259200

Here is a sample text config file at an enterprise level. You must add the following values for your
environment:

bind-address=0.0.0.0
key_buffer_size=16M
max_allowed_packet=1G
thread_stack=192K

thread _cache size=8
tmp_table_size=2G
max_heap_table_size=2G
table_open_cache=512
innodb_buffer_pool_size=126G
innodb_log_file_size=256M
innodb_log_buffer_size=12M
innodb_thread_concurrency=16
max_connections=351
wait_timeout=259200

Important

The following steps apply only if you are creating a new database instance to support
the KOTS upgrade.

To install and configure MySQL.:

1. Make sure that the InnoDB engine is enabled.
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6.

Download and install a supported version of MySQL [469].
On the MySQL database server, create an empty Jama Connect schema / database that uses UTF8:
CREATE DATABASE jama character set utf8mb4;

On the MySQL database server, create two additional database schemas and a user ("jamauser")
with the ability to access, create, and update tables within the database:

CREATE DATABASE saml;

CREATE DATABASE oauth;

CREATE USER "jamauser®"@"%" IDENTIFIED BY "password”;

CREATE USER "oauthuser"@"%" IDENTIFIED BY "password-®;

CREATE USER “"samluser®@"%" IDENTIFIED BY "password”;

GRANT ALL PRIVILEGES ON jama.* TO "jamauser®"@"%";

GRANT ALL PRIVILEGES ON oauth.* TO "oauthuser"@"%";

GRANT ALL PRIVILEGES ON saml.* TO "samluser"@"%";

Create a database schema for Quartz to support horizontal scaling in KOTS:

CREATE DATABASE quartz;
CREATE USER T"quartzuser"@"%" IDENTIFIED BY "password®;
GRANT ALL PRIVILEGES ON quartz.* TO "quartzuser"@"%"

Restart the database server.

Follow the instructions to Restore backup data from traditional Replicated to KOTS [797].

Install and configure Microsoft SQL Server (upgrading traditional to KOTS)

If you are using Microsoft SQL Server for your database, follow these steps to install and configure it.

Important considerations

¢ You must have full database admin permissions to the server hosting the SQL Server database.

Important

The following steps apply only if you are creating a new database instance to support
the KOTS upgrade.

To install and configure SQL Server:

1.

2.

Connect to the SQL Server using a SQL management application (such as SQL Server Management
Studio).

Replace the following values in the installation script: <JAMA_LOGIN_Psswd>, <SAML_LOG-
IN_Psswd> & <OAUTH_LOGIN_Psswd>.

Copy and store the passwords you create here. You will need them later to configure the Admin
Console settings.

In a new query window, run this SQL query script:

-- Fresh Install Preparation SCRIPT
/*

INSTRUCTIONS:

This script must be run prior to Jama installation or installation might fail
to

complete.

Modify login passwords as needed.

Passwords must be enclosed in single quotes.

*/
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USE master;

CREATE LOGIN jamauser with password = "password”;
CREATE LOGIN samluser with password = "password-®;
CREATE LOGIN oauthuser with password = "password”;
GO

USE master;

CREATE DATABASE jama;

GO

ALTER DATABASE jama SET READ_COMMITTED_SNAPSHOT ON WITH ROLLBACK IMMEDIATE
GO

USE jama;

EXEC ("CREATE SCHEMA oauth®);
EXEC ("CREATE SCHEMA saml™);
GO

USE jama;

CREATE USER jamauser for LOGIN jamauser;

CREATE USER samluser for LOGIN samluser with DEFAULT_SCHEMA=saml ;
CREATE USER oauthuser for LOGIN oauthuser with DEFAULT_SCHEMA=oauth;
GO

EXEC sp_addrolemember N"db_owner®, jamauser;
EXEC sp_addrolemember N"db_owner®, samluser;
EXEC sp_addrolemember N*"db_owner®, oauthuser;
GO

Create a database schema for Quartz to support horizontal scaling in KOTS:

USE master;
CREATE LOGIN quartzuser with password = "password®;
GO

USE jama;
EXEC ("CREATE SCHEMA quartz®);
GO

USE jama;
CREATE USER quartzuser for LOGIN quartzuser with DEFAULT_SCHEMA=quartz;
GO

EXEC sp_addrolemember N"db_owner®, quartzuser;
GO

Confirm that these actions were successful:

o Script completed — Check the Query Execution results for errors.

e Users created — Run the following SQL script in a new query window.
USE jama

SELECT * from master.sys.sql_logins
SELECT * from Jama.sys.sysusers

The results include jamauser, samluser, and oauthuser in the "Name" column of the result panes.
e Users granted the DB_owner role — Run the following SQL script in a new query window.

USE jama

SELECT DP1.name AS DatabaseRoleName,

isnull (DP2.name, “No members®) AS DatabaseUserName
FROM sys.database_role_members AS DRM

RIGHT OUTER JOIN sys.database_ principals AS DP1

ON DRM.role_principal_id = DP1.principal_id

LEFT OUTER JOIN sys.database_principals AS DP2

ON DRM.member_principal_id = DP2_principal_id
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WHERE DP1.type = "R"
ORDER BY DP1.name;

The results show that db_owner role is granted to jamauser, samluser, and oauthuser.
7. Keep the database from locking users' accounts while they are logging in or working in Jama
Connect (you must have db_owner permissions):

ALTER DATABASE jama SET READ_COMMITTED_SNAPSHOT ON WITH ROLLBACK IMMEDIATE;
8. Make sure the flag was successfully enabled:
SELECT is_read_committed_snapshot_on FROM sys.databases WHERE name="jama®;

If the returned value is 1, the flag is on.

Follow the instructions to Restore backup data from traditional Replicated to KOTS [7971].

Restore database backups from traditional Replicated to KOTS

After you install and configure your MySQL or Microsoft SQL database server, you must restore backups
of the tenant and OAuth databases from the existing traditional Replicated database instance to the new
KOTS database instance.

Important

If you use SAML authentication in your traditional Replicated environment, it must be
configured in the new KOTS environment, rather than restoring from a backup.

When you restore the database, use instructions for MySQL or SQL Server.
To restore your database backups:

1. Restore the tenant database from a native backup to the new environment.
2. Restore the OAuth database from a native backup to the new environment.

Your database backups are restored to the new KOTS database instance.

Configure custom memory settings for OpenSearch (upgrading traditional to
KOTS)

To prepare for installing Jama Connect, you must first update the system that hosts the application. The
update consists of configuring memory settings for OpenSearch.

Requirements

e The memory settings must be configured on each server in the KOTS cluster for OpenSearch to run
on these servers. If you use the remote OpenSearch setting, the memory settings can be applied on-
ly to servers that are dedicated to OpenSearch.

¢ You must have admin permissions to configure the memory settings for OpenSearch.
To configure memory settings:

1. As an admin, open the /etc/sysctl.conf file, add the following line to the file, then save the file.
vm.max_map_count=262144

2. Reload the sysctl.conf file:
sudo sysctl -p

3. To confirm, type this command:
sudo sysctl -a | grep max_map_count
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The system responds with:
vm.max_map_count=262144

The memory settings on your system are now configured for OpenSearch.

Upgrading the Replicated platform from traditional to KOTS

Whether your organization is internet-enabled or requires an airgap installation, follow these instructions
to download, install, and configure the software you need for your Jama Connect instance.

Important

KOTS and Jama Connect must be installed on a new cluster that is created during
installation and dedicated to KOTS.

The software includes:

e KOTS Admin Console (Replicated)

e Jama Connect

e Jama Connect KOTS license file (contact your Customer Success Manager to request a KOTS internet
or airgap license)

The upgrade process consists of these tasks:

e Install KOTS and Jama Connect (internet [798] or airgap [800])
e Provision your tenant in Jama Connect KOTS [803]
e Create a Replicated Snapshot [807]

Depending on your environment, the process can also include these tasks:

Configure KOTS to save tenant assets in Amazon EFS

Enable horizontal scaling

Configure dedicated OpenSearch nodes

Configure Federated Authentication for KOTS Admin Console

Install the Jama Connect Replicated KOTS platform (internet)

The installation script and the installation wizard guide you through the process of installing the KOTS-
required software and Jama Connect, then configuring the KOTS Admin Console.

To install and configure the required software:

1. Contact your Customer Success Manager to request a KOTS internet license, then save the license
file on your local system.
2. Run the command on the application server provisioned for Jama Connect:

curl -sSL https://k8s.kurl_sh/jama-k8s-standardkots | sudo bash

The installation process can take up to an hour to complete.
3. After the command runs, save the KOTS admin URL, password, and other configuration options for
future reference. This is the only time these credentials appear, so make sure you save them.
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4. In asupported browser, enter the URL for Kotsadm, which was generated when you installed KOTS.
5. Login to the KOTS Admin Console using the password you just saved.

6. Select the appropriate option:

¢ Have key/certificate — Select Choose file under Private key and Certificate, navigate to the files
and select them, then select Upload & Continue.

¢ No key/certificate — Select Self-Signed Cert.

You can configure the SSL/TLS certificates in the KOTS Admin Console after the deployment as
needed.

Upload the license file that you saved on your local system.
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The Config tab in the KOTS Admin Console opens, where you can configure and provision Jama
Connect [803].

The installation script is finished and the license file is uploaded.

Install the Jama Connect Replicated KOTS platform (airgap)

The installation script and the installation wizard guide you through the process of installing the KOTS-
required software and Jama Connect, then configuring the KOTS Admin Console.

To install the software in an airgapped environment:

1. Contact your Customer Success Manager to request a KOTS airgap license, then save the license file
on your local system.

2. Login to the airgap portal, select Embedded Cluster, then download the jama-k8s Airgap Bundle
and Embedded Kubernetes Installer files to your local system.
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3. To download the Kubernetes Installer for your channel and install it, run the following command on
the application server provisioned for Jama Connect.

export REPLICATED_APP=jama-k8s
export REPLICATED_CHANNEL=standardkots

curl -LS https://k8s.kurl.sh/bundle/$REPLICATED_APP-$REPLICATED_CHANNEL.tar.gz \
-0 $REPLICATED_APP-$REPLICATED_CHANNEL .tar.gz
tar -zxvf $REPLICATED_APP-$REPLICATED_CHANNEL.tar.gz

cat install_sh | sudo bash -s airgap

If your application server doesn't have internet access, you can download the Kubernetes Installer
from the airgap-safe portal and upload it to the application server.

4. After the command runs (which might take several minutes), save the KOTS admin URL, password,
and other configuration options for future reference. This is the only time these credentials appear,
so make sure you save them.

5. Inasupported browser, enter the URL for Kotsadm, which was generated when you installed KOTS.

6. Loginto the KOTS Admin Console using the password you just saved.
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7. Select the appropriate option:

o Have key/certificate — Select Choose file under Private key and Certificate, navigate to the files
and select them, then select Upload & Continue.

¢ No key/certificate — Select Use Self-Signed Cert.

You can configure the SSL/TLS certificates in the KOTS Admin Console after the deployment as
needed.

8. Upload the license file saved on your local system.
9. Upload your jama-k8s airgap bundle, then select Continue.

The Config tab in the KOTS Admin Console opens, where you can configure and provision Jama Con-
nect [803].
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Provision your tenant in Jama Connect KOTS (upgrading traditional to KOTS)
After upgrading the KOTS Replicated environment, you must provision the existing tenant in the new
environment.

Important
The KOTS Admin Console doesn't support formulas. Instead, use literal values.

To provision your tenant in KOTS:

1. From the KOTS Admin Console, select the Config tab.

2. Configure the settings for each group, as needed. Scroll down to see each group of settings.

Important

Make sure that the current Host name, Database name, Username, and Password
are configured correctly in the KOTS Admin Console. If you installed KOTS in a
new environment, you must point to the newly installed database host or the
deployment fails.

e Database Settings — Select your database type (MySQL or Microsoft SQL Server), then use the
information from Preparing your database server to complete the settings.

e Host Name — Enter the name of the database server (for existing resources, enter current name;
for new resources, enter the new name).

e TLS Key Pair Source — (Optional) If you have a custom key and certificate for the host name,
select Custom TLS Configuration. In the TLS Configuration section, upload the key and certificate.

o Assets Size — Enter the estimated size of the assets based on the current data assets size of your
environment and its projected growth.
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5.

¢ OpenSearch Settings > Volume Size — Enter the amount of disk space that each OpenSearch
node is allowed to use.

(Optional) From the Config tab in the KOTS Admin Console, follow the steps to configure KOTS to

save tenant assets in the Amazon EFS.

Scroll down to Tenant Manager Settings and deselect the checkbox to disable it.

Disabling the Tenant Manager prevents Jama Connect from completing tenant provisioning, which

allows you to copy data assets and tenant.properties from the traditional replicated environment to

the KOTS environment.

Scroll to the bottom of the page and select Save config.
The Preflight checks run.
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From the Preflight checks screen, select Continue to deploy the Jama Connect application and

services.
When the system is available, the status in the KOTS Admin Console changes to Ready.

The deployment process can take up to an hour.

When the preflight checks are complete, Jama Connect creates the Kubernetes pods, which contain

the Jama Connect application and related services.
7. From the application server CLI, verify that the Kubernetes pods were successfully created:

kubectl get pods
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ubuntu@ip-18-59-8-42:~% kubectl get pods

MAME READY  STATUS RESTARTS  AGE
activemg-@ 111 Running @ 3d2@h
core-@ 111 Running @ 3d18h
diff-@ 171 Running @ 3d2@h
elasticsearch-@ 171 Running @ 3d2@h
hazelcast-@ 171 Running @ 3dz2@h

kotsadm-7dBEd7daf-x7agxc 171 Running a
kotsadm-postgres-@ 171 Running @
kurl-proxy-kotsadm-5c6bbB4446-1wdwg 171 Running @
nginx-@ 111 Running @ 3d2@h
oauth-@ 111 Running 3d18h
saml-@ 111 Running 3d18h
search-@ 171 Running 3dZ2@h

8. When the pods are ready and running, copy the data assets, which you preserved in an earlier task,
to an accessible location on the application server.

9. On the application server, set the tenant name for the environment (the tenant name, usually jama,
and can be found in the tenant.properties file is the name of the Jama Connect database schema):

export TENANT_NAME=<t enant _nane>

10. On the application server:

a. Copy and extract the previously preserved data assets into the running core pod and change
the ownership permissions:

kubectl cp -c core /tmp/contour/assets.tar.gz default/core-0:/home/contour/
tenant/${TENANT_NAME}/

kubectl exec --tty -c core pods/core-0 -- tar -xvzf /home/contour/tenant/$
{TENANT_NAME}/\

assets.tar.gz -C /home/contour/tenant/${TENANT_NAME}/

kubectl exec --tty -c core pods/core-0 -- chmod -R 755 /home/contour
kubectl exec --tty -c core pods/core-0 -- chown -R tomcat:tomcat /home/
contour

b. Delete the core stateful set to recreate the core pod:
kubectl delete sts/core
11. From the KOTS Admin Console, select the Config tab, enable the Tenant Manager Settings, then
select Save config.
12. Remove entries from the Jama Connect database tenantstate table to prepare for a new deploy-
ment:
DELETE FROM tenantstate;

13. To deploy the new version of Jama Connect:

a. From the KOTS Admin Console, select Deploy next to the newly saved version of Jama Con-
nect.

b. When the deployment is complete and all pods are running, log in to Jama Connect as root
using the hostname configured for Jama Connect.

c. If upgrading with new servers:
e SAML authentication must be configured in the new KOTS Jama Connect environment.
e Update the base URL before performing a full reindex.

d. Perform a full reindex in Jama Connect to complete the deployment.

The existing tenant is now provisioned in the new environment.

806



Upgrading from Jama Connect traditional to KOTS

Create a Replicated Snapshot (KOTS)

Taking a full snapshot creates a backup of the KOTS Admin Console and application data. It can be used
for full Disaster Recovery by restoring over the same instance or in a new cluster. Tenant assets are
included in the snapshot. OpenSearch data is included by default.

A Replicated Snapshot can be taken while Jama Connect is running without interruption.
Requirements

e Replicated Snapshots must be enabled for your Replicated customer license.

e KOTS Admin Console 1.79 and later.

e Replicated Snapshots don't include your database. You must use a proprietary backup/restore system
for your type of database, MySQL or SQL Server.

Important considerations

¢ When restoring from a snapshot in a new cluster, you must reinstall KOTS.

e Recommended — Include OpenSearch data in snapshots to avoid having to reindex your data after
performing a restore. However, if your snapshot is not recent, we recommend reindexing your data.

¢ Replicated Snapshots don't support IAM authentication against EFS. Saving Replicated Snapshots in
EFS requires that you use the default file system policy to allow all nodes in the cluster to mount the
EFS.

To create a Replicated snapshot:

1. Capture the KOTS installer.

2. (Recommended) Include OpenSearch data in snapshots: From the KOTS Admin Console under the
OpenSearch Settings section, select Include OpenSearch in Replicated Snapshots.

3. Airgap only — Capture the IP address of the private registry, which is the IP address value in the
Cluster-IP column:

kubectl get service/registry -n kurl

4. Configure the storage destination:
a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. From the Destination drop-down menu, select a storage destination for your snapshots.
e For AWS S3 — The IAM role assigned to the underlaying servers or the user associated with
the credentials (access and secret key) must have the Policy template attached.
Use the following template to create a policy, replacing the <arn-S3> parameter with ARN of
the S3 bucket. For example: arn:aws:s3:::;jama-snapshots.

{
"Version': '""2012-10-17",

"Statement": [
{
"Effect': "Allow",
"Action": [
"s3:PutObject",
"'s3:GetObject",
""s3:AbortMultipartUpload™,
"'s3:DeleteObject”,
"s3:ListMul tipartUploadParts™
1.
"Resource': ''<arn-s3>/*"
)
{
"Effect": "Allow",

"Action': "s3:ListBucket",
""Resource': '<arn-s3>"
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}

e For NFS — If using EFS as an NFS server, the Server field = the DNS name of the EFS and the
Path field = a directory inside the EFS, writable by the user:group 1001:1001.
c. Select Update storage settings to save your preferences.
5. Schedule Full Snapshots:
a. Inthe KOTS Admin Console, select Snapshots > Settings & Schedule.
b. Select Enable automatic scheduled snapshots, then select Update schedule.
6. Create a Full Snapshot (follow the steps provided by Replicated).

The Full Snapshot is now available if you need to restore your environment for Disaster Recovery.

After upgrading Jama Connect traditional to KOTS

Whether your environment is internet-enabled or airgap, after upgrading from Jama Connect traditional
to KOTS you can continue to set up your Jama Connect environment.

Follow any post upgrade instructions that apply to your organization, which can be found in the Jama
Connect 9.35.x User Guide:

Add Organization Admin account

Modify organization details

Configure email/collaboration settings

Configure user authentication

Create XML backups (optional)

Update the license for KOTS environments (optional)

If you have further questions about Jama Connect installation and setup, visit the Jama Support Com-
munity or contact Support.

808


https://docs.replicated.com/enterprise/snapshots-creating#full
https://community.jamasoftware.com/home
https://community.jamasoftware.com/home
https://support.jamasoftware.com/hc/en-us

	Jama Connect Help
	Table of Contents
	Welcome to Jama Connect
	Getting started
	Log in to Jama Connect
	Exploring the Jama Connect workspace
	Explorer Tree
	Toolbar
	List View
	Document View
	Trace View
	Single Item View
	Side toolbar
	Compare View


	Learn more

	Setting up your work environment
	Reset your password
	Set API credentials
	Configure email notifications and subscriptions
	Configure your profile to receive review notifications
	Customize the Explorer Tree
	Configure fields
	Add and delete bookmarks


	Getting to know Jama Connect features
	Item-based product development
	Project approach and tree structure
	Traceability from Requirements to Test
	How reviews work
	Testing
	Exporting documents from Jama Connect
	All about baselines
	Using Categories to manage product variants
	Change management
	Reuse and synchronization
	Administration
	Manage item types
	Managing relationship rules
	Managing workflow

	REST API and extensibility
	Jama Connect top tasks

	Creating content
	Containers
	Add a component
	Add a set
	Add a folder

	Items
	Add an item
	Quick-add an item
	Add a child item
	Edit an item
	Edit an item in List View
	Batch-edit multiple items
	Add, edit, or delete links
	Using and managing locked items
	View and unlock items across projects
	Locking an item
	Manually lock and unlock items from the toolbar
	Lock or unlock items in List View

	Converting items to another item type
	Convert items using drag and drop
	Convert items in List View or Explorer Tree
	Convert items back to their original type

	Moving items
	Move items in Explorer Tree
	Move items in List View
	Move items between projects

	Duplicate an item
	Delete an item
	Restore a deleted item

	Tags
	Add and delete tags

	Attachments
	Add, edit, and delete attachments

	Using the rich text editor
	Insert image to rich text fields
	Insert a link in rich text fields
	Add and edit tables with rich text editor
	Insert rich text diagrams
	Insert equations in rich text fields
	Insert templates to rich text editor
	Run Accessibility Checker

	Importing content into Jama Connect
	Importing items from a Word file
	Setting hierarchy with heading styles
	How tables are imported from Word
	Prepare your Word file for import
	Import a Word file

	Importing from Excel
	Preparing a worksheet to import items
	Defining header row in Excel
	Defining pick lists in Excel
	Setting hierarchy with color in Excel
	Setting hierarchy with indentation in Excel
	Preparing a worksheet to import test cases
	Add and delete a test step in Excel
	Import items or test cases from Excel
	Export/import via Jama Connect-to-Excel round-trip 
	Relationship Import Plugin
	Preparing your CSV file
	Import relationships from Excel



	Importing from IBM DOORS
	DOORS export prerequisites
	Jama Connect prerequisites for DOORS import
	Create custom fields in Jama Connect
	Export data from DOORS
	Import DOORS files to Jama Connect



	Searching for content
	Full text search
	Search for content
	Filter items for targeted results

	Advanced filters
	Create or edit an advanced filter
	Copy and customize an advanced filter
	Filter the Explorer Tree
	Export data from advanced filters


	Reviews in Jama Connect
	Roles for review workflow
	Review lifecycle — Who does what during a review
	Workflow status for reviews
	Review Center dashboard views
	Moderator tasks
	Create a review
	Define your review — Definition page
	Configure review settings — Settings page
	Choose reviewers — Participants page
	Configure email notification — Invitation page

	Add and manage review participants
	Modifying an "In progress" review
	Modify a "Closed" review
	Incorporate review feedback
	Close an "In progress" review
	Publish a revised review
	Finalize a review
	Delete a review
	Archive a review
	Recover an archived review
	Remove or recover items in a review
	Transition a Peer review to an Approval review
	Close and finalize an Approval review

	Reviewer tasks
	Contribute feedback
	Finish a review as a reviewer

	Approver tasks
	Approve or reject review items
	Finish a review as an approver
	Sign a review electronically
	Delegate approval
	Add reviewers

	Review administrator tasks
	Recover a deleted review
	Configure review comments to appear in projects

	Tasks for all participant roles
	Filter items in a review
	Highlighting review comments
	Apply @mention to review comments
	Compare versions
	Show related items in a review
	View participant progress
	View item progress
	View review activity
	Filter review comments
	Subscribe to a review
	Export reviews
	Voting


	Categories
	Managing categories in projects (users)
	Apply or unapply categories (user)

	Controlling the Categories feature (organization admin)
	Enable the Categories feature (organization admin)
	Enable category management for locked items (organization admins)
	Add a new category (organization admin)
	Edit category properties (organization admin)
	Remove a category variation (organization admin)
	Delete a category (organization admin)
	Organize the Category tree (organization admin)
	Managing category access to projects (organization admin)
	Add Categories field to items in review (organization admin)
	Configure access to projects (organization admin)


	Collaborating with your team
	Email notifications and subscriptions
	Subscribe to email notifications for yourself
	Subscribe other users to email notifications

	Workflow
	Using workflow in Projects
	Use workflow to batch transition items
	Use workflow to batch transition items in reviews
	Lock items in a workflow (organization or project admin)


	Stream — Staying connected
	Types of streams
	Global stream
	Project Activity Stream
	Item Collaboration Stream
	Baseline Activity Stream
	Review activity (stats)
	Test Plan Activity Stream

	Activity Stream
	Comments
	Add, delete, or restore a comment
	Add a comment hashtag
	Add an @mention reference
	Add a reviewer from outside Jama Connect
	View referenced projects and items

	Email notifications for the stream
	Upload images to the Stream
	Request or resolve an action
	Filter the Stream
	View collaboration Stream at an item level
	View Collaboration Stream at a project level
	View Comment and Activity Stream for an item
	View the Collaboration Stream across projects
	View connected users

	Electronic signatures
	Sign a review electronically
	Add signer role
	Sign a baseline electronically


	Managing your content
	Item versions
	Change the current item version
	Compare versions of an item
	View previous versions of an item

	Change requests
	Add a change request and associate items
	Edit a change request association
	Run Impact Analysis on a change request
	Delete change request associations
	Close a change request

	Releases
	Assigning an item to a release
	Release field
	Customize the Release settings

	Baselines
	What is a baseline source?
	Benefits of organizing your baseline tree
	Compare baselines in Baseline source List View
	Create a baseline manually
	Edit a baseline
	Locate an existing baseline
	Compare baselines
	Compare current baseline to an older version
	Open baselined items in Single Item View
	View baseline activity
	Locate review baselines
	Sign a baseline electronically
	Delete a source or baseline
	Replace current items with a baselined version
	Reuse baselined items

	Coverage and traceability
	Trace View
	Save, copy, and bookmark a Trace View
	Export a Trace View
	Filter items in Trace View

	Relationships
	Relationships and access permissions
	Relationship Status Indicator
	Add a relationship from Single Item View
	Add a new related item
	Allow locked items to be related (organization admin)
	Filter relationships
	Relate to an existing item
	Clear suspect links

	Run Impact Analysis
	Coverage Explorer
	Create and export views in the Coverage Explorer

	Live Trace Explorer
	What's included in the diagram
	Understanding the diagram
	Interpreting the Trace Score calculation
	How the trace path figures are calculated
	Enable Live Trace Explorer (organization admins)
	Enable Live Trace Explorer for creators (organization and project admins)
	Save an existing diagram
	Generate a diagram (organization and project admins)
	Modify a tile in the diagram
	Modify the entire diagram
	Export a Live Trace Explorer diagram to PDF


	Reuse and synchronization
	Reuse
	Reuse an item
	Add and edit reuse rules

	Synchronization
	Sync options window
	Break synchronization
	Synchronize items from Synced Items window
	Connect items from Single Item View
	Compare synchronized items
	Configure Compare View for synchronized items



	Exporting data to a document
	Export to Word
	Export to Excel
	Export to PDF
	Restore line breaks by updating Report Parameters (organization admin)
	Office Templates
	Export data with Office templates
	Download an existing export template
	Upload an export template for a report
	Create an All Item Details report
	Create a Coverage Report
	Generate the Word Template Reference Guide
	Embed custom fonts in exports



	Testing for verification
	Test cases
	Manage test cases
	Import test cases
	Edit test cases using round-trip
	Special use of item types for test
	View and edit test case details
	Export test cases to Microsoft Excel
	Test steps
	Add and edit test steps
	Add images to test steps

	Test case status
	Add a Test Run Results column

	Test plans
	Add a test plan
	Add test cases to a plan
	View test plan details
	Edit a test plan
	Send a test plan for review
	Duplicate a test plan
	Archive a test plan
	Delete a test plan
	Test groups
	Add, edit, or delete a test group


	Test cycles
	Add a test cycle
	Edit a test cycle
	Send a test cycle for review

	Test runs
	Find and manage test runs
	View test run details
	Configure test run view
	Assign test runs
	Execute a test run
	Archive a test run
	Configure custom fields to appear during test execution
	Sync test runs with test cases
	View the test run status summary
	Batch update test run status
	Using the Test Runs widget


	Analysis — Monitoring your project
	Working with dashboards
	View and customize the dashboard (user)
	Configure the dashboard (organization or project admin)
	Dashboard widget options

	Reports
	Run a report
	Run a Baseline Current Diff report
	Run a Baseline Comparison report

	Custom reports
	View and download Reports history
	Manage the Reports history page
	Export Velocity reports to Excel


	Installing Jama Connect (KOTS)
	Installation workflow (KOTS)
	Planning your installation (KOTS)
	System requirements and supported software (KOTS)
	Application server requirements (KOTS)
	Resource sizing for application server (KOTS)
	Database server requirements (KOTS)
	Resource sizing for database server (KOTS)
	Things to do before installation (KOTS)
	Run the KOTS preflight installation checks
	Prepare your application server (KOTS)
	Preparing your database server (KOTS)
	Install and configure MySQL (KOTS)
	Install and configure Microsoft SQL Server (KOTS)
	Configure custom memory settings for OpenSearch (KOTS)


	Installing the software (KOTS)
	Install Jama Connect and KOTS (internet)
	Install Jama Connect and KOTS (airgap)
	Provision your Jama Connect dataset (KOTS)
	Create a Replicated Snapshot (KOTS)
	Capture KOTS Installer (KOTS)
	Restore KOTS Admin Console and Jama Connect from a Replicated Snapshot (KOTS)
	Enable horizontal scaling (KOTS)
	Configure dedicated OpenSearch nodes (KOTS)
	Configure KOTS to save tenant assets in Amazon EFS
	Back up tenant assets to a TAR file in KOTS
	Restore tenant assets from TAR in KOTS
	Configure Federated Authentication for KOTS Admin Console
	After installing Jama Connect (KOTS)
	Troubleshooting your installation (KOTS)
	Installation errors (KOTS)
	Connection errors (KOTS)
	Federated Authentication errors (KOTS)
	Backup and restore errors (KOTS)
	Generate a support bundle (KOTS)
	Configure Liveness and Readiness Probe settings (KOTS)
	KOTS FAQ



	Upgrading Jama Connect (KOTS)
	Perform a clean installation of Jama Connect
	Performing an in-place upgrade of Jama Connect (internet)
	Update the Jama Connect KOTS platform (internet)
	Update the Jama Connect KOTS platform from Longhorn-based deployments to OpenEBS (internet)
	Upgrade Jama Connect with KOTS (internet)

	Performing an in-place upgrade of Jama Connect (airgap)
	Update the Jama Connect KOTS platform (airgap)
	Update the Jama Connect KOTS platform from Longhorn-based deployments to OpenEBS (airgap)
	Upgrade Jama Connect with KOTS (airgap)

	Reindex all search items
	Troubleshooting your upgrade (KOTS)
	Troubleshoot HorizontalPodAutoscaler errors if Jama Connect deployment fails
	Troubleshoot PersistentVolumeAccessMode errors if Jama Connect deployment fails
	Troubleshoot kURL installer errors if node connectivity tests fail
	Troubleshoot ingress errors if Jama Connect deployment fails


	Administration
	Authentication methods
	SCIM provisioning for user management
	REST API
	Configure the REST API Access Control feature
	Manage REST API access for groups and users
	Monitor REST API usage

	Supported image extensions and attachment types
	System administrator (KOTS)
	Configuring the Admin Console settings
	Create a Replicated Snapshot (KOTS)
	Restore KOTS Admin Console and Jama Connect from a Replicated Snapshot (KOTS)
	Configure database settings
	Configure web server settings
	Configure host name
	Bypass browser TLS warning
	Configure TLS certificate
	Configure memory settings
	Configure advanced startup settings
	Configure Search Service Settings
	Set a custom location for the MathType Equations Editor

	Setting up Jama Connect
	Log in as root for the first time
	Assign a new user as organization admin
	Grant permissions to users
	Edit organization details
	Configure general properties
	Configure Inbound email (IMAP) settings
	Configure Outgoing Email (SMTP) settings
	Configure Basic authentication
	Configure SAML authentication
	Configure multi-mode authentication
	Configure LDAP authentication
	Troubleshooting LDAP errors

	Configure Crowd authentication
	How users and groups work in Crowd


	Backing up and restoring your data
	Create a Replicated Snapshot (KOTS)
	Restore KOTS Admin Console and Jama Connect from a Replicated Snapshot (KOTS)
	Back up to .jama or XML file
	Restore to a new server from .jama or XML
	Backing up MySQL or SQL Server database

	Maintaining your Jama Connect environment
	Monitoring memory usage
	Maintaining your Jama Connect database
	Deactivate and reactivate users
	Reset Admin Console password
	Update the license
	Update the certificate
	Change URL
	Update URL references after changing URL
	Delete an organization
	Remove old Docker images
	Remove unused container images
	View scheduled jobs
	View applied patches
	Clear cache
	Reindex all search items
	Folder locations

	Upgrading from Jama Connect traditional to KOTS
	Troubleshooting
	Thread dump
	View and configure logging
	Reconnect to the Wiris server (self-hosted only)


	Organization administrator
	Monitoring changes with the Admin Activity stream
	Managing content
	Change Global ID
	Configure baselines status for pick lists
	Unlock items locked by another user
	Unlock system-locked items
	Configuring reuse and synchronization
	View a system health report
	Plugins
	Relationship Import Plugin
	Preparing your CSV file
	Gathering information for the Relationship Import Plugin
	Configure the Relationship Import Plugin
	Import relationships from Excel

	Configure the User Import Plugin

	Upload custom reports and exports

	Managing relationships
	Configure relationships
	Set relationship types
	Set up relationship rules

	Managing users and groups
	User groups
	Add a user group

	Add a user
	Configure the User Import Plugin

	Add users to multi-mode authentication
	Edit user details
	Edit user and group subscriptions
	Reset user password
	License types and permissions
	Configure Jama Connect for test runner license
	Batch update license types
	Monitor license usage
	View license details

	Organize and manage project folders
	Grant permissions
	Roles
	Deactivate and reactivate users

	Managing process
	Fields
	Predefined fields
	Custom fields
	Add, edit, or delete fields
	Enable test case item
	Hide test case status field
	Pick lists
	Manage pick list values

	Add a lookup matrix

	Configure organization details
	Item types
	Add and edit item types
	Enable or disable item widgets
	Use a different item type as a test case or defect
	Enable test case item
	Change a set key

	Configure workflow for item type
	Set up editor templates
	Configure views
	Managing relationships
	Configure relationships
	Set relationship types
	Set up relationship rules
	Configure the Relationship Import Plugin

	Managing tests
	Test run item

	Managing collaboration
	Configure organization details
	Edit user and group subscriptions
	Manage Stream comments

	Managing reviews
	Configure review access
	Item workflow for Approval Reviews

	Organizing projects
	Add a project
	Edit project details
	Change a project key
	Duplicate a project
	Archive a project
	Delete a project

	Integrations
	Integrate OSLC Model Connector with Jama Connect


	Project administrator
	Monitor changes with the Admin Activity stream (project admin)
	Managing projects
	Edit project details
	Configure item types for a project
	Configure default Explorer Tree settings
	Project key
	Unique ID
	Change a project key
	Change a set key
	Manage releases
	Manage attachments
	Manage tags
	Manage workflows
	Set up a project workflow
	Configure workflow for item type
	Lock items in a workflow (organization or project admin)

	Unlock system-locked items
	Configure project settings
	Clean up your project and baselines
	Index project items

	View project users
	Manage project-level groups
	Edit user and group subscriptions
	Grant project permissions



	Reference
	Permissions
	License types and permissions
	Error messages — Licensing issues
	Roles
	Permissions granted by role
	Roles and permissions
	Permission questions and scenarios

	Access permissions
	Relationships and access permissions


	Quick find
	Find an item in the Explorer Tree
	Find moved items
	Find synchronized items
	Find advanced filters
	Find review status
	Find relationships
	Find relationship rules
	Find suspect links
	Find test cases
	Find test plans

	Best practices and guardrails
	Keyboard shortcuts
	Application performance testing
	Getting help 
	Widgets
	Glossary
	Jama Connect Interchange (JCI)

	Jama Connect MCP™
	Upgrading from Jama Connect traditional to KOTS
	Workflow for upgrading from traditional to KOTS
	Planning your upgrade to KOTS
	Run the KOTS preflight installation checks
	System requirements and supported software (KOTS)
	Application server requirements (upgrading traditional to KOTS)
	Resource sizing for application server (upgrading traditional to KOTS)
	Database server requirements (upgrading traditional to KOTS)
	Resource sizing for database server (upgrading traditional to KOTS)
	Things to do before upgrading from traditional to KOTS
	Preserve data assets
	Prepare your application server (upgrading traditional to KOTS)
	Preparing your new or existing database server (upgrading traditional to KOTS)
	Install and configure MySQL (upgrading traditional to KOTS)
	Install and configure Microsoft SQL Server (upgrading traditional to KOTS)
	Restore database backups from traditional Replicated to KOTS
	Configure custom memory settings for OpenSearch (upgrading traditional to KOTS)


	Upgrading the Replicated platform from traditional to KOTS
	Install the Jama Connect Replicated KOTS platform (internet)
	Install the Jama Connect Replicated KOTS platform (airgap)
	Provision your tenant in Jama Connect KOTS (upgrading traditional to KOTS)
	Create a Replicated Snapshot (KOTS)
	After upgrading Jama Connect traditional to KOTS





